Create apps and visualizations
Contents

1 About this document ........................................................................................................... 8

2 Creating apps ..................................................................................................................... 9
  2.1 Foundation ....................................................................................................................... 9
    Data load script .................................................................................................................. 9
    Data model ......................................................................................................................... 9
    Measures ............................................................................................................................ 9
    Dimensions ....................................................................................................................... 10
  2.2 Structure and visuals ....................................................................................................... 10
    Sheets ................................................................................................................................ 10
    Bookmarks ....................................................................................................................... 10
    Stories ............................................................................................................................... 10
  2.3 More about apps ............................................................................................................ 10
  2.4 Structuring an app using sheets ..................................................................................... 11
    Overview ........................................................................................................................... 11
    Creating a new sheet .......................................................................................................... 12
    Changing the title and description of a sheet ................................................................. 12
    Changing the sheet thumbnail ....................................................................................... 13
    Changing the grid sizing of a sheet ................................................................................ 14
    Customizing sheet size .................................................................................................... 16
    Changing the small screen layout ................................................................................ 16
    Extending the sheet area .................................................................................................. 17
    Copying, replacing and moving items on sheets .......................................................... 17
    Duplicating a sheet ........................................................................................................... 17
  2.5 Managing apps ................................................................................................................ 18
    Creating an app ................................................................................................................ 18
    On-demand apps ............................................................................................................. 18
    Styling an app .................................................................................................................. 23
    Converting a QlikView document into a Qlik Sense app ........................................... 28
    Manually converting a QlikView document into a Qlik Sense app ............................ 28
    Changing the title and description of an app ............................................................... 32
    Changing the thumbnail of an app ............................................................................... 32
    Duplicating an app ........................................................................................................... 33
    Deleting an app ............................................................................................................... 33
    Uploading image files to media library ........................................................................ 34
    Deleting image files from media library ....................................................................... 35
  2.6 Adding apps to the cloud hub ....................................................................................... 36
    Creating apps in the cloud hub .................................................................................... 37
    Reloading app data in the cloud hub ............................................................................ 39
    Editing app details in the cloud hub ............................................................................ 40
    Exporting apps from cloud hubs ................................................................................ 40
    Deleting apps in the cloud hub ..................................................................................... 41
    Troubleshooting - Creating apps in the cloud hub .................................................... 41
  2.7 Troubleshooting - Creating apps .................................................................................. 42
    Images are not included in an app that has been moved from one Qlik Sense environment to another .............................................................. 42
Images are not included in an app that has been moved from one Qlik Sense Desktop installation to another ................................................................. 43
The image I want to use does not seem to work ........................................... 44
Using insights advisor impacts system performance ........................................... 44
3 Creating visualizations .............................................................. 45
  3.1 Understand the data sources for your visualizations ........................................ 45
  3.2 Select visualization types that align with your purpose ...................................... 46
  3.3 Update visualizations to improve how data is displayed ................................... 46
  3.4 Data assets in visualizations ........................................................................ 46
    Data assets ..................................................................................... 47
    Expressions .................................................................................... 48
    Data types in visualizations ................................................................. 48
    Fields ............................................................................................... 49
    Dimensions ..................................................................................... 58
    Measures .......................................................................................... 61
    Reusing assets with master items ......................................................... 62
    Using expressions in visualizations ...................................................... 86
    Searching in the assets ...................................................................... 99
    Designing visualizations with Direct Discovery ..................................... 100
  3.5 When to use what type of visualization ...................................................... 101
    Viewing comparisons ......................................................................... 101
    Viewing relationships ........................................................................ 102
    Viewing compositions ....................................................................... 102
    Viewing distributions ........................................................................ 102
    Viewing performances ....................................................................... 103
    Viewing data .................................................................................... 103
    Viewing geography .......................................................................... 103
    What if no standard chart suits my purpose? ........................................... 104
  3.6 Visualizations .................................................................................... 104
    Creating a visualization ....................................................................... 104
    Reusing a visualization ...................................................................... 105
    Which visualizations are available? ....................................................... 105
    Bar chart ......................................................................................... 107
    Box plot ........................................................................................... 121
    Combo chart .................................................................................... 130
    Distribution plot ............................................................................... 140
    Filter pane ....................................................................................... 149
    Gauge ............................................................................................... 155
    Histogram ......................................................................................... 160
    KPI .................................................................................................. 165
    Line chart ........................................................................................ 170
    Maps ................................................................................................ 179
    Pie chart ........................................................................................... 218
    Pivot table ......................................................................................... 228
    Scatter plot ...................................................................................... 242
3.7 Creating and editing visualizations ......................................................... 287
Creating visualizations .............................................................................. 287
Editing visualizations ................................................................................. 288
Best practices for designing visualizations .................................................. 289
Creating visualizations from your data using insight advisor .................... 292
Creating visualizations using chart suggestions ......................................... 295
Guidelines for visualizations, fields, and naming ........................................ 297
Using alternate states for comparative analysis ......................................... 303
Creating a visualization using a custom object ............................................ 305
100% stacked bar chart .............................................................................. 320
Area chart ................................................................................................. 321
Adding connectors ...................................................................................... 322
Setting stacked bars to 100% ..................................................................... 322
Adding transitions ....................................................................................... 322
Changing the color scheme ....................................................................... 324
Changing the range limits ......................................................................... 324
Changing the scale of the axis .................................................................... 324
Funnel mode .............................................................................................. 327
Colors ........................................................................................................ 329
Styling, formatting ...................................................................................... 332
Using the lasso selection tool ..................................................................... 335
Using dimension selection option ............................................................... 336
Changing the color scheme ....................................................................... 336
Changing label colors ................................................................................. 337
Toggling the legend ..................................................................................... 337
Adjusting tile opacity .................................................................................. 337
Using a mean in scale ................................................................................ 337
Setting a fixed scale ................................................................................... 338
Toggling titles .............................................................................................. 338
Changing label sizes on chart axes ............................................................. 338
Limiting dimension values ........................................................................ 338
Setting minimum horizontal size ............................................................... 338
Number formatting ..................................................................................... 338
3.8 Multi KPI properties ............................................................................... 340
Coloring a Multi KPI .................................................................................. 341
Changing sizes of a Multi KPI .................................................................... 342
Changing the fonts of a Multi KPI ............................................................... 342
Changing icons .......................................................................................... 342
Using infographic mode ............................................................................. 343
Embedding a master visualization .............................................................. 344
Using Styles (CSS) properties ................................................................. 345
Layout, style, formatting, alignment ......................................................... 345
3.9 Limitations ......................................................................................... 350
Configuring edge type ............................................................................... 353
Toggling edge value .................................................................................. 354
Configuring edge label ............................................................................. 354
Configuring node shape ........................................................................... 355
Toggling shadow option ........................................................................... 355
Sorting ....................................................................................................... 355
Number formatting .................................................................................... 355
Style template format ............................................................................... 357
Style template example for profit and loss reporting .............................. 358
Changing the color scheme ..................................................................... 361
Changing the stroke type ........................................................................ 362
Toggling the legend ................................................................................. 362
Limiting dimensions ................................................................................ 362
Toggling titles ........................................................................................... 362
Number formatting ................................................................................... 362
Link colors ............................................................................................... 365
Link opacity .............................................................................................. 365
Node colors ............................................................................................... 366
Node padding and width ........................................................................... 366
Troubleshooting ........................................................................................ 367
Setting the number of columns ............................................................... 368
Setting the y-axis range of charts ............................................................ 368
Slide mode ............................................................................................... 368
Unsupported visualizations ..................................................................... 369
Multi KPI visualizations with embedded master visualizations ............. 369
Changing the orientation ........................................................................ 370
Adjusting the start and end angles .......................................................... 371
Changing font size ................................................................................... 371
Changing scale ........................................................................................ 371
Setting custom ranges ............................................................................ 371
Formatting numbers ................................................................................ 372
Copying a visualization from an existing visualization ............................ 373
Creating time-aware charts ..................................................................... 374
Changing the data of a visualization ......................................................... 374
Changing the appearance of a visualization ............................................. 380
Examples ................................................................................................. 394
RGB ........................................................................................................ 396
ARGB ......................................................................................................... 396
HSL ............................................................................................................ 396
Color keywords ....................................................................................... 397
Qlik Sense color functions ....................................................................... 397
Example 1: Coloring by a dimension in the visualization ................................................. 403
Example 2: Coloring by a dimension not included in the visualization .............................. 404
Example 1: Color by expression in a table ................................................................. 405
Example 2: Color by expression in a chart ................................................................. 406
Converting a visualization to another kind of visualization ........................................... 407
Embedding a visualization or a sheet in a web page ..................................................... 408

3.10 Troubleshooting - Creating visualizations .......................................................... 410
I cannot find the fields in the assets panel ................................................................. 410
My chart is not sorted correctly .................................................................................. 410
My calendar measures display incorrect aggregations in visualizations ....................... 411
There are no time ranges to select in Create calendar measures .................................. 411
My date field selected for calendar measures does not use the correct calendar ............... 411
I cannot edit a variable value ....................................................................................... 412
The map is placing the locations in my location field incorrectly ..................................... 412
No map is displayed ..................................................................................................... 412
Error message: The data contains invalid geometries that could not be shown on the map.
Review your data for errors and try again. ..................................................................... 413
Error message: The following locations could not be found: <locations>. Review the values
in your data and try again. ............................................................................................. 413
Error message: The following locations could not be located: <locations>. Review the values
in your data and try again. ............................................................................................. 414
Error message: The following locations had more than one result: <locations>. Set a
custom scope to clarify which locations to display. ...................................................... 414
Error message: Some lines could not be shown because of invalid data in the width
expression. Review your data for errors and try again. .............................................. 414
Error message: Some density points could no be shown because of invalid data in the
weight expression. Review your data for errors and try again. .................................... 415
I added an image background layer and cannot see my image ........................................ 415
1 About this document

Visualizations are used to present the data that is loaded into the app. The selections you make in the app are reflected in all associated visualizations on all sheets.

Read and learn how to create and customize sheets and visualizations in your app. You will also learn about creating reusable master items, and about expressions in visualizations.

This document is derived from the online help for Qlik Sense. It is intended for those who want to read parts of the help offline or print pages easily, and does not include any additional information compared with the online help.

You find the online help, additional guides and much more at help.qlik.com/sense.
2 Creating apps

A Qlik Sense app is a collection of reusable data items (measures, dimensions, and visualizations), sheets and stories. It is a self-contained entity that includes data in a structured data model for analysis.

The purpose of an app is to let you and others make data discoveries and decisions using data visualizations and making selections.

The foundation of an app is a collection of reusable data items. The structure and visuals is a collection of sheets and stories.

2.1 Foundation

Data load script
You use a data load script to load data into the app. The script connects to a data source (database, Excel sheet, etc.) and retrieves the data.

Data model
The loaded data is structured in a data model. You edit the data load script and reload the data to build the data model you find is best suitable for your app.

Measures
Measures are calculations and expressions for use in visualizations.
Measures are calculations for use in visualizations. Measures are created from an expression composed of aggregation functions, such as **Sum** or **Max**, combined with one or several fields.

For more information, see *Measures (page 61)*.

**Dimensions**

Dimensions are fields for use in visualizations. Dimensions determine how the data in a visualization is grouped - for example total sales per country or number of products per supplier.

For more information, see *Dimensions (page 58)* and *Fields (page 49)*.

### 2.2 Structure and visuals

**Sheets**

Sheets include data visualizations, such as charts and tables. You create a structure in the app by grouping visualizations with different purposes on different sheets.

**Bookmarks**

Bookmarks are shortcuts to a certain set of selections on a particular sheet.

**Stories**

Stories are based on snapshots of visualizations. You present your data by creating a story that guides you to new insights by combining snapshots of data at specific times and selection states.

### 2.3 More about apps

The app makes it possible for people to create new visualizations based on any questions they might have, for example by using dimensions and measures that are defined in the app, thus further developing the app for personal use or to share with others.

 Whoever creates an app is automatically designated as its owner. An app can be re-used, modified and shared with others, depending on access rights. Different actions can be carried out depending on if the app is published or not.

---

**The .qvf file format is a proprietary format.**

**In Qlik Sense Desktop, apps are typically stored in <user>\Documents\Qlik\Sense\Apps, as <Appname>.qvf, where <Appname> is the name of the app. If you rename an app in Qlik Sense Desktop, the .qvf is not updated.**
2.4 Structuring an app using sheets

Sheets structure your ideas and purpose of your app. When you create an new app, it is good practice to first build a structure of empty sheets, where each sheet represents an idea or a goal. This gives a good overview of the app.

Overview

For example, you are creating an overview of your company's key metrics, sales, and margins by state, region, and product. Instead of having all this information in one place, you could structure it by having one sheet for each purpose.

Each sheet has a purpose and an idea of its own.

A sheet is where charts and tables for data visualization are placed. An app can include several sheets. The selections that you make affect visualizations, regardless of which sheets they are on.

An example of a sheet with boxes on the left to select and filter out the data to be presented in the visualizations on the right.
Creating a new sheet

You can create a new sheet from the app overview or from the sheet navigator.

You access the sheet navigator from the sheet view by clicking in the toolbar.

Do the following:

1. From the app overview, click to view the sheets.
2. Click or Create new sheet.
3. Give your sheet a title and add a description.
4. Click outside the text area to save the title and description.

A new sheet is created.

Changing the title and description of a sheet

You can change the title and description of your sheets. You can either use a fixed sheet title, or a dynamic sheet title based on an expression.

Do the following:
2. Creating apps

1. In the app overview, click 📊 to view the sheets.
2. Do one of the following:
   - If you are in grid view, 📑, click the sheet title followed by clicking 🖊.
   - If you are in list view, 📐, click 🖊.
3. Edit Title and Description.
4. Click outside the text area.
The changes you made are saved.

You can also change a sheet’s title and description in the Sheet properties panel.

Using a dynamic sheet title

You can set a dynamic sheet title based on an expression in the Title expression property of the sheet properties panel. You can use any valid chart expression. For more information, see Using expressions in visualizations (page 86).

If you set a dynamic sheet title, the fixed title (Title) is not used.

Changing the sheet thumbnail

You can replace the default thumbnail, to make it easier to distinguish between sheets in the app overview and in the sheet navigator. You can use one of the default images, or an image of your own.

Note the following:

- The following formats are supported: .png, .jpg, .jpeg, and .gif.
- The optimal aspect ratio of a thumbnail is 8:5 (width:height).
- You can only add or change the thumbnail of an unpublished sheet.

Do the following:

1. In the app overview, click 📊 to view the sheets.
2. Do one of the following:
   - If you are in grid view, 📑, click the sheet title followed by clicking 🖊.
   - If you are in list view, 📐, click 🖊.
3. Click 🌌 on the default thumbnail.
   The Media library opens.
4. Click on a folder in the media library, for example In app or Default.
5. Select the image you want to use as a thumbnail for the sheet and click Insert.
6. Click ✔ to stop editing.

The image you selected is now used as a thumbnail for the sheet, and is visible in the sheet navigator and in the app overview.
You can also change a sheet's thumbnail in the sheet navigator at the top right or in the Sheet properties panel.

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the In app folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.

For Qlik Sense Desktop: You can place images in the following folder on your computer:
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the default folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, for example Qlik Sense Cloud, the images will be in the In app folder in the media library for the app.

Changing the grid sizing of a sheet

You can adjust the grid sizing of the sheet to be able to fit more visualizations on a sheet, or have more control over how visualizations are positioned. The grid displays when you are adding, moving, or resizing a visualization.

Grid size can be changed in the Sheet properties pane
Do the following:

- Change the **Grid spacing** setting in Sheet properties from **Wide** (the default option) to **Medium** or **Narrow**.

The sheet grid is now more dense and the grid squares are smaller.
Customizing sheet size

By default, Qlik Sense uses a responsive layout for sheets that adjusts the sheet to the dimensions of the user’s screen. You can set a custom width and height for the sheet if you want to use a non-responsive layout for your sheets. This ensures that your dashboard will be presented to users exactly as you created them, with no adjustments for responsiveness. You can set the height and width of a sheet anywhere between 300 pixels and 4,000 pixels.

When a sheet is using a custom size, you can change the grid spacing, but you cannot use Extend sheet to change the size.

> When a custom sheet is exported, the exported sheet is exported as a Responsive sheet. For optimal default sheet thumbnails, keep your custom size ratio to 8:5 (width:height).

Do the following:

1. Change the **Sheet size** setting from **Responsive** to **Custom**.
2. Enter a width for the sheet in pixels.
3. Enter a height for the sheet in pixels.

Changing the small screen layout

By default, sheets are displayed in List view when viewed on small screens. You can change them to display as a grid. Sheets must be set to responsive layout to display as grid on small screens.

> A sheet viewed on a small screen in List view (left) and Grid view (right)
Grid view shows a small preview of your visualizations. List view only shows the visualization titles.

Do the following:

1. Under **Sheet properties**, go to **Small screen layout**.
2. From the drop-down, select **Grid view**.

### Extending the sheet area

You can extend the area of a sheet vertically if you need to add more visualizations than what can fit on a screen.

Note the following:

- You need to activate **Extend sheet** under **Sheet properties**.
- Each extension adds 50% of the original sheet height.
- If you have visualizations that scroll, this can interfere with scrolling of an extended sheet. You should leave some empty space that allows for scrolling when you design the sheet.

You can extend the sheet in two different ways:

Do the following:

- Drag an object to the bottom of the sheet and drop it on the drop zone that appears.
- Toggle **Extend sheet** under **Sheet properties**.

The sheet is now expanded by 50% of the original height. You can scroll vertically in the sheet to access all content.

### Copying, replacing and moving items on sheets

You can copy, replace, and move items on a sheet and between sheets. You can do this in the following ways:

- Using the edit bar on the sheet (** », ** ‹** and ** »**).
- By right-clicking and selecting **Cut**, **Copy** and **Paste**.
- With the keyboard shortcuts Ctrl+C, Ctrl+X and Ctrl+V.

### Duplicating a sheet

You can duplicate any sheet, regardless of whether it is a sheet that belongs to the app or a sheet you have created yourself. The purpose of duplicating sheets is to save time by reusing content, and to allow you to modify the duplicate so that it fits your needs better. A duplicated sheet contains the same visualizations as the original sheet, and is linked to the same master items. The duplicated sheet is a standalone sheet with no connection to the original sheet. Duplicated sheets appear under **My sheets** in app overview and in the sheet navigator.

You can duplicate a sheet in the following ways:

- Click **Duplicate** in the shortcut menu of a sheet in the app overview or in the sheet navigator.
- Click **Duplicate sheet** in the global menu in the app overview or in sheet view.
2.5 Managing apps

Once you have created and built an app with the sheets and visualizations you want it to have, you may want to fine-tune it to make it easy and efficient to use, not only for yourself but also for other people.

You can, for instance:

- Apply app styling (logo and header)
- Create reusable master items (visualizations, dimensions and measures)
- Add bookmarks to keep track of important and interesting data selections and connections
- Change the app’s title and description, and also add a thumbnail to it
- Publish your own apps
- Move your own published apps between streams
- Export an app

Creating an app

The first thing you need to do when building an app is to create an empty placeholder for it. You create the app placeholder from the hub.

Do the following:

1. Click Create new app in the hub.
2. Give your app a name.
3. Click Create.
   The app is created.
4. Click Open app.
   The app opens in the app overview.

The next step is to add data to the new app.

On-demand apps

On-demand apps enable you to load and analyze big data sources in Qlik Sense. Trying to analyze an entire big data store at one time is highly inefficient. Nevertheless, to make representative visualizations, all the data must be discoverable. Qlik Sense on-demand apps give users aggregate views of big data stores and allow them to identify and load relevant subsets of the data for detailed analysis.

On-demand apps are made up of several building blocks or components, and some of those components are built by users with advanced scripting skills.

Generating an on-demand app

You generate an on-demand app when you have selected a manageable subset of data using an on-demand selection app. Any selection app that you are working with will contain one or more navigation links for generating on-demand apps in the App navigation bar.
2 Creating apps

The on-demand apps shown on the **App navigation** bar have completion indicators that start to turn green as you make selections in the selection app. Each on-demand app on the app navigation bar has a limit on the amount of data it can contain. When selections are made in the selection app, the completion indicator shows when the amount of data selected is within the bounds set for the on-demand app.

Once an on-demand app’s indicator turns completely green, you can generate that app with the currently selected data. Or you can choose to open an instance of that app that was generated previously with another selection of data. Every on-demand app in the app navigation bar can be generated multiple times, and those generated apps remain accessible. When the maximum number of apps has been generated, you must delete an existing app before you can generate a new on-demand app. On-demand apps also may have an expiration time after which they are automatically deleted.

---

Anonymous users can only generate on-demand apps that are published automatically. Because anonymous users can only use published apps, they cannot use an on-demand app unless it is published automatically when it is generated. If an anonymous user attempts to generate an on-demand app that is not set for automatic publication, a message displays indicating that the user cannot generate an app from that particular on-demand app navigation point. This functionality is not available in Kubernetes.

---

The maximum number of apps and the retention time are set on the on-demand app navigation link. The app navigation link is one of the building blocks of on-demand apps, and it is usually added by the creator of the selection app.

Do the following:

1. Open an on-demand selection app.
2. Select from the visualization objects in the selection app.
3. When the completion indicator on an on-demand app in the **App navigation** bar turns completely green, click the on-demand app.

   You can select an on-demand app in the **App navigation** bar to open its generation panel. There you can click the ![Help](https://cdn.jsdelivr.net/npm/@qwik/element-icons@1.0.0/icons/question-mark.svg) to see the **Constraint** (maximum number of records allowed) and the number of records currently selected. You can also see the number of values selected for each field and any constraints on the fields. When on-demand apps are created, constraints can be placed on individual fields. For example, a field for Year might be limited so that no more than two values can be selected. When the number of records (**Row count**) currently selected is less than or equal to the maximum number of records allowed, the completion indicator turns completely green. An app cannot be generated, however, until all the constraints have been met. If the row count is within the constraint but one or more of the fields have not met the requirements of their constraints, the **Generate new app** button will not be enabled.

---

If you select **Generate new app** when constraints panel is open, you will not see the generated app. Click the ![Help](https://cdn.jsdelivr.net/npm/@qwik/element-icons@1.0.0/icons/question-mark.svg) to close the panel, and you will see the new app listed if it generated successfully.
4. Click the **Generate new app** button to create a new instance of the on-demand app with the data currently selected. The new instance of the app is generated and appears in the generation panel above the **Generate new app** button. To see more about the generated app, open its detail panel.

In this view in **Windows**, you can also rename the on-demand app. By default, on-demand apps are assigned the name of the navigation point from which they are generated, and the user’s name is appended. For example, when the name of the navigation point is "Ox Sample Detail," the default name of the generated on-demand app would be "Ox Sample Detail_John-Doe" for user "John Doe." In the illustration above, the name of the on-demand app has been changed to "Ox Sample Detail_Airlines." You can rename an on-demand app even if it has been published.

In this view in **Kubernetes**, you can also rename the on-demand app. By default, on-demand apps are assigned the name of the navigation point from which they are generated, and a timestamp is appended. For example, when the name of the navigation point is "Ox Sample Detail," the default name of the generated on-demand app would be "Ox Sample Detail_20190405_113822". In the illustration above, the name of the on-demand app has been changed to "Ox Sample Detail_Airlines."
On-demand apps generated by anonymous users are given default names indicating that they were generated by an anonymous user rather than a registered user. Anonymous users can change the names of generated apps just as registered users can change the names of their apps. This functionality is not available in Kubernetes.

The Apply button applies the selections listed on the generated on-demand app’s Selections tab to the selection app.

5. Select Open app from the ••• menu to open the generated app.
   You can select to open the app in a new tab by clicking ☰.
   You can also reload data and regenerate an on-demand app. The Reload menu is available when the detail panel is open:
The selections on the **Reload** menu work as follows:

- **Reload**: reloads the data based on the current selections that have been made within the on-demand app.
- **Regenerate using current selections**: regenerates the on-demand app using the current selections that have been made within the selection app.

> The **Apply** button on the **Selections** tab applies the on-demand app’s selections to the selection app. The on-demand app’s selections are those listed as **Selections made when this app was generated**. For more information, see the illustration above. This is the reverse of what is done when **Regenerate using current selections** is used.

- **Regenerate copy using the current selections**: generates a new on-demand app using the current selections that have been made within the selection app. The previously generated on-demand app remains in its current state.

**Exploring a published on-demand app (Windows)**

Most users who use on-demand apps to explore big data sets access them as published apps. There are two points at which most users will use on-demand apps:
1. In a published on-demand selection app, where the user selects data and generates an on-demand app from the **App navigation** bar.

2. In a stream where a generated on-demand app is published.

Published on-demand apps have a preselected subset of data from a very large data source. You can explore that data through the visualization objects in the on-demand app. In that way, on-demand apps are like apps created with data from any other source.

You cannot change them after they have been published, though like other published apps, you can add private sheets and stories if you have the correct access rights. You work with published on-demand apps the same way you work in other published apps.

**Exploring a shared on-demand app (Kubernetes)**

You can share on-demand selection apps in your personal space. You must first publish the sheets of the selection and template apps, and then share the selection app. The selection app will then be accessible to the users with whom it is shared. Those users can access the navigation points in those apps. For example, they can generate an on-demand app from the **App navigation** bar. You cannot create or share on-demand apps in shared spaces.

**Styling an app**

You can apply styling to your app to customize the app based on your company standards. The selected styling will be applied to all sheets in the app. Once the app has been published, you cannot change the app styling.

The following styling options are available:

- Changing the direction of the characters in strings of text or numbers
- Changing the default app theme
- Changing the background color for the sheet titles.
- Changing the sheet title font color.
- Adding and aligning an image, such as a logo.

> More styling can be applied to an app by a developer through custom theme extensions.

**Opening app options**

You can open the app options from anywhere in an unpublished app. It does not matter if you are exploring and discovering data, building a data model or working with data storytelling.

Do the following:

- In an unpublished app, click ☰ and then click ☉ to open app options.
- Click ☇ to close the app options.

> If you are using a mobile device, the app options are not available.
As of Qlik Sense June 2018, app options is not available on a published apps even when having custom security rules defined with Update action on App resources.

Changing the reading order

Do the following:

1. In an unpublished app, click and then click to open app options.
2. Under Appearance > Right-to-left, select On or Off.

If a visualization is shared using Qlik Sense Charts, changing the reading order in the app will also affect the reading order in the shared chart.

Changing the default app theme

In an unpublished app, the app theme can be set to one of the default Qlik themes using the App Theme drop-down menu. You can also apply any custom theme that you have created and installed.

The default Qlik themes are:

- **Sense Classic** - Provides a more compact view of objects, and limits the space between them.
- **Sense Focus** - Adjusts the padding and spacing around objects as well as provides designated spaces for titles.
- **Sense Breeze** - Based on Sense Focus but with different color settings.

Do the following:

1. In an unpublished app, click and then click to open app options.
2. Select the theme to apply from the App Theme drop-down menu.

You cannot change themes in published apps.

Custom themes

You can also create custom themes based on your company standards. With themes you can precisely style an app by changing the colors, adding images and backgrounds as well as specifying the fonts, font sizes, font weights and font styles on a global or granular basis throughout your app. You can also define color palettes and customize the specifications for margins, padding and spacing.

For more information, see Sense for Developers: Custom themes.

Custom themes are not dependent on the app. This means that if you for example change the colors defined in a custom theme these will be updated in all apps using the theme, even if the app is published.
When you have created a custom theme, you store it in Qlik Sense as an extension. The JSON file and any additional resources, such as CSS files, are zipped and imported as an extension in the Qlik Management Console (QMC). This enables that security rules can be added in the QMC for controlling which themes specific users have access to.

Custom themes appear under **Custom** in the **App Theme** drop-down menu.

![Custom themes in Qlik Sense](image)

### Changing colors

The sheet title background color can be set to a solid color or a gradient of colors by selecting two colors. The sheet title font can only be set to a solid color.

*If you are using a mobile device, the sheet title background is displayed as one solid color even if two colors has been set.*

When choosing colors, you have the following options:

- Choose a color from the default color palette.
- Set a Hex color by typing 6 characters in the # input field.
- Click the palette to show more color options:
  - Click the color wheel to select color.
  - Drag the slider to change the color saturation.

### Choosing a color from the default color palette

Do the following:

1. Click ▼ in a color drop-down. The dialog opens and displays the default colors.
2. Click one of the colors in the palette.
The color is selected.

3. Click outside the dialog.
The dialog is closed.

Now you have set a color by selecting in the default color palette.

*The color dialog with the default color palette and a blue color selected.*

Typing a Hex color

Do the following:

1. Click ▼ in a color drop-down.
The dialog opens and displays the default colors.
2. Type 6 characters in the Hex input field: #.
The color is selected in the palette.
3. Click outside the dialog.
The dialog is closed.

Now you have set a color by typing the 6 hexadecimal digits.

Using the advanced color options

Do the following:

1. Click ▼ in a color drop-down.
The dialog opens and displays the default colors.
2. Click 📌 at the bottom of the dialog.
The dialog changes and displays the advanced options.
3. Do one of the following:
   - Click in the color wheel.
The color changes and the Hex color code updates accordingly.
• Drag the slider.  
The saturation changes and the Hex color code updates accordingly.

Either way a color is selected.

4. Click outside the dialog.  
The dialog is closed.

Now you have set a color by using the color wheel and/or the slider.

The color dialog with the advanced options and a blue color selected.

Adding an image

You can add an image to the sheet title, such as a logo. The following formats are supported: .png, .jpg, .jpeg, and .gif.

Do the following:

1. Click the image placeholder next to Image.  
The Media library opens.

2. Click on a folder in the media library, for example In app or Default.

3. Select the image that you want to add to the sheet title.  
A preview of the image is shown.

4. Click Insert.  
The image is added.

5. Click to align the image: left, center or right.

Now you have added an image to the sheet title and selected its alignment.
Converting a QlikView document into a Qlik Sense app

If you have a QlikView document, you can reuse part of your work in Qlik Sense. The load script and data model can be used to create an app in Qlik Sense. Visualizations, dimensions and measures, however, have to be created in Qlik Sense.

After converting the document to an app, you may need to adapt the load script to be able to reload the script in Qlik Sense. In some cases, you may need to make some changes in the QlikView script before you convert the document.

Qlik Sense provides a tool to help convert a QlikView document (QVW file) to a Qlik Sense app. The tool converts visualizations, dimensions, measures, and variables. You must have access to the Dev Hub To use the QlikView to Qlik Sense converter.

Instructions for how to use the converter tool are provided on the Qlik Sense Developer site.

If you do not have access to the Dev Hub, you can convert a QlikView document manually.

We recommend that you make changes only in a duplicate of any app that you convert, so that your changes are not overwritten by a later conversion.

Manually converting a QlikView document into a Qlik Sense app

You can manually convert a QlikView document (QVW file) to a Qlik Sense app by following the instructions here. If you have access to the Dev Hub, you can use the QlikView to Qlik Sense converter tool to simplify the process.

The QlikView to Qlik Sense converter is described on the Qlik Sense Developer site.

Prerequisites

- You need to have Qlik Sense Desktop installed to be able to convert a QlikView document into a Qlik Sense app.
- Your computer must have sufficient memory, at least 32 GB, when converting a large QlikView document.
- If the QlikView document contains hidden script or uses section access, you need to have full access to the hidden script and section access of the document.

Before converting the document

The Always One Selected Value property for QlikView list boxes or multi boxes must be disabled in order to clear selections in the Qlik Sense app. If your QlikView document contains hidden script or uses section access, you need to adapt the document before you convert it.
Converting hidden script tabs

When a QlikView document with hidden script is converted, the hidden script part will be disregarded and not included in the Qlik Sense script. If you want to convert the entire script, do the following before converting the document. This requires that you have access to the hidden script in the QlikView document.

1. Open the document in QlikView Script Editor.
2. Copy the code from the hidden script tabs and paste it into regular script tabs.
3. Save the document.

It is not possible to hide script code in Qlik Sense.

Removing section access code

A QlikView document with section access cannot be imported to Qlik Sense, as there are differences in format and supported functionality. You can still convert the document manually.

1. Remove the section access code in QlikView Script Editor before converting the document. This requires that you have full access to the script of the document.
2. Convert the document into an app.
3. Reapply section access in the Qlik Sense app. There are some differences that you may need to take account for:
   - User authentication is changed. The USERID field is now used to authenticate all users, and the NTNAME and PASSWORD fields are not supported anymore.
   - If you have access to the script, but not to the data, you can open the app without data and edit the script, including the section access.
   - Section access is applied using strict exclusion in Qlik Sense. This means that you can only see data that you have been specifically granted access to.

QlikView variables excluded from export

A number of variables are not exported from a QlikView document (QVW) as they are only relevant for QlikView or is handled differently in Qlik Sense.

The following variables are not exported from a QlikView document:

- All variables starting with CD
- All variables starting with FLOPPY
- QvPath
- QvRoot
- QvWorkPath
- QvWorkRoot
- WinPath
- WinRoot
- ErrorMode
- StripComments
Creating apps

- ScriptErrorCount
- ScriptError
- ThousandSep
- DecimalSep
- MoneyThousandSep
- MoneyDecimalSep
- MoneyFormat
- TimeFormat
- DateFormat
- TimestampFormat
- MonthNames
- DayNames
- ScriptErrorDetails
- ScriptErrorList
- OpenUrlTimeout
- HidePrefix
- FirstWeekDay
- BrokenWeeks
- ReferenceDay
- FirstMonthOfYear
- CollationLocale
- LongMonthNames
- LongDayNames

Converting the document into an app

Do the following:

1. Copy the QlikView document (qvw format) to the directory where your apps are located. This is usually `<user>\Documents\Qlik\Sense\Apps`, but the location of the Apps directory depends on where you installed Qlik Sense Desktop.

2. Start Qlik Sense Desktop. You now see the QlikView document as an app in the hub, with the name ending with (qvw).

3. Click on the app to open it.

The app is saved into the Qlik Sense format (qvf file) in the folder where your QlikView document (qvw file) was stored. Also, the QlikView document file (qvw) is removed from the folder and automatically converted into a backup file (qvw.backup) stored here: `<user>\Documents\Qlik\Sense\AppsBackup`.

You have now migrated a QlikView document into a Qlik Sense app. The app contains the data model, including the loaded data, and the data load script.

You can use the data model to build visualizations, copy it or import it into your server environment through the Qlik Management Console (QMC), but you need to adapt the load script before you can reload the data model.
Adapting the data load script in Qlik Sense

Qlik Sense and QlikView data load scripts are compatible in general, but there are some differences that you may need to take account for and adapt the script in the data load editor before you can reload data. You can adapt the script directly in Qlik Sense Desktop, or you can import the app into Qlik Sense and then adapt the script.

Change file path references to data connections

QlikView uses absolute or relative file paths which are not supported in Qlik Sense standard mode, so you need to use folder data connections to point to file locations instead.

Do the following:

1. Create folder data connections for all file paths that are used in the data load script.
   You need to check statements and functions that refer to files. **LOAD** statements are the most common ones, but there is a complete list available.
2. Replace all references to absolute or relative file paths in the script with **lib://** references to the data connections you created.

<table>
<thead>
<tr>
<th><strong>Original script in QlikView</strong></th>
<th><strong>Adapted Qlik Sense script</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>LOAD * FROM [C:\data\Tutorials source\Sales rep.csv];</td>
<td>LOAD * FROM [lib://Tutorials source/Sales rep.csv]; In this case, the Tutorials source folder data connection should be pointing to C:\data\Tutorials source, or where the data is located if you have moved the app to another computer or a Qlik Sense server.</td>
</tr>
<tr>
<td>FileSize('C:\data\Tutorials source\Sales rep.csv')</td>
<td>FileSize('lib://Tutorials source/Sales rep.csv')</td>
</tr>
<tr>
<td>for each Dir in dirlist ('C:\data\Tutorials source*')</td>
<td>for each Dir in dirlist ('lib://Tutorials source/*')</td>
</tr>
</tbody>
</table>

Handling features that are not supported or recommended

There are some features in QlikView that are not supported or recommended in Qlik Sense, for example:

- Input fields
- Message boxes
• **Bundle** and **Info** load
• **ALL** qualifier

We recommend that you check your script code against these lists of statements and functions that are not supported or recommended, and adapt the code according to recommendations.

**Installing custom connectors**

If your QlikView document uses custom connectors to access data, you should be able to use them to load data in Qlik Sense as well without changes in the script. This requires that the same connector is installed on the Qlik Sense computer.

If you want to make any changes in the data selection by the custom connector, you need to install a version of the custom connector adapted for Qlik Sense.

**Changing the title and description of an app**

You can change the title and description of your apps. When creating a new app, the name of the app is used as its title. When you change the title, the name of the app is not changed.

Do the following:

1. In the app overview, click **pencil** in the app details area.
2. Edit **Title** and **Description**.
3. Click ✔️ to stop editing.

The changes you made are saved.

*You can only change the title and description of an unpublished app.*

**Changing the thumbnail of an app**

You can replace the default thumbnail of an app with another thumbnail, to make it easier to distinguish between apps in the hub. You can use one of the default images, or an image of your own.

Do the following:

1. In the app overview, click **pencil** in the app details area.
2. Click **folder** on the default thumbnail.
   The Media library opens.
3. Click on a folder in the media library, for example **In app** or **Default**.
4. Select the image you want to use as a thumbnail for the app and click **Insert**.
5. Click ✔️ to stop editing.

The image you selected is now used as a thumbnail for the app.
The optimal aspect ratio of a thumbnail is 8:5 (width:height).

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the **In app** folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.

For Qlik Sense Desktop: You can place images in the following folder on your computer: 
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the **default** folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, for example Qlik Sense Cloud, the images will be in the **In app** folder in the media library for the app.

**You can only change the thumbnail of an unpublished app.**

**Duplicating an app**

You can duplicate an existing app, to create a copy to develop further. You can only duplicate an app that you have created yourself unless your administrator has assign you a security role with duplication enabled.

If you have an admin role, giving you the administration rights needed, you can create duplicates of apps from the QMC.

**When you duplicate a published app, only the base sheets and stories will be included in the copy.**

Do the following:

- In the hub, long-touch/right-click the app you want to duplicate and select **Duplicate**.
  
  A toast notification is displayed for a while, at the bottom of the screen, when the duplication starts. A new toast notification will be displayed when the app has been duplicated and give you the possibility to update the app list. If the duplication fails, an error message will be displayed.

A copy of the app is created under **Work**. You can click the app to open it and start adapting it according to your preferences.

**Because of how the synchronization of data works in multi-node sites, apps containing images may display broken thumbnails or images inside the apps if opened right after being duplicated or imported. The broken images are restored when the synchronization is complete. To check if the images have been restored, refresh the browser window.**

**Deleting an app**

You can delete an app that you no longer need.
From the hub, you can only delete apps that you have created and that have not yet been published.

If you have published an app, the published version is locked and can only be deleted from the Qlik Management Console. The published version is a duplicate of the original app. The original version of the app can be deleted from your personal work in the hub.

Do the following:

1. Long-touch/right-click the app in the hub and select **Delete**.
   A confirmation dialog opens.
2. Click **Delete**.
   A toast notification is displayed for a while, at the bottom of the screen, when the app is being deleted. If the deletion fails, an error message will be displayed.

You can delete a published app from the Qlik Management Console.

If an app is being deleted by someone else from the stream you are currently viewing, a toast notification will be displayed and give you the possibility to update the app list.

Uploading image files to media library

The media library contains the images you can use in your app: in text & image visualizations, on story slides, and as thumbnails for apps, sheets, and stories.

You can upload images to the media library. Because of limitations in the web browsers supported by Qlik Sense, it is recommended to keep the height and width as well as the file size of the images as small as possible. The maximum file size is 5 MB.

The following formats are supported: .png, .jpg, .jpeg, and .gif.

For Qlik Sense: You can upload images to the **In app** folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.

For Qlik Sense Desktop: You can place images in the following folder on your computer: 
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the **default** folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, for example Qlik Sense Cloud, the images will be in the **In app** folder in the media library for the app.

You can open the media library in several ways. Do one of the following:

- In the app overview, click 🔍 in the app details area and click 📧 on the thumbnail.
- If you are editing a sheet, double-click the text & image visualization to open the editing toolbar and click 📧.
In storytelling view, click 👇 in the story tools panel and drag Image onto the slide and then double-click inside the image placeholder.

The Media library dialog opens and now you can upload images.

Do the following:

1. Select Upload media.
2. Do one of the following:
   - Drop one or more image files onto the designated area.
   - Click the designated area to open the upload dialog, browse and select images, and click Open.

An upload indicator is displayed while the image file is being uploaded. You can cancel an ongoing upload by clicking on ❌ on the image.

You cannot upload a file if its file name already exists in the media library.

Now you have added images to the media library. Click the image and select ✉ to insert the image.

Deleting image files from media library

The media library contains the images you can use in your app: in text & image visualizations, on story slides, and as thumbnails for apps, sheets, and stories.

You can delete images from the media library.

You can open the media library in several ways. Do one of the following:

- In the app overview, click 👇 in the app details area and click 📦 on the thumbnail.
- If you are editing a sheet, double-click the text & image visualization to open the editing toolbar and click 📦.
- In storytelling view, click 👇 in the story tools panel and drag Image onto the slide and then double-click inside the image placeholder.

The Media library dialog opens and now you can delete images.

Delete images using Qlik Sense

Do the following:

1. Select the In app folder.
2. Select the file you want to delete.
3. Click 📦.
   A confirmation dialog is displayed.
4. Click Delete.

Now you have deleted images from the media library.
You can also long-touch/right-click on an image file and select **Delete**.

For Qlik Sense: You need to use the Qlik Management Console to delete images from the default folder, or other folders that were created from the Qlik Management Console.

Delete images using Qlik Sense Desktop
You can delete images from the default folder by removing the files from this location: `<user>\Documents\Qlik\Sense\Content\Default`.  

The images in the **In app** folder are bundled images, saved in the qvf file together with the rest of the contents of the app. If a bundled image is no longer used in the app, the image will be deleted from the qvf file when saving the app.

2.6 Adding apps to the cloud hub
You can add, edit, and share apps directly in the cloud hub.

Apps can be added in the cloud hub by users with the professional role. Cloud hub members can view and interact with shared apps. They cannot add community content such as sheets and stories to shared apps unless the app is in a shared space to which they have edit access.

**Apps made in Qlik Sense Enterprise and published to the cloud hub cannot be edited or shared within the cloud hub. If you want to edit these apps in the cloud hub, you should export the apps from the QMC and import them into the cloud hub.**

There are different ways of developing apps and sharing them in your cloud hub. Here is a sample app lifecycle:

**Add your app to the cloud hub**
You can create a new app and develop it in the cloud hub. If you own an app in the cloud hub that you want to use as a template, you can duplicate that app and then edit the copy. You can also import an app exported from another deployment of Qlik Sense.  
For more information, see Creating apps in the cloud hub (page 37)  
If you want to develop the app collaboratively, you can add the app to a shared space.

**Add data and develop your app**
If you created a new app, you can add data sources, build your data model, and then create sheets and stories.  
If you copied an app, you can change the data sources, revise the data model, and then edit the sheets and stories. If you duplicate an app containing data sources you do not own, you will need to add those sources.
If you uploaded an app, you need to add the original data sources to the app again. You can also add new data sources and change the content. Your sheets and stories are private until you make them public. When your sheets and stories are finished, make them public so other users will be able to see them.

Create a data reload schedule
You can create scheduled reloads of your app data to make sure your visualizations reflect the most up to date information.
*Reloading app data in the cloud hub* (page 39)

Share your app with other members
You can share your personal app with members of your cloud hub. They can view the app, but they cannot edit the app. If you want other members to be able to edit your app, you can move the app to a shared space and add those members to the space.

Update your app
As app owner, you may receive feedback from your app users. A shared app can be updated at any time. You can make sheets and stories private again to work on them further. You can make changes to the data model.

Retire an app in the cloud hub
When the app is no longer required, you can delete it from the cloud hub.
*Deleting apps in the cloud hub* (page 41)

## Creating apps in the cloud hub

Apps can be added to the cloud hub by creating new apps, duplicating existing apps, or uploading exported apps.

Any cloud hub member with the professional license can create apps in the cloud hub.

### Creating a new app

You can create apps in the Explore and Your content sections of the cloud hub by clicking Create and then Create app. When you create a new app, you can specify the destination space of the app. By default, apps are added to current space.

### Duplicating apps in the cloud hub

You can duplicate any app you have access to by clicking ⋆⋆⋆ on the app and selecting Duplicate. The duplicate can be modified: you can add different data or edit sheets.

Duplicating apps has several uses. For example, you can copy an app to use it as a template. You can also duplicate apps as a form of version control, and store older ones a space created for archival purposes.

Duplicated apps keep the original data sources and data. If you did not create the original data sources used in the app, you will have to recreate data sources in the app.
If you duplicate an app published to the cloud hub from Qlik Sense Enterprise, the data sources in the app may not be supported for apps in the cloud hub. You will not be able to reload data. You can change the data sources in a duplicated app, however.

Uploading apps to the cloud hub

You can upload an app you exported from the cloud hub or another Qlik Sense version into the cloud hub.

You can upload apps in the Explore and Your content sections of the cloud hub by clicking Create, then Upload app, and then adding your app.qvf file to Upload apps. You can upload multiple apps at once.

After uploading the app, you need to add data sources to the uploaded app.

You can continue working on the app. If the app is ready, share the app with your cloud hub users, or move the app to a shared space.

Apps uploaded into the cloud hub must be from Qlik Sense 3.1 or later.

On-Demand apps are not supported for upload to the cloud hub.

Preparing apps from other versions of Qlik Sense for upload

While the cloud hub supports uploading apps from other versions of Qlik Sense, there are limitations:

- Uploaded apps cannot exceed 500 MB in size.
- Uploaded apps include data already loaded into the app, but the data sources are removed. If you want to reload attached files and data connections, you will need to re-add them. Ensure you have the information to add the connections to your app again.
- Uploaded apps do not include any community or private sheets. You need to approve all sheets and stories you want to keep as base sheets and stories before you export the app.
- Qlik Cloud Services cloud hub apps only support the visualization bundle and dashboard bundle extensions. Unsupported extensions will be marked invalid once an app is uploaded.

Adding data and content to apps in cloud hub

Once you create your new app, you need to add data. You can only see and use data connections that you own. You cannot change the owner of a connection.

After you add data, you can create sheets, stories, and visualizations. Apps in the cloud hub have the following limitations:

- You cannot export sheets as images, PDFs, or Excel sheets.
- You do not have access to precedent based learning with insight advisor.
- The Qlik Cloud Services cloud hub only supports Dashboard and Visualization bundle extensions.

Sheets, stories, and bookmarks in your app are private until you make them public.
Creating apps

Reloading app data in the cloud hub

Apps in the cloud hub do not automatically update when their data sources are updated. Reloading an app updates it with the latest data from the app data sources. You can manually reload your apps or schedule reloads for your apps.

You cannot reload data in the cloud hub for apps published to the cloud from a Qlik Sense Enterprise deployment. Apps published from Qlik Sense Enterprise can be reloaded using the QMC in Qlik Sense Enterprise.

You can only reload apps you own.

You can view the status of current and past reloads for an app from Reload history in Details.

Scheduling reloading app data

You can create a schedule for data reloading in your app. Qlik Sense adds a reload to the reload queue at the frequency, date, and time you schedule. You can schedule a single reload of the data or schedule a repeating reload of app data.

When you schedule a single reload, you can pick a specific date and time for the reload. When you schedule a repeating reload, you can pick the interval and time of the reload. Repeating reloads can be set at the following intervals:

- Hourly
- Daily
- Weekly
- Monthly
- Yearly

You can remove a scheduled reload from an app by setting the schedule to Inactive and saving.

The dates and times in the schedule reload dialog use your current time zone. Qlik Sense determines your current time zone based on your browser settings.

Do the following:

1. Click *** on the app and select Schedule reload.
2. Set the schedule to active and create your schedule.
   
   If you cannot see the AM option when setting the reload time, use the scroll bar.

3. Click Save.
Manually reloading app data
You can reload an app manually, adding a reload task to the reload queue.

Do the following:

- Click on the app and select **Reload**.

Viewing reload history for your app
**Reload history** contains the reload history for the selected app. You can view the status, start and end times, and duration of past and current reloads. For failed reloads, you can also view error logs.

To view the reload history for an app, click on the app, select **Details**, and click **Reload history**.

Editing app details in the cloud hub
After creating an app in the cloud hub, you can edit the app details. You can add new information to the app or move the app to a different space in the cloud hub.

You can change the titles and descriptions of your apps. You can change the tags used with the app. Tags are used to group apps with related apps in the cloud hub. Tags are shared in the cloud hub, but you can only see tags that you have created yourself or that are used with apps to which you have access.

If you have access to spaces, you can change the space in which the app is located.

Do the following:

1. Click on the app you want to edit and select **Edit**.
2. Change the app details and click **Save**.

Exporting apps from cloud hubs
You can export apps from the cloud hub as .qvf files. These can be uploaded into other cloud hubs or Qlik Sense versions.

Apps that manage security with section access can only be exported by a tenant administrator.

When you export an app, the following content is included:

- Public content (sheets, stories, bookmarks)
- Private content belonging to you
- The media library.
- Data loaded in the app.

Attached files are not included. The exported app is saved in the default download folder of your web browser.
You can export the app without any data. This only exports the sheets and stories of the app. If you have access to a Qlik Sense Enterprise deployment, you can import this into QMC and use it to replace the sheets and stories of an app without changing the data model.

Exporting apps with data
Do the following:

- Click *** on the app you want to export and select Export with data.

Exporting apps without data
Do the following:

- Click *** on the app you want to export and select Export without data.

Deleting apps in the cloud hub
You can delete any app you own in the cloud hub. If you have permission in a space, you can also delete the app from the space.

Do the following:

1. Click *** on the app you want to delete and click Delete.
   A confirmation dialog opens.
2. Click Delete.

If someone was viewing the app you deleted, they will receive a connection lost error message and if they refresh, they will be told the app can no longer be found.

Troubleshooting - Creating apps in the cloud hub

There are no data sources in the app I uploaded to the cloud hub
I uploaded an app to the cloud hub, but all the attached files and data connections have been removed from the app.

Possible cause
Exporting and uploading an app removes the attached files and data connections from an app.

Proposed action
Reattach these files and reconfigure the data connections for the app.

Error message: The visualization failed to render
When I uploaded my app to cloud hub, the error message *The visualization failed to render* displayed on one or more visualization objects in my sheets.

Possible cause
Your app may be from an unsupported version of Qlik Sense. Apps must be from Qlik Sense 3.1 or later.
Proposed action
Update the app to a more recent version of Qlik Sense by updating the Qlik Sense deployment. You can also import the app into a more recent version of Qlik Sense and then export the app again.

Error message: **Invalid visualization. The extension is not available in the cloud**
When I uploaded my app to the cloud hub, the error message **Invalid visualization. This visualization was not found. The extension is not available in the cloud** displayed on one or more of my extensions.

Possible cause
You uploaded an app that contained an unsupported extension. Qlik Cloud Services only supports extensions from the Dashboard bundle and Visualization bundle.

Proposed action
Remove the invalid extensions from your app.

My app failed to export
When I tried to export my app, it failed.

Possible cause
Your app may use section access for security in the data load script.

Proposed action
For security reasons, exporting apps that use section access is not permitted in the cloud hub.

2.7 Troubleshooting - Creating apps
This section describes problems that can occur when creating apps and visualizations in Qlik Sense.

Images are not included in an app that has been moved from one Qlik Sense environment to another

Possible cause
You have created an app in Qlik Sense and moved the app to another Qlik Sense environment.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.
Proposed action
Import the images from the Qlik Sense environment where the app was created to the target location using the Qlik Management Console.

Images are not included in an app that has been imported from Qlik Sense Desktop to Qlik Sense

Possible cause
You have created an app in Qlik Sense Desktop and imported the app to Qlik Sense.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.

Proposed action
Import the images from the images folder of the Qlik Sense Desktop app using the Qlik Management Console.

Images are included automatically only when you move an app from one Qlik Sense Desktop installation to another.

The default location of the images in Qlik Sense Desktop is <user>\Documents\Qlik\Sense\Content\Default.

If you have organized images in subfolders in the Content\Default folder in Qlik Sense Desktop, these have to be added manually to the app and its sheets, stories and text & image objects after importing the images.

Images are not included in an app that has been moved from one Qlik Sense Desktop installation to another

Possible cause
You have moved an app between Qlik Sense Desktop installations.

When you move apps between Qlik Sense environments, images may not have been moved automatically. The images have to be handled manually, in different ways depending on between which environments the app has been moved.

Proposed action
Do the following:

- Copy the images from the PC where the app was created and paste into the images folder of the target location.
The default location of the images in Qlik Sense Desktop is `<user>\Documents\Qlik\Sense\Content\Default`.

The image I want to use does not seem to work

Images are part of apps as thumbnails of the apps, sheets and stories, in the text & image object and in story slides.

**Possible cause**

You are using an image in a format that is not supported.

**Proposed action**

Do the following:

- Convert the image to one of the supported formats (png, jpg, jpeg or gif).

Using insights advisor impacts system performance

Insight advisor uses master items as fields in recommended charts.

**Possible cause**

The charts generated by the insight advisor are choosing fields that end up with costly charts.

**Proposed action**

Do the following:

- Change what fields are exposed to published app users.
3 Creating visualizations

Visualizations let you present data so that your app's users can interpret and explore it. For example, you can show a bar chart that compares sales numbers for different regions, or a table with precise values for the same data. Good visualizations help you quickly and accurately interpret the displayed data.

Visualizations are easy to add and customize. They can take the form of charts (such as bar charts, pie charts, tables, gauges, and treemaps), or custom objects created using tools in the Qlik Sense Dev Hub. Interactivity, such as drill-down and filtering, is built in because Qlik Sense automatically highlights items associated with your selections. You can enhance interactivity further with functionality specific to the different visualizations.

An example of a sheet with four different visualizations.

To build effective visualizations, you should:

- Understand the data sources for your visualizations
- Select visualization types that align with your purpose
- Update visualizations to help users understand the data

3.1 Understand the data sources for your visualizations

To design an effective visualization with a clear purpose, you need to understand your data. The following
3 Creating visualizations

Questions will help you find out what you want to convey with your data:

- What kind of data is it? Nominal, ordinal, interval, or ratio data?
- How do different parts of the data relate to each other?
- Can you organize the data in a way that makes it easy for you to create your visualizations?
- What do you want to communicate with your data?
- Are there dimensions or measures you will want to reuse in multiple visualizations?

You also need to understand your data in terms of fields, dimensions, and measures. These affect how your data is used in your visualizations.

3.2 Select visualization types that align with your purpose

Each visualization type has a specific goal. You need to think about the purpose of your visualization, and pick a visualization type that lets you explore your data for that purpose effectively.

For example: You want to show how a measure, quarterly sales, behaves over time. You should create a line chart, because one of its strengths is displaying how measure values change over time.

If you are unsure of what visualization types to use with your data, Qlik Sense offers two methods of creating visualizations with assistance:

- You can use insight advisor to have Qlik Sense analyze your data and generate a selection of visualizations. You can then choose to add these visualizations to your sheets.

- You can also create visualizations using chart suggestions by dragging a field onto the sheet from the assets panel and then dragging additional fields that you want in the visualization onto the first field. Qlik Sense then creates a suggested visualization based on the fields selected for the visualization.

3.3 Update visualizations to improve how data is displayed

As you create your visualizations, you can modify them to improve how data is displayed and highlighted within the sheet. You can also change the data within it, or switch the visualization to another type.

3.4 Data assets in visualizations

Visualizations use data in many different ways. How your data is comprised or created impacts your visualizations. Primarily, your data assets become dimensions and measures in your visualizations, defining the categories in your visualizations and the measurements of those categories. A field can be used to group data, or it can be transformed with an aggregate function to provide a measurement in data categories.

The types of data you have in your tables and fields also impacts whether they can be used as dimensions or measures, as well as what sorting options are most effective. For example, quantitative data and qualitative data have different recommended uses when they are used as either dimensions or measures.
In addition to providing the data to display, data assets can be used to control what data is displayed and how it is presented. For example, you can color a visualization using a dimension or measure not present in the visualization. For more information, see Changing the appearance of a visualization (page 380).

The assets panel contains the different data sources you can use in your visualizations.

**Data assets**

The following data assets are available when creating visualizations:

- Fields
- Measures
- Dimensions
- Master items

**Fields**

Fields hold the data loaded into Qlik Sense. Fields contain one or more values and correspond to columns in a database table. The field data can be qualitative or quantitative.

When creating visualizations, you use fields to create your dimensions and measures. You can also use fields in different ways when you add visualizations to your app. Some visualizations, such as tables, can present fields in an unmodified state.

Some fields require extra considerations, such as date or time fields.

For more information, see *Fields* (page 49).

**Measures**

Measures are the data that you want to show. Measures are created from an expression composed of aggregation functions, such as **Sum** or **Max**, combined with one or several fields.

For more information, see *Measures* (page 61).

**Dimensions**

Dimensions determine how the data in a visualization is grouped - for example total sales per country or number of products per supplier. Dimensions display the distinct values from the field selected as a dimension. Dimensions can also be calculated using an expression.

For more information, see *Dimensions* (page 58).

**Master items**

Master items are dimensions, measures, or visualizations that can be reused in other visualizations and sheets in your app. Updating a master item updates every instance of it. This means you could have the same measure in 5 visualizations, and they would all update whenever the master item is changed.

Master items also have more design options available. You can, for example, assign colors to a master dimension’s distinct values so that the distinct values are consistent across visualizations.

Master items also include special dimensions such as drill-down dimensions and calendar measures.
Expressions

An expression is a combination of functions, fields, and mathematical operators (+ * / =). Expressions are used to process data in the app in order to produce a result that can be seen in a visualization.

Expressions are used primarily used to create measures. They can also be used to build calculated dimensions, or to set properties within different visualizations. For example, you can use expressions to define range limits for gauges, or reference lines for bar charts.

For more information, see Using expressions in visualizations (page 86).

Data types in visualizations

Different types of data have different properties; certain data may work better as dimensions, and some as measures. Similarly, as dimensions or measures, certain kinds of data may work better as a dimension in some visualizations better than others, or as a measure with certain aggregation functions.

The data in your fields can be quantitative or qualitative. Quantitative data values are measured numerically on an ascending scale. Quantitative data can be ratios or intervals:

- Ratio: Ratios are quantitative data that you can perform arithmetic operations on, such as cost or age. For example, you can sum sales values for the month to get totals.
- Interval: Intervals are quantitative data that you cannot perform arithmetic operations on. For example, you cannot calculate a sum of temperatures during the week, but you can calculate the average temperature per day, and the high/low for each day.

Qualitative data can not be measured numerically, but can be described through language. Qualitative data can be nominal or ordinal:

- Nominal: Fields with nominal data have distinct qualitative values, but without a set order. For example, product names or customer names are nominal data, as they have distinct values, but do not have a required order.
- Ordinal: Fields with ordinal data have qualitative values that have a ranked or positioned value. Ordinal data should be sorted by its order as opposed to alphabetically. For example, low, medium, high are ordinal values. Small, medium, and large are also ordinal values.

The following table contains a general overview of recommended visualization types and aggregation functions for data types. These recommendations should not be considered absolute.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Recommended aggregation functions</th>
<th>Non-recommended aggregation functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal</td>
<td>Count</td>
<td>Average</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Median</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sum</td>
</tr>
</tbody>
</table>

For more information, see Reusing assets with master items (page 62).
3 Creating visualizations

<table>
<thead>
<tr>
<th>Data type</th>
<th>Recommended aggregation functions</th>
<th>Non-recommended aggregation functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinal</td>
<td>Count</td>
<td>Average</td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td>Sum</td>
</tr>
<tr>
<td>Ratio</td>
<td>Count</td>
<td>Sum</td>
</tr>
<tr>
<td></td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td></td>
</tr>
<tr>
<td>Interval</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Average</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Median</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td></td>
</tr>
</tbody>
</table>

Fields
Fields hold the data that is used in Qlik Sense. Fields can be thought of as the data loaded from the load script. Fields contain one or more values, called field values, and at the basic level, correspond to columns in a database table, but can also exist in more than one table. Field values consist of numeric or alphanumeric data. When loaded from the load script, fields can be represented as a table visualization.

Example of data in a load script:

```
Temp:
LOAD * inline [
    Customer Product UnitSales UnitPrice
    Imagine Film 4 16
    Imagine Film 10 15
    Imagine Shutter 9 9
    PhotoInc Shutter 5 10
    PhotoInc Lens 2 20
    PhotoInc Magnifier 4 25
    Gallery Film 8 15
    Gallery Lens 7 19
] (delimiter is ' ');
```

The fields represented in a data model table after having loaded the data:
Creating visualizations

The same fields as columns in a table visualization on a sheet:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Product</th>
<th>UnitPrice</th>
<th>UnitSales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery</td>
<td>Film</td>
<td>15</td>
<td>5</td>
</tr>
<tr>
<td>Gallery</td>
<td>Lens</td>
<td>19</td>
<td>7</td>
</tr>
<tr>
<td>Imagine</td>
<td>Film</td>
<td>15</td>
<td>18</td>
</tr>
<tr>
<td>Imagine</td>
<td>Film</td>
<td>10</td>
<td>4</td>
</tr>
<tr>
<td>Imagine</td>
<td>Shutter</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Lens</td>
<td>20</td>
<td>2</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Magnifier</td>
<td>25</td>
<td>4</td>
</tr>
<tr>
<td>PhotosInc</td>
<td>Shutter</td>
<td>10</td>
<td>5</td>
</tr>
</tbody>
</table>

Date & time fields

If you are working with fields containing date or timestamp information in your app, you can define a number of related attributes of a date, for example, year or week, and use them in your visualization.

Creating date fields in Data manager

Date fields are created automatically for all data fields recognized as a date or a timestamp when you use Add data with data profiling enabled to build your data model in Data manager, or when you click Load data in Data manager.

> **Date fields created in Data manager** are automatically added to autoCalendar.

If the date or timestamp field is not recognized automatically, you can adjust the input format in the Data manager table editor. You can also set the display format to use in visualizations.

Which date & time fields are automatically recognized?

Date & timestamp fields will be recognized automatically based on your system locale settings. Additionally, the following formats are recognized:

- M/D/YYYY h:mm
- D/M/YYYY h:mm TT
- M/D/YYYY
- D/MM/YYYY
- YYYYMMDD
- YYYYMMDDhhmmss
- YYYYMMDDhhmmss.fff
- YYYYMMDDhhmmssK
- YYYY-MM-DD
- YYYY-MM-DDThh:mm:ss

Create apps and visualizations - Qlik Sense, June 2019
• YYYY-MM-DD-Thh:mm:ss.fff
• YYYY-MM-DD-Thh:mm:ssK

Creating date & time formats

<table>
<thead>
<tr>
<th>Format specifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YYYY</td>
<td>Year</td>
</tr>
<tr>
<td>M, MM</td>
<td>Month</td>
</tr>
<tr>
<td>D, DD</td>
<td>Day</td>
</tr>
<tr>
<td>hh</td>
<td>Hour</td>
</tr>
<tr>
<td>mm</td>
<td>Minute</td>
</tr>
<tr>
<td>ss</td>
<td>Second</td>
</tr>
<tr>
<td>fff</td>
<td>Millisecond</td>
</tr>
<tr>
<td>TT</td>
<td>AM or PM</td>
</tr>
<tr>
<td>K</td>
<td>Timezone</td>
</tr>
<tr>
<td>T</td>
<td>Divider between date and time. T can not be replaced with another character.</td>
</tr>
</tbody>
</table>

Creating date & time fields in the data load script

If you use the data load editor to build your data model, you need to create a calendar template where you define which fields to derive in the data load script. The derived date & time fields will be generated when the script is run and data is reloaded.

Using date & time fields in your app

**Date & time fields in visualizations**

All date or timestamp fields in the assets panel **Fields** tab are marked with [12], and you can expand them to use the generated date & time fields. You can use them in visualizations, just like any other data field.

**Date & time fields in dimensions**

You can also use date & time fields when you create a dimension. The date & time fields are listed under the field that they have been generated from.

**Date & time fields in expressions**

You can use date & time fields in all expressions, for example when you create a measure. The date & time fields are named according to:

[field name].autoCalendar.[date & time field].

• [field name] is the name of the data field that was used to generate date & time fields.
• [date & time field] is the date & time field you want to use, for example, Year.

**Example:**

Date.autoCalendar.Year
**Date & time fields in calendar measures**

Calendar measures use date & time fields created in autoCalendar. Each of these date & time fields is calculated by a set analysis expression that determines whether or not data falls within the time-to-date period, or if dates are within a defined relative position to the current date. These date & time fields are relative and return results based on the current date. You can use these fields independently of calendar measures.

Calendar field date & time fields are formatted as follows:

```
[field name].autoCalendar.[date & time field]=[[value]]
```

- `[field name]` is the name of the date field used to generate date & time fields.
- `[data & time field]` is the name of the date & time field used, for example, InYTD.
- `[value]` is the value for the date & time field's set analysis expression and determines which dates are included.

**Example:**

```
Date.autoCalendar.YearsAgo={1}
```

The following are the available date & time fields with sample values:

### InYTD

This date & time field determines whether or not dates are within the year-to-date range or outside the year-to-date range.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.InYTD={0}</td>
<td>Returns all dates that fall in the year-to-date time range.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current date was the 54th day of the year, the dates within the first 54 days of every year in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.InYTD={1}</td>
<td>Returns all dates outside the year-to-date time range.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current date was the 54th day of the year, all the dates after the first 54 days of every year in the date field would be included.</td>
</tr>
</tbody>
</table>

### Years Ago

This date & time field determines whether or not dates are from a specific year relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.YearsAgo={0}</td>
<td>Returns all dates from this year.</td>
</tr>
<tr>
<td>Date.autoCalendar.YearsAgo={1}</td>
<td>Returns all dates from last year.</td>
</tr>
<tr>
<td>Date.autoCalendar.YearsAgo={8}</td>
<td>Returns all dates from eight years ago.</td>
</tr>
</tbody>
</table>
InQTD
This date & time field determines whether or not dates are within the quarter-to-date range or outside the quarter-to-date range, relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.InQTD=0</code></td>
<td>Returns all dates from all quarters that are within the quarter-to-date range. For example, if the current date was the 14th day of Quarter 1, the first 14 days of every quarter in the date field would be included.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.InQTD=1</code></td>
<td>Returns all dates from all quarters that are outside the current quarter-to-date range. For example, if the current date was the 14th day of Quarter 1, all dates after the first 14 days of every quarter in the date field would be included.</td>
</tr>
</tbody>
</table>

QuartersAgo
This date & time field determines whether or not dates are from a specific quarter relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.QuartersAgo=0</code></td>
<td>Returns all dates from the current quarter.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.QuartersAgo=1</code></td>
<td>Returns all dates from the last quarter.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.QuartersAgo=8</code></td>
<td>Returns all dates from eight quarters ago.</td>
</tr>
</tbody>
</table>

QuarterRelNo
This date & time field determines whether or not dates are from a specific quarter relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.QuarterRelNo=0</code></td>
<td>Returns all dates from each instance of the current quarter. For example, if the current date was in Quarter 4, all dates from each Quarter 4 in the date field would be included.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.QuarterRelNo=3</code></td>
<td>Returns all dates from each instance of the quarter two quarters prior to the current quarter. For example, if the current date was in Quarter 4, all dates from each Quarter 1 in the date field would be included.</td>
</tr>
</tbody>
</table>

InMTD
This date & time field determines whether or not dates are within the month-to-date range or outside the month-to-date range, relative to the current date.
InMTD

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.InMTD= {0}</td>
<td>Returns all dates from all months that are within the current month-to-date range. For example, if the date was November 15, 2016, dates from the first 15 days of every month in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.InMTD= {1}</td>
<td>Returns all dates from all months that are outside the current month-to-date range. For example, if the date was November 15, 2016, dates after the first 15 days to the end of the month of every month in the date field would be included.</td>
</tr>
</tbody>
</table>

MonthsAgo

This date & time field determines whether or not dates are from a specific month relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.MonthAgo={0}</td>
<td>Returns all dates from the current month.</td>
</tr>
<tr>
<td>Date.autoCalendar.MonthAgo={1}</td>
<td>Returns all dates from the last month.</td>
</tr>
<tr>
<td>Date.autoCalendar.MonthAgo={8}</td>
<td>Returns all dates from eight months ago.</td>
</tr>
</tbody>
</table>

MonthRelNo

This date & time field determines whether or not dates are from a specific month relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date.autoCalendar.MonthRelNo= {0}</td>
<td>Returns all dates from each instance of the current month. For example, if the current month was June, all dates in every instance of June in the date field would be included.</td>
</tr>
<tr>
<td>Date.autoCalendar.MonthRelNo= {1}</td>
<td>Returns all dates from the each instance of the previous month. For example, if the current month was June, all dates in every instance of May in the date field would be included.</td>
</tr>
</tbody>
</table>

InWTD

This date & time field determines whether or not dates are within the week-to-date range or outside the week-to-date range, relative to the current date.
3 Creating visualizations

**InWTD**

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.InWTD= {0}</code></td>
<td>Returns all dates from all weeks that are within the current week-to-date range.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current date was the third day of a week, dates from the first three days of every week in the date field would be included.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.InWTD= {1}</code></td>
<td>Returns all dates from all months that are outside the current month-to-date range.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current date was the third day of a week, dates from the last four days of the every week in the date field would be included.</td>
</tr>
</tbody>
</table>

**WeeksAgo**

This date & time field determines whether or not dates are from a specific week relative to the current week.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.weeksAgo={0}</code></td>
<td>Returns all dates from the current week.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.weeksAgo={8}</code></td>
<td>Returns all dates from eight weeks ago.</td>
</tr>
</tbody>
</table>

**WeekRelNo**

This date & time field determines whether or not dates are from a specific week relative to the current date.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Date.autoCalendar.WeekRelNo= {0}</code></td>
<td>Returns all dates from each instance of the current week.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current week was the second week of the year, dates from the second week of every year in the date field would be included.</td>
</tr>
<tr>
<td><code>Date.autoCalendar.WeekRelNo= {1}</code></td>
<td>Returns all dates from each instance of the previous week.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current week was the second week of the year, dates from the first week of every year in the date field would be included.</td>
</tr>
</tbody>
</table>

**Always one selected value**

You can select the **Always one selected value** for a field in an app. The value specifies that one, and only one, value is always selected for a field. You can use this value to specify, for example, that one currency is always selected for a field.

Consider the following when using the **Always one selected value**: 
3 Creating visualizations

- You can use the **Always one selected value** on one or more fields.
- You cannot clear the **Always one selected value** setting when viewing a sheet. You can, however, clear the setting by editing the sheet in your workspace.
- When you publish an app with the **Always one selected value** selected, the value is applied to all sheets in the app. The app consumer cannot clear the value.
- When you duplicate an app, the **Always one selected value** is duplicated with the app.
- The **Always one selected value** is not supported for derived fields.

You can use the value with a default bookmark in to highlight specific selections for your app consumer.

Set the **Always one selected value**

Do the following:

1. Open a sheet in an app.
2. Click **Edit**.
3. Click **Fields**.
4. Right-click a field, and then click **Field settings**.
5. In the window that opens, select the **Always one selected value** check box, and then save.
6. Click **Done** to finish editing. The value appears as a tab in the top toolbar. Unlike a bookmark, there is no option to clear the selection.

The **Always one selected value** defaults to the first entry in the field. In the example above, the value is applied to **Currency**. CHF is the currency that is selected by default. You or your app consumer can change this selection, in this case to a different currency.

7. To test that the **Always one selected value** is working properly, close and then reopen the app. The value should be shown in the top toolbar.

To remove the **Always one selected value** for a field, right-click the field in **Edit** mode, click **Field settings**, and deselect the **Always one selected value** check box.

Always one selected value and default bookmark example: Controlling selections to guide app consumers to insights

In this example, we set **Always one selected value** for a field. We then specify a default bookmark for that field. By specifying a default bookmark, and enabling **Always one selected value**, we control what our app consumers sees when they open the sheets in our published app.
1. Here is a sheet in our app before the **Always one selected value** and a default bookmark are applied.

![My new sheet](image)

For the **Amount** measure in the chart above, we used this expression: `=sum(DISTINCT {<Currency=>} Amount_LOCAL)* RATE`

2. To ensure that one, and only one, value is always selected for the **Currency** field, we edit the sheet, click **Fields**, and then right-click **Currency**.

3. We then select the **Always one selected value** check box and save.

![Currency settings](image)

4. When we close **Edit** mode for the app, the **Always one selected value** value appears as a tab in the top toolbar. The value defaults to the first entry in the field, in this case the value is **CHF**.

![My new sheet](image)

5. However, we want to show expenses in **Euro** when the app is opened. So we select **Euro** from the **Currency** field, and then click **Bookmarks** to create a new bookmark for **Currency("EUR")**. We then right-click the **Currency("EUR")** bookmark, and click **Set selections as app default**.

![My new sheet](image)
Now, when we open the app, or publish the app for an app consumer, the app opens with one value selected, and the default bookmark is shown.

Dimensions

Dimensions determine how the data in a visualization is grouped - for example total sales per country or number of products per supplier. You typically find a dimension as the slices in a pie chart or on the x-axis of a bar chart with vertical bars.

Dimensions are created from fields in the data model tables.

Example:

*Product Type* is a field in the *Product* table that is loaded into the app. The values of this field are the different types that products are grouped into.

You can, for example, create a bar chart to visualize the cost of each type, by adding the *Product Type* dimension to the chart. To complete the visualization, you must add a measure (in this case Cost), which is grouped by the *Product Type* dimension.

*Bar chart with the dimension Product Type and measure Cost.*
Field groups as dimensions

One main difference between Qlik Sense and many other database viewers and online analytical processing tools (OLAP systems), is that in Qlik Sense, you do not need to redefine any hierarchies in the input data. The unique internal logic of Qlik Sense gives you the complete freedom to access any field as a full dimension in any order you like.

For most purposes, the built-in functionality is fully satisfactory, but in some situations, a predefined hierarchy can help you to display data more efficiently. In Qlik Sense, you can achieve this by defining hierarchic groups of fields as drill-down dimensions.

Any fields or calculated dimensions can be grouped together.

Drill-down groups

When several fields form a natural hierarchy, it can make sense to create a drill-down group.

**Example 1:**

Organization: Company, Department, Employee

**Example 2:**

Geography: Continent, Country, State, City

When you use a drill-down group as a dimension in a chart, the chart uses the first field in the group’s list of fields that has more than one possible value. If the currently made selections cause the field to have only one possible value, the next field in the list is used instead, provided that it has more than one possible value. If no field in the list has more than one possible value, the last field is used anyway.

In the first example above, Company will be used as chart dimension until a single company is selected. The chart will then show Department. If a single department is selected, the chart will switch to Employee.
As selections are reverted, so that more than one value becomes possible in the upper fields of the group’s field list, the chart is automatically drilled back up.

**Drill-up**

The drill-up function is available in bar charts, pie charts, and line charts. Other visualizations reflect the changes made in the charts, but cannot themselves be used to drill up through the different dimensions. When you drill down in a dimension group, breadcrumbs provide links back to the previous dimensions. Click the dimension that you want to drill up to.

In the following bar chart, the breadcrumbs Year > Quarter > Month enable drilling up.

![Bar chart with drill-up example]

**Calculated dimensions**

You can use expressions to create calculated dimensions. A calculated dimension consists of an expression involving one or more fields. All standard functions may be used.

For performance reasons, it is recommended to perform all calculations in the data load editor. When dimensions are calculated in the chart, Qlik Sense first calculates the dimension values, and then aggregates the measures for these calculated values, which affects the performance more than calculations in the load script.

There are cases when calculated dimensions are powerful in data analysis, for example, if you want to generate the dimensions values during analysis, when dimension values are dependent on the selections.

Calculated dimensions are also useful if you want to modify a field.

Once you have created a calculated dimension, you can use it as any other dimension.
3 Creating visualizations

Example:

You have a field called Calendar Month that includes each of the months of the year. In your app, you want include a table that shows the sales for each of the first 6 months of the year. For the rest of the months, you want to see a total. You can use an expression to create this calculated dimension.

Syntax:

\[
\text{If } ([\text{Calendar Month}] < 7, [\text{Calendar Month}], '\text{Rest}')
\]

Measures

Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as \textbf{Sum} or \textbf{Max}, combined with one or several fields.

A measure must have a name, and may also be supplied with descriptive data such as description and tags.

Example:

You can, for example, create a bar chart to visualize the cost of each type, by adding the \textit{Product Type} dimension to the chart, and the measure \textit{Cost}, which is made from the expression \textbf{Sum(Cost)}, that is the result of the calculation of the aggregation function \textbf{Sum} over the field \textit{Cost}. The results are grouped by the \textit{Product Type} dimension.

\textit{Bar chart with the dimension Product Type and the measure Cost.}
Reusing assets with master items

When you create and build your visualizations, you can save assets to reuse in other visualizations and on other sheets. You can save visualizations, dimensions and measures, as master items in the assets panel. When your app gets published these master items will be available to others as ready-to-use visualizations, dimensions and measures.

Any updates you make to the master item are applied everywhere the master item is used. For example, you could use a master measure in as many of your visualizations as you like while only having to update it in a single instance to update all instances of the measure in your visualizations.

One of the purposes with creating and maintaining master items is for other users to explore their own ways and directions in the data, on top of what you have provided in the app as pre-made sheets with visualizations. The users will be able to create their own visualizations with your pre-made master dimensions and master measures, for example.

Reusing visualizations with a master visualization

You can create a master visualization to be able to reuse it. Users of a published app will have access to the master visualizations, but will not be able to modify them.

You can only create master visualizations when you are working with an unpublished app. Visualizations with Chart suggestions enabled cannot be made into a master visualization.

Do the following:

1. While editing a sheet, drag a visualization from the sheet to the master items. If you have given the visualization a title, this is automatically added as the name of the master visualization.
2. Add a name, or change the name if you want to.
3. Type a description for the visualization (optional).
4. Add tags (optional).
5. Click Add.

The visualization is now saved to the master items tab.

You can also add a visualization to the master items by long-touching/right-clicking it on the sheet, and selecting Add to master items.

Editing a master visualization

When you update a visualization in the master items, the changes will be reflected in all instances of the master visualization.

Do the following:
1. In sheet view, click Edit in the toolbar. The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the visualization that you want to edit. The preview opens.
4. Click at the bottom of the preview.
   If the visualization is used on a sheet, a dialog is displayed to inform you that any changes to the master visualization will be applied to all its instances on the sheets.
5. Click OK. The visualization opens for editing.
6. Make the changes you want, and click Done in the upper right corner of the visualization to finish editing.

The visualization is updated and reflected in all its instances.

You can also edit a master item from its preview. You open the preview by clicking an item in the master items.

Reusing dimensions with master dimensions

When you are working with an unpublished app, you can create master dimensions so that they can be reused. Users of a published app will have access to the master dimensions, but will not be able to modify them.

You can create a master dimension in different ways.

Creating a master dimension from a field

When you are working with an unpublished app, you can create master dimensions so that they can be reused. You can create a master dimension from the Fields section of the assets panel.

Do the following:

1. Click in the toolbar. The assets panel opens on the left-hand side.
2. Click to select the fields tab.
3. Click the field you want to use to create a dimension. The preview opens.
4. Click at the bottom of the preview.
   The Create new dimensions dialog opens with the field you selected. The field name is also used as the name of the dimension.
5. Select if the dimension is to be single or drill-down.
6. Edit the name if you want to.
7. Type a description for the dimension (optional).
8. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
• Click one of the colors in the palette.
• Type a 6 character color code in the Hex input field: #.
• Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

9. Add tags (optional).
10. Click Add dimension.
11. Click Done to close the dialog.

The dimension is now saved in the Dimensions category in the master items, and you can use it in visualizations.

You can quickly add several dimensions as master items by clicking Add dimension after adding each dimension. Click Done when you have finished.

Direct Discovery fields are indicated by in the Fields section of the assets panel.

Creating a master dimension from the assets panel

When you are working with an unpublished app, you can create master dimensions so that they can be reused. Users of a published app will have access to the master dimensions, but will not be able to modify them.

You can only create master dimensions when you are working with an unpublished app.

Do the following:

1. Click in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to select the master items tab.
3. Click the Dimensions heading to expand the category.
4. Click Create new.
   The Create new dimensions dialog opens.
5. Select if the dimension is to be single or drill-down.
6. Click a field on the left-hand side to select it.
   The name of the field is automatically added as the name of the dimension.
7. Change the name if you want to.
8. Type a description for the dimension (optional).
9. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
   • Click one of the colors in the palette.
   • Type a 6 character color code in the Hex input field: #.
Creating visualizations

- Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

10. Add tags (optional).
11. Click Add dimension.
12. Click Done to close the dialog.

The dimension is now saved in the Dimensions category in the master items, and you can use it in visualizations.

10. You can quickly add several dimensions as master items by clicking Add dimension after adding each dimension. Click Done when you have finished.

Creating a drill-down dimension

When adding a dimension, you can select between creating a single or a drill-down dimension. The following description explains how to create a drill-down group from the Create new dimensions dialog.

Do the following:

1. Select Drill-down as dimension type.
2. Click at least two fields from the fields list on the left-hand side to insert them as the referenced fields.
3. Type a name for the dimension.
4. Type a description for the dimension (optional).
5. If you want to specify a color, click in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
6. Add tags (optional).
7. Click Add dimension.
8. Click Done to close the dialog.

The drill-down dimension is now saved in the Dimensions category among the master items.

When you click the dimension in the panel on the left-hand side, the preview displays the dimension type and which fields are included in the drill-down dimension.
Creating a calculated dimension

You can create a calculated dimension from the Master items tab in the assets panel. The expression editor opens from the Create new dimensions dialog.

Do the following:

1. Click the Dimensions heading on the Master items tab to expand the category.
2. Click Create new.
   
   The Create new dimensions dialog opens.
3. Click in the Field text box to open the Add expression dialog.

You will now be able to add expressions in different ways, depending on your preferences and of different levels of complexity.

You can also add an expression by typing directly into the Field text box, but you will then not be provided with syntax highlighting and syntax check.

Using a common function

1. Select a field from the drop-down list.
2. Click the aggregation function you want to use.
3. Click Insert to insert the function and the field into the expression editor.
4. Click **Apply** to close the **Add expression** dialog.
Continue by adding the descriptive data for the dimension.

**Adding an expression by typing**

1. Type the expression directly in the expression editor.
The field names you use in the expression are checked, and the syntax of the expression is validated.

   **As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect. Additional error information may be available by clicking the icon next to the hint.**

   Each line in the expression editor is numbered and syntax highlighting is used.

2. Click **Apply** to close the **Add expression** dialog.
For a measure, you continue by adding the descriptive data for the measure.

**Adding an expression through the properties panel**

You can add an expression to a visualization through the properties panel.

1. Open the sheet with the visualization that you want to edit.
2. Click **Edit** to open the properties panel. (If it is hidden, click in the lower right-hand corner to open it.)
3. Click the visualization that you want to edit.
The properties panel for that visualization is displayed on the right-hand side.
4. Under **Data**, click **Add data** and select **Dimension**.
A dimension text box is displayed.
5. Type your expression. The expression must begin with an equals sign (=), otherwise the string will be interpreted as text.

**Detailed syntax help**

You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name.

**This feature is supported only when using a computer with a keyboard.**

**Adding the descriptive data for the dimension**

After having entered the expression, you need to add some descriptive information.

1. Type a name for the dimension.
2. Type a description for the dimension (optional).
3. Optionally, click ▼ in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
4. Add tags (optional).
5. Click Add dimension.
6. Click Done to close the dialog.

The calculated dimension is now saved in the Dimensions category of the Master items, and you can use it in visualizations.

Editing a master dimension
When you update a master dimension, the changes will be reflected in all its instances, including all visualizations that use it.

Do the following:

1. In sheet view, click Edit in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension that you want to edit.
   The preview opens.
4. Click at the bottom of the preview.
   If the dimension is used on a sheet, a dialog is displayed to inform you that any changes to the master dimension will be applied to all its instances on the sheets.
5. Click OK.
   The Edit dimension dialog opens, where you update the field or expression, name, description and tags.
6. Click Save.

The dimension is now updated.

💡 You can also edit a master item from its preview. You open the preview by clicking an item in the master items.

Deleting a master dimension or master measure
You can delete dimensions and measures from the master items as long as the app is not published.

ℹ️ If you delete a master dimension or master measure, the visualizations that use the deleted master item will not work unless you replace it with a new dimension or measure.

Do the following:
1. In sheet view, click Edit in the toolbar. The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension or measure that you want to delete. The preview opens.
4. Click at the bottom of the preview. A dialog is displayed stating that all visualizations that use the dimension or measure will stop working.
5. Click OK.

The dimension or measure is deleted from the master items, and all visualizations on the sheets that used the deleted item do not work anymore. You see the text **Dimension not found** or **Measure not found** on those visualizations.

*A visualization that is lacking both a dimension and a measure, both which have been deleted from the master items.*

**Replacing an invalid dimension or measure**

When a dimension or measure has been deleted from the master items, all visualizations that reference to the deleted master item will not work anymore, until the missing dimension or measure is replaced.

Do the following:

1. In sheet view, click Edit in the toolbar. The assets panel opens on the left-hand side. Click to display the master items.
2. Drag a dimension or measure from the **Dimensions** or **Measures** sections to the visualization on the
3 Creating visualizations

sheet.
The shortcut menu opens.

3. Select Replace invalid dimension or Replace invalid measure.

The visualization is complete and works again.

Reusing measures with master measures

When you are working with an unpublished app, you can create master measures so that they can be reused. Users of a published app will have access to the master measures, but will not be able to modify them.

A measure is a combination of an expression and descriptive data, such as name, description and tags. You can add the expression for the measure in different ways.

You can create a master measure in different ways.

Creating a master measure from a field

When you are working with an unpublished app, you can create master measures so that they can be reused. You can create a master measure from the Fields section of the assets panel.

1. Click in the toolbar.
The assets panel opens on the left-hand side.
2. Click to select the fields tab.
3. Click the field you want to use to create a measure.
The preview opens.
4. Click at the bottom of the preview.
5. The Create new measure dialog opens with the field you selected as the name of the measure and as a part of the expression.
6. Click in the Expression field to open the Edit expression dialog.
7. Type the expression directly in the expression editor (the main window).
The field names you use in the expression are checked, and the syntax of the expression is validated.

As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect in the lower left-hand corner. Additional error information may be available by clicking the icon next to the hint.

Each line in the expression editor is numbered and syntax highlighting is used.

You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name, and only when using a computer with a keyboard.

8. Click Apply to close the Add expression dialog.
Now you need to add some descriptive data for the measure.
Creating visualizations

9. Edit the name if you want to.
10. Type a description for the measure (optional).
11. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click 🌧 at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
12. Add tags (optional).
13. Click Create.

The measure is now saved in the Measures category in the master items, and you can use it in visualizations.

Direct Discovery fields are indicated by ☰ in the Fields section of the assets panel.

Creating a master measure with a common aggregation function

When you are working with an unpublished app, you can create master measures so that they can be reused. You can easily create a measure using one of the most common aggregation functions by selecting the function and the field from drop-down lists.

Do the following:

1. Click in the toolbar.
   The assets panel opens on the left-hand side.
2. Click 🌋 to select the master items tab.
3. Click the Measures heading to expand that category.
4. Click Create new.
   The Create new measure dialog opens.
5. Click ❓ in the Expression field to open the Add expression dialog.
   You find drop-down lists for selecting a field and a common function on the right-hand side.
6. If you want to show fields from a particular table, select this table in the top drop-down list (optional).
7. Select a field from the Field drop-down list.
8. Select a function from the bottom drop-down list.

You can insert just a field by not selecting a function.

9. Click Insert to insert the field and the function into the expression editor.
You can open the online help with the full description of how to use the current function by double-clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This feature becomes available after having entered the first parenthesis of the expression after the function name, and only when using a computer with a keyboard.

10. Click **Apply** to close the **Add expression** dialog.
    Now you need to add some descriptive data for the measure.

11. Type a name for the measure.

12. Type a description for the measure (optional).

13. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
    - Click one of the colors in the palette.
    - Type a 6 character color code in the Hex input field: #.
    - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.


15. Click **Create**.

The measure is now saved in the **Measures** category in the master items, and you can use it in visualizations.

Creating a master measure by typing the expression

When you are working with an unpublished app, you can create master measures so that they can be reused.

You can add complex expressions by typing the expression into the expression editor.

1. Click in the toolbar.
   The assets panel opens on the left-hand side.

2. Click to select the master items tab.

3. Click the **Measures** heading to expand that category.

4. Click **Create new**.
   The **Create new measure** dialog opens.

5. Click in the **Expression** field to open the **Add expression** dialog.

6. Type the expression directly in the expression editor (the main window).
   The field names you use in the expression are checked, and the syntax of the expression is validated.

   As you type in the expression editor, the expression is validated continuously. If there is an error, you see a hint about what is incorrect in the lower left-hand corner. Additional error information may be available by clicking the icon next to the hint.

Each line in the expression editor is numbered and syntax highlighting is used.
7. Click **Apply** to close the **Add expression** dialog.
   Now you need to add some descriptive data for the measure.

8. Type a name for the measure.

9. Type a description for the measure (optional).

10. If you want to specify a color, click ▼ in the color drop down and select a color through one of the following methods:
    - Click one of the colors in the palette.
    - Type a 6 character color code in the Hex input field: #.
    - Click  at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.

11. Add tags (optional).

12. Click **Create**.

The measure is now saved in the **Measures** category in the master items, and you can use it in visualizations.

**Editing a master measure**

When you update a master measure, the changes will be reflected in all its instances, including all visualizations that use it.

Do the following:

1. In sheet view, click **Edit** in the toolbar.
   The assets panel opens on the left-hand side.

2. Click  to display the master items.

3. Click the measure that you want to edit.
   The preview opens.

4. Click  at the bottom of the preview.
   If the measure is used on a sheet, a dialog is displayed to inform you that any changes to the master measure will be applied to all its instances on the sheets.

5. Click **OK**.
   The **Edit measure** dialog opens, where you update the expression, name, description, color, and tags.

6. Click **Save**.

The measure is now updated.
Assigning colors to master items

To ensure colors are used consistently for the same dimensions and measures in visualizations, you can assign colors to your master items. Colors assigned to master dimensions and master measures persist across all instances of those master items in all visualizations. If you change the color used for the master item, the color will be updated across all instances of that master item. Optionally, master item colors can be disabled for individual visualizations.

Visualizations use master dimension colors when Single color is selected in the Colors and legend section of the visualization properties panel. Master measure colors are used when Single color or Multicolored are selected in the Colors and legend section of the visualization properties panel.

By default, if a visualization's default Auto settings use the Single or Multicolored, master item colors will be applied automatically. If they do not, you must switch to Custom and select a supported setting. Master item colors can be disabled in individual visualizations.

In a visualization with colors specified for both master dimension and master measure, Qlik Sense defaults to the master dimension color. Master measure colors can be applied using the Use library colors drop-down and selecting Measure in the Colors and legend section of the visualization properties panel. In visualization with a mix of master measures with assigned colors and measures without assigned colors, the other measures will use the default palette colors.

Master dimensions can have colors assigned to their distinct values.

Master measures can have custom color gradients applied to their values in visualizations.

When assigning colors to your master items, you have the following options:

- Choose a color from the default palette
- Type a hexadecimal color code
- Choose a color using advanced color options

Assigning a color from the default color palette

Do the following:

1. In sheet view, click Edit in the toolbar.
2. Click to display the master items.
3. Select a master item from your library.
4. Click .
5. Click ▼ in the color drop-down.
6. Select one of the colors in the palette.
7. Click outside the dialog.
8. Click **Save**.

*The color dialog with the default color palette and a blue color selected.*

Assigning a color using a hexadecimal color code

Do the following:

1. In sheet view, click **Edit** in the toolbar.
2. Click ☰️ to display the master items.
3. Select a master item from your library.
4. Click ☰️.
5. Click ▼ in the color drop-down.
6. Type a 6 character color code in the input field: #.
7. Click outside the dialog or press Enter.
8. Click **Save**.

Assigning a color using advanced color options

Do the following:

1. In sheet view, click **Edit** in the toolbar.
2. Click ☰️ to display the master items.
3. Select a master item from your library.
4. Click ☰️.
5. Click ▼ in the color drop-down.
6. Click ☰️ at the bottom of the dialog.
   The dialog displays the advanced options.
7. Select a color in the color wheel. The selected color changes and the Hex color code updates accordingly.

8. Optionally, adjust the color saturation using the slider. The saturation changes and the Hex color code updates accordingly.

9. Click outside the dialog.

10. Click **Save**.

*The color dialog with the color wheel in the advanced options and a blue color selected.*

Assigning colors to master dimension values

You can assign colors to the distinct values contained in a master dimension. This ensures that the distinct values of your dimensions use the same colors in all visualizations. Colors assigned to values are used when you choose to color by dimension and have **Library colors** enabled. If you choose to color by Single color, the master dimension's color is used instead.

Assigning colors to master dimension values has the following limitations:

- A maximum of 100 colors can be assigned to a dimension's values.
- Dimension values cannot be longer than 1024 characters. Longer values are disabled in the list of values.
- Drill-down dimensions do not support assigning colors to dimension values

*You must not assign colors to master dimension values if you use section access or work with sensitive data because the values may be exposed.*

The **Value colors** section of **Edit dimensions** contains the options for assigning colors to a dimension's distinct values. You can search the list of values with **Q**.
Qlik Sense automatically applies an auto fill to your values to provide a default color. The auto fill is either a single color or a color scheme. Changing your auto-fill settings will not change colors you have assigned to values.

In addition to distinct values, you can set colors for the values classified as others in a visualization, that is, the collection of distinct values that fall outside the displayable values in a dimension. You can also set colors for null values.

Do the following:

1. In sheet view, click Edit in the toolbar.
2. Click to display the master items.
3. Select a master dimension from your library.
4. Click .
5. Click Value colors.
6. If you want to change the auto fill settings, set Auto fill to Custom, select the auto fill method, and either select a single color or color scheme.
7. Select a value and do one of the following:
   - Select a color in the color wheel, and optionally adjust the saturation slider.
   - Type a 6 character color code in the Hex input field: #.
     Values assigned colors display the icon.
8. If you want to remove an assigned color, select the value and click .
9. Optionally, to assign a color to Others or Null values, click and do one of the following:
   - Click one of the colors in the palette.
   - Type a 6 character color code in the Hex input field: #.
   - Click at the bottom of the dialog, select a color in the color wheel, and optionally adjust the saturation slider.
10. Click Save.

Assigning colors to master measure values
You can assign a color gradient or segment scheme to a master measure, enabling you to color visualizations by measure, using colors other than the default color schemes. This enables you to color visualizations using colors other than the default color schemes when coloring by measure.

If you choose to color by single color, the master measure’s color is used instead of the color scheme.

To assign custom segment or gradient colors to the values in a master measure, do the following:

1. Access and enable segment colors.
2. Select the template scheme.
3. Select the segment format.
4. Optionally, add or remove limits.
5. Optionally, edit your segment limits.
6. Assign colors to your segments.
7. Save.

**Accessing and enabling segment colors**

Do the following:

1. In sheet view, click Edit in the toolbar.
2. Click to display the master items.
3. Select a master measure from your library.
4. Click .
5. Click on the Segment colors tab.
6. Set the Segment colors button to Custom coloring.

**Selecting the template scheme**

The template scheme provides a default template to edit. You can choose from the default classes and gradients.

Do the following:

- Under Select a template scheme, select a template scheme.

**Selecting the segment format**

The segment format determines how colors will be applied. Percentage adds value classes based on where values fit into the percentile of their value. Fixed value uses defined values to set the limits of each segment.

Do the following:

- Set Segment format to Fixed value or Percentage.

**Adding, editing and removing limits**

By default, the number of segments depends on the scheme selected. You can create additional segments by adding limits. When a new segment is created a pointer marks the value of its limit.

Do the following:

- Click on the Add limit button to add a limit to the gauge.
- Use the slider to change the value of a limit. You can also type a value for the selected limit.
- Click on the Remove limit button to remove the selected limit.

**Editing segments**

By default, segment colors depend on the scheme selected. You can change the color of a segment and its ending.

Do the following:

- Click the segment to change colors.
- Select Gradient to use different shades of colors in the transition between segments for the selected limit.
Create calendar measures

To analyze data over relative time ranges, use calendar measures. For example, you might want to compare current year-to-date sales figures with figures from the same period the previous year.

Calendar measures aggregate data from a field over a time range, and are saved in the Measures category in the master items. Calendar measures comprise a field to be aggregated, an aggregation, a date field, and a time range for that date field that sets which data is included in the aggregation. You create calendar measures under Fields in the Assets panel, using the Create calendar measures dialog.

You can aggregate fields from tables loaded in Data manager or from a script in Data load editor, as long as the field is in the same table as the date field, or is in an associated table.

However, the date field must be from a table that has been loaded using Data manager, because calendar measures use expressions tagged as date & time fields that are declared in autoCalendar, and date fields are only mapped to autoCalendar when loaded in Data manager. Calendar measures support the following aggregations with the aggregated field: Sum, Count, Avg, Min, and Max.

Calendar measures do not support calendars created using the Data load editor. If you use calendars created using Data load editor and want to create calendar measures, you must load a table containing a date field using Data manager for use with your tables loaded using Data load editor.

If your date field is subject to more than one calendar and both calendars are qualified for use with calendar measures, then the first calendar loaded in the data load script is used in the calendar measures.

A calendar measure can use one of the following time ranges are available for use with calendar measures: weekly, monthly, quarterly, and yearly. Within each time range, different measures exist for periods such as current month, year-to-date, and current week last year. The following time ranges and measures are available for creating calendar measures:

### Calendar measures for time range Yearly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YTD</td>
<td>The year to date for all years.</td>
</tr>
<tr>
<td>YTD Current Year</td>
<td>The year to date for the current year.</td>
</tr>
<tr>
<td>YTD Last Year</td>
<td>The year to date for last year.</td>
</tr>
</tbody>
</table>

### Calendar measures for time range Monthly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTD</td>
<td>The month to date for all months and years.</td>
</tr>
</tbody>
</table>
Creating visualizations

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTD Current Month</td>
<td>The month to date for the current month.</td>
</tr>
<tr>
<td>MTD Last Month</td>
<td>The month to date for last month.</td>
</tr>
<tr>
<td>Current Month</td>
<td>All dates this month.</td>
</tr>
<tr>
<td>Current Month Last Year</td>
<td>All dates this month last year.</td>
</tr>
<tr>
<td>Last Month</td>
<td>All dates last month.</td>
</tr>
</tbody>
</table>

Calender measures for time range Quarterly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QTD</td>
<td>The quarter to date for all years.</td>
</tr>
<tr>
<td>QTD Current Quarter</td>
<td>The quarter to date for the current quarter.</td>
</tr>
<tr>
<td>QTD Last Quarter</td>
<td>The quarter to date for the last quarter.</td>
</tr>
<tr>
<td>Current Quarter</td>
<td>All dates in the current quarter.</td>
</tr>
<tr>
<td>Current Quarter Last Year</td>
<td>All dates in the current quarter last year.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>All days for the last quarter.</td>
</tr>
</tbody>
</table>

Calender measures for time range Weekly

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WTD</td>
<td>The week to date for all weeks across all years.</td>
</tr>
<tr>
<td>WTD Current Week</td>
<td>This week to date for the current week.</td>
</tr>
<tr>
<td>WTD Last Week</td>
<td>The week to date for the last week.</td>
</tr>
<tr>
<td>Current Week</td>
<td>All dates this week.</td>
</tr>
<tr>
<td>Current Week Last Year</td>
<td>All dates this week last year.</td>
</tr>
<tr>
<td>Last Week</td>
<td>All dates last week.</td>
</tr>
</tbody>
</table>

Once created, calendar measures are treated identically to master measures. That is, calendar measures are reusable and editable while an app is unpublished. Users of a published app will have access to the calendar measures, but will not be able to modify them.

Creating a calendar measure from a field

Do the following:

1. Click in the toolbar. The assets panel opens on the left-hand side.
2. Click to open the Fields tab.
3. Right-click a field and select Create calendar measures. By default, the field you right-clicked will be included as the Aggregated field.
4. Select a date field from the **Date field** drop-down list.
5. Select a field from the **Aggregated field** drop-down list.
6. Select an aggregation from the **Aggregation** drop-down list.
7. Select a time range from the **Time range** drop-down list.
   A list of the available measures displays under **Preview of measures**.
   You can toggle the display of the measures’ expressions by selecting the **Preview of measures** switch.
8. Select the calendar measures to add to your master items.
   By default, all measures are selected.
9. Click **Save to master items**.
10. Click **Close**.

**Tagging master items**
You can use tags to organize master items. You will find matches in tags when searching in the assets panel.

Each tag can contain a maximum of 31 characters, and each master item can have up to 30 tags.

**Adding tags to a master item**
You can add tags when creating or editing a master item.

*Adding tags while creating a new measure.*
3 Creating visualizations

You can add tags by clicking + or by pressing Enter.

Previewing tags
In the assets panel, tags are displayed when previewing dimensions, measures and visualizations.

The preview displays the dimension type, which fields are included in the drill-down dimension and tags.
Unlinking from a master visualization

If you want to make changes to a visualization that is linked to a master visualization, you must first unlink it from the master visualization. The visualization on your sheet is then independent with no connection to the master visualization in the assets panel.

Unlinking using

A linked visualization can be unlinked using that is located in the top right corner of a linked visualization.

Do the following:

1. Click .
2. Click in the top right corner of a linked visualization on the sheet.
   - A dialog is displayed that you are about to unlink from a master visualization.
3. Click .

The visualization on the sheet can now be edited and the changes will not affect any other visualizations.

Unlinking from the shortcut menu

A linked visualization can be unlinked from the shortcut menu.

Do the following:

1. Click .
2. Long-touch/right-click a linked visualization on the sheet.
   - The shortcut menu opens.
3. Select Unlink visualization.
   - A dialog is displayed that you are about to unlink from a master visualization.
4. Click .

The visualization on the sheet can now be edited and the changes will not affect any other visualizations.
Deleting a master dimension or master measure
You can delete dimensions and measures from the master items as long as the app is not published.

If you delete a master dimension or master measure, the visualizations that use the deleted master item will not work unless you replace it with a new dimension or measure.

Do the following:

1. In sheet view, click Edit in the toolbar. The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the dimension or measure that you want to delete. The preview opens.
4. Click at the bottom of the preview. A dialog is displayed stating that all visualizations that use the dimension or measure will stop working.
5. Click OK.

The dimension or measure is deleted from the master items, and all visualizations on the sheets that used the deleted item do not work anymore. You see the text **Dimension not found** or **Measure not found** on those visualizations.

*A visualization that is lacking both a dimension and a measure, both which have been deleted from the master items.*
Creating visualizations

Replacing an invalid dimension or measure
When a dimension or measure has been deleted from the master items, all visualizations that reference the deleted master item will not work anymore, until the missing dimension or measure is replaced.

Do the following:

1. In sheet view, click Edit in the toolbar.
   The assets panel opens on the left-hand side. Click to display the master items.
2. Drag a dimension or measure from the Dimensions or Measures sections to the visualization on the sheet.
   The shortcut menu opens.
3. Select Replace invalid dimension or Replace invalid measure.

The visualization is complete and works again.

Deleting a master visualization
You can delete visualizations from the master items as long as the app is not published.

Do the following:

1. In sheet view, click Edit in the toolbar.
   The assets panel opens on the left-hand side.
2. Click to display the master items.
3. Click the visualization that you want to delete.
   The preview opens.
4. Click at the bottom of the preview.
   A dialog is displayed stating that wherever this visualization is used on sheets, there will be invalid instances of it.
5. Click OK.

The visualization is deleted from the master items, and on all sheets where this visualization was used, you see invalid visualizations. You now need to replace the invalid visualization with other ones, or delete the instances.

You can also delete visualizations from the preview that is displayed when clicking the visualization in the master items.

Replacing an invalid visualization on a sheet
The representation of the invalid visualization is there to tell you that there used to be a visualization at a certain location on the sheet, but the invalid visualization serves no purpose.

Do the following:

1. In sheet view, click Edit in the toolbar.
   The assets panel opens on the left-hand side. Click to display the master items.
2. Drag a visualization from the master items to the location of the invalid visualization on the sheet.

The invalid visualization is replaced.

Deleting an invalid visualization

1. In sheet view, click Edit in the toolbar.
2. Long-touch/right-click on the invalid visualization and select Delete in the shortcut menu.

The invalid visualization is deleted.

Using expressions in visualizations

Visualizations in Qlik Sense are built from charts, which in turn, are built from dimensions and measures, depending on the type of chart. Visualizations can have titles, subtitles, footnotes, and other elements to help convey information. All of the elements that make up a visualization can be simple: a dimension consisting of a field representing data, a title consisting of text, for example.

For visualizations that contain measures, the measures are calculations based on fields, for example \( \text{Sum} (\text{Cost}) \), which means all the values of the field Cost are aggregated using the function Sum. In other words, \( \text{Sum}(\text{Cost}) \) is an expression.

What is an expression?

An expression is a combination of functions, fields, and mathematical operators (+ * / =). Expressions are used to process data in the app in order to produce a result that can be seen in a visualization. They are not limited to use in measures. You can build visualizations that are more dynamic and powerful by using expressions for titles, subtitles, footnotes, and even dimensions.

This means, for example, that instead of the title of a visualization being static text, it can be made from an expression whose result changes depending on the selections made.

Where can I use expressions?

Expressions can be used in a visualization wherever the symbol \( \text{fx} \) is seen in the properties panel while editing a visualization. The \( \text{fx} \) symbol indicates an expression field. By clicking \( \text{fx} \), you enter the expression editor, which is designed to help you build and edit expressions. Expressions can also be entered directly into the expression field, without using the expression editor.

An expression cannot be saved directly as a master item, but if an expression is used in a measure or dimension, which is then saved as a master item, with its descriptive data, such as name, description, and tags, the expression in the measure or dimension is preserved.

Expressions are used both in scripts and in chart visualizations. They can be simple, involving only basic calculations, or complex, involving functions fields and operators. Expressions can be used in several different situations. The difference between measures and expressions is that expressions have no name or descriptive data.
3 Creating visualizations

**In a script, an expression is evaluated as the script execution passes it by. In visualizations (including charts and tables), expressions are evaluated automatically whenever any of the fields, variables or functions that the expression contains change value or logical status. A few differences exist between script expressions and chart expressions in terms of syntax and available functions.**

For detailed reference regarding script functions and chart functions, see the Script syntax and chart functions.

Working with the expression editor

You can enter the expression editor to add or edit an expression wherever you see the symbol \( fx \) in the properties panel while editing a visualization. The \( fx \) symbol indicates an expression field. Click \( fx \) to enter the expression editor.

You can add expressions in two ways. Expressions can be created using the **Fields**, **Functions**, **Variables**, and **Set expressions** sections by making selections and inserting them into the expression field. You can edit the inserted expressions and add more complex expressions by typing directly into the expression field. You can undo an action by clicking the **Undo button** (↩).

Inserting an expression using Fields

You can insert an expression by making selections from the **Fields** section at the right-hand side of the expression editor dialog.

Do the following:

1. If you want to limit the available fields to those from a particular table in your data model, select a table from the **Filter by table** drop-down list.
2. Select a field from the **Field** drop-down list.
3. Select the aggregation function you want to use. The functions available are from the group of basic aggregation functions.
4. If you want to insert the current selection as a set expression in your aggregation, use the **Set expression** check box. The current selection is always based on the default state.
5. If you want to insert a **Distinct** or a **Total** clause together with the aggregation function, use the check boxes for each clause. Each clause can be used separately.
6. Click **Insert** to insert the field and the function into the expression field.

   **If you do not select an aggregation function, only the field will be inserted into the expression. Clauses can only be added if you select an aggregation function.**

7. Click **Apply** to close the **Add expression** dialog.

   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.
Inserting a function using Functions
You can insert more than the basic aggregation functions by making selections from the Functions section at the right-hand side of the expression editor dialog.

1. If you want to filter the list of available functions, select a function category from the Function category drop-down list.
2. Select a function from the Function name drop-down list.
   You see a preview of the function.
3. Click **Insert** to insert the function and the first parenthesis into the expression field.
4. Type the rest of the expression in the expression editor according to the syntax.
5. Click **Apply** to close the Add expression dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Inserting a variable using Variables
You can insert a variable by making selections from the Variables section at the right-hand side of the expression editor dialog.

1. If you want system variables to appear in the list of available variables use the Show system variables check-box.
2. Select a variable from the Variable drop-down list.
   You see a Definition and Value of the variable, if available.
3. Click **Insert** to insert the variable into the expression field.
4. Click **Apply** to close the Add expression dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Inserting a set expression using Set expressions
You can insert a set expression by making selections from the Set expressions section at the right-hand side of the expression editor dialog.

1. Select whether to Use current selections or Use bookmark, as a set expression.
   You can only Use current selections if a selection has been made in the app. You can only Use bookmark if a bookmark is available. Use the Bookmark drop-down menu to choose between bookmarks.
2. If you have defined alternate states, you can change the alternate state which the set expression is based on. Select the alternate state from Alternate state drop-down menu.
3. Click **Insert** to insert the set expression into the expression field.
4. Click **Apply** to close the Add expression dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Adding or editing an expression by typing
Do the following:

1. Type the expression directly in the expression field.
   The field names you use in the expression are checked, and the syntax of the expression is validated.
3 Creating visualizations

As you type in the expression editor, the expression is validated. If there is an error, you see a hint about what is incorrect. Additional error information may be available by clicking the icon next to the hint.

When you type the name of a function in the expression, a tooltip appears that provides information to help you enter the function correctly, including argument names and qualifiers.

The tooltip for some chart functions shows the ALL qualifier. It is recommended that you do not use the ALL qualifier. Instead, use the set expression \{1\}.

Each line in the expression editor is numbered and syntax highlighting is used.

2. Click **Apply** to close the **Add expression** dialog.
   For a dimension or measure, you continue by adding descriptive data for the dimension or measure.

Auto-complete, evaluation and color coding

When typing in the expression editor, you get an auto-complete list of matching fields, variables and functions to select from. The list is narrowed down as you continue to type. The color coding helps you to see where fields, variables and functions are used in the expression.

The color coding applies both in the auto-complete list and in the expression itself.

You can verify that any dollar-sign expansions added in your expression give the correct result, by checking the expression evaluation, in the dollar-sign expansion preview.

How names are interpreted

It is not recommended to name a variable identically to a field or a function in Qlik Sense. But if you do, you must know how to use them in an expression.

**Example:**

XXX is a field, a variable and a function. XXX will be interpreted as one of them depending on how you create the expression.

<table>
<thead>
<tr>
<th>Expression</th>
<th>XXX interpreted as</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(XXX)</td>
<td>variable</td>
</tr>
<tr>
<td>count(XXX)</td>
<td>field</td>
</tr>
<tr>
<td>XXX()</td>
<td>function</td>
</tr>
</tbody>
</table>

Rules for expressions

The following rules apply for chart expressions:
3 Creating visualizations

- All expressions return a number and/or a string, whichever is appropriate.
- Logical functions and operators return 0 for False, -1 for True. Number-to-string conversions and string-to-number conversions are implicit.
- Logical operators and functions interpret 0 as False and all else as True.
- Expressions that cannot be correctly evaluated, for example as a result of incorrect parameters or functions, return NULL.

Detailed syntax help
You can activate help mode by clicking the Help button ( ). When active, all functions in the expression editor act like hyperlinks. Clicking on a function opens a browser tab to the online help section with the full description of how to use the specific function. When a function is clicked, help mode is exited.

Using functions in charts
A function is a type of procedure or routine that performs a specific task on data in apps. Qlik Sense contains several hundred ready-made functions that can be used in charts when creating visualizations. Functions can be, for example, mathematical, logical, can operate on financial or date and time information, can be used to manipulate strings, and other situations.

Functions can be grouped into the types:

- Aggregation functions, which use several records as input and produce a single value result.
- Scalar functions, which take a single input and produce a single output.
- Range functions, which produce a single value based on a range of input values.
- Range-producing functions, which are like range functions, but produce a range of values as output.

Many of the functions can be used in both chart expressions and scripts, but some are specific for chart expressions.

The following list shows some examples of functions:

- **Max**: an aggregation function that can be used in scripts and charts.
  For example: Max(Sales) calculates the highest value in the field Sales.
- **IF**: a conditional function that can be used in scripts and charts.
  For example: IF(Amount>0, 'OK', 'Alarm') determines if the condition 'is the value of Amount greater than zero?' is met. If it is, OK is written, otherwise Alarm is written.
- **Date#**: an interpretation function that can be used in scripts and charts.
  For example: Date#(A) takes the input value A and evaluates it as a date.

A few differences exist between script expressions and chart expressions in terms of syntax and available functions. The most important difference is the role of the aggregation functions and the use of field references. The basic rule is that any field name in a chart expression must be enclosed by exactly one aggregation function. An aggregation function can never have another expression containing an aggregation function as argument.
For detailed reference regarding script functions and chart functions, see the Script syntax and chart functions.

Set analysis and set expressions

Set analysis offers a way of defining a set (or group) of data values that is different from the normal set defined by the current selections.

Normally, when you make a selection, aggregation functions, such as **Sum**, **Max**, **Min**, **Avg**, and **Count** aggregate over the selections that you have made: the current selections. Your selections automatically define the data set to aggregate over. With set analysis you can define a group that is independent of the current selections. This can be useful if you want to show a particular value, for example, the market share of a product across all regions, irrespective of the current selections.

Set analysis is also powerful when making different sorts of comparisons, such as what are the best-selling products compared with poorly-selling products, or this year against last year.

Let us imagine an example in which you start working in an app by selecting the year 2010 in a filter pane. The aggregations are then based on that selection, and the visualizations only show values for that year. When you make new selections, the visualizations are updated accordingly. The aggregations are made over the set of possible records defined by the current selections. With set analysis, you can define a set that is of interest to you and does not depend on the selections.

Creating set expressions

Before looking at the different parts of a set analysis example, there is a distinction that should be made between a set expression and set analysis:

Defining a set of field values is referred to as defining a set expression, whereas using set expressions to analyze data is referred to as set analysis. Consequently, the rest of this section focuses on the set expression and its components.

Here is a set analysis example: `sum( {$<Year={2009}>}$ sales )`, in which `{$<Year={2009}>$}` is a set expression.

There are two general syntax rules for a set expression:

- A set expression must be used in an aggregation function. In this example, the aggregation function is `sum(sales)`.
- A set expression must be enclosed by braces, `{}`. In the example, the set expression is: `{$<year={2009}>$}`.

A set expression consists of a combination of the following parts:

- **Identifiers**. One or more identifiers define the relationship between the set expression and what is being evaluated in the rest of the expression. A simple set expression consists of a single identifier, such as the dollar sign, `$`, which means all records in the current selection.
- **Operators**. If there is more than one identifier, an operator or operators are used to refine the set of data by specifying how the sets of data represented by the identifiers are combined to create a subset or superset, for example.
Modifiers. A modifier or modifiers can be added to the set expression to change the selection. A modifier can be used on its own or to modify an identifier to filter the data set.

Examples:

Example 1:

\{\textdollar<\text{year}=(2009)>\}

This set expression contains an identifier $\textdollar$, and the modifier \textless<year=(2009)>\textgreater. This example does not include an operator. The set expression is interpreted as: “All records in the current selection that belong to the year 2009”.

Example 2:

\text{Sum}(\{$<\text{year}=(2009)>\}+1<\text{Country}=\{'Sweden'\}>) \text{Sales})

This set expression contains the identifiers $\textdollar$ and 1, the operator + and the modifiers \textless<Year=(2009)>\textgreater and \textless<Country=\{'Sweden'\}>\textgreater. This set expression is designed to sum the sales for the year 2009 associated with the current selections and add the full set of data associated with the country Sweden across all years.

Identifiers, operators and modifiers are described in more detail with in the following subsections.

Identifiers

Identifiers define the relationship between the set expression and the field values or expression being evaluated.

In our example \text{sum}(\{$<\text{year}=(2009)>\} \text{ sales }), the identifier is the dollar sign, $\textdollar$, and means that the set of records to be evaluated consists of all the records of the current selection. This set is then further filtered by the modifier part of the set expression. In a more complex set expression, two identifiers can be combined using an operator.

This table shows some common identifiers.

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Represents the full set of all the records in the application, irrespective of any selections made.</td>
</tr>
<tr>
<td>$</td>
<td>Represents the records of the current selection. The set expression {$} is thus the equivalent to not stating a set expression.</td>
</tr>
<tr>
<td>$1</td>
<td>Represents the previous selection. $2 represents the previous selection-but-one, and so on.</td>
</tr>
<tr>
<td>$1_1</td>
<td>Represents the next (forward) selection. $2_1 represents the next selection-but-one, and so on.</td>
</tr>
<tr>
<td>BM01</td>
<td>You can use any bookmark ID or bookmark name.</td>
</tr>
<tr>
<td>MyAltState</td>
<td>You can reference the selections made in an alternate state by its state name.</td>
</tr>
</tbody>
</table>

This table shows some examples with different identifiers.
### Creating visualizations

#### Examples with different identifiers

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>sum (1 Sales)</td>
<td>Returns total sales for the app, disregarding selections but not the dimension.</td>
</tr>
<tr>
<td>sum ($ Sales)</td>
<td>Returns the sales for the current selection, that is, the same as sum(Sales).</td>
</tr>
<tr>
<td>sum ($1 Sales)</td>
<td>Returns the sales for the previous selection.</td>
</tr>
<tr>
<td>sum ([BM01] Sales)</td>
<td>Returns the sales for the bookmark named BM01.</td>
</tr>
</tbody>
</table>

#### Operators

Operators are used to include, exclude, or intersect parts of or whole data sets. All operators use sets as operands and return a set as result.

This table shows operators that can be used in set expressions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Union. This binary operation returns a set consisting of the records that belong to any of the two set operands.</td>
</tr>
<tr>
<td>-</td>
<td>Exclusion. This binary operation returns a set of the records that belong to the first but not the other of the two set operands. Also, when used as a unary operator, it returns the complement set.</td>
</tr>
<tr>
<td>*</td>
<td>Intersection. This binary operation returns a set consisting of the records that belong to both of the two set operands.</td>
</tr>
<tr>
<td>/</td>
<td>Symmetric difference (XOR). This binary operation returns a set consisting of the records that belong to either, but not both of the two set operands.</td>
</tr>
</tbody>
</table>

This table shows some examples with operators.

<table>
<thead>
<tr>
<th>Examples</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>sum( (1-$) Sales )</td>
<td>Returns sales for everything excluded by the selection.</td>
</tr>
<tr>
<td>sum( ($=BM01) Sales )</td>
<td>Returns sales for the intersection between the selection and bookmark BM01.</td>
</tr>
<tr>
<td>sum( (-($=BM01)) Sales )</td>
<td>Returns sales excluded by the selection and bookmark BM01.</td>
</tr>
<tr>
<td>sum((&lt;$&lt;year= (2009)&gt;1&lt;Country= ('Sweden')&gt;) Sales)</td>
<td>Returns sales for the year 2009 associated with the current selections and add the full set of data associated with the country Sweden across all years.</td>
</tr>
</tbody>
</table>
Modifiers
Modifiers are used to make additions or changes to a selection. Such modifications can be written in the set expression. A modifier consists of one or several field names, each followed by one or several selections that can be made in the field. Modifiers begin and end with angle brackets, < >.

A set modifier modifies the selection of the preceding set identifier. If no set identifier is referenced, the current selection state is implicit.

This table shows some examples with modifiers.

| Example                                      | Result                                                                 |
|----------------------------------------------|                                                                      |
| `sum({$<OrderDate = DeliveryDate>} Sales)`  | Returns the sales for the current selection where OrderDate = DeliveryDate. |
| `sum({1<Region = {US}>} Sales)`              | Returns the sales for region US, disregarding the current selection.  |
| `sum({$<Region = >} Sales)`                 | Returns the sales for the selection, but with the selection in Region removed. |
| `sum({<Region = >} Sales)`                  | Returns the same as the example above. When the set to modify is omitted, $ is assumed. |
| `sum({$<Year=2000}, Region={"U*">} Sales)` | Returns the sales for the current selection, but with new selections both in Year and in Region. |

Using variables in expressions
A variable in Qlik Sense is a container storing a static value or a calculation, for example a numeric or alphanumeric value. When you use the variable in the app, any change made to the variable is applied everywhere the variable is used. You can define variables in the variables overview, or in the script using the data load editor. You set the value of a variable using Let or Set statements in the data load script.

*When using variables in expressions, you can change the expression used in a range of charts simultaneously simply by editing the variable.*

You open the Variables overview by clicking in the edit bar when editing a sheet.

The following actions are available in the variables overview:

- Create a new variable.
- Edit the selected variable.
- Delete the selected variable.

If you want to edit or delete a variable that is defined in the script, you must edit the script.
3 Creating visualizations

Getting an overview of all variables in an app
You can get an overview of all variables in an unpublished app.

Do the following:

1. When editing a sheet, click \[\text{ë} \] in the edit bar on the sheet to open the variables overview. The variables overview opens and displays a list of all variables in the app and their definitions (if any).
2. Select a variable in the list that you want to view details of. The variable expands and displays detailed information about the variable, if any: definition, description and tags.

When a variable is created or edited, all fields except the name field can be left empty.

See also:

Working with the expression editor (page 87)

Creating a variable
A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable’s definition. Variables are defined using the variables overview or in the script using the data load editor.

You can create a new variable from the variables overview, when editing a sheet in an unpublished app.

Do the following:

1. When editing a sheet, click \[\text{ë} \] in the edit bar on the sheet to open the variables overview. The variables overview opens.
2. Click Create new. The following input fields for the variable are displayed:
   - Name (mandatory)
   - Definition
   - Description
   - Tags

   Press Esc or click \[ \text{ë} \] if you want to cancel creating the new variable. If all input fields are empty, you can also cancel by clicking outside the new variable section in the variables overview or by clicking outside the variables overview window.
3. Type a name for the variable (mandatory). Use the following guidelines when choosing a name:
   - You cannot change the name once you have created the variable.
   - Use a letter as the first character, do not use a number or a symbol.
   - It is not recommended to name a variable identically to a field or a function in Qlik Sense.

   For more information, see How names are interpreted (page 98).
Creating visualizations

- Some characters have specific uses in Qlik Sense expressions, therefore do not use the following characters when naming a variable: $ ( ) [ ] "
- The name must be unique. You are not allowed to name a variable identically to a reserved variable or a system variable. These variables are not listed in the variables overview, but if you are not allowed to use a certain name, even though you cannot find a duplicate in the variables overview, a reserved variable or a system variable already has this name.
- A long name is not recommended. If a variable's name is too long, the name cannot be fully displayed in the variables overview.

4. Create a definition for the variable (optional). You can enter the expression editor by clicking $\text{fx}$. For more information, see Working with the expression editor (page 87).

Example:

Set the variable's value to today's date, presented as a number:

$$\text{Num}(\text{Today}())$$

5. Type a description for the variable (optional).
6. Add tags by typing and click $\text{+}$ or press Enter (optional).
7. Save the variable by clicking $\text{\textbf{\text{Save}}}$. You can also save by clicking outside the new variable's section in the variables overview or by clicking outside the variables overview window. The variable is added to the top of the list and marked with New.

The new variable is created.

See also:

Working with the expression editor (page 87)

Editing a variable

A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable's definition. Variables are defined using the variables overview or in the script using the data load editor.

You can choose to edit a variable from the variables overview, when editing a sheet in an unpublished app.

Do the following:

1. When editing a sheet, click $\text{\textbf{\text{ heter}}} \text{\textbf{\text{ heter}}} \text{\textbf{\text{ heter}}}$ in the edit bar on the sheet to open the variables overview. The variables overview opens.

   **Important:** If you want to edit a variable that is defined in the script, you can either edit in the script, using the data load editor, or delete it from the script and then edit it in the variables overview.

2. From the list, select a variable that you want to edit and click $\text{\textbf{\text{Save}}}$. 

Create apps and visualizations - Qlik Sense, June 2019
The variable expands and displays the following:

- **Definition** (if any)
- **Description** (if any)
- **Tags** (if any)

3. **Edit the variable as desired:**

   - You can open the expression editor and create the definition by clicking \( \mathbb{E} \).
   - For more information, see *Working with the expression editor (page 87).*
   - Cancel editing the variable, by pressing Esc.

   **If you click \( \mathbb{E} \) the variable is deleted.**

   - Add new tags by typing and and click \( \mathbb{P} \) or press Enter. Remove tags by clicking \( \mathbb{X} \).

4. **Save the changes by clicking \( \mathbb{V} \).** You can also save by clicking outside the variable's section in the variables overview or by clicking outside the variables overview window.

The variable is updated.

**See also:**

*Working with the expression editor (page 87)*

**Deleting a variable**

You can delete variables, from an unpublished app, by deleting them from the variables overview.

Do the following:

1. When editing a sheet, click \( \mathbb{E} \) in the edit bar on the sheet to open the variables overview. The variables overview opens.
2. Select the variable you want to delete.

   **If you want to delete a variable that is defined in the script, you must edit the script. If you remove a variable from the script and reload the data, the variable stays in the app. If you want to fully remove the variable from the app, you must also delete the variable from the variables overview.**

The details of the variable are displayed.

**Deleting a variable cannot be undone.**

3. Click \( \mathbb{E} \).
A confirmation message is displayed, asking if you are sure you want to delete the variable.

4. Click OK.

The variable is deleted.

Examples of using a variable in an expression
A variable in Qlik Sense is a named entity, containing a data value. When a variable is used in an expression, it is substituted by its value or the variable's definition.

Example:

The variable $x$ contains the text string $\text{Sum}(Sales)$.

In a chart, you define the expression $(\text{Sum}(x)/12$. The effect is exactly the same as having the chart expression $\text{Sum}(Sales)/12$.

However, if you change the value of the variable $x$ to for example $\text{Sum}(Budget)$, the data in the chart are immediately recalculated with the expression interpreted as $\text{Sum}(Budget)/12$.

When using variables in expressions, you can change the expression used in a range of charts simultaneously simply by editing the variable.

How names are interpreted
It is not recommended to name a variable identically to a field or a function in Qlik Sense. But if you do, you must know how to use them in an expression.

Example:

XXX is a field, a variable and a function. XXX will be interpreted as one of them depending on how you create the expression.

<table>
<thead>
<tr>
<th>Expression</th>
<th>XXX interpreted as</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(XXX)$</td>
<td>variable</td>
</tr>
<tr>
<td>$\text{count}(XXX)$</td>
<td>field</td>
</tr>
<tr>
<td>$XXX()$</td>
<td>function</td>
</tr>
</tbody>
</table>

Variable calculation
There are several ways to use variables with calculated values in Qlik Sense, and the result depends on how you define it and how you call it in an expression.

This example requires the following data is loaded in the data load editor:

```
LOAD * INLINE [
  Dim, Sales
]"
Let's define two variables, from the variables overview:

- **Name vSales** Definition 'Sum(Sales)'
- **Name vSales2** Definition '=Sum(Sales)'

In the second variable, we add an equal sign before the expression. This will cause the variable to be calculated before it is expanded and the expression is evaluated.

If you use the vSales variable as it is, for example in a measure, the result will be the string Sum(Sales), that is, no calculation is performed.

If you add a dollar-sign expansion and call $(vSales) in the expression, the variable is expanded, and the sum of Sales is displayed.

Finally, if you call $(vSales2), the variable will be calculated before it is expanded. This means that the result displayed is the total sum of Sales. The difference between using=$(vSales) and=$(vSales2) as measure expressions is seen in this chart showing the results:

<table>
<thead>
<tr>
<th>Dim</th>
<th>$(vSales)</th>
<th>$(vSales2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>350</td>
<td>1560</td>
</tr>
<tr>
<td>B</td>
<td>470</td>
<td>1560</td>
</tr>
<tr>
<td>C</td>
<td>740</td>
<td>1560</td>
</tr>
</tbody>
</table>

As you can see, $(vSales) results in the partial sum for a dimension value, while $(vSales2) results in the total sum.

**See also:**

*Working with the expression editor (page 87)*

**Searching in the assets**

The search field at the top of the assets panel helps you find assets on the different tabs. As you start to type in the search field, all items that have a name or a tag that contains the search string, are presented.

> The search function is not case sensitive.
When a matching string is found in a tag, it is indicated by a tag icon in the search result. Clicking the item in the list of results, brings up a preview of it.

*Searching for ”inv” among the measures presents any measure that contains that string in its name or a tag.*

---

### Designing visualizations with Direct Discovery

Designing visualizations from Direct Discovery fields requires some background knowledge about the nature of the field types that can be used.

#### Direct Discovery fields in visualizations

**DIMENSION**
- The Direct Discovery DIMENSION field type can be used in the same way as any other dimension.

**MEASURE**
- A Direct Discovery MEASURE must be aggregated with one of the common functions before it can be used in a visualization.
Creating visualizations

- A regular field that is dropped onto a sheet becomes a filter pane, but not a Direct Discovery MEASURE as it must be aggregated first.

DETAIL

The Direct Discovery DETAIL field type can only be used in tables, and not in combination with a measure.

**When creating a table using a Direct Discovery DETAIL field, and the number of rows being retrieved exceeds a value defined in the load script (by default, 1000 rows), you may see a warning message and the table may appear to be invalid. To make the table work normally, try making selections in the app to reduce the data set.**

**This functionality is not available in all editions of Qlik Sense.**

3.5 When to use what type of visualization

A good visualization clearly presents relationships among many values, and lets you analyze data at a glance. Qlik Sense offers a range of visualizations and charts. Each chart excels at visualizing data in different ways for different purposes. You should select your charts by deciding what you want to see from the data in your charts.

If you are unsure of what visualizations to use, Qlik Sense can offer recommendations. For more information, see *Creating visualizations using chart suggestions (page 295)*.

The following lists the purposes for viewing data and the chart type recommended to achieve that purpose:

### Viewing comparisons

Comparison charts are used to compare values against each other. They show the differences in values, such as the difference between categories, or how values are changing over time.

Questions that might be answered by comparison charts include:

- What product has the highest total sales this year?
- How have product sales risen or fallen over the last 24 months?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart (page 107)</td>
<td>Comparing categories against the same measure or measures.</td>
</tr>
<tr>
<td>Line chart (page 170)</td>
<td>Comparing trends over time.</td>
</tr>
<tr>
<td>Combo chart (page 130)</td>
<td>Comparing measures that are different in scale.</td>
</tr>
</tbody>
</table>

If you want to compare different values of the same dimension, you can use alternate states.
Viewing relationships

Relationship charts are used to explore how values relate to each other. A relationship chart allows you to find correlations, outliers, and clusters of data.

Questions that might be answered by relationship charts include:

- Is there a correlation between advertising spending and sales for our products?
- How do expenses and income vary per region?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scatter plot (page 242)</td>
<td>Viewing the relationship between two or three measures for a dimension.</td>
</tr>
</tbody>
</table>

Viewing compositions

Composition charts take a total value and discover what component values make up that total. Composition charts can be static, showing the current composition of a total value, or they can show how the composition of a total value changes over time. Composition charts can display compositions either by percentage of the total value or the fixed values in the total value.

Questions that might be answered by composition charts include:

- What percentages of our total sales come from which regions?
- What is each department's allotment of our total quarterly budget over the past year?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart (page 107)</td>
<td>Viewing the changing composition of a value over a short period of time.</td>
</tr>
<tr>
<td>Line chart (page 170)</td>
<td>Viewing the changing composition of a value over a long period of time.</td>
</tr>
<tr>
<td>Pie chart (page 218)</td>
<td>Viewing the static composition of a value.</td>
</tr>
<tr>
<td>Waterfall chart (page 276)</td>
<td>Viewing the static composition of a value with accumulation or subtraction to the total.</td>
</tr>
<tr>
<td>Treemap (page 268)</td>
<td>Viewing the static composition of a value's accumulation to the total.</td>
</tr>
</tbody>
</table>

Viewing distributions

Distribution charts are used to explore how the values within data are grouped. Distribution charts show you the shape of your data, the range of its values, and possible outliers.

Questions that might be answered by distribution charts include:

- What is the number of customers per age group?
- What cities have the highest use of our services?
Chart types for viewing distributions

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Histogram (page 160)</em></td>
<td>Viewing the how data is distributed over intervals.</td>
</tr>
<tr>
<td><em>Scatter plot (page 242)</em></td>
<td>Viewing the distribution of two measures.</td>
</tr>
<tr>
<td><em>Distribution plot (page 140)</em></td>
<td>Viewing the distribution of measure values in a dimension.</td>
</tr>
<tr>
<td><em>Box plot (page 121)</em></td>
<td>Viewing the range and distribution of numerical data.</td>
</tr>
</tbody>
</table>

**Viewing performances**

Performance charts provide a quick view of a performance measure. Looking at a performance chart, a user can quickly identify the measure value and whether the results are as expected or not.

Questions that might be answered by performance charts include:

- What are is the current total sales for this quarter?
- Are current total sales for this quarter meeting the projected sales for the quarter?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Gauge (page 155)</em></td>
<td>Viewing a performance value to understand performance immediately.</td>
</tr>
<tr>
<td><em>KPI (page 165)</em></td>
<td>Viewing one or two performance measures.</td>
</tr>
<tr>
<td><em>Text &amp; image (page 263)</em></td>
<td>Viewing text or several measures with an image.</td>
</tr>
</tbody>
</table>

**Viewing data**

Data charts present detailed data rather than a visualization of the data. Data charts are useful when you need to view precise values, and when you want to compare individual values.

Questions that might be answered by data charts include:

- What are the records for each transaction for this month?
- What are the quantity and sales for each item in each product group for each of our customers?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Table (page 252)</em></td>
<td>Viewing precise values from your data without trends or patterns.</td>
</tr>
<tr>
<td><em>Pivot table (page 228)</em></td>
<td>Viewing precise value for several dimensions and measures.</td>
</tr>
</tbody>
</table>

**Viewing geography**

Geographical charts let you visualize your data by geography, displaying your data on a map either as points or areas.

Common questions that might be answered by geographical charts include:
What cities have the highest use of our services?
Which countries have the most customers?

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Common purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maps (page 179)</td>
<td>Viewing data represented geographically by point or area.</td>
</tr>
</tbody>
</table>

What if no standard chart suits my purpose?

You can use visualization extensions from an extension bundle supplied by Qlik:

- Qlik Sense Dashboard bundle is a set of visualization extensions that you can use to enhance navigation and selection in your Qlik Sense app. The extensions are optional. You do not have to install or enable them to use Qlik Sense. (page 308)

You can also create custom visualization objects if none of the standard charts provided fit your requirements for visualizing your data.

For more information, see Creating a visualization using a custom object (page 305).

3.6 Visualizations

You can use visualizations to present the data that is loaded into the app. For example, you can use a bar chart to compare sales numbers for different regions, or use a table to show precise values for the same data.

The selections you make in a visualization are reflected in all associated visualizations on all sheets.

Creating a visualization

You create visualizations from pre-defined charts or custom objects. You must be in Edit mode to be able to add a visualization to the sheet.

1. Drag the visualization from the assets panel onto the sheet, or double-click the visualization.
2. Add dimensions and measures to the visualization. The number of dimensions and measures that are required depends on which visualization you selected. Dimensions determine how the data in a visualization is grouped - for example total sales per country or number of products per supplier. For more information, see Dimensions (page 58). Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as Sum or Max, combined with one or several fields. For more information, see Measures (page 61).
3. Adjust the presentation, for example sorting, coloring, or labeling.

You can convert from one visualization type to another by dragging a new chart to a visualization on a sheet.

For other methods of creating a visualization, see Creating and editing visualizations (page 287).
3 Creating visualizations

Reusing a visualization
If you have created a visualization that you want to reuse in other sheets of the app, you can save it as a master visualization. You can only create master visualizations in an unpublished app. When the app is published, all users can add the visualization to their own sheets, but not modify it.

Right-click on a visualization and select Add to master items to save it as a master visualization.

You can find master visualizations under in the assets panel.

Which visualizations are available?
There are two basic types of visualizations available in the assets panel.

- Charts illustrate the data with visual elements like bars, lines, or points.
- Text-based visualizations present data in text form, for example, tables or filters.

The best choice of chart type depends on the purpose of the visualization.

If the pre-defined visualizations does not fill your purpose, you can use a visualization extension or a widget. You find them in the assets panel under .

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>![Bar chart icon]</td>
<td>The bar chart displays a bar for each dimension value. The bar length corresponds to its numerical measure value.</td>
</tr>
<tr>
<td>Box plot</td>
<td>![Box plot icon]</td>
<td>The box plot is suitable for comparing range and distribution for groups of numerical data, illustrated by a box with whiskers, and a center line in the middle.</td>
</tr>
<tr>
<td>Combo chart</td>
<td>![Combo chart icon]</td>
<td>The combo chart combines bars and lines in the same chart. The bars and lines have different axes to enable comparing percentages and sums.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>![Distribution plot icon]</td>
<td>The distribution plot is suitable for comparing range and distribution for groups of numerical data. Data is plotted as value points along an axis.</td>
</tr>
<tr>
<td>Gauge</td>
<td>![Gauge icon]</td>
<td>The gauge is used to display the value of a single measure, lacking dimensions.</td>
</tr>
<tr>
<td>Histogram</td>
<td>![Histogram icon]</td>
<td>The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period. The data is divided into bins.</td>
</tr>
</tbody>
</table>
### Chart Icon Description

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line chart</td>
<td>📈</td>
<td>The line chart displays data lines between values. Line charts are often used to visualize a trend in data over intervals of time.</td>
</tr>
<tr>
<td>Map</td>
<td>🗺</td>
<td>The map is used to combine geospatial data and measure values, such as the sales for a region or a store.</td>
</tr>
<tr>
<td>Pie chart</td>
<td>🥧</td>
<td>The pie chart shows the relation between a single dimension and a single measure.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>⬤ ⬥</td>
<td>The scatter plot presents values from two measures. This is useful when you want to show data where each instance has two numbers, for example, country (population and population growth). An optional third measure can be used and is then reflected in the size of the bubbles. When showing large data sets colors will be used instead of bubble size to represent the measure size.</td>
</tr>
<tr>
<td>Treemap</td>
<td>🌲</td>
<td>The treemap shows hierarchical data. A treemap can show a large number of values simultaneously within a limited space.</td>
</tr>
<tr>
<td>Waterfall chart</td>
<td>⬣</td>
<td>The waterfall chart illustrates how an initial value is affected by intermediate positive and negative values.</td>
</tr>
</tbody>
</table>

### Text-based visualizations

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter pane</td>
<td>⌁</td>
<td>The filter pane allows you to control what data that is shown in the visualizations on a sheet. A filter pane can filter the data of several dimensions at once.</td>
</tr>
<tr>
<td>KPI</td>
<td>#1</td>
<td>The KPI is used to present central performance figures. You can add a link to a sheet.</td>
</tr>
<tr>
<td>Pivot table</td>
<td>📊</td>
<td>The pivot table presents dimensions and measures as rows and columns of a table. The pivot table allows you to analyze data in multiple dimensions at a time. The data in a pivot table may be grouped based on a combination of the dimensions, and partial sums can be shown.</td>
</tr>
<tr>
<td>Table</td>
<td>📊</td>
<td>The table displays values in record form, so that each row of the table contains fields calculated using measures. Typically, a table includes one dimension and multiple measures.</td>
</tr>
</tbody>
</table>
3 Creating visualizations

<table>
<thead>
<tr>
<th>Chart</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text &amp; image</td>
<td>A</td>
<td>You can use the text &amp; image visualization to add text, images, measures and links to a webpage.</td>
</tr>
</tbody>
</table>

**Bar chart**

The bar chart is suitable for comparing multiple values. The dimension axis shows the category items that are compared, and the measure axis shows the value for each category item. In the image, the dimension values are different regions: Nordic, USA, Japan, UK, Spain, and Germany. Each region represents a dimension value, and has a corresponding bar. The bar height corresponds to the measure value (sales) for the different regions.

You can make more complex comparisons of data by using grouped or stacked bars. This requires using two dimensions and one measure. The two example charts use the same two dimensions and the same measure:

- **Grouped bars:** With grouped bars, you can easily compare two or more items in the same categorical group.
3 Creating visualizations

Stacked bars: With stacked bars it is easier to compare the total quantity between different months. Stacked bars combine bars of different groups on top of each other and the total height of the resulting bar represents the combined result.

The bar chart can be displayed horizontally or vertically, as in the example below:
When to use it

Grouping and stacking bars makes it easy to visualize grouped data. The bar chart is also useful when you want to compare values side by side, for example sales compared to forecast for different years, and when the measures (in this case sales and forecast) are calculated using the same unit.

Advantages: The bar chart is easy to read and understand. You get a good overview of values when using bar charts.

Disadvantages: The bar chart does not work so well with many dimension values due to the limitation of the axis length. If the dimensions do not fit, you can scroll using the scroll bar, but then you might not get the full picture.

Creating a bar chart

You can create a simple bar chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty bar chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

In a bar chart you need at least one measure.

You can include up to two dimensions and one measure, or one dimension and up to 15 measures in a bar chart. Each bar corresponds to a dimension, and the values of the measures determine the height or length of the bars.

You can also create a bar chart with no dimension and up to 15 measures. In this case, one bar is displayed for every measure. The value of the measure determines the height or length of a bar.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple bar chart with one bar for each dimension value.</td>
</tr>
</tbody>
</table>
### Creating visualizations

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A grouped or a stacked bar chart with one bar for each value of the two dimensions.</td>
</tr>
<tr>
<td>No dimension</td>
<td>up to 15 measures</td>
<td>A simple bar chart with one bar for each measure.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 15 measures</td>
<td>A grouped or a stacked bar chart with one bar for each value of each measure.</td>
</tr>
</tbody>
</table>

When you have created the bar chart, you may want to adjust its appearance.

#### Display limitations

#### Displaying large numbers of dimension values

When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed. You can scroll by using the scroll bar in the mini chart, or, depending on your device, by using the scroll wheel or by swiping with two fingers. When a large number of values are used, the mini chart no longer displays all the values. Instead, a condensed version of the mini chart (with the items in gray) displays an overview of the values, but the very low and the very high values are still visible.

You can exchange the mini chart with a regular scrollbar, or hide it, with the **Scrollbar** property.

#### Displaying out of range values

In the properties panel, under **Appearance**, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut diagonally to show that it is out of range.
When a reference line is out of range, an arrow is displayed together with the number of reference lines that are out of range.

Displaying large amounts of data in a stacked bar chart

When displaying large amounts of data in a stacked bar chart, there may be cases when not each dimension value within a bar is displayed with correct color and size. These remaining values will instead be displayed as a gray, striped area. The size and total value of the bar will still be correct, but not all dimension values in the bar will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties panel.

The approximate limit for how many stacked bars that can be displayed without gray areas is 5000 bars, assuming that each bar consists of 10 inner dimension values and one dimension value and one measure value for the whole bar.

The initial data load is 500 dimension values or dimension stacks. (The value 500 refers to the outer dimension values, not each dimension value in a stack.) When you have scrolled past those 500 values, an incremental load is performed, where values are instead loaded based on the current view or scroll position.

Comparing categories against a measure with a bar chart

This example shows how to make a bar chart to visualize sales data and how to compare different product groups against the same measure.

Dataset

In this example, we’ll use two data files available in the Qlik Sense Tutorial - Building an App. Download and expand the tutorial, and the files are available in the Tutorials source folder:
• Sales.xls
• Item master.xls

To download the files, go to Tutorial - Building an App.

Add the two data files to an empty app, and make sure that they are associated by Item Number.

The dataset that is loaded contains sales data. The Item master table holds the information about the items ordered, such as product groups.

Measure

We use the sales volume as the measure, by creating a measure in Master items with the name Sales, and the expression `sum(Sales)`.

Visualization

We add a bar chart to the sheet and set the following data properties:

- **Dimension**: Product Group (product group).
- **Measure**: Sales; the measure that was created as a master item.

The following bar chart is created, with a bar showing the sales for each product group:

![Bar Chart](image)

But we want to have some more detailed information about the product sales, by adding the Product Sub Group as a dimension. The Product Sub Group field divides the product groups into sub groups. By default, a grouped chart is selected when adding the second dimension. We want to display a stacked chart instead, that is changed under **Appearances** in the properties panel.
**Discovery**

The bar chart visualizes the sales volume of different product groups, divided into product subgroups. The visualization is sorted in order of sales volume per product. You can hover the mouse pointer over a product subgroup and view the details.

In the bar chart we can see that Produce has the highest sales volume. One of the sub products contribute to most of the Produce sales, if we hover over that part of the bar we can see it is Fresh Vegetables.

**Bar chart properties**

You open the properties panel for a visualization by clicking **Edit** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **Edit** in the lower right-hand corner to open it.

*If the visualization has a lock icon in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*

*Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.*

**Data**

Click **Add** to add a dimension or a measure.
3 Creating visualizations

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click fx to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[ \text{If (Week < 14, Week, 'Sales')} \]

If Add is missing, you cannot add more dimensions.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, long-touch/right-click the dimension and select in the dialog.
  Alternatively, click the dimension and click .

  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click fx to open the expression editor.

  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.

  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).

  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:

    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click fx to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click fx to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click fx to open the expression editor.
    - **Calculated on measure**: <measure>: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

    - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
3 Creating visualizations

- **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\text{fx}$ to open the expression editor.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

**Measures**

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\text{fx}$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is missing, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select $\text{Trashcan}$ in the dialog. Alternatively, click the measure and click $\text{Trashcan}$.

  - **Expression**: Click $\text{fx}$ to open the expression editor. The existing expression is displayed by default.
  
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.
3 Creating visualizations

Examples:

- `##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.00` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  
  **Limitations**: Only works with visualizations that accept measures. Cannot be used with a box plot. Does not affect the number formatting of the axis.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡ ) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Each of the dimensions and measures can also be sorted internally:
Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

Add-ons

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)`<3. If the condition is not fulfilled, the message or expression entered in Displayed message is displayed.
  - A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.
  - **Reference lines**: Add reference line: Click to add a new reference line.
    - **Show**: When selected, the reference line is displayed.
    - **Label**: Enter a label for the reference line.
    - **Color**: In the color picker, select the color of the reference line and the label.
    - **Reference line expression**: Enter a value or an expression for the reference line. Click $\mathcal{F}$ to open the expression editor.
    - $\mathcal{F}$: Click to remove the reference line.

Appearance

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  - Click $\mathcal{F}$ if you want to create an expression by using the expression editor.
Example:

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - <inherited>, in which case the state defined for the sheet is used.
  - <default state>, which represents the state where no alternate state is applied.

Presentation

When you have at least two dimensions or two measures, you can present the dimensions or measures grouped together or stacked on top of each other.

Select vertical or horizontal orientation of the visualization.

- **Scroll alignment**: Set the position of the chart scrollbar. By default the scroll alignment is set to Start.
- **Scrollbar**: Set the type of scrollbar to display. There are three settings:
  - **Mini chart**: Show a miniature of the chart.
  - **Bar**: Show a regular scrollbar.
  - **None**: There is no scrollbar, but you can still scroll in the visualization.
- **Grid line spacing**: Select the spacing of the grid lines. The Auto setting is Medium.
- **Value labels**: Set Value labels: By default, Off. With the Auto setting, the value labels are displayed when there is enough space.
  You can select to show Segment labels, Total labels, or both.

You can change the styling of the bars by clicking on Styling.

- **Outline width**: Select if the bars should have an outline, and what the width of the outline should be. Default setting is None.
- **Outline color**: In the color picker, select the color of the outline. This option is not available if Outline width is set to None.
- **Bar width**: Set the bar width. This option is not available when using a continuous axis.
- **Reset all**: Resets all style editor properties to their default values.
Colors and legends

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
  - **Multicolored**: Option when more than one measure is used.
    By default, 12 colors are used for the measures. The colors are reused when there are more than 12 measures values.
    When selected, the following settings are available:
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
    - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
  - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
    - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
    - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
    - **Persistent colors**: Select to have colors remain the same between selection states.
    - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
  - **By measure**:
    - **Select measure**: Select the measure to use to color your chart.
    - **Library colors**: Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has a color assigned to it.
    - **Label**: Enter text or an expression for the measure that displays in the legend.
• **Color scheme:** Select a color scheme from the following options:
  - **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
  - **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
  - **Diverging gradient:** Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
  - **Diverging classes:** Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
  - **Reverse colors:** When selected, the color scheme is reversed.
  - **Range:** Define the range of values used to color by measure or by expression.
    - **Auto:** The color range is set by the measure or expression values.
    - **Custom:** When custom is selected, you can set the Min and Max values for the color range.
  - **By expression:** Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
    - **Expression:** Enter the expression that you want to use. Click \( \text{fix} \) to open the expression editor.
    - **The expression is a color code:** Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see *Coloring a visualization* (page 387)
    - When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
  - **Show legend:** Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
  - **Legend position:** Select where to display the legend.
  - **Show legend title:** When selected, the legend title is displayed.

**X-axis**

- **<Dimension>**
  - **Continuous:** Set to **Custom** to be able to show a continuous axis by selecting **Use continuous scale**. **Use continuous scale** is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
Creating visualizations

- **Show mini chart**: You can select if you want to display the mini chart below the chart. This option is only available when you use a continuous scale.
- **Labels and title**: Select what to display of labels and title.
- **Label orientation**: Select how to display the labels.
- **Position**: Select where to display the dimension axis.
- **Number of bars**: Set the upper limit to the number of visible bars.
  - **Auto**: The number of visible bars is determined by the number of dimensions and measures used.
  - **Max**: The number of visible bars is set to maximum.
  - **Custom**: When custom is selected, you can directly set the upper limit to the number of visible bars using **Maximum number**, or by entering an expression. Click \( \text{\( f \)} \) to open the expression editor.

**Y-axis**

- **<Measure>**
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the measure axis.
  - **Scale**: Set the spacing of the measure axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

**Box plot**

The box plot is suitable for comparing range and distribution for groups of numerical data, illustrated by a box with whiskers, and a center line in the middle. The whiskers represent high and low reference values for excluding outlier values. You can define the box start and end points, and whiskers ranges with a few different presets, or define your own settings using expressions.

![Box plot diagram](image)

1. First whisker
2. Box start
3. Center line
4. Box end
5. Last whisker

You can hover over a box to display a popup showing the respective values of the box plot elements.
Creating visualizations

When to use it

The box plot is suitable for comparing range and distribution for groups of numerical data.

Advantages: The box plot organizes large amounts of data, and visualizes outlier values.

Disadvantages: The box plot is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a box plot

You can create a box plot on the sheet you are editing.

In a box plot you need to use one or two dimensions, and one measure. If you use a single dimension you will receive a single box visualization. If you use two dimensions, you will get one box for each value of the second, or outer, dimension.

! You cannot use calculated dimensions in a box plot.

Do the following:

1. From the assets panel, drag an empty box plot to the sheet.
2. Add the first dimension. This is the inner dimension, which defines a box.
3. Add a second dimension. This is the outer dimension, which defines the boxes shown on the dimension axis.
4. Click Add measure and create a measure from a field. The measure does not have to contain an aggregation.

When you have created the box plot, you may want to adjust its appearance and other settings in the properties panel. By default, the Standard (Tukey) preset is used.

Changing the definition of the box plot

You can use one of the three presets, found under Box plot elements in the properties panel, to define your box plot.

- **Standard (Tukey)**
  This preset is based on the original box plot definition by J. Tukey. The center line represents the median (second quartile), and the box start and end points represent the first and third quartiles. Whisker length can be set to 1, 1.5 or 2 inter-quartile ranges. An inter-quartile range represents the difference between the first and third quartiles.

- **Percentile-based**
  This preset is also defined with the box start and end points representing the first and third quartiles, and the center line representing the median, but the whisker length is adjusted by setting a percentile based whisker position.

- **Standard deviation**
This preset is based on standard deviations, with the center line representing the average value, and the box start and end points representing one standard deviation variance. You can set the whisker length to a multiple of standard deviations.

You can also define a custom box plot where you set the value of each box plot element using an expression.

Visualizing range and distribution of numerical data with a box plot

This example shows how to make a box plot to visualize range and distribution of numerical data using daily temperature measurements from Qlik DataMarket.

Dataset

In this example, we'll use weather data loaded from the Weather for more than 2500 cities worldwide data source in Qlik DataMarket. The dataset is based on the following selections in Qlik DataMarket:

- Location: Sweden > Gällivare Airport, Kiruna Airport, Kramfors Sollefteå Airport, Luleå Airport, Ostersund Froson, Skellefteå Airport, Umeå Airport, Örnsköldsvik Airport
- Date: All time
- Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a number of weather stations in the north of Sweden during the time period of 2010 to 2017.

Measure

We use the average temperature measurement in the dataset as the measure, by creating a .measure in Master items with the name Temperature degrees Celsius, and the expression \( \text{Avg}([\text{Average of the 24 hourly temperature observations in degrees Celsius}]) \).

Visualization

We add a box plot to the sheet and set the following data properties:

- **Dimension**: Date (date) and Year (year). The order is important; Date needs to be the first dimension.
- **Measure**: Temperature degrees Celsius; the measure that was created as a master item.

In this example we use the default box plot preset, **Standard (Tukey)** with the whisker length **1.5 interquartile range**.
Discovery

The box plot visualizes the distribution of the daily temperature measurements. The visualization is sorted in mean temperature order. The mean temperature for each year is illustrated by the middle line in each box. The box stretches from the first quartile to the third quartile, and the whiskers stretch 1.5 inter-quartile ranges. There are also a number of outlier values, the points that are placed outside the whiskers. You can hover the mouse pointer over an outlier point and view the details.

In the box plot we can see that the year 2010 has the longest box and whiskers. That shows that the year 2010 has the largest distribution of temperatures measured. It also seems to be the coldest year in average.

The range of 2017 is small, as the dataset only contains measurements from the first months of the year.

Box plot properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.
3  Creating visualizations

Data
Click Add to add a dimension or a measure.

Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click \( \mathcal{F} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

\[ \text{If} \ (\text{Week} < 14, \ \text{Week}, \ 'Sales') \]

If Add is dimmed, you cannot add more dimensions.

It is not possible to put limitations on the inner dimension of a box plot.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, long-touch/right-click the dimension and select \( \mathcal{H} \) in the dialog. Alternatively, click the dimension and click \( \mathcal{H} \).
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click \( \mathcal{F} \) to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).

You can also click \( \mathcal{F} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You cannot use calculated dimensions in a box plot.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (\( \equiv \)) to rearrange the order.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions
removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click **fx** to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, long-touch/right-click the measure and select **editar** in the dialog.
  
  Alternatively, click the measure and click **editar**.

  - **Expression**: Click **fx** to open the expression editor. The existing expression is displayed by default.
  
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
    
    To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- `##0` describes the number as an integer with a thousands separator. In this example `,` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example,
number 123 will be shown as 0123.

- 0.000 describes the number with three decimals. In this example "," is used as a
decimal separator.
  
  If you add the percent sign (%) to the format pattern, the measure values are
automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the
  operating system. Use the **Format pattern** box to change the format pattern.

- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from
  the options in the drop-down list. Click the button to change to **Custom** formatting, and
  use the **Format pattern** box to change the format pattern.

- **Duration:** By default, the format pattern used for duration is the same as set up in the
  operating system. Duration can be formatted as days, or as a combination of days, hours,
  minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the
  format pattern.

- **Custom:** By default, the format pattern used for custom is the same as set up in the
  operating system. Use the **Format pattern** boxes to change the format pattern.
    
    - **Decimal separator:** Set the decimal separator.
    - **Thousands separator:** Set the thousands separator.
    - **Format pattern:** Set the number format pattern.
    - **Reset pattern:** Click to reset to default pattern.

- **Measure expression:** The format pattern is determined by the measure expression. Use
  this option to display custom number formatting for a measure in a visualization.

  Limitations:
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Bars/Line/Marker:** You can choose to add a measure as bars, as a line, or as markers.
  For lines and markers, you can use the **Primary axis** to the left or the **Secondary axis** to the
  right.
  For markers you can choose between several different shapes.

- **Fill marker:** Select to display markers filled.

- **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to
  a visualization, but are not displayed until a user chooses to switch which dimensions and measures are
  being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars
(//=) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures**
assigns it an aggregation. You cannot drag a master dimension to **Measures**.
Box plot elements

- **<Use presets>:** If you set this to On you can select one of the available presets that define the elements of the box plot: **Standard (Tukey), Percentile-based** or **Standard deviation**. If you set to Off you need to define all elements using custom expressions.
  
  - **Standard (Tukey):** This preset is based on the original box plot definition by J. Tukey. The center line represents the median (second quartile), and the box start and end points represent the first and third quartiles. You can set the length of the whiskers with **Whisker length:** 1 inter-quartile range, 1.5 inter-quartile range or 2 inter-quartile ranges. 1 inter-quartile range represents the length of the box, that is, the difference between the first and third quartiles.
  
  - **Percentile-based:** This preset is also defined with the box start and end points representing the first and third quartiles, and the center line representing the median, but the whisker length is adjusted by setting a percentile based **Whisker position:** Min/max. This setting sets the whisker start and end points to the minimum and maximum values: 1st/99th percentile, 5th/95th percentile or 10th/90th percentile.
  
  - **Standard deviation:** This preset is based on standard deviations, with the center line representing the average value, and the box start and end points representing one standard deviation variance. You can set the whisker length to a multiple of standard deviations: One standard deviation, Two standard deviations or Three standard deviations.
  
  - **Include outliers:** You can select to display outlier values, that is, values on either side of the whiskers.
  
  - Custom boxplot element settings: If you set Use presets to Off you can define all elements using a custom expression and label. Expressions are prefilled with the expressions used to define the elements in the most recently used preset. **Center line: Name and Expression**  
    - **Box edges:** Box start name, Box start expression, Box end name or Box end expression  
    - **Whiskers:** First whisker name, First whisker expression, Last whisker name or Last whisker expression

**Sorting**

If you set Sorting to Custom, you can sort the box plot by a custom expression, or by the second dimension of the chart in numerical or alphabetical order. The sorting is either Ascending or Descending.

- **Sort by expression:** Select which element to sort by (First whisker, Box start, Center line, Box end or Last whisker).

- **Sort numerically:** Enable this to sort numerically by the second dimension of the chart. If you change the second dimension, the chart will be sorted by the new dimension.

- **Sort alphabetically:** Enable this to sort alphabetically by the second dimension of the chart. If you change the second dimension, the chart will be sorted by the new dimension.

You can also customize the sort expression. Do the following:
1. Click \( \mathcal{O} \) to unlink the sort expression.
2. Edit the sort expression.

You can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

- **Data handling:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: \( \text{count}(\text{distinct Team}) < 3 \). If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines:**
  - **Add reference line:** Click to add a new reference line.
  - **Show:** When selected, the reference line is displayed.
  - **Label:** Enter a label for the reference line.
  - **Color:** In the color picker, select the color of the reference line and the label.
  - **Reference line expression:** Enter a value or an expression for the reference line. Click \( \mathcal{E} \) to open the expression editor.
  - \( \mathcal{H} \): Click to remove the reference line.

**Appearance**

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart.

Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

Click \( \mathcal{E} \) if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & \( \text{Sum}(\text{Sales}) \).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & \( \text{Sum}(\text{Sales}) \)), the string is interpreted as an expression instead. The output is then \( \text{Sales: <value of expression>} \), where \(<\text{value of expression}>\) is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation

You can set the orientation to be **Vertical** or **Horizontal**.

- **Show whisker ticks**: Enable this to display vertical lines at the end of each whisker.
- **Gridline spacing**: Set this to **Custom** if you want to customize the horizontal gridlines. You can choose between: **No lines**, **Medium**, and **Narrow**.

Colors

- **Colors**: You only need to select **Custom** if you want to change the settings. The **Auto** settings are based on the visualization used and the number of dimensions and measures, that is, the settings are not fixed, but are dependent on the data input.
  - **Single color**: A single color (by default blue) is used for all items in the chart. In visualizations that do not benefit from multiple colors (bar charts with one dimension and scatter plots), single color is the default setting. Use the color picker to change the dimension color.
  - **By expression**: You can use coloring by expression to accentuate certain values. Supported formats: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click **fx** to open the expression editor.

X-axis

- `<Measure>`
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the measure axis.

Y-axis

- `<Dimension>`
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the dimension axis.
  - **Scale**: Set the spacing of the dimension axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

Combo chart

The combo chart is suitable for comparing two sets of measure values that are usually hard to compare because of the differences in scale. A typical example is when you have a bar chart with sales figures and want to combine these figures with the margin values (in percent). In a regular bar chart, the bars for sales would be
displayed as usual, but the margin values would be almost invisible because of the very large difference between the numeric values for sales and margin.

*A combo chart with the margin values (in percent) and bars with sales figures.*

With a combo chart you can combine these values by, for example, using bars for the sales values and a line for the margin values. By default, the bars have the measure axis on the left and the margin values have a separate axis to the right. The two measures use the same dimension (YearMonth).

If you have yet another measure, for example, gross sales, with values that are roughly in the same range as the sales values, you can add the third measure as bars and either stack or group the new measure values with the sales values. With grouped bars, you can easily compare two or more items in the same categorical group. Stacked bars combine bars of different groups on top of each other and the total height of the resulting bar represents the combined result.

*A combo chart with three measures; the margin values (in percent), bars with sales figures and the measure Gross sales grouped with the sales values.*
The combo chart can only be displayed vertically.

**When to use it**

With the possibility to have different measure scales, one to the left and one to the right, the combo chart is ideal when you want to present measure values that are normally hard to combine because of the significant difference in value ranges.

But a combo chart can also be quite useful when comparing values of the same value range. In the image above, the combo chart only has one measure axis, but the relationship between the two categories sales and cost is clear.

**Advantages**
The combo chart is the best choice when combining several measures of different value ranges.

**Disadvantages**
The combo chart only supports one dimension, and can therefore not be used when you need to include two or more dimensions in the visualization.

**Creating a combo chart**

You can create a combo chart on the sheet you are editing. In a combo chart, you need at least one dimension and one measure.

Do the following:

1. From the assets panel, drag an empty combo chart to the sheet.
2. Click **Add dimension** and select a dimension or a field.
3 Creating visualizations

3. Click **Add measure** and select a measure or create a measure from a field. Select to show the measure as a bar.

4. Add another measure, selecting to show the measure as a line or a marker.

You can only have one dimension, but you can continue adding up to 15 measures. You can only have two measure axes though. This means, if you add three or more measures with a large difference in value range it can be hard to display all measures with a good distribution of values.

When you have created the combo chart, you may want to adjust its appearance and other settings in the properties panel.

**Display limitations**

**Displaying out of range values**

In the properties panel, under **Appearance**, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut diagonally to show that it is out of range. For a line data point value that is out of range, an arrow indicates the direction of the value.

**Combo chart properties**

You open the properties panel for a visualization by clicking **Edit** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **Add** in the lower right-hand corner to open it.

- **If the visualization has** in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- **Some of the settings in the properties panel are only available under certain circumstances, for example, when you use at least one line or when you have two measures.**

**Data**

Click **Add** to add a dimension or a measure.

**Dimensions**

On the **Data** tab, under **Dimensions**, click **Add** to open a list of available **Dimensions** and **Fields**. Select the dimension or field that you want to use.

You can also click **fx** to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:
If \( (\text{Week} < 14, \text{Week}, \text{’Sales’}) \)

If **Add** is dimmed, you cannot add more dimensions.

- **<Dimension name>:** Click the dimension name to open the dimension settings. If you want to delete the dimension, long-touch/right-click the dimension and select \( \square \) in the dialog. Alternatively, click the dimension and click \( \square \).
  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field:** If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click \( \checkmark \) to open the expression editor.
  - **Label:** Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Includenull values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation:** The default value.
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click \( \checkmark \) to open the expression editor.
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click \( \checkmark \) to open the expression editor.
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click \( \checkmark \) to open the expression editor.
    - **Calculated on measure:** \(<\text{measure}>\): Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
  - **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is **Others**. This option is not available in box plot dimensions.
  - **Other label:** Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click \( \checkmark \) to open the expression editor.
  - **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (\( \equiv \)) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions**
removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

### Measures

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click **fx** to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**: Click the measure to open the measure settings.
  - If you want to delete the measure, long-touch/right-click the measure and select **\[** in the dialog.
  - Alternatively, click the measure and click **\[**.

  - **Expression**: Click **fx** to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  - **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

  **Examples**:

  - `##0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
  - `###0` describes the number as an integer without a thousands separator.
  - `0000` describes the number as an integer with at least four digits. For example, the
3 Creating visualizations

number 123 will be shown as 0123.

- 0.000 describes the number with three decimals. In this example "," is used as a
decimal separator.
  If you add the percent sign (%) to the format pattern, the measure values are
automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the
  operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from
  the options in the drop-down list. Click the button to change to **Custom** formatting, and
  use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the
  operating system. Duration can be formatted as days, or as a combination of days, hours,
  minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the
  format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the
  operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use
  this option to display custom number formatting for a measure in a visualization.
  **Limitations:**
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Bars/Line/Marker**: You can choose to add a measure as bars, as a line, or as markers.
  For lines and markers, you can use the **Primary axis** to the left or the **Secondary axis** to the
  right.
  For markers you can choose between several different shapes.

- **Fill marker**: Select to display markers filled.
  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to
    a visualization, but are not displayed until a user chooses to switch which dimensions and measures are
    being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars
(Ξ) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures**
assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Each of the dimensions and measures can also be sorted internally:
Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

Add-ons

- **Data handling**:
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: \( \text{count(distinct Team)} < 3 \). If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.

**Appearance**

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

Click **fx** if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales). By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - **<inherited>**, in which case the state defined for the sheet is used.
  - **<default state>**, which represents the state where no alternate state is applied.

Presentation

When you have at least two dimensions or two measures, you can present the dimensions or measures grouped together or stacked on top of each other.

Select vertical or horizontal orientation of the visualization.

- **Scroll alignment**: Set the position of the chart scroll bar. By default the scroll alignment is set to **Start**.
- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is **Medium**.
- **Value labels**: By default, **Off**. With the **Auto** setting, the value labels are displayed when there is enough space.

> Value labels are available for ***Bars*** and ***Lines***, but they are not available for ***Marker***.

Colors and legends

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Color settings are based on the visualization used and the number of dimensions and measures, that is, the settings are not fixed, but are dependent on the data input.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: A single color (by default blue) is used for all items in the chart. In visualizations that do not benefit from multiple colors (bar charts with one dimension and scatter plots), single color is the default setting. Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
  - **Multicolored**: Option when more than one measure is used. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
3 Creating visualizations

- **Color scheme**: Select **12 colors** or **100 colors** to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
- **By dimension**: By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
  - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
  - **Persistent colors**: When selected, colors are persistent between selection states. Only available when using one dimension and the setting **By dimension** or **Multicolored**.
  - **Color scheme**: Select **12 colors** or **100 colors** to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
- **By measure**: By default, **Sequential gradient** is selected. The higher the measure value, the darker the color.
  - **Select measure**: Select the measure to use to color your chart.
  - **Library colors**: Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has a color assigned to it.
  - **Color scheme**: Select a color scheme from the following options:
    - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
    - **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
  - **Reverse colors**: When selected, the color scheme is reversed.
- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \( \mathbf{fx} \) to open the expression editor.
3 Creating visualizations

- **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see Coloring a visualization (page 387). When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

- **Range**: When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

- **Show legend**: Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.

- **Legend position**: Select where to display the legend.

- **Show legend title**: When selected, the legend title is displayed.

**X-axis**

- **<Dimension>
  - **Continuous**: Set to **Custom** to be able to show a continuous axis by selecting **Use continuous scale**. **Use continuous scale** is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
  - **Show mini chart**: You can select if you want to display the mini chart below the chart. This option is only available when you use a continuous scale.
  - **Labels and title**: Select what to display of labels and title.
  - **Label orientation**: Select how to display the labels.
  - **Position**: Select where to display the dimension axis.

**Y-axis**

- **<Measure>
  - **Labels and title**: Select what to display of labels and title.
  - **Position**: Select where to display the measure axis.
  - **Scale**: Set the spacing of the measure axis scale.
  - **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

**Distribution plot**

The distribution plot is suitable for comparing range and distribution for groups of numerical data. Data is plotted as value points along an axis. You can choose to display only the value points to see the distribution of values, a bounding box to see the range of values, or a combination of both as shown here:
When to use it
The distribution plot is suitable for comparing range and distribution for groups of numerical data.

Advantages
The distribution plot visualizes the distribution of data.

Disadvantages
The distribution plot is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a distribution plot
You can create a distribution plot on the sheet you are editing.

In a distribution plot you need to use one or two dimensions, and one measure. If you use a single dimension you will receive a single line visualization. If you use two dimensions, you will get one line for each value of the second, or outer, dimension.

Do the following:

1. From the assets panel, drag an empty distribution plot to the sheet.
2. Add the first dimension.
   This is the inner dimension, which defines the value points.
3. Add a second dimension.
   This is the outer dimension, which defines the groups of value points shown on the dimension axis.
4. Click Add measure and create a measure from a field.

Viewing the distribution of measure values in a dimension with a distribution plot (page 142)
When you have created the distribution plot, you may want to adjust its appearance and other settings in the properties panel.

Distribution plot properties (page 143)

Display limitations

Displaying large amounts of data in a distribution plot

When displaying large amounts of data in a distribution plot, the message "Currently showing a limited data set." is shown to indicate that not all data is displayed.

- If the chart uses more than one dimension, 3000 data points are displayed.

Viewing the distribution of measure values in a dimension with a distribution plot

This example shows how to make a distribution plot to view the distribution of measure values in a dimension, using weather data from Qlik DataMarket as an example.

Dataset

In this example, we’ll use weather data loaded from the Weather for more than 2500 cities worldwide data source in Qlik DataMarket. The dataset is based on the following selections in Qlik DataMarket:

- Location: Sweden > Gävle Airport
- Date: All time
- Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a weather station in the north of Sweden during the time period of 2010 to 2017.

Measure

We use the average temperature measurement in the dataset as the measure, by creating a .measure in Master items with the name Temperature degrees Celsius, and the expression \(\text{Avg}([\text{Average of the 24 hourly temperature observations in degrees Celsius}])\).

Visualization

We add a distribution plot to the sheet and set the following data properties:

- **Dimension**: Date (date) and Year (year). The order is important, Date needs to be the first dimension.
- **Measure**: Temperature degrees Celsius, the measure that was created as a master item.

Distribution plot with the dimensions Date (date) and Year (year) and the measure Temperature degrees Celsius.
Discovery
The distribution plot visualizes the distribution of the daily temperature measurements. The visualization is sorted by year, and each point represents a temperature measurement.

In the visualization we can see that the year 2012 has the lowest extreme temperature measurement, close -40 degrees Celsius. We can also see that the year 2016 seems to have the largest distribution of temperature measurements. With this many points in the distribution plot, it can be hard to spot clusters and outliers, but the year 2017 has two low temperature measurements that stand out. You can hover the mouse pointer over a point and view the details.

Distribution plot properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.
Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click $\text{fx}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

=If (Week < 14, Week, 'Sales')

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, long-touch/right-click the dimension and select $\text{fx}$ in the dialog.
  Alternatively, click the dimension and click $\text{fx}$.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click $\text{fx}$ to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (\text{-}).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.
    - **Calculated on measure**: <measure>: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
      This option is not available in box plot dimensions.
• **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathbf{f}x$ to open the expression editor.

• **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathbf{f}x$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

• **<Measure name>**: Click the measure to open the measure settings.
  
  If you want to delete the measure, right-click the measure and select $\mathbf{\overline{\mathbf{\text{e}}}}$ in the dialog. Alternatively, click the measure and click $\mathbf{\overline{\mathbf{x}}}$.

• **Expression**: Click $\mathbf{f}x$ to open the expression editor. The existing expression is displayed by default.

• **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.

• **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

• **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

• **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

• **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting,
and use the **Format pattern** box to change the format pattern.

**Examples:**

- `##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as `0123`.
- `0.00` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  
  - **Decimal separator:** Set the decimal separator.
  
  - **Thousands separator:** Set the thousands separator.
  
  - **Format pattern:** Set the number format pattern.
  
  - **Reset pattern:** Click to reset to default pattern.

- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  
  - Only works with visualizations that accept measures.
  
  - Cannot be used with a box plot.
  
  - Does not affect the number formatting of the axis.

- **Bars/Line/Marker:** You can choose to add a measure as bars, as a line, or as markers. For lines and markers, you can use the **Primary axis** to the left or the **Secondary axis** to the right. For markers you can choose between several different shapes.

- **Fill marker:** Select to display markers filled.

- **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.
You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (Ê) to rearrange the order.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

**Sorting**

You can sort the distribution plot by any of the distribution plot elements or a custom expression, or by the second dimension of the chart in numerical or alphabetical order.

Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Add-ons**

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: count(distinct Team)<3. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
    A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines**:
  - **Add reference line**: Click to add a new reference line.
  - **Show**: When selected, the reference line is displayed.
  - **Label**: Enter a label for the reference line.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
  - **Delete**: Click to remove the reference line.
3 Creating visualizations

Appearance

General

- **Show titles:** **On** by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click `fx` if you want to create an expression by using the expression editor.

Example:

Assume that the following string is used, including quotation marks: `Sales: ’ & Sum(Sales)`. By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=`Sales: ’ & Sum(Sales)`), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State:** Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation

You can set the orientation to be **Vertical** or **Horizontal**.

You can present the distribution plot in three ways:

- **Points and background** - this option displays a bounding box showing the range of the values, and value points.
- **Points only** - this option displays value points only.
- **Background only** - this option displays a bounding box showing the range of the values only.
- **Gridline spacing:** Set this to **Custom** if you want to customize the horizontal gridlines. You can choose between: **No lines**, **Medium** or **Narrow**.
- **Bubble size:** You can adjust the size of the bubbles that illustrate the value points.
- **Jitter points:** You can use this option to jitter several overlapping value points. This moves some of the points slightly to create a larger footprint that shows that there are more than one value behind the point.

Colors and legends

You can set the presentation colors of the distribution plot. You only need to select **Custom** if you want to change the settings.
3 Creating visualizations

**Custom:** Manually select the method of coloring your values in the chart. The following methods are available:

- **Single color:** A single color (by default blue) is used for all items in the chart.
- **By dimension:** By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  - **Persistent colors:** When selected, colors are persistent between selection states.
  - **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
- **By expression:** Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression:** Enter the expression that you want to use. Click $\mathbb{fx}$ to open the expression editor.
  - **The expression is a color code:** Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.
    For more information, see Coloring a visualization (page 387)
  - **Range:** When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option The expression is a color code must be cleared before you can set the color range.

- **Show legend:** Not available when Single color is selected. By default set to Auto. The legend is displayed if there is enough space. The placement can be changed in the Legend position setting.

- **Legend position:** Select where to display the legend.

- **Show legend title:** When selected, the legend title is displayed.

**X-axis**

- **<Measure>**
  - **Labels and title:** Select what to display of labels and title.
  - **Position:** Select where to display the measure axis.
  - **Scale:** Set the spacing of the measure axis scale.
  - **Range:** Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

**Y-axis**

- **<Dimension>**
  - **Labels and title:** Select what to display of labels and title.
  - **Position:** Select where to display the dimension axis.

**Filter pane**

You can add a filter pane to control what data that is shown in the visualizations on a sheet. A filter pane can filter the data of several dimensions at once. For example, if you have a chart of sales over time, you can use a filter pane to limit the data in the chart to only show sales from a selected time period, from certain product...
categories, and from a certain region.

When a dimension is added, it is placed to the right of the previous dimensions, or below, depending on the available space. As long as there is space enough, the dimensions are displayed as expanded lists. If there is not enough space, the dimensions that were added first are turned into filter panes.

*Selections have been made in the dimensions* Year, Quarter, and Week.

When to use it

With filter panes, you can easily make several selections to define your data set exactly like you want it. With your well-defined data set, you can explore data of particular interest.

By using the selection menu options in the filter panes (select possible, select alternative, and select excluded), you can make adjustments to the data set and compare the results with the previous selection.

Advantages

Filter panes are good for making selections and defining data sets. But they also show the relationship between different values, the associations. The green, white, and gray colors reflect the data associations that exist - and that do not exist. And by analyzing those associations, you can make new discoveries, for example, that a sales representative has too many customers, or that a region lacks a sales representative.

Disadvantages

When the dimensions contain a very large amount of values, it may be hard to manage the data.

Creating a filter pane

You can create a filter pane on the sheet you are editing.

In a filter pane you can use up to 1000 dimensions.

Do the following:

1. From the assets panel, drag an empty filter pane to the sheet.
2. Click Add dimension and select a dimension or a field.
3. If you want to add more dimensions, click Add dimension again.
Creating visualizations

When you have created the filter pane, you may want to adjust its appearance and other settings in the properties panel.

If you double-click or drag a field or a dimension from the assets panel, a filter pane is added to the sheet using the dimension. If you then double-click more dimensions, they are automatically added to the new filter pane.

Selections in filter panes

During analysis you click a compressed filter pane dimension to open a selection list.

When you make a selection, it is reflected in the small bars at the bottom of each filter pane dimension. Four states can be displayed in the bars: selected (green), possible (white), alternative (light gray), and excluded (dark gray). Locked values are indicated by a lock icon. The details of the selections are displayed in the selections bar, above the sheet. You can click an item to see the details and change your selection.

Fields are filtered out from each dimension to be shown in the visualizations on the sheet.

Making selections in filter pane lists

When there is space enough in a filter pane, the dimension values are displayed in a list. In lists, you can click to select a single value or draw to select several values. On a touch device, you can two-finger-tap in the list to select a range of values.

Germany, Japan and Nordic selected in the Region filter pane.
The selections tool

The selections tool offers an option to get an overview of the fields and dimensions in an app. In the selections tool you can make selections in all the fields and dimensions in the app, regardless of whether they are used in the app or not.

During analysis, click **Selections** to open selections view.

Display limitations

Responsive design

The filter pane has a responsive design and renders as many dimensions as possible. When space is limited, this could involve reducing the size of each dimension so that all dimensions are displayed.

**Example:**

The following image shows a filter pane while it is being edited. Only three out of five dimensions are displayed. The other dimensions are replaced by a button with an ellipsis (…), indicating that there are more dimensions that are not displayed. You can click the button to open the filter pane in full screen view.
When you have finished editing the filter pane and enter analysis mode, you will see the filter pane with all the dimensions displayed. If all items cannot be shown due to lack of space, the ellipsis box is displayed to indicate that there are more dimensions.

*Five dimensions are displayed when analyzing data.*

![Diagram showing filter pane with dimensions](image)

**Full screen view**

In full screen view, the filter pane is maximized and displays as many dimensions as possible expanded. When not all dimensions can be displayed expanded, the priority order is that the most recently added dimensions are expanded to the right. You can change the priority order in the properties panel, under **Dimensions**. Drag the dimensions to change the order.

**Filter pane properties**

You open the properties panel for a visualization by clicking 🖼 Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click ☐️ in the lower right-hand corner to open it.

*If the visualization has 🌟 in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*

**Data**

Click **Add** to add a dimension or create a dimension from a field. If the option is dimmed it is not available.

**Dimensions**

You can also click ✂️ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

`=If (Week < 14, Week, 'Sales')`
If Add is dimmed, you cannot add more dimensions.

The following properties are available for dimensions:

- `<Dimension name>`: Click the dimension name to open the dimension settings. If you want to delete the dimension, long-touch/right-click the dimension and select ⌘ in the dialog. Alternatively, click the dimension and click ⌘.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click ⚙ to open the expression editor.
  - **Title**: Enter a title for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

**Sorting**

By default, the dimensions are sorted in the order they were added, with the most recently added dimension last. For filter panes, you change the sorting order of the dimensions under Dimensions in the Data section. Drag the dimensions to change the order. Under Sorting you can change the internal sorting of the dimensions.

Each dimension is sorted internally in the most common way for that type of data. Numbers are sorted numerically, ascending. Text is sorted alphabetically, ascending. If you want to change the internal sorting of a dimension, click the sorting button. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by state**: Sorts by selected, possible, and excluded selection states.
- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort by frequency**: Only available for filter panes.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Appearance**

**General**

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter Title, Subtitle, and Footnote. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  
  Click ⚙ if you want to create an expression by using the expression editor.
Example:

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - <inherited>, in which case the state defined for the sheet is used.
  - <default state>, which represents the state where no alternate state is applied.

Gauge

The gauge is designed to show a single measure value and visualize how to interpret that value.

When to use it

The gauge is often used to present KPIs, for example, on an executive dashboard, and together with segmenting and color coding, it is an effective way of illustrating a performance result.

It is important to set relevant max and min values to support the interpretation of the value. You can use a reference line to provide additional context.

Advantages

A gauge is easy to read and understand and gives an instant indication of the performance within an area.
Creating visualizations

Disadvantages
The gauge is quite space-demanding in relation to the single value it visualizes.

Although visually compelling, the gauge is not always the best choice for presenting a single measure value. Problems when deciding the max and min values can indicate that some other visualization should be used.

If you only want to show a performance value, without a gauge, consider using a KPI instead.

Creating a gauge
You can create a gauge on the sheet you are editing. In a gauge you can only have one measure and no dimensions.

Do the following:
1. From the assets panel, drag an empty gauge to the sheet.
2. Click Add measure and select a measure or create a measure from a field.

When you have created the gauge, you may want to adjust its appearance and other settings in the properties panel.

The following settings are used by default in a gauge:
- A radial gauge.
- A single (blue) color.
- Range limits: min (0), max (100).
- No segments.
- Label and title are displayed in medium scale.

For example, you can change the radial gauge to a bar, and use a color gradient.

Display limitations
When a measure value is outside the range limits, an arrow indicates whether the measure value is higher or lower than the range values.

Gauge properties
You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.
3 Creating visualizations

If the properties panel is hidden, click ▶ in the lower right-hand corner to open it.

If the visualization has ⚜ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Measures

On the Data tab, under Measures, click Add measure to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathbf{\text{fx}}$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add measure is dimmed, you cannot add more measures.

The following properties are available for measures:

- **<Measure name>**:
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Expression**: Click $\mathbf{\text{fx}}$ to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
  
  To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
Examples:

- `##0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.00` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (`%`) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  
  **Limitations:**
  - Only works with visualizations that accept measures.
  - Does not affect the number formatting of the axis.

Add-ons

- **Data handling**: **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)`<3. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines**: **Add reference line**: Click to add a new reference line.
3 Creating visualizations

- **Show**: When selected, the reference line is displayed.
- **Label**: Enter a label for the reference line.
- **Color**: In the color picker, select the color of the reference line and the label.
- **Reference line expression**: Enter a value or an expression for the reference line. Click \( \mathbf{fx} \) to open the expression editor.
- \( \mathbf{\text{trash}} \): Click to remove the reference line.

Appearance

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click \( \mathbf{fx} \) if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: `<value of expression>`, where `<value of expression>` is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation

- **Range limits**
  - **Min**: Set the minimum value for the gauge. Click \( \mathbf{fx} \) if you want to create an expression.
  - **Max**: Set the maximum value for the gauge. Click \( \mathbf{fx} \) if you want to create an expression.
  - **Radial/Bar**: Select to display the gauge as a radial or as a bar. Select vertical or horizontal orientation of the visualization. Only available for bar gauges.
  - **Use segments**: When not selected, a single color (by default blue) is used to illustrate the value. When selected, you can divide the gauge into segments with different colors. When segments are used, a pointer marks the value.
Click **Add limit** to add a segment to the gauge. Use the slider or type an expression to set the limit. Click $$\text{\texttt{\textbf{fx}}}$$ to create an expression. You can add several segments. Click the segment to change colors.

- **Remove limit**: Click to remove the selected limit.
- **Gradient**: Select to use different shades of colors in the transition between the segments.
- **Use library**: Option when a master measure used in the visualization has a color assigned to it. You can select to use the master measure colors or to disable the master measure color. This option is not available if **Use segments** is enabled.

**Measure axis**
- **Labels and title**: Select what to display of labels and title.
- **Scale**: Set the spacing of the measure axis scale.

**Histogram**

The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period. The data is divided into bins, and each bar in a histogram represents the tabulated frequency at each bin.

![Histogram](image)

**When to use it**

The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or a certain time period.

**Advantages**

The histogram organizes large amounts of data, and produces a visualization quickly, using a single dimension.
Disadvantages
The histogram is not relevant for detailed analysis of the data as it deals with a summary of the data distribution.

Creating a histogram
You can create a histogram on the sheet you are editing. You can only apply a single dimension to a histogram. Histograms do not need a measure, as the frequency of the binned data is automatically calculated.

Do the following:
1. From the assets panel, drag an empty histogram to the sheet.
2. Add the dimension to calculate the frequency on.

When you have created the histogram, you may want to adjust its appearance and other settings in the properties panel.

Dimension limitations
There are some limitations to the dimension used in a histogram.

- The dimension must be a numerical field.
- You cannot use a master dimension that was created using the expression editor, even if the resulting field is numeric.
- The dimension cannot be based on an aggregation function.

Viewing the distribution of data over intervals with a histogram
This example shows how to make a histogram to the distribution of data over intervals, using weather data from Qlik DataMarket as an example.

Dataset
In this example, we'll use weather data loaded from the Weather for more than 2500 cities worldwide data source in Qlik DataMarket. The dataset is based on the following selections in Qlik DataMarket:

- Location: Sweden > Gällivare Airport
- Date: All time
- Measurement: Average of the 24 hourly temperature observations in degrees Celsius

The dataset that is loaded contains a daily average temperature measurement from a weather station in the north of Sweden during the time period of 2010 to 2017.

Visualization
We add a histogram to the sheet and add the field *Average of the 24 hourly temperature observations in degrees Celsius* as dimension.

The visualization creates a frequency measure automatically, and sorts the temperature measurements into a number of bars according to frequency distribution.
We can adjust the size of the bars to get even intervals, by setting Bars to Custom and Bar width (x-axis) with a width of 5. This adjusts the bars to be intervals of 5 degrees Celsius as shown below:

![Histogram of temperature measurements]

**Discovery**

The histogram visualizes the frequency distribution of the temperature measurements. You can hover the mouse over a bar to see more details of the frequency.

We can see that most days, the temperature is between -5 and 15 degrees Celsius. There are days below -30, but they are not many.

**Histogram properties**

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

- **If the visualization has** in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- **Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.**

**Data**

Click Add to add a field.
3 Creating visualizations

**Fields**

On the **Data** tab, under **Fields**, click **Add** to open a list of available **Fields**. Select the field that you want to use.

You can also click `fx` to create a field in the expression editor. Another way to create a field is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated field:

`=If (Week < 14, Week, 'Sales')`

If **Add** is dimmed, you cannot add more fields.

- **<Field name>**
  - **Field**: Click the field name to open the field settings.
    - If you want to delete the field, long-touch/right-click the field and select `>` in the dialog. Alternatively, click the field and click `>`.
    - **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click `fx` to open the expression editor.
    - **Label**: Enter a label for the field.
    - **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
    - **Add alternative**: Alternative fields are fields that are added to a visualization, but are not displayed until a user chooses to switch which fields are being displayed during visual exploration.

**Histogram settings**

- **Bars**: You can set **Bars** to **Auto** or **Custom**:
  - **Auto** divides the data into the optimal number of bars based on the current data selection. You do not need to make any other settings. The calculation is based on Sturje's formula.
  - **Custom** lets you define how to divide the data into bars.
- **Number of bars**: Set **Maximum number** to the number of bars you want to divide the data into.
- **Bar width (x-axis)**: Set **Width** to define how wide each bar is. This is based on the values on the x-axis. You can offset the bars by changing the **Offset** setting.

**Example:**

If you set **Width** to 2 and keep the default **Offset** setting 0, your bars may be defined 0 to 2, 2 to 4, 4 to 6, and so on. If you change **Offset** to 1, the bars are defined -1 to 1, 1 to 3, 3 to 5, and so on.

- **Count distinct values only**: Select this to exclude duplicate values.

**Add-ons**

- **Data handling: Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
• **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: \( \text{count(distinct Team)} < 3 \). If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

• **Reference lines: Add reference line:** Click to add a new reference line.
  
  • **Show:** When selected, the reference line is displayed.
  
  • **Label:** Enter a label for the reference line.
  
  • **Color:** In the color picker, select the color of the reference line and the label.
  
  • **Reference line expression:** Enter a value or an expression for the reference line. Click \( \mathbf{fx} \) to open the expression editor.

• ![ ]: Click to remove the reference line.

### Appearance

#### General

• **Show titles:** **On** by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

Click \( \mathbf{fx} \) if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: `Sales: ' & Sum(Sales)`. By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=`Sales: ' & Sum(Sales)`), the string is interpreted as an expression instead. The output is then **Sales: `<value of expression>`, where `<value of expression>` is the calculated value.**

• **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

### Alternate states

• **State:** Set the state to apply to the visualization. You can select:
  
  • Any alternate state defined in **Master items**.
  
  • `<inherited>`, in which case the state defined for the sheet is used.
  
  • `<default state>`, which represents the state where no alternate state is applied.
Presentation

Gridline spacing: Set this to Custom if you want to customize the horizontal gridlines. You can choose between: No lines, Medium, or Narrow.

Value labels: By default, Off. With the Auto setting, the value labels are displayed when there is enough space.

- Colors: You can only set the bar color of the histogram.
- Y-axis: Frequency When set to Auto, the label is displayed if there is enough space.
  - Labels and title: Select what to display of labels and title.
  - Position: Select where to display the frequency axis.
  - Scale: Set the spacing of the frequency axis scale.
  - Range: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.
  - Label: Set the label for the frequency axis.
- X-axis: <Field>:
  - Labels and title: Select what to display of labels and title.
  - Position: Select where to display the field axis.

KPI

The KPI visualization can show one or two measure values, and is used to track performance.

A KPI visualization with two measure values, using conditional colors and symbols.

![Total Sales](image)

When to use it

Use KPIs to get an overview of performance values that are central to an organization. Use color coding and symbols to indicate how the figures relate to the expected results.

Advantages

KPIs give a quick understanding of the performance within an area.

Disadvantages

The KPI is somewhat limited when it comes to graphical components. You can use symbols to help illustrate the performance, but if you want a more conspicuous component, consider using a gauge.

Creating a KPI

You can create a KPI visualization on the sheet you are editing.
Do the following:

1. From the assets panel, drag an empty KPI chart to the sheet.
2. Click **Add measure** and select a measure or create a measure from a field.

In a KPI visualization, you can have one or two measures and no dimensions. With two measures, the second value automatically becomes a complementary value and is shown with a smaller font size. You can easily switch their order by dragging the measures in the properties panel under **Measures**.

When you have created the KPI visualization, you may want to adjust its appearance and other settings in the properties panel.

The following settings are used by default in a KPI visualization:

- Centered alignment.
- Black text color.
- Medium font size.
- No titles.
- Measure label displayed.
- Conditional colors and symbols are turned off.
- No link to sheet.

*If you double-click or drag a measure from the assets panel, a KPI visualization is added on the sheet using the measure.*

Using conditional colors and symbols

When you use conditional colors for your KPI visualization, you have the option to use symbols to be displayed next to your measure value. Additionally, you can use the following options:

- Set range limits.
  - Add limits to create subsections with different colors to indicate performance, for example, good (green), below expectations (yellow), or critical (red).
- Add symbols to the values.
- Use gradient coloring between color sections.

You can use expressions to set the limits. All these settings are done in the properties panel that is displayed on the right-hand side of the window when editing a sheet.

Linking to another sheet

You can link from the KPI visualization to a sheet in the app. When making data analysis and clicking the visualization, you can click a second time to go to a predefined sheet. The sheet is opened in a new tab. When hovering over ✅, the name of the sheet is displayed. The icon is only displayed when **Show title** is selected, under **Presentation**.

KPI properties
3 Creating visualizations

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a measure.

Measures
On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure. Pie charts require a measure for Angle, but optionally a measure can be added for Radius, which determines the radius of each slice of the pie chart.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add measure is dimmed, you cannot add more measures.

The following properties are available for measures:

- <Measure name>:
  - Expression: Click to open the expression editor. The existing expression is displayed by default.
  - Label: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - Measure: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - Number formatting: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.
    The following number formats are available:
• **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

• **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `###0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

• **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

• **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

• **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

• **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.

  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

• **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

**Add-ons**

• **Data handling**: Calculation condition: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.

  Enter **Title, Subtitle, and Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click \( \text{\(\text{fx}\)} \) if you want to create an expression by using the expression editor.

  **Example:**

  Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).

  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation

- **Show title**: On by default. When selected, the measure title is displayed above the KPI value.

- **Alignment**: Set the alignment of the KPI value and the title.

- **Font size**: Set the relative font size of the measure value. When the chart is resized, the font size is adjusted to fit the chart.

- **Link to sheet**: Off by default. When turned On, you can link from the KPI to any sheet in the app. Select the sheet in the list. You can also select if the linked sheet opens in a new tab.

Colors

- **Conditional colors**: When used, you can add range limits and use different colors and symbols for the different sections.

- **Add limit**: Use the slider to set the limit. You can add several sections. Click the section to change color.

  You can use an expression as a limit. Click \( \text{\(\text{fx}\)} \) if you want to create an expression.

- **Gradient**: Select to use different shades of colors in the transition between the sections.
- **Remove limit**: Click to remove the selected limit. If no limit is selected, the most recently added limit is removed.

**Line chart**

The line chart is used to show trends over time. The dimension is always on the x-axis, and the measures are always on the y-axis. The orientation cannot be changed to vertical.

Your data set must consist of at least two data points to draw a line. A data set with a single value is displayed as a point.

If you have a data set where data is missing for a certain month, you have the following options for showing the missing values:

- As gaps
- As connections
- As zeros

When a month is not present at all in the data source, it is also excluded from the presentation.

**When to use it**

The line chart is primarily suitable when you want to visualize trends and movements over time, where the dimension values are evenly spaced, such as months, quarters, or fiscal years.

**Advantages**

The line chart is easy to understand and gives an instant perception of trends.

**Disadvantages**

Using more than a few lines in a line chart makes the line chart cluttered and hard to interpret. For this reason, avoid using more than two or three measures.
Creating a line chart

You can create a line chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty line chart to the sheet.
2. Click **Add dimension** and select a dimension or a field.
3. Click **Add measure** and select a measure or create a measure from a field.

When you have created the line chart, you may want to adjust its appearance and other settings in the properties panel.

In a line chart you need at least one dimension and one measure.

You can include up to two dimensions and one measure, or one dimension and up to 15 measures in a line chart.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple line chart with a single line.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A line chart with the first dimension on the X-axis, and a line for each value of the second dimension.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 15 measures</td>
<td>A line chart with one line for each measure.</td>
</tr>
</tbody>
</table>

Display limitations

Displaying large numbers of dimension values

When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed. You can scroll by using the scroll bar in the mini chart, or, depending on your device, by using the scroll wheel or by swiping with two fingers. When a large number of values are used, the mini chart no longer displays all the values. Instead, a condensed version of the mini chart (with the items in gray) displays an overview of the values, but the very low and the very high values are still visible.

*Line chart with a mini chart, since the dimension values exceeds the width of the visualization.*
Displaying out of range values

In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a limit, the range is automatically set to include the highest positive and lowest negative value, but if you set a limit you may have values that exceed that limit. When a data point value cannot be displayed, due to the range limits, an arrow indicates the direction of the value.

When a reference line is out of range, an arrow is displayed together with the number of reference lines that are out of range.

Displaying large amounts of data in a line chart

When displaying large amounts of data in a line chart, the message "Currently showing a limited data set." is shown to indicate that not all data is displayed.

- If the chart uses a continuous scale, 2000 data points are displayed.
- If the chart uses a non-continuous scale, the number of data points displayed is in the range of 2500 to 5000. The limit depends on if the chart has one or two dimensions, and if coloring is used.

Above that number, data points are neither displayed, nor included in selections made in the line chart.

Additionally, only twelve dimension values are displayed for the second dimension in a chart with two dimensions and continuous scale.

To avoid displaying limited data sets, you can either make a selection or use dimension limits in the properties panel.

Line chart properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

**If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.**

**Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.**

Data

Click Add to add a dimension or a measure.
Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click $\mathbf{fx}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

$$=\text{if (Week < 14, Week, 'Sales')}$$

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>:** Click the dimension name to open the dimension settings.
  If you want to delete the dimension, long-touch/right-click the dimension and select $\mathbf{\ldots}$ in the dialog.
  Alternatively, click the dimension and click $\mathbf{\ldots}$.
  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click $\mathbf{fx}$ to open the expression editor.
  - **Label:** Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Includenull values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation:** The default value.
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Calculated on measure:** $<\text{measure}>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    - **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
3 Creating visualizations

- **Other label:** Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click \( \text{fx} \) to open the expression editor.

- **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (\( \equiv \)) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

- **<Measure name>**: Click the measure to open the measure settings.
  - If you want to delete the measure, long-touch/right-click the measure and select \( \text{trash can} \) in the dialog.
  - Alternatively, click the measure and click \( \text{trash can} \).

  - **Expression**: Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default.
  
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET statements** at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data.
  - To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- \(# ##0\) describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- \(###0\) describes the number as an integer without a thousands separator.
- \(0000\) describes the number as an integer with at least four digits. For example, the
number 123 will be shown as 0123.

- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.
  If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.
- **Money:** By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date:** By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration:** By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
- **Custom:** By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
- **Measure expression:** The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations:
  Only works with visualizations that accept measures.
  Cannot be used with a box plot.
  Does not affect the number formatting of the axis.

- **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

### Sorting

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Each of the dimensions and measures can also be sorted internally:

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression:** Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.
If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

- **Data handling:**
  - **Include zero values:** When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  - A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

- **Reference lines:** **Add reference line:** Click to add a new reference line.
  - **Show:** When selected, the reference line is displayed.
  - **Label:** Enter a label for the reference line.
  - **Color:** In the color picker, select the color of the reference line and the label.
  - **Reference line expression:** Enter a value or an expression for the reference line. Click `fx` to open the expression editor.
  - **🗑:** Click to remove the reference line.

**Appearance**

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart.
  
Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (`=`), at the beginning of a string shows that it contains an expression.
  
  Click `fx` if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: `Sales: ‘ & Sum(Sales)`.
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: `="Sales: ‘ & Sum(Sales)"`, the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - **<inherited>**, in which case the state defined for the sheet is used.
  - **<default state>**, which represents the state where no alternate state is applied.

Presentation

- **Line/Area**: Select to display the chart as a line or as an area.
- **Stacked alignment**: Set the position of the chart scroll bar. By default the scroll alignment is set to **Start**.
- **Stacked area**: When selected, the different areas are displayed on top of each other. Only available with **Area** style.
- **Stack positive and negative values separately**: Only available with **Area** style.
- **Missing values**: Set how to show missing values.
  - **Show as gaps**: The line has a gap, which represents the missing value.
  - **Show as connections**: The line connects the values that exist on either side of the missing value. If the missing value is first or last, no line is drawn.
  - **Show as zeros**: The line is drawn to zero and from there to the next existing value. If the missing value is first or last, no line is drawn.
- **Show data points**: When selected, the data points are displayed. **Value labels**: By default, **Off**. With the **Auto** setting, the value labels are displayed when there is enough space.
- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is **Medium**.

Colors and legends

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
    - **Multicolored**: Option when more than one measure is used. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors
assigned to them, you can select which to use in the visualization.

- **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By dimension:** Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
  - **Select dimension:** Enter a field or expression containing the values to color objects in this chart.
  - **Library colors:** Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
  - **Persistent colors:** Select to have colors remain the same between selection states.
  - **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By measure:**
  - **Select measure:** Select the measure to use to color your chart.
  - **Library colors:** Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has assigned colors.
  - **Label:** Enter text or an expression for the measure that displays in the legend.
  - **Color scheme:** Select a color scheme from the following options:
    - **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient:** Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
    - **Diverging classes:** Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.
    - **Reverse colors:** When selected, the color scheme is reversed.
    - **Range:** Define the range of values used to color by measure or by expression.
      - **Auto:** The color range is set by the measure or expression values.
      - **Custom:** When custom is selected, you can set the Min and Max values for the color range.
• **By expression:** Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  • **Expression:** Enter the expression that you want to use. Click $\text{fx}$ to open the expression editor.
  • **The expression is a color code:** Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see *Coloring a visualization (page 387)*
  When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.
  • **Show legend:** Not available when **Single color** is selected. By default set to Off. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.
  • **Legend position:** Select where to display the legend.
  • **Show legend title:** When selected, the legend title is displayed.

**X-axis**

  • **<Dimension>**
    • **Continuous:** Set to **Custom** to be able to show a continuous axis by selecting **Use continuous scale. Use continuous scale** is only available for dimensions with numeric values. You cannot change sorting when you use a continuous scale.
    • **Show mini chart:** You can select if you want to display the mini chart below the chart. This option is only available when you use a continuous scale.
    • **Labels and title:** Select what to display of labels and title.
    • **Label orientation:** Select how to display the labels.
    • **Position:** Select where to display the dimension axis.

**Y-axis**

  • **<Measure>**
    • **Labels and title:** Select what to display of labels and title.
    • **Position:** Select where to display the measure axis.
    • **Scale:** Set the spacing of the measure axis scale.
    • **Range:** Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

**Maps**

Maps enable you to view your data geographically. A Qlik Sense map visualization consists of a base map and layers. The base map is the background for the layers of data representations - your dimensions and measures. Multiple base maps are available with Qlik Sense. The layers project your dimensions and measures either by
Creating visualizations

single points or by area, enabling you to see the geography of your data. For example, if you wanted to view total sales by city, you could add a point layer of cities on a map and have the color and size of the points be determined by the total sales for stores in those cities.

Maps have many ways to present your data. You can add multiple layers to your map to display different types of information on the same map. You can set a custom scope for locations so that if two locations have the same name, you display the locations and their data correctly. You can use drill-down dimensions to create a hierarchy of geographic areas for selection. You can limit the pan of a map to a specific view and scope of the map, such as a region of interest, out of which users cannot pan or zoom out. You can add custom base maps to your map and use non-WGS-84 coordinates.

Layers

Layers contain visualized dimension and measure data that is displayed over your map. You can stack layers on top of each other. You can also control at what zoom levels different layers appear in or have layers that appear only if other values in a drill-down dimension are selected. This enables you to create different levels of detail as you make selections and zoom in and out of areas of interest on your map. Layers can be point, area, line, density, chart, or background layers.

Point layer

A point layer overlays individual locations on a map, representing them with shapes. By default, point layers use circular bubbles, but you can also use several other shapes. The size of the points in your layer can be fixed or you can specify a measure or expression to set the sizes of the different points. You can highlight these differences in values further by coloring by measure.

Map with point layer displaying cities in Atlantic Canada colored and sized by population.
3 Creating visualizations

Area layer
An area layer presents areas on your map, such as countries or states. With polygon geometry loaded into a field, it can present any custom area.

With an area layer, each dimension value corresponds to a presented area. By using colors with your area layer, you can present different measure values for the areas. In the properties panel, under Appearance > Colors and legend, switch Colors to Custom where the options By measure and By expression are available.

Map with area layer displaying Australian states and territories colored by population.

Line layer
A line layer enables you to display lines between points on your map. For example, you can use a line layer to show aircraft flights between cities. With a line layer, you can use two fields containing point data to define the start points and end points for lines in the layer. Alternatively, you can use a field containing line geometry in either GeoJSON LineString or MultiLineString format. You can customize the width and curvature of lines in the line layer and add directional arrows to your lines.

Map with line layer displaying departing flights between airports in Europe.
Creating visualizations

Density layer

A density layer enables you to visualize the density of points in an area using a color ramp. Each point influences a circular area, with the highest influence at the center and declining towards its outer perimeter. You can specify the influence radius of the points, change its color and scale it to suit your visualization. Density layers can be used to show hotspots of activity, population densities and more.

*Map with density layer displaying number of global volcanic eruptions.*
Chart layer
A chart layer enables you to display small pie charts or bar charts over locations in your map. It uses one dimension to identify the locations and a second dimension to create the pie or bar charts. You can label the charts and use an expression to control their size. The info bubble displays useful information about the contents of the selected chart.

Map with chart layer displaying source of funds in European Union countries as pie charts. The size of each pie chart shows average absorption rate of funds.

Background layer
Background layers enable you to display a custom base map for your map visualization. A background layer could, for example, be a map of an airport that then has a point layer with WIFI hotspot locations overlaid on it. If the custom base map format supports transparency, you can overlay it on top of another map. Qlik Sense supports the following custom maps formats as background layers:

- Slippy or tile map services (TMS)
- Web Map Service (WMS)
- Image URL (Image)
Maps services must be located on their own server. Unlike other layers, the background layer uses no dimensions or measures and only displays an external base map.

If your WMS contains areas with no data, you can set the areas with no data to be transparent. This enables the WMS background layer to be overlaid on another base map or background layer. You can also choose which WMS layers to include in the background layer.

You can insert an image as a background layer. This can be used as a custom base map. You could add an image of a floor plan and use it as a custom base map. An image background layer can also be overlaid on top of another background layer. For example, you could insert an image of a detailed local map as a background layer over top another map. Background layers support the following image types:

- .png
- .jpg
- .jpeg
- .gif

*Map with background layer displaying a TMS OpenStreetMap map.*

**Location data**

Maps support several ways for determining locations in a layer. Locations can be either geometries or names of locations such as names of countries, regions, cities, postal codes etc. Geometries can either be added at load time by the data preparation service or loaded from geographic sources such as KML. Point layers also support latitudes and longitudes in separate fields. For area layers, areas can be defined using geometries from a geographic data source such as KML files. Line layers support the same point data as point layers. Line layers also support strings with line geometries in GeoJSON LineString or MultiLineString formats.

Layer locations can be defined using fields that contain names and codes. Qlik Sense can identify the following types of locations:
3 Creating visualizations

- Continent names
- Country names
- ISO alpha 2 country codes
- ISO alpha 3 country codes
- First-order administrative area names, such as a state or province names
- Second-order administrative area names
- Third-order administrative area names
- Fourth-order administrative area names
- Postal codes or ZIP Codes
- City, village, or other populated place names
- IATA airport codes
- ICAO airport codes

Availability of locations may vary by country. If the named location is not available, use coordinate or area data for the location.

Qlik Sense uses map and location data obtained from recognized field leaders who use accepted methodologies and best practices in marking borders and naming countries within their mappings.

Qlik Sense provides flexibility to enable users to integrate their own, separate background maps. If the standard maps do not fit, Qlik Sense offers the option to load customer provided background maps, borders, and areas.

If you are using a custom map in a background layer that uses non-WGS-84 coordinates, you can use a field with locations defined in the coordinate system the map uses (either degrees or meters). For more information, see Using non-WGS-84 coordinate systems (page 192).

When adding a field as a dimension to a map layer, you can either use a field containing location data or use a field containing identifying information for your locations. For example, if you have a field containing custom area geometries and a field containing the names of the custom areas, you can set the name field as the dimension and then set the area geometry field as the location field in Location in the map properties.

When to use it

You can use a map to show the geographical distribution of offices, stores, and other sites of business interest. You can visualize not only locations but also sales values and other measures and display the value differences by bubble size or color.

Advantages

The map is a versatile visualization that efficiently presents the geographical distribution of key values related to location or area.

Disadvantages

With a large number of values, it may be hard to get a good overview. Values may be placed on top of each other and not visible until zoomed in.
Creating visualizations

Creating a map
You can add a map to the sheet you are editing.

You can create several map visualizations based on different point data or area data, which use the same dimension data.

Do the following:

1. From the assets panel, drag an empty map to the sheet.
2. From Map settings, select the Base map.
3. From Layers in the properties panel, add layers to your map.
   Layers are placed above layers of the same type. You can set the order of layers by dragging layers up and down in the list. The layer at the top of your list is also overlaid on top of the other layers on your map.

Once the map is created, you can adjust its appearance and other settings for the map and its layers in the properties panel. For more information on settings, see Map properties (page 207).

Adding a point layer
Do the following:

1. Do one of the following:
   - Drag and drop a field onto the map, select Add as new layer, and select Add as point layer.
   - From Layers in the properties panel, click Add layer and select Point layer. In Dimensions, click Add and select a field containing point data to use as the dimension.
2. If there are issues with the point locations, adjust the location settings in Locations in the properties panel.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 207).

Adding an area layer
Do the following:

1. Do one of the following:
   - Drag and drop a field onto the map, select Add as new layer, and select Add as area layer.
   - From Layers in the properties panel, click Add layer and select Area layer. In Dimensions, click Add and select a field containing area data to use as the dimension.
2. If there are issues with the point locations, adjust the location settings in **Locations** in the properties panel.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see *Map properties (page 207)*.

**Adding a line layer**

Line layers display lines using either start and end points, where two fields are used to determine where lines start and end, or using line geometries in GeoJSONLineString or MultiLineString format.

If you are using a start and end point line layer, the dimension you select for your line layer should represent the fields selected as the start and end points in your **Location** settings. For example, if you wanted to visualize where your shipments are being sent, you could set **Shipments** as the dimension and then use **Distribution Center Location** and **Shipping Destination** as the start point and end point in **Location**.

Alternatively, you can add two dimensions to the line layer and use these as the start and end points. This is useful if you want to display lines between all locations in the first dimensions to all locations in the second dimension, which has an association to the first dimension.

**Adding a line layer with start and end points**

Do the following:

1. Do one of the following:
   - Drag and drop a field containing start point data onto the map, select **Add as new layer**, and select **Add as line layer**.
   - From **Layers** in the properties panel, click **Add layer** and select **Line layer**. In **Dimensions**, click **Add** and select a field to use as the dimension.

2. If your dimension contains start point data, add a field containing end point data. Do one of the following:
   - Drag and drop a field containing end point data onto the map, select **Use in <layer name>**, and select **Add <field name> as a second dimension**.
   - In **Data**, click **Add** and select a field containing end point data.

3. If your dimension does not contain start or end point data, in **Location**, add the fields containing the start point data and end point data as location fields.

4. If there are issues with the start and end point locations, adjust the location settings in **Location** in the properties panel.
   - Line layers using start point field and end point fields each have separate location settings in **Location**.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see *Map properties (page 207)*.

**Adding a line layer with line geometries**

Do the following:
3 Creating visualizations

1. Do one of the following:
   - Drag and drop a field containing line geometries onto the map, select Add as new layer, and select Add as line layer.
   - From Layers in the properties panel, click Add layer and select Line layer. In Dimensions, click Add and select a field to use as the dimension.

2. In Location, select Line geometry and then select a field in Line geometry field.
   By default, your dimension is selected as the Line geometry field.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 207).

Adding a density layer
Do the following:

1. Do one of the following:
   - Drag and drop a field containing point data onto the map, select Add as new layer, and select Add as density layer.
   - From Layers in the properties panel, click Add layer and select Density layer. In Dimensions, click Add and select a field containing point data to use as the dimension.

2. If there are issues with the point locations, adjust the location settings in Locations in the properties panel.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 207).

Adding a chart layer
Do the following:

1. Do one of the following:
   - Drag and drop a field containing point data onto the map, select Add as new layer, and select Add as chart layer.
   - From Layers in the properties panel, click Add layer and select Chart layer.

2. In Dimensions, under Location, click Add and select a field containing point data to use as the locations on your map. Click Add and select a field containing data to use as the dimension on your charts.

3. In Measures, click Add and select a field containing data to use as the measure on your charts.

4. If there are issues with the point locations, adjust the location settings in Location in the properties panel.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see Map properties (page 207).

Adding a background layer
Background layer configuration varies depending on the type of background map.

Adding a TMS background layer
Do the following:
1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. After **Format**, select **TMS**.
4. After **URL**, enter the URL to a tile or slippy map server. For example, http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png.
5. After **Attribution**, enter the attribution string for the map. For example, © <a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 207).

**Adding a WMS background layer**

Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. Under **Format**, select **WMS**.
4. Click **WMS setup**.
5. Under **WMS server URL**, enter the URL.
7. Click **Load WMS**.

If the load fails, select **Via server (CORS)** to try loading using the Qlik GeoAnalytics server and click **Load WMS**.

8. After **CRS**, enter the coordinate reference system used by the WMS map.
9. Select **Transparent** to generate map images that are transparent where there is not data.

This is not supported by all WMS.

10. Under **Image format**, select the WMS image format.
11. Under **Layers**, select the map layers that your WMS server supports.
12. Click **Save**.
13. After **Attribution**, enter the attribution string for the map. For example, © <a href='http://www.opencyclemap.org/' target='_blank'>OpenCycleMap</a>.

Once the layer is added, you can adjust settings for the layer in the properties panel. For more information on settings, see **Map properties** (page 207).
Adding an image background layer

Images can be used as a custom base map, such as for floor plans. When using an image background layer as a custom base map, set **Base map** in **Map settings** to **None**. Select **Undefined meters** or **Undefined degrees** as the projection. The location data for your other layers must use same coordinate system as this background layer.

When you add an image background layer for a smaller geographic area as a custom base map, add a layer containing data, such as a point layer, at the same time. This lets the map automatically zoom in to the position of your image background layer.

The lowest unit in the scale bar is 10 meters. If this measurement is too large for your image, you can disable the scale bar in **Presentation** and then proportionally adjust up your image in the background layer to the scale you want. Scale the location data you want to use in other layers as well.

Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Background layer**.
3. Under **Format**, select **Image**.
4. After **URL**, enter the URL of the image.
5. Position your image by entering the coordinates for the top left and bottom right corners of the image. Coordinates must be in the same coordinate type as was selected in **Projection**.

If you are unsure of the coordinates in your image background layer, enable **Show debug info**. This will display the coordinates for the current center of your map.

6. After **Attribution**, enter the attribution string for the image.

Once the layer is added, you can adjust settings for the layer in the properties panel. For image background layers being used as custom base maps, it is recommended that you change the **Limit zoom levels** and **Limit pan navigation settings** to set the focus on your custom map. For more information on settings, see **Map properties** (page 207).

Setting the scope of locations for a map layer

By default, Qlik Sense searches a broad scope of locations for the location field when names are used. In cases where there are multiple possible matches, you may need to limit the scope of locations searched to ensure Qlik Sense displays the desired location.

Do the following:
1. From **Layers** in the properties panel, click **Location**.
2. Set **Scope for location** to **Custom**.
3. After **Location type**, select the type of data contained in the field or expression selected as **Location field**.
4. Optionally, after **Country**, enter a field, expression, or text indicating the country the locations in the **Location field** are located.
5. Optionally, after **Administrative area (Level 1)**, enter a field, expression, or text indicating the first-level administrative area the locations in the **Location field** are located.
6. Optionally, after **Administrative area (Level 2)**, enter a field, expression, or text indicating the second-level administrative area the locations in the **Location field** are located.

Creating drill-down layers

When creating a map that has multiple points of data located in a wide geographical area, you can use drill-down dimensions to display your layers in a selection hierarchy. This enables you to use different layers at different levels within your map, ensuring only the most relevant information is being displayed.

As you make selections in a drill-down layer, the dimension used for locations changes to the next dimension in the drill-down dimension. The drill-down happens across layers that use the same drill-down dimension. If you have an area and a point layer that use the same drill-down dimension, you can set which layer displays with which dimension from the drill-down dimension.

Drill-down dimensions used for drill-down layers should have the fields in order of highest geographical area to smallest geographical area.

For information on creating drill-down dimensions, see *Creating a drill-down dimension (page 65)*.

Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Point layer**, **Area layer**, **Line layer**, **Density layer**, or **Chart layer**.
3. Click **Dimensions**, click **Add** and select your drill-down dimension.
4. In your layer, click **Options**.
5. Click **Layer display**.
6. After **Visible drill-down levels**, select which dimensions to display in the layer.

Limiting panning in your map

You can limit the panning settings in your map to keep the view in your map limited to a set area, such as a specific region of interest. When you limit the panning in a map, you lock the map to the current view. The map will not zoom out further than the current view. You cannot pan the map beyond the limits of the current view. If you zoom in, you can pan, but you are limited by the boundaries of the pan limit.

Do the following:

1. From the properties panel, click **Appearance**.
2. In **Presentation**, set **Limit pan navigation** to **Custom**.
3. Set your map to the view you want to which you want to limit the pan.

4. Click **Set pan limit**.

You can toggle the set pan limit on and off with **Limit pan navigation**. You can clear the saved pan limit by clicking **Clear pan limit**.

Using non-WGS-84 coordinate systems

If you have data and a background map in a projection other than WGS-84, you should set the base map to **None**, add your background map as a background layer, and then set your projection to use undefined degrees or meters depending on the unit of length used in your base map.

When using non-WGS-84 coordinates, you must use geometries loaded into a field. Location names cannot be used.

Do the following:

1. From the properties panel, click **Map settings**.
2. In **Base map**, select **Empty (undefined degrees)** or **Empty (undefined meters)**.
3. Select **Background layer**.
4. After **URL**, enter the URL to a slippy map server.
   
   For example, http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png.
5. After **Attribution**, enter the attribution string for the map.
   
   For example, &copy; &lt;a href='http://www.opencyclemap.org/' target='_blank'&gt;OpenCycleMap&lt;/a&gt;. Map data &copy; &lt;a href='http://www.openstreetmap.org/copyright' target='_blank'&gt;OpenStreetMap&lt;/a&gt; contributors.
6. From **Layers**, click **Add layer**.
7. Select your layer type.
8. In **Dimensions**, click **Add** and select a field containing data in your map's coordinate system.

Map example: Controlling visible data with drill-down layers

When creating a map that has multiple points of data located in a wide geographical area, you can use drill-down dimensions to display your layers in a hierarchy. As users make selections in a layer, the dimension displayed in the layer changes to the next dimension in the drill-down dimension. This enables you to use display data at different selection levels within your map, ensuring only the most relevant information is being displayed.

This example will show you how to build a map with a top-level area layer that drills down into with two point layers.

**Example**

We have a list of all historical sites in the United States National Park Service’s National Register of Historic places. When we add the cities that historical sites are located in to a map as a point layer, we get accurate locations for our bubbles. It could be made more understandable with better organization, however.
How then can we organize this information better, especially if we also want to add in another point layer containing airports to help plan how to get to the different sites?

To solve this problem, we will create a map of the United States of America with a layer of states that drills down to the county level. Drilling down to the county level will also show the cities that contain the historical sites as data points, as well as all airports for that state and the surrounding states.
Creating visualizations

Dataset

This example uses two sets of data:

- **Federal listings**: National Register of Historic Places listed properties from federal agencies (FED_LI_2015.xlsx)
  
  This data set is available from the National Park Service National Register of Historic Places. It contains data about all registered history places, their location, and the federal agencies associated to them.

  ![FED_LI_2015.xlsx](image)

  When you use this data set, we recommend that you clean up the data as follows before loading it into Qlik Sense.

  Do the following:
  1. Delete the first empty rows of data.
  2. Convert rows 6 and 7 into a single header row.

- **Airport data**: This table contains data for airports in the United States. It consists of each airport's International Air Transport Association (IATA) code, city, and state or territory.
  
  You must import this data into Qlik Sense either by adding to a spreadsheet that you then import into Qlik Sense or by importing the table from this help page as a web file.

### Airport data

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABE</td>
<td>Allentown/Bethlehem/Easton, PA</td>
<td>PA</td>
</tr>
<tr>
<td>ABI</td>
<td>Abilene, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ABQ</td>
<td>Albuquerque, NM</td>
<td>NM</td>
</tr>
</tbody>
</table>
## Creating visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABR</td>
<td>Aberdeen, SD</td>
<td>SD</td>
</tr>
<tr>
<td>ABY</td>
<td>Albany, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ACT</td>
<td>Waco, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ACV</td>
<td>Arcata/Eureka, CA</td>
<td>CA</td>
</tr>
<tr>
<td>ADK</td>
<td>Adak Island, AK</td>
<td>AK</td>
</tr>
<tr>
<td>ADQ</td>
<td>Kodiak, AK</td>
<td>AK</td>
</tr>
<tr>
<td>AEX</td>
<td>Alexandria, LA</td>
<td>LA</td>
</tr>
<tr>
<td>AGS</td>
<td>Augusta, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ALB</td>
<td>Albany, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ALO</td>
<td>Waterloo, IA</td>
<td>IA</td>
</tr>
<tr>
<td>AMA</td>
<td>Amarillo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ANC</td>
<td>Anchorage, AK</td>
<td>AK</td>
</tr>
<tr>
<td>APN</td>
<td>Alpena, MI</td>
<td>MI</td>
</tr>
<tr>
<td>ART</td>
<td>Watertown, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ASE</td>
<td>Aspen, CO</td>
<td>CO</td>
</tr>
<tr>
<td>ATL</td>
<td>Atlanta, GA</td>
<td>GA</td>
</tr>
<tr>
<td>ATW</td>
<td>Appleton, WI</td>
<td>WI</td>
</tr>
<tr>
<td>AUS</td>
<td>Austin, TX</td>
<td>TX</td>
</tr>
<tr>
<td>AVL</td>
<td>Asheville, NC</td>
<td>NC</td>
</tr>
<tr>
<td>AVP</td>
<td>Scranton/Wilkes-Barre, PA</td>
<td>PA</td>
</tr>
<tr>
<td>AZO</td>
<td>Kalamazoo, MI</td>
<td>MI</td>
</tr>
<tr>
<td>BDL</td>
<td>Hartford, CT</td>
<td>CT</td>
</tr>
<tr>
<td>BET</td>
<td>Bethel, AK</td>
<td>AK</td>
</tr>
<tr>
<td>BFL</td>
<td>Bakersfield, CA</td>
<td>CA</td>
</tr>
<tr>
<td>BGR</td>
<td>Bangor, ME</td>
<td>ME</td>
</tr>
<tr>
<td>BHM</td>
<td>Birmingham, AL</td>
<td>AL</td>
</tr>
<tr>
<td>BIL</td>
<td>Billings, MT</td>
<td>MT</td>
</tr>
<tr>
<td>BIS</td>
<td>Bismarck/Mandan, ND</td>
<td>ND</td>
</tr>
<tr>
<td>BJI</td>
<td>Bemidji, MN</td>
<td>MN</td>
</tr>
<tr>
<td>BKG</td>
<td>Branson, MO</td>
<td>MO</td>
</tr>
</tbody>
</table>
### 3 Creating visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLI</td>
<td>Bellingham, WA</td>
<td>WA</td>
</tr>
<tr>
<td>BMI</td>
<td>Bloomington/Normal, IL</td>
<td>IL</td>
</tr>
<tr>
<td>BNA</td>
<td>Nashville, TN</td>
<td>TN</td>
</tr>
<tr>
<td>BOI</td>
<td>Boise, ID</td>
<td>ID</td>
</tr>
<tr>
<td>BOS</td>
<td>Boston, MA</td>
<td>MA</td>
</tr>
<tr>
<td>BPT</td>
<td>Beaumont/Port Arthur, TX</td>
<td>TX</td>
</tr>
<tr>
<td>BQK</td>
<td>Brunswick, GA</td>
<td>GA</td>
</tr>
<tr>
<td>BQN</td>
<td>Aguadilla, PR</td>
<td>PR</td>
</tr>
<tr>
<td>BRD</td>
<td>Brainerd, MN</td>
<td>MN</td>
</tr>
<tr>
<td>BRO</td>
<td>Brownsville, TX</td>
<td>TX</td>
</tr>
<tr>
<td>BRW</td>
<td>Barrow, AK</td>
<td>AK</td>
</tr>
<tr>
<td>BTM</td>
<td>Butte, MT</td>
<td>MT</td>
</tr>
<tr>
<td>BTR</td>
<td>Baton Rouge, LA</td>
<td>LA</td>
</tr>
<tr>
<td>BTV</td>
<td>Burlington, VT</td>
<td>VT</td>
</tr>
<tr>
<td>BUF</td>
<td>Buffalo, NY</td>
<td>NY</td>
</tr>
<tr>
<td>BUR</td>
<td>Burbank, CA</td>
<td>CA</td>
</tr>
<tr>
<td>BWI</td>
<td>Baltimore, MD</td>
<td>MD</td>
</tr>
<tr>
<td>BZN</td>
<td>Bozeman, MT</td>
<td>MT</td>
</tr>
<tr>
<td>CAE</td>
<td>Columbia, SC</td>
<td>SC</td>
</tr>
<tr>
<td>CAK</td>
<td>Akron, OH</td>
<td>OH</td>
</tr>
<tr>
<td>CDC</td>
<td>Cedar City, UT</td>
<td>UT</td>
</tr>
<tr>
<td>CDV</td>
<td>Cordova, AK</td>
<td>AK</td>
</tr>
<tr>
<td>CEC</td>
<td>Crescent City, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CHA</td>
<td>Chattanooga, TN</td>
<td>TN</td>
</tr>
<tr>
<td>CHO</td>
<td>Charlottesville, VA</td>
<td>VA</td>
</tr>
<tr>
<td>CHS</td>
<td>Charleston, SC</td>
<td>SC</td>
</tr>
<tr>
<td>CIC</td>
<td>Chico, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CID</td>
<td>Cedar Rapids/Iowa City, IA</td>
<td>IA</td>
</tr>
<tr>
<td>CLD</td>
<td>Carlsbad, CA</td>
<td>CA</td>
</tr>
<tr>
<td>CLE</td>
<td>Cleveland, OH</td>
<td>OH</td>
</tr>
</tbody>
</table>
### Creating visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLL</td>
<td>College Station/Bryan, TX</td>
<td>TX</td>
</tr>
<tr>
<td>CLT</td>
<td>Charlotte, NC</td>
<td>NC</td>
</tr>
<tr>
<td>CMH</td>
<td>Columbus, OH</td>
<td>OH</td>
</tr>
<tr>
<td>CMI</td>
<td>Champaign/Urbana, IL</td>
<td>IL</td>
</tr>
<tr>
<td>CMX</td>
<td>Hancock/Houghton, MI</td>
<td>MI</td>
</tr>
<tr>
<td>COD</td>
<td>Cody, WY</td>
<td>WY</td>
</tr>
<tr>
<td>COS</td>
<td>Colorado Springs, CO</td>
<td>CO</td>
</tr>
<tr>
<td>COU</td>
<td>Columbia, MO</td>
<td>MO</td>
</tr>
<tr>
<td>CPR</td>
<td>Casper, WY</td>
<td>WY</td>
</tr>
<tr>
<td>CRP</td>
<td>Corpus Christi, TX</td>
<td>TX</td>
</tr>
<tr>
<td>CRW</td>
<td>Charleston/Dunbar, WV</td>
<td>WV</td>
</tr>
<tr>
<td>CSG</td>
<td>Columbus, GA</td>
<td>GA</td>
</tr>
<tr>
<td>CWA</td>
<td>Mosinee, WI</td>
<td>WI</td>
</tr>
<tr>
<td>CVG</td>
<td>Cincinnati, OH</td>
<td>KY</td>
</tr>
<tr>
<td>DAB</td>
<td>Daytona Beach, FL</td>
<td>FL</td>
</tr>
<tr>
<td>DAL</td>
<td>Dallas, TX</td>
<td>TX</td>
</tr>
<tr>
<td>DAY</td>
<td>Dayton, OH</td>
<td>OH</td>
</tr>
<tr>
<td>DBQ</td>
<td>Dubuque, IA</td>
<td>IA</td>
</tr>
<tr>
<td>DCA</td>
<td>Washington, DC</td>
<td>VA</td>
</tr>
<tr>
<td>DEN</td>
<td>Denver, CO</td>
<td>CO</td>
</tr>
<tr>
<td>DFW</td>
<td>Dallas/Fort Worth, TX</td>
<td>TX</td>
</tr>
<tr>
<td>DHN</td>
<td>Dothan, AL</td>
<td>AL</td>
</tr>
<tr>
<td>DIK</td>
<td>Dickinson, ND</td>
<td>ND</td>
</tr>
<tr>
<td>DLH</td>
<td>Duluth, MN</td>
<td>MN</td>
</tr>
<tr>
<td>DRO</td>
<td>Durango, CO</td>
<td>CO</td>
</tr>
<tr>
<td>DSM</td>
<td>Des Moines, IA</td>
<td>IA</td>
</tr>
<tr>
<td>DTW</td>
<td>Detroit, MI</td>
<td>MI</td>
</tr>
<tr>
<td>EAU</td>
<td>Eau Claire, WI</td>
<td>WI</td>
</tr>
<tr>
<td>ECP</td>
<td>Panama City, FL</td>
<td>FL</td>
</tr>
<tr>
<td>EGE</td>
<td>Eagle, CO</td>
<td>CO</td>
</tr>
</tbody>
</table>
### Creating visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>EKO</td>
<td>Elko, NV</td>
<td>NV</td>
</tr>
<tr>
<td>ELM</td>
<td>Elmira/Corning, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ELP</td>
<td>El Paso, TX</td>
<td>TX</td>
</tr>
<tr>
<td>EUG</td>
<td>Eugene, OR</td>
<td>OR</td>
</tr>
<tr>
<td>EWN</td>
<td>New Bern/Morehead/Beaufort, NC</td>
<td>NC</td>
</tr>
<tr>
<td>EWR</td>
<td>Newark, NJ</td>
<td>NJ</td>
</tr>
<tr>
<td>EVV</td>
<td>Evansville, IN</td>
<td>IN</td>
</tr>
<tr>
<td>EYW</td>
<td>Key West, FL</td>
<td>FL</td>
</tr>
<tr>
<td>FAI</td>
<td>Fairbanks, AK</td>
<td>AK</td>
</tr>
<tr>
<td>FAR</td>
<td>Fargo, ND</td>
<td>ND</td>
</tr>
<tr>
<td>FAT</td>
<td>Fresno, CA</td>
<td>CA</td>
</tr>
<tr>
<td>FAY</td>
<td>Fayetteville, NC</td>
<td>NC</td>
</tr>
<tr>
<td>FCA</td>
<td>Kalispell, MT</td>
<td>MT</td>
</tr>
<tr>
<td>FLG</td>
<td>Flagstaff, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>FLL</td>
<td>Fort Lauderdale, FL</td>
<td>FL</td>
</tr>
<tr>
<td>FNT</td>
<td>Flint, MI</td>
<td>MI</td>
</tr>
<tr>
<td>FOE</td>
<td>Topeka, KS</td>
<td>KS</td>
</tr>
<tr>
<td>FSD</td>
<td>Sioux Falls, SD</td>
<td>SD</td>
</tr>
<tr>
<td>FSM</td>
<td>Fort Smith, AR</td>
<td>AR</td>
</tr>
<tr>
<td>FWA</td>
<td>Fort Wayne, IN</td>
<td>IN</td>
</tr>
<tr>
<td>GCC</td>
<td>Gillette, WY</td>
<td>WY</td>
</tr>
<tr>
<td>GCK</td>
<td>Garden City, KS</td>
<td>KS</td>
</tr>
<tr>
<td>GEG</td>
<td>Spokane, WA</td>
<td>WA</td>
</tr>
<tr>
<td>GFK</td>
<td>Grand Forks, ND</td>
<td>ND</td>
</tr>
<tr>
<td>GGG</td>
<td>Longview, TX</td>
<td>TX</td>
</tr>
<tr>
<td>GJT</td>
<td>Grand Junction, CO</td>
<td>CO</td>
</tr>
<tr>
<td>GNV</td>
<td>Gainesville, FL</td>
<td>FL</td>
</tr>
<tr>
<td>GPT</td>
<td>Gulfport/Biloxi, MS</td>
<td>MS</td>
</tr>
<tr>
<td>GRB</td>
<td>Green Bay, WI</td>
<td>WI</td>
</tr>
<tr>
<td>GRI</td>
<td>Grand Island, NE</td>
<td>NE</td>
</tr>
</tbody>
</table>
Create apps and visualizations - Qlik Sense, June 2019

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRK</td>
<td>Killeen, TX</td>
<td>TX</td>
</tr>
<tr>
<td>GRR</td>
<td>Grand Rapids, MI</td>
<td>MI</td>
</tr>
<tr>
<td>GSO</td>
<td>Greensboro/High Point, NC</td>
<td>NC</td>
</tr>
<tr>
<td>GSP</td>
<td>Greer, SC</td>
<td>SC</td>
</tr>
<tr>
<td>GTF</td>
<td>Great Falls, MT</td>
<td>MT</td>
</tr>
<tr>
<td>GTR</td>
<td>Columbus, MS</td>
<td>MS</td>
</tr>
<tr>
<td>GUC</td>
<td>Gunnison, CO</td>
<td>CO</td>
</tr>
<tr>
<td>GUM</td>
<td>Guam, TT</td>
<td>TT</td>
</tr>
<tr>
<td>HDN</td>
<td>Hayden, CO</td>
<td>CO</td>
</tr>
<tr>
<td>HIB</td>
<td>Hibbing, MN</td>
<td>MN</td>
</tr>
<tr>
<td>HLN</td>
<td>Helena, MT</td>
<td>MT</td>
</tr>
<tr>
<td>HNL</td>
<td>Honolulu, HI</td>
<td>HI</td>
</tr>
<tr>
<td>HOB</td>
<td>Hobbs, NM</td>
<td>NM</td>
</tr>
<tr>
<td>HOU</td>
<td>Houston, TX</td>
<td>TX</td>
</tr>
<tr>
<td>HPN</td>
<td>White Plains, NY</td>
<td>NY</td>
</tr>
<tr>
<td>HRL</td>
<td>Harlingen/San Benito, TX</td>
<td>TX</td>
</tr>
<tr>
<td>HSV</td>
<td>Huntsville, AL</td>
<td>AL</td>
</tr>
<tr>
<td>IAD</td>
<td>Washington, DC</td>
<td>VA</td>
</tr>
<tr>
<td>IAH</td>
<td>Houston, TX</td>
<td>TX</td>
</tr>
<tr>
<td>ICT</td>
<td>Wichita, KS</td>
<td>KS</td>
</tr>
<tr>
<td>IDA</td>
<td>Idaho Falls, ID</td>
<td>ID</td>
</tr>
<tr>
<td>ILG</td>
<td>Wilmington, DE</td>
<td>DE</td>
</tr>
<tr>
<td>ILM</td>
<td>Wilmington, NC</td>
<td>NC</td>
</tr>
<tr>
<td>IMT</td>
<td>Iron Mountain/Kingsfd, MI</td>
<td>MI</td>
</tr>
<tr>
<td>IND</td>
<td>Indianapolis, IN</td>
<td>IN</td>
</tr>
<tr>
<td>INL</td>
<td>International Falls, MN</td>
<td>MN</td>
</tr>
<tr>
<td>ISN</td>
<td>Williston, ND</td>
<td>ND</td>
</tr>
<tr>
<td>ISP</td>
<td>Islip, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ITO</td>
<td>Hilo, HI</td>
<td>HI</td>
</tr>
<tr>
<td>JAC</td>
<td>Jackson, WY</td>
<td>WY</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>JAN</td>
<td>Jackson/Vicksburg, MS</td>
<td>MS</td>
</tr>
<tr>
<td>JAX</td>
<td>Jacksonville, FL</td>
<td>FL</td>
</tr>
<tr>
<td>JFK</td>
<td>New York, NY</td>
<td>NY</td>
</tr>
<tr>
<td>JLN</td>
<td>Joplin, MO</td>
<td>MO</td>
</tr>
<tr>
<td>JNU</td>
<td>Juneau, AK</td>
<td>AK</td>
</tr>
<tr>
<td>KOA</td>
<td>Kona, HI</td>
<td>HI</td>
</tr>
<tr>
<td>KTN</td>
<td>Ketchikan, AK</td>
<td>AK</td>
</tr>
<tr>
<td>LAN</td>
<td>Lansing, MI</td>
<td>MI</td>
</tr>
<tr>
<td>LAR</td>
<td>Laramie, WY</td>
<td>WY</td>
</tr>
<tr>
<td>LAS</td>
<td>Las Vegas, NV</td>
<td>NV</td>
</tr>
<tr>
<td>LAW</td>
<td>Lawton/Fort Sill, OK</td>
<td>OK</td>
</tr>
<tr>
<td>LAX</td>
<td>Los Angeles, CA</td>
<td>CA</td>
</tr>
<tr>
<td>LBB</td>
<td>Lubbock, TX</td>
<td>TX</td>
</tr>
<tr>
<td>LCH</td>
<td>Lake Charles, LA</td>
<td>LA</td>
</tr>
<tr>
<td>LEX</td>
<td>Lexington, KY</td>
<td>KY</td>
</tr>
<tr>
<td>LFT</td>
<td>Lafayette, LA</td>
<td>LA</td>
</tr>
<tr>
<td>LGA</td>
<td>New York, NY</td>
<td>NY</td>
</tr>
<tr>
<td>LGB</td>
<td>Long Beach, CA</td>
<td>CA</td>
</tr>
<tr>
<td>LIH</td>
<td>Lihue, HI</td>
<td>HI</td>
</tr>
<tr>
<td>LIT</td>
<td>Little Rock, AR</td>
<td>AR</td>
</tr>
<tr>
<td>LMT</td>
<td>Klamath Falls, OR</td>
<td>OR</td>
</tr>
<tr>
<td>LNK</td>
<td>Lincoln, NE</td>
<td>NE</td>
</tr>
<tr>
<td>LRD</td>
<td>Laredo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>LSE</td>
<td>La Crosse, WI</td>
<td>WI</td>
</tr>
<tr>
<td>LWS</td>
<td>Lewiston, ID</td>
<td>ID</td>
</tr>
<tr>
<td>MAF</td>
<td>Midland/Odessa, TX</td>
<td>TX</td>
</tr>
<tr>
<td>MBS</td>
<td>Saginaw/Bay City/Midland, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MCI</td>
<td>Kansas City, MO</td>
<td>MO</td>
</tr>
<tr>
<td>MCO</td>
<td>Orlando, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MDT</td>
<td>Harrisburg, PA</td>
<td>PA</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>MDW</td>
<td>Chicago, IL</td>
<td>IL</td>
</tr>
<tr>
<td>MEM</td>
<td>Memphis, TN</td>
<td>TN</td>
</tr>
<tr>
<td>MFE</td>
<td>Mission/McAllen/Edinburg, TX</td>
<td>TX</td>
</tr>
<tr>
<td>MFR</td>
<td>Medford, OR</td>
<td>OR</td>
</tr>
<tr>
<td>MGM</td>
<td>Montgomery, AL</td>
<td>AL</td>
</tr>
<tr>
<td>MHK</td>
<td>Manhattan/Ft. Riley, KS</td>
<td>KS</td>
</tr>
<tr>
<td>MHT</td>
<td>Manchester, NH</td>
<td>NH</td>
</tr>
<tr>
<td>MIA</td>
<td>Miami, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MKE</td>
<td>Milwaukee, WI</td>
<td>WI</td>
</tr>
<tr>
<td>MKG</td>
<td>Muskegon, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MLB</td>
<td>Melbourne, FL</td>
<td>FL</td>
</tr>
<tr>
<td>MLI</td>
<td>Moline, IL</td>
<td>IL</td>
</tr>
<tr>
<td>MLU</td>
<td>Monroe, LA</td>
<td>LA</td>
</tr>
<tr>
<td>MMH</td>
<td>Mammoth Lakes, CA</td>
<td>CA</td>
</tr>
<tr>
<td>MOB</td>
<td>Mobile, AL</td>
<td>AL</td>
</tr>
<tr>
<td>MOD</td>
<td>Modesto, CA</td>
<td>CA</td>
</tr>
<tr>
<td>MOT</td>
<td>Minot, ND</td>
<td>ND</td>
</tr>
<tr>
<td>MQT</td>
<td>Marquette, MI</td>
<td>MI</td>
</tr>
<tr>
<td>MRY</td>
<td>Monterey, CA</td>
<td>CA</td>
</tr>
<tr>
<td>MSN</td>
<td>Madison, WI</td>
<td>WI</td>
</tr>
<tr>
<td>MSO</td>
<td>Missoula, MT</td>
<td>MT</td>
</tr>
<tr>
<td>MSP</td>
<td>Minneapolis, MN</td>
<td>MN</td>
</tr>
<tr>
<td>MSY</td>
<td>New Orleans, LA</td>
<td>LA</td>
</tr>
<tr>
<td>MTJ</td>
<td>Montrose/Delta, CO</td>
<td>CO</td>
</tr>
<tr>
<td>MYR</td>
<td>Myrtle Beach, SC</td>
<td>SC</td>
</tr>
<tr>
<td>OAJ</td>
<td>Jacksonville/Camp Lejeune, NC</td>
<td>NC</td>
</tr>
<tr>
<td>OAK</td>
<td>Oakland, CA</td>
<td>CA</td>
</tr>
<tr>
<td>OGG</td>
<td>Kahului, Hi</td>
<td>HI</td>
</tr>
<tr>
<td>OKC</td>
<td>Oklahoma City, OK</td>
<td>OK</td>
</tr>
<tr>
<td>OMA</td>
<td>Omaha, NE</td>
<td>NE</td>
</tr>
</tbody>
</table>

Create apps and visualizations - Qlik Sense, June 2019
### 3 Creating visualizations

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>OME</td>
<td>Nome, AK</td>
<td>AK</td>
</tr>
<tr>
<td>ONT</td>
<td>Ontario, CA</td>
<td>CA</td>
</tr>
<tr>
<td>ORD</td>
<td>Chicago, IL</td>
<td>IL</td>
</tr>
<tr>
<td>ORF</td>
<td>Norfolk, VA</td>
<td>VA</td>
</tr>
<tr>
<td>ORH</td>
<td>Worcester, MA</td>
<td>MA</td>
</tr>
<tr>
<td>OTH</td>
<td>North Bend/Coos Bay, OR</td>
<td>OR</td>
</tr>
<tr>
<td>OTZ</td>
<td>Kotzebue, AK</td>
<td>AK</td>
</tr>
<tr>
<td>PAH</td>
<td>Paducah, KY</td>
<td>KY</td>
</tr>
<tr>
<td>PBI</td>
<td>West Palm Beach/Palm Beach, FL</td>
<td>FL</td>
</tr>
<tr>
<td>PDX</td>
<td>Portland, OR</td>
<td>OR</td>
</tr>
<tr>
<td>PHF</td>
<td>Newport News/Williamsburg, VA</td>
<td>VA</td>
</tr>
<tr>
<td>PHL</td>
<td>Philadelphia, PA</td>
<td>PA</td>
</tr>
<tr>
<td>PHX</td>
<td>Phoenix, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>PIA</td>
<td>Peoria, IL</td>
<td>IL</td>
</tr>
<tr>
<td>PIH</td>
<td>Pocatello, ID</td>
<td>ID</td>
</tr>
<tr>
<td>PIT</td>
<td>Pittsburgh, PA</td>
<td>PA</td>
</tr>
<tr>
<td>PNS</td>
<td>Pensacola, FL</td>
<td>FL</td>
</tr>
<tr>
<td>PPG</td>
<td>Pago Pago, TT</td>
<td>TT</td>
</tr>
<tr>
<td>PSC</td>
<td>Pasco/Kennewick/Richland, WA</td>
<td>WA</td>
</tr>
<tr>
<td>PSE</td>
<td>Ponce, PR</td>
<td>PR</td>
</tr>
<tr>
<td>PSG</td>
<td>Petersburg, AK</td>
<td>AK</td>
</tr>
<tr>
<td>PSP</td>
<td>Palm Springs, CA</td>
<td>CA</td>
</tr>
<tr>
<td>PVD</td>
<td>Providence, RI</td>
<td>RI</td>
</tr>
<tr>
<td>PWM</td>
<td>Portland, ME</td>
<td>ME</td>
</tr>
<tr>
<td>RAP</td>
<td>Rapid City, SD</td>
<td>SD</td>
</tr>
<tr>
<td>RDD</td>
<td>Redding, CA</td>
<td>CA</td>
</tr>
<tr>
<td>RDM</td>
<td>Bend/Redmond, OR</td>
<td>OR</td>
</tr>
<tr>
<td>RDU</td>
<td>Raleigh/Durham, NC</td>
<td>NC</td>
</tr>
<tr>
<td>RHI</td>
<td>Rhinelander, WI</td>
<td>WI</td>
</tr>
<tr>
<td>RIC</td>
<td>Richmond, VA</td>
<td>VA</td>
</tr>
<tr>
<td>Airport</td>
<td>AirportCity</td>
<td>AirportState</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>RKS</td>
<td>Rock Springs, WY</td>
<td>WY</td>
</tr>
<tr>
<td>RNO</td>
<td>Reno, NV</td>
<td>NV</td>
</tr>
<tr>
<td>ROA</td>
<td>Roanoke, VA</td>
<td>VA</td>
</tr>
<tr>
<td>ROC</td>
<td>Rochester, NY</td>
<td>NY</td>
</tr>
<tr>
<td>ROW</td>
<td>Roswell, NM</td>
<td>NM</td>
</tr>
<tr>
<td>RST</td>
<td>Rochester, MN</td>
<td>MN</td>
</tr>
<tr>
<td>RSW</td>
<td>Fort Myers, FL</td>
<td>FL</td>
</tr>
<tr>
<td>SAF</td>
<td>Santa Fe, NM</td>
<td>NM</td>
</tr>
<tr>
<td>SAN</td>
<td>San Diego, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SAT</td>
<td>San Antonio, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SAV</td>
<td>Savannah, GA</td>
<td>GA</td>
</tr>
<tr>
<td>SBA</td>
<td>Santa Barbara, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SBN</td>
<td>South Bend, IN</td>
<td>IN</td>
</tr>
<tr>
<td>SBP</td>
<td>San Luis Obispo, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SCC</td>
<td>Deadhorse, AK</td>
<td>AK</td>
</tr>
<tr>
<td>SCE</td>
<td>State College, PA</td>
<td>PA</td>
</tr>
<tr>
<td>SDF</td>
<td>Louisville, KY</td>
<td>KY</td>
</tr>
<tr>
<td>SEA</td>
<td>Seattle, WA</td>
<td>WA</td>
</tr>
<tr>
<td>SFO</td>
<td>San Francisco, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SGF</td>
<td>Springfield, MO</td>
<td>MO</td>
</tr>
<tr>
<td>SGU</td>
<td>St. George, UT</td>
<td>UT</td>
</tr>
<tr>
<td>SHV</td>
<td>Shreveport, LA</td>
<td>LA</td>
</tr>
<tr>
<td>SIT</td>
<td>Sitka, AK</td>
<td>AK</td>
</tr>
<tr>
<td>SJC</td>
<td>San Jose, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SJT</td>
<td>San Angelo, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SJU</td>
<td>San Juan, PR</td>
<td>PR</td>
</tr>
<tr>
<td>SLC</td>
<td>Salt Lake City, UT</td>
<td>UT</td>
</tr>
<tr>
<td>SMF</td>
<td>Sacramento, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SMX</td>
<td>Santa Maria, CA</td>
<td>CA</td>
</tr>
<tr>
<td>SNA</td>
<td>Santa Ana, CA</td>
<td>CA</td>
</tr>
</tbody>
</table>
### Instructions

Once you have loaded the data sets into a new app in Qlik Sense, you can begin building your map. To make the example map, you must complete the following tasks:

<table>
<thead>
<tr>
<th>Airport</th>
<th>AirportCity</th>
<th>AirportState</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPI</td>
<td>Springfield, IL</td>
<td>IL</td>
</tr>
<tr>
<td>SPS</td>
<td>Wichita Falls, TX</td>
<td>TX</td>
</tr>
<tr>
<td>SRQ</td>
<td>Sarasota/Bradenton, FL</td>
<td>FL</td>
</tr>
<tr>
<td>STL</td>
<td>St. Louis, MO</td>
<td>MO</td>
</tr>
<tr>
<td>STT</td>
<td>Charlotte Amalie, VI</td>
<td>VI</td>
</tr>
<tr>
<td>STX</td>
<td>Christiansted, VI</td>
<td>VI</td>
</tr>
<tr>
<td>SUN</td>
<td>Sun Valley/Hailey/Ketchum, ID</td>
<td>ID</td>
</tr>
<tr>
<td>SUX</td>
<td>Sioux City, IA</td>
<td>IA</td>
</tr>
<tr>
<td>SWF</td>
<td>Newburgh/Poughkeepsie, NY</td>
<td>NY</td>
</tr>
<tr>
<td>SYR</td>
<td>Syracuse, NY</td>
<td>NY</td>
</tr>
<tr>
<td>TLH</td>
<td>Tallahassee, FL</td>
<td>FL</td>
</tr>
<tr>
<td>TOL</td>
<td>Toledo, OH</td>
<td>OH</td>
</tr>
<tr>
<td>TPA</td>
<td>Tampa, FL</td>
<td>FL</td>
</tr>
<tr>
<td>TRI</td>
<td>Bristol/Johnson City/Kingsport, TN</td>
<td>TN</td>
</tr>
<tr>
<td>TTN</td>
<td>Trenton, NJ</td>
<td>NJ</td>
</tr>
<tr>
<td>TUL</td>
<td>Tulsa, OK</td>
<td>OK</td>
</tr>
<tr>
<td>TUS</td>
<td>Tucson, AZ</td>
<td>AZ</td>
</tr>
<tr>
<td>TVC</td>
<td>Traverse City, MI</td>
<td>MI</td>
</tr>
<tr>
<td>TWF</td>
<td>Twin Falls, ID</td>
<td>ID</td>
</tr>
<tr>
<td>TXK</td>
<td>Texarkana, AR</td>
<td>AR</td>
</tr>
<tr>
<td>TYR</td>
<td>Tyler, TX</td>
<td>TX</td>
</tr>
<tr>
<td>TYS</td>
<td>Knoxville, TN</td>
<td>TN</td>
</tr>
<tr>
<td>VLD</td>
<td>Valdosta, GA</td>
<td>GA</td>
</tr>
<tr>
<td>VPS</td>
<td>Valparaiso, FL</td>
<td>FL</td>
</tr>
<tr>
<td>WRG</td>
<td>Wrangell, AK</td>
<td>AK</td>
</tr>
<tr>
<td>XNA</td>
<td>Fayetteville, AR</td>
<td>AR</td>
</tr>
<tr>
<td>YAK</td>
<td>Yakutat, AK</td>
<td>AK</td>
</tr>
<tr>
<td>YUM</td>
<td>Yuma, AZ</td>
<td>AZ</td>
</tr>
</tbody>
</table>
1. Create the drill-down dimensions.
2. Add the map to our sheet.
3. Add the State-County area layer.
4. Add the State-City point layer.
5. Add the State-Airport point layer.
6. Add the Resource filter pane.

Creating the drill-down dimensions
First, you need to create three drill-down dimensions. This will create the relationships between State and the fields County, City, and Airport, enabling the County, City, and Airport layers to become visible after a state from the State layer has been selected.

Do the following:

1. In sheet view, click Edit in the toolbar.
2. Click to display the master items.
3. Click Dimensions.
4. Click Create new.
5. Select Drill-down.
6. Add the field State to the dimension.
7. Add the field County to the dimension.
8. After Name, type State-County.
9. Click Add dimension.
10. Add the field State to the dimension.
11. Add the field City to the dimension.
12. After Name, type State-City.
13. Click Add dimension.
14. Add the field State to the dimension.
15. Add the field Airport to the dimension.
16. After Name, type State-Airport.
17. Click Add dimension.
18. Click Done.

Adding the map to the sheet
The next step is to add a map to your sheet.

Do the following:

1. In sheet view, click Edit in the toolbar.
2. From the assets panel, drag an empty map to the sheet.
Adding the State-County area layer
The first layer you add is an area layer to which you add the dimension State-County. In addition, you set the country as 'USA' to ensure we map to the state of Georgia rather than the nation of Georgia.

Do the following:

1. From Layers in the properties panel, click Add layer.
2. Select Area layer.
3. In Dimensions, click Add and select State-County.
4. Click Location.
5. Set Scope for locations to Custom.
6. After Country, enter 'USA'.
7. After Administrative area (Level 1), select State.
8. Click Colors.
9. Set Colors to Custom, select By dimension, and select 100 colors.
10. Select Persistent colors.
11. Adjust the Opacity slider to half opacity.
12. Click @ Done.

Adding the State-City point layer
The next layer you add is a point layer. You add State-City as the dimension and then set the country as 'USA' and then set State as the first-level administrative area, as some counties cities in different states have the same names.

Do the following:

1. From Layers in the properties panel, click Add layer.
2. Select Area layer.
3. In Dimensions, click Add and select State-City.
4. Click Location.
5. Set Scope for locations to Custom.
6. After Country, enter 'USA'.
7. After Administrative area (Level 1), select State.
8. Click Colors.
9. Set Colors to Custom, select Single color, and select a color.
10. Click Options.
11. In Layer display, set Visible drill-down levels to Custom.
13. Click @ Done.
Adding the **State-Airport** point layer

The final layer you add to the map is a point layer to which you add the State-Airport field as the dimension. Qlik Sense recognizes IATA codes for placement, ensuring the airports are located in their actual position rather than just in their city.

Do the following:

1. From **Layers** in the properties panel, click **Add layer**.
2. Select **Area layer**.
3. In **Dimensions**, click **Add** and select **State-Airport**.
4. Click **Location**.
5. Set **Scope for locations** to **Custom**.
6. After **Country**, enter ‘USA’.
7. After **Administrative area (Level 1)**, select **State**.
8. Click **Size & Shape**.
9. From **Shape**, select **Triangle**.
10. Click **Colors**.
11. Set **Colors** to **Custom**, select **Single color**, and select a color.
12. Click **Options**.
13. In **Layer display**, set **Visible drill-down levels** to **Custom**.
14. Clear **State**.
15. Click **Done**.

Add the **Resource filter pane**

Finally, you can optionally add a filter pane containing the field **Resource**. This provides you with a list of the available historical sites as you make selections within your map.

Do the following:

1. In the assets panel, drag and drop a filter pane into the sheet.
2. Click **Add dimension**.
3. Add a filter pane containing the field **Resource**.

Map properties

You open the properties panel for a visualization by clicking **Edit** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **in the lower right-hand corner to open it.**
3 Creating visualizations

If the visualization has 🗝 in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Common properties

Map settings

- **Base map**: Select the base map for the map chart. The following options are available:
  - **Default**: Use an OpenStreetMap-based map.
  - **Pale**: Use a paler version of the Default map.
  - **Satellite**: Use a satellite image map.
  - **None**: Use no map for the base map. This selection should be used if a background layer is going to be added to the map. **None** uses the background color from the current theme or the value defined for `mapChart.backgroundColor` in the current theme.

- **Projection**: Set the projection the map uses for locations and define what kind of coordinates the map uses. Each base map supports a set of projections. The following projections are available:
  - **Mercator**: Display the map using Mercator projection. Mercator projections require coordinates use WGS-84. Available with **Default**, **Pale**, **Satellite**, and **None** base maps.
  - **Adaptive**: Display the map in an adaptive projection that does not exaggerate the areas close to the poles as much when zoomed out. Available with **Default** and **Pale** base maps.
  - **Undefined degrees**: Display the map using coordinates in a degree-based coordinate system. If you are using a custom base map with custom coordinates that use degrees, select this option. All settings in **Location** except **Location field** are not compatible with this projection. Available with **None**.
  - **Undefined meters**: Display the map using coordinates in a degree-based coordinate system. If you are using a custom base map with custom coordinates that use meters, select this option. All settings in **Location** except **Location field** are not compatible with this projection. Available with **None**.

- **Map language**: Set the language for labels on the map.
  - **Auto**: Use English labels (where available) when the map view is zoomed out and local language labels when zoomed in.
  - **Local**: Use labels in the local language for the displayed country or region where available. **English**: Use English labels where available.
• **Map units**: Set the units of measure for the map. The following options are available:
  • Metric
  • Imperial
• **Selection method**: Sets how users can select multiple values on the map while holding down the Shift key:
  • None: Disable multiselect in the map using the Shift key and clicking and dragging the cursor.
  • Circle with distance: Select by dragging from a center point and out in a circle. The circle measures and presents the radius of the circle.
  • Lasso: Select by drawing the perimeter of an area.
• **Auto-zoom**: Set whether the map zooms to a selected locations when the selection changes.
• **Set default view**: Set the current view of the map as the default view of the map when the app is opened.

**Appearance**

**General**

• **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the map.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click **fx** if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=”Sales: ’ & Sum(Sales)”), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

**Alternate states**

• **State**: Set the state to apply to the visualization. You can select:
  • Any alternate state defined in **Master items**.
  • **<inherited>**, in which case the state defined for the sheet is used.
  • **<default state>**, which represents the state where no alternate state is applied.

**Legend**

• **Show legend**: Show or hide the legend for all layers.
• **Legend position**: Set the position of the legend relative to the map.

**Presentation**

• **Navigation**: Show navigation controls on top of map with buttons for panning, zooming, and returning to original position.
• **Show scale bar:** Select to show a scale bar for your map.

• **Limit zoom levels:** Set the zoom limits in the map.
  If set to **No**, the map can be zoomed in and out to the predefined limits in the base map.
  If set to **Custom**, the slider can be used to set limits:
  - Set the zoom out limit by adjusting the left side of the slider.
  - Set the zoom in limit by adjusting the right side of the slider.

• **Limit pan navigation:** Set limits on the vertical and horizontal movement of the map view, as well as limiting the zoom of the map.
  If set to **No**, there are no pan limits.
  If set to **Custom**, you set the pan limit to the current view of the map by clicking **Set pan limit**. When a pan limit is set, users cannot move the map view outside the bounds of the current view or zoom out past the current zoom level.

• **Show debug info:** Display resolution, scale, zoom level, and coordinates for the center of the displayed area.

Layer properties

**Data (Point layer, area layer, line layer, and density layer)**

• **Dimensions**
  - **Field:** The field or expression selected as the dimension for the layer. The dimension usually defines the locations on the layer, although you can change the field that defines locations in the **Location** properties settings.
  - **Label:** Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Include null values:** Select to include null values in the map. By default, this is selected.

**Data (Chart layer)**

• **Dimensions**
  - **Field:** The field or expression selected as the dimension for the layer. The first dimension usually defines the locations on the layer, although you can change the field that defines locations in the **Location** properties settings. The second dimension defines the dimension on the charts of the layer.
  - **Label:** Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Include null values:** Select to include null values in the map. By default, this is selected.
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation:** The default value.
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click \( \text{fix} \) to open the expression editor.
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click \( \text{fix} \) to open the expression editor.
3 Creating visualizations

- **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\text{fx}$ to open the expression editor.

- **Calculated on measure**: $<$measure$>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

- **Others label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label.

- **Measures**
  - **Expression**: The field or expression selected as the measure for the charts on the layer.
  - **Label**: Enter a label for the measure. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Number formatting**: Select to include null values in the map. By default, this is selected.

**Data (Background layer)**

- **Label**: Set the name of the background layer in the map.

- **Format**: The format of the service to which the background layer is connecting. The following formats are supported:
  - **TMS**
  - **WMS**

- **Image**: Background layers support the following image types:
  - .png
  - .jpg
  - .jpeg
  - .gif

- **URL**: (TMS and image only)
  - TMS: Enter the URL to a slippery or tile map server. You can use $\{z\}, \{x\}, \{y\}$ in the URL to select the correct tile. For example, http://tile.openstreetmap.org/$\{z\}/$\{x\}/$\{y\}.png. You can also use Bing Maps $\{$quadkey$\}$ in the URL to select the correct tile. You can use expressions between the curly brackets in the URL when defining $\{z\}, \{x\}, \{y\}$, or $\{$quadkey$\}$. The URL is an expression and if the URL changes, the background data is reloaded. The map server must produce tiles in the same projection type as is set for the map in Projection in Map settings to display layer data correctly.
  - Image: Enter the URL to the image.

- **Attribution**: Enter the attribution string for the map set in URL. HTML-style escaped characters, such as &copy, and HTML links, (<a> elements with href attributes) are allowed.

- **Advanced options**: (TMS only) Enables additional configuration options for TMS format maps. The following settings are available:
3 Creating visualizations

- **Tile size pixels**: Set the width and height of map tiles in pixels.
- **Tile width**: Set the tile width at level 0 (maximum zoom out) in the base map. The geographic unit is the one used by the base map.

  *For most base maps, the internal coordinate system uses Mercator with width in meters, even if the external coordinate system uses WGS-84 format degrees.*

- **Tile height**: Set the tile height at level 0 (maximum zoom out) in the base map. The geographic unit is the one used by the base map.

  *For most base maps, the internal coordinate system uses Mercator with height in meters, even if the external coordinate system uses WGS-84 format degrees.*

- **Origin X**: The origin of tiles in the x-axis. This field uses the same unit as **Tile height**. All tiles to the left of this origin use a negative value.
- **Origin Y**: The origin of tiles in the y-axis. This field uses the same unit as **Tile width**. All tiles above this origin use a negative value.

  *If $-y$ is used in the URL, the y-axis is reversed and all tiles below this value will have a negative value.*

- **WMS Setup**: (WMS only) Click to set up the WMS format background layer.
  - **WMS server URL**: Enter the URL to the WMS server.
  - **Version**: Select the WMS version. Qlik Sense supports:
    - 1.1.0
    - 1.1.1
    - 1.3.0
  - **Via server (CORS)**: Select this option if Qlik Sense fails to load information after you click **Load WMS**. If a browser does not allow loading data from another site, the Qlik GeoAnalytics server can load the capabilities information instead, enabling cross-origin resource sharing (CORS).
  - **CRS**: Select the coordinate reference system used by the WMS map.
  - **Transparent**: Select to make areas in the WMS map that have no data as transparent. This enables the WMS map can be overlaid another base map.

    *Support for transparency depends on your WMS.*

- **Layers**: Select the WMS layers to display in the map chart. The available layers depend on your source WMS map.
3 Creating visualizations

- **Image position**: (Image only) Set the coordinates of the image in the background layer.
  - **Top left corner**: Enter the coordinates for the location of the top left corner of the image.
  - **Bottom right corner**: Enter the coordinates for the location of the bottom right corner of the image.

**Sorting (Point layer, area layer, density layer, and chart layer)**

Click the dimension name to open the settings and click the sorting button to switch to Custom sorting. Sorting determines the order map locations are added. For example, if you have three overlapping points in a layer, sorting determines which point is on top. Sorting also determines which locations are displayed in a layer if you limit the number of visible map objects with Max visible objects. The sorting is either Ascending or Descending. The following sorting options are available:

- **Sort by expression**: Enter an expression to sort by.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Location**

- **(Line layer only)** Set what kind of data you are using for your lines.
  - **Start & end point**: Select to use two fields to set the start and end points. When selected, separate sections are added in Location for the start point and end point location settings.
  - **Line geometry**: Select to use GeoJSONLineString or MultiLineString format line geometry from a field. When selected, all other location settings are replaced with Line geometry field.
- **Latitude and Longitude fields**: (Point, Line, Density, and Chart layers only) Select to use separate latitude and longitude fields.
  If selected, Location field is replaced with the following fields:
  - **Latitude**: (Point, Line, Density, and Chart layers only) Enter the field or expression containing latitude data.
  - **Longitude**: (Point, Line, Density, and Chart layers only) Enter the field or expression containing longitude data.
- **Location field**: Enter the field or expression containing the locations to use in this layer. The field can contain geometries or the names of locations such as countries, cities, or postal codes.

> If there are multiple locations associated with dimension values, you should set a custom scope for locations or use an expression that contains qualifiers.

- **Scope for locations**: Set the scope of locations names the map chart uses to look for values contained in Location field. This improves accuracy when the name of a location is not globally unique or if you want one location per dimension value.
3 Creating visualizations

- **Auto**: Set the scope of locations to all any type of locations.
- **Custom**: Set the scope of locations to a custom set of locations.
  - **Location type**: Select the type of locations contained in **Location field**:
    - **Auto**: Any type of location.
    - **Continent**: Continent names.
    - **Country**: Country names.
    - **Country code (ISO 2)**: ISO alpha 2 country codes.
    - **Country code (ISO 3)**: ISO alpha 3 country codes.
    - **Administrative area (Level 1)**: First-level administrative area names. such as a state or province names.
    - **Administrative area (Level 2)**: Second-level administrative area names.
    - **Administrative area (Level 3)**: Third order administrative area names.
    - **Administrative area (Level 4)**: Fourth order administrative area names.
    - **Postal code/ZIP Code**: Postal codes or ZIP Codes.
    - **City, place**: City, village, or other populated place names.
    - **Airport code (IATA)**: IATA airport codes.
    - **Airport code (ICAO)**: ICAO airport codes.
  - **Country**: Enter a field or expression containing country names or country codes for the locations in **Location field**.
  - **Administrative area (Level 1)**: Enter a field or expression containing first-order administrative area names or codes for the locations in **Location field**.
  - **Administrative area (Level 2)**: Enter a field or expression containing second-order administrative area names or codes for locations in **Location field**.

**Size & Shape (Point layer)**

- **Size by**: Enter a field or expression to control the size of the symbol. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the field in **<Symbol> size range**, unless the **Range** is set to **Custom**.
- **Label**: Set a label for the **Size by** property.
- **<Symbol> size range**: Set a minimum and maximum size range limit for the selected symbol for your point layer.
- **Range**: Set the value limits for the size range.
  - **Auto**: The symbol size range maps to the minimum and maximum value of the **Size by** field.
  - **Custom**: The symbol size range maps to the minimum and maximum values set in **Minimum size value** and **Maximum size value**. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.
- **Shape**: Select the shape for your point layer. The following shapes are available:
  - Bubble
  - Triangle
  - Square
- Pentagon
- Hexagon

**Size & Shape (Chart layer)**

- **Pie chart**
  - **Size by**: Enter a field or expression to control the size of the pie charts. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the pie charts, unless the **Range** is set to **Custom**.
  - **Label**: Set a label for the **Size by** property.
  - **Pie chart size range**: Set a minimum and maximum size range limit for the pie charts for your chart layer.
  - **Range**: Set the value limits for the size range.
    - **Auto**: The size range maps to the minimum and maximum value of the **Size by** field.
    - **Custom**: The size range maps to the minimum and maximum values set in **Minimum size value** and **Maximum size value**. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.

- **Bar chart**
  - **Height**: Set a height size for the bar charts for your chart layer.
  - **Width**: Set a width size for the bar charts for your chart layer.

**Width & Style (Line layer only)**

- **Width by**: Enter a field or expression to control the width of the lines. The minimum and maximum values in the data are mapped to the minimum and maximum sizes of the field in **Line size width range**, unless the **Range** is set to **Custom**.
- **Label**: Set a label for the **Width by** property.
- **Line size width range**: If you are using **Width by**, set the minimum and maximum width of the lines.
- **Line width**: Set the width of the lines.
- **Range**: Set the value limits for line width.
  - **Auto**: The line width range maps to the minimum and maximum value of the **Width by** field.
  - **Custom**: The line width range maps to the minimum and maximum values set in **Minimum line value** and **Maximum line value**. Values exceeding the minimum and maximum values will use the same settings as the minimum and maximum values.
- **Line curve**: Set the curvature of the lines in your line layer.
- **Arrow**: Set the style of the arrows for your lines. The following options are available:
  - **None**: No arrow is added to your line.
  - **Forward**: An arrow is added in the direction of the last point of the line.
  - **Backward**: An arrow is added in the direction of the first point of the line.
  - **Both**: Arrows are added facing both the first and last point of the line.
- **Arrow position**: Set the position of the arrow in the line.
**Weight & Radius (Density layer only)**

- **Weight by:** Enter a field or expression to control how much each point contributes to the density. The default weight value is 1.
- **Label:** Set a label for the Weight by property.
- **Influence radius:** Set the radius of the circular area that each point influences. The unit of measure for the radius is set by Radius unit.
- **Radius unit:** Set the unit of measure for the radius of influence. The following options are available:
  - **Pixels:** Screen pixels.
  - **Meters:** Map meters.
  - **Feet:** Map feet.

**Colors (Point layer, area layer, line layer, chart layer, and background layer)**

- **Colors:** Select how the map values are colored. There are two settings:
  - **Auto:** Colors the map values using default settings.
  - **Custom:** Manually select the method of coloring your values in the map. The following methods are available:
    - **Single color:** Color the map using a single color (by default blue). When selected, the following settings are available:
      - **Color:** Select the color to use for objects in the layer.
      - **Outline color:** Select the outline color for objects in the layer.
    - **By dimension:** Color the map by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      - **Select dimension:** Enter a field or expression containing the values to color objects in this layer.
      - **Library colors:** Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
      - **Persistent colors:** Select to have colors remain the same between selection states.
      - **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
  - **By measure:**
    - **Select measure:** Select the measure to use to color your layer.
    - **Label:** Enter text or an expression for the measure that displays in the legend.
    - **Color scheme:** Select a color scheme from the following options:
      - **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
      - **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
3 Creating visualizations

- **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.

- **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the Min and Max values for the color range.

- **By expression**: Color the map using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click $\text{fx}$ to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

  - **Outline color**: Select the color for the outline of the shapes in the map.

  - **Outline opacity**: (Point, chart, and area layers only) Set how opaque the outline of shapes in the map is.

- **Opacity**: Set how opaque the layer is over the base map.

**Colors (Density layer)**

- **Segment Colors**: Select how the influence area of the points is colored. There are two settings:
  - **Auto**: Colors the influence area using default settings.
  - **Custom**: Manually select the method of coloring the influence area in the map.

  - **Add limit**: Adds a segment to the gauge. Use the slider or type an expression to set the limit of the segment. Click $\text{fx}$ to open the expression editor. You can add several segments. Click the segment to change colors.

    - **Gradient**: Select to use different shades of colors in the transition between the segments.

    - **Remove limit**: Click to remove the selected limit.

  - **Range**: Define the range of values used to color the influence area. There are two settings:
3 Creating visualizations

- **Auto**: Sets the range of values using default settings.
- **Custom**: Manually select the range of values coloring the influence area.
  - **Min**: Set the minimum value for the range. Click $\text{fx}$ if you want to create an expression.
  - **Max**: Set the maximum value for the range. Click $\text{fx}$ if you want to create an expression.
- **Opacity**: Set how opaque the layer is over the base map.

**Options**

**General**

- **Show legend**: Display a legend if there is enough space on the map. You can set a size for the legend or let Qlik Sense automatically determine the size. The placement can be changed using **Legend position**.
- **Show size legend**: (Point, line, and chart layers only) Display a legend for point, line, or chart size.
- **Show tooltip**: (Point, area, chart, and line layers only) Display a tooltip over the displayed locations in a layer with the location's value.
- **Max visible objects**: (Point, area, density, chart, and line layers only) Set the maximum locations to display in the layer. The maximum number of values in a map layer is 50,000 for point layers, 10,000 for area layers, 20,000 for line layers, 50,000 for density layers, and 50,000 for chart layers. By default, map layers display a maximum of 4,000 values for point layers and 1,000 for other layers.
- **Show label**: (Point, area, chart, and line layers only) Set whether to include a text label with the layer’s locations on your map.
  - **Labels**: Set the label for the locations in this layer.
  - **Label position**: Set the position of the label relative to the location.
  - **Show in zoom levels**: Set the label to be visible at all zoom levels or at a select range of zoom levels.

**Layer display**

- **Show layer**: Select to show or hide layer.
- **Show in zoom levels**: Set the layer to be visible at all zoom levels or at a select range of zoom levels.
- **Visible drill-down levels**: Set which dimensions in the drill-down are displayed with this layer.
- **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: \( \text{count(distinct Team)} < 3 \). If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

**Pie chart**

The pie chart displays the relation between values as well as the relation of a single value to the total. You can use a pie chart when you have a single data series with only positive values.
In the pie chart, the dimensions form sectors of the measure values. A pie chart can have one dimension and up to two measures. The first measure is used to determine the angle of each slice in the chart.

*Sales per region in a pie chart.*

Optionally, a second measure can be used to determine the radius of each pie slice. This style of pie chart is also known as a rose chart.

*Sales by product sub group in a pie chart with the average sales per invoice sales determining slice radius*
In the pie presentation of the pie chart, negative values in the radius measure are not supported and will be excluded. Negative values in the radius measure are supported in the donut presentation and will point in towards the center of the pie chart.

_Sales by product sub group in a pie chart with radius measure containing a comparison of sales from the previous year_
When to use it

The primary use of a pie chart is to compare a certain sector to the total. The pie chart is particularly useful when there are only two sectors, for example yes/no or queued/finished.

We do not recommend that you compare the results of two pie charts with each other.

Advantages

The pie chart provides an instant understanding of proportions when few sectors are used as dimensions. When you use 10 sectors, or less, the pie chart keeps its visual efficiency.

Disadvantages

It may be difficult to compare different sectors of a pie chart, especially a chart with many sectors.

The pie chart takes up a lot of space in relation to the values it visualizes.
Creating visualizations

Creating a pie chart

You can create a pie chart on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty pie chart to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

The following settings are used by default in a pie chart:

- The top 10 sectors are presented in descending size order, clockwise.
- Colors are presented by dimension.
- Value labels are presented in percent.

After you have created the pie chart, you may want to add a radius measure or adjust its appearance and other settings in the properties panel.

Pie chart properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click the icon in the lower right-hand corner to open it.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add to add a dimension or a measure.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

Dimensions

On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.
3 Creating visualizations

You can also click $\mathbf{fx}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

$$=\text{If (Week < 14, Week, 'Sales')}$$

If Add is dimmed, you cannot add more dimensions.

The following properties are available for dimensions:

- **<Dimension name>:** Click the dimension name to open the dimension settings. If you want to delete the dimension, long-touch/right-click the dimension and select \(\mathbb{H}\) in the dialog. Alternatively, click the dimension and click \(\mathbb{H}\).
  - **Field:** If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click $\mathbf{fx}$ to open the expression editor.
  - **Label:** Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
  - **Dimension:** Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Includenull values:** When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation:** Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation:** The default value.
    - **Fixed number:** Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Exact value:** Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Relative value:** Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
    - **Calculated on measure:** $<$measure$: $Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
    - **Show others:** When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
    - **Other label:** Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathbf{fx}$ to open the expression editor.
  - **Add alternative:** Alternative dimensions and measures are dimensions and measures that are added to
a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

**Measures**

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure. Pie charts require a measure for Angle, but optionally a measure can be added for Radius, which determines the radius of each slice of the pie chart.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathcal{f}x$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is dimmed, you cannot add more measures.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

The following properties are available for measures:

- **<Measure name>**:
  
  - **Expression**: Click $\mathcal{f}x$ to open the expression editor. The existing expression is displayed by default.
  
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

  The following number formats are available:

  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

**Examples**:

- # ##0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.

- ###0 describes the number as an integer without a thousands separator.
• 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
• 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

• **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

• **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

• **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

• **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

• **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  - **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

**Sorting**

Drag the dimension and measure to set the sorting priority order. The numbers show the order.

The dimension and measure can be sorted internally.

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options:

• **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
• **Sort numerically**
• **Sort alphabetically**

The sorting is either **Ascending** or **Descending**.

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.
Add-ons

- **Data handling: Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.

A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart.

  Enter **Title, Subtitle, and Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click **fx** if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: `Sales: ‘ & Sum(Sales)`.

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (="Sales: ‘ & Sum(Sales)"), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

- **State:** Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

**Presentation**

- **Pie/Donut:** Select to present the chart as a pie or as a donut.
- **Dimension label:** When set to **Auto**, the label is displayed if there is enough space.
- **Value labels:**
  - **Auto:** The measure values are displayed as a percentage of the whole.
  - **Custom:** Select how to display the measure values.
    - **None:** No measure values are displayed.
    - **Share:** The measure values are displayed as a percentage of the whole (default setting).
3 Creating visualizations

- **Values**: The regular measure values are displayed.
  - **Label measure**: Select whether to use the values from the Angle measure or the Radius measure.

**Colors and legends**

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
  - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
    - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
    - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
    - **Persistent colors**: Select to have colors remain the same between selection states.
    - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By measure**:
  - **Select measure**: Select the measure to use to color your chart.
  - **Label**: Enter text or an expression for the measure that displays in the legend.
  - **Color scheme**: Select a color scheme from the following options:
    - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.
• **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

• **Reverse colors**: When selected, the color scheme is reversed.

• **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the **Min** and **Max** values for the color range.

• **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \(\text{\text{x}}\) to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see **Coloring a visualization** (page 387).

When the coloring is by measure or by expression, you can set the color range (\(\text{Min}\) and \(\text{Max}\) values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

• **Show legend**: Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.

• **Legend position**: Select where to display the legend.

• **Show legend title**: When selected, the legend title is displayed.

**Pivot table**

The pivot table presents dimensions and measures as rows and columns in a table. In a pivot table you can analyze data by multiple measures and in multiple dimensions at the same time. You can rearrange the measures and dimensions to get different views of the data. The activity of moving measures and dimensions interchangeably between rows and columns is known as “pivoting”.
Creating visualizations

3  When to use it

The pivot table is particularly useful when you want to include several dimensions or measures in a single table, and then want to reorganize them to see different subtotals.

Advantages

The pivot table is very powerful when you want to analyze multiple dimensions and measures at once, and then reorganize them to get a different perspective on your data. Another advantage is that you can expand the rows you are interested in while keeping the rows in the rest of the table collapsed.

Disadvantages

The pivot table may seem a bit complicated, and does not give insights at a glance.

Creating a pivot table

You can create a new pivot table on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty pivot table to the sheet.
2. Click **Add dimension** and select a dimension or a field.
3. Click **Add measure** and select a measure or create a measure from a field.

When you have created the pivot table, you may want to adjust its appearance and other settings in the properties panel.
Pivoting
When you want to rearrange your data to get a new view, you drag the items to the new place, either to a column or a row. In the following pivot table, the dimension Customer has been dragged to the position after Product Group and the dimension Item to the position before Product Group. As a consequence, the dimensions are now sorted by Item, primarily. Focus has shifted from Customer to Item. By expanding the dimensions you can find out the quantities and sales for each customer, but there is another way to achieve that goal.

By moving the dimension Customer from rows to columns, you retain focus on the dimension Item, but you also get the distribution of items per customer. The move has made the pivot table more information dense.

Measure grouping
As you may have noticed, Quantity and Sales are not presented as separate measures in the top column row. Next to the dimension Customer, you find an item called Measures. When you use more than one measure, the measures are automatically grouped together forming a measure group, Measures, which as a whole can be added to the rows section or the columns section. The measure group is not editable in the table. You cannot split the measure item and use one measure as a row and another as a column, nor can you change the order in which the measures are presented. Changes to the Measures item are made in the properties panel.
Creating visualizations

Different ways of pivoting
Essentially, pivoting involves dragging the dimensions and measures from rows to columns and columns to rows, but you have two options for performing the pivoting.

- In the pivot table (both when editing and when analyzing).
- In the properties panel (only when editing).

Pivoting using the properties panel
In the properties panel, you can add measures and dimensions to the pivot table, and also move the dimensions and measures to rows or columns. When you use more than one measure, the measures are grouped and a *Measures* item is created. You can change the internal order of the dimensions and measures, but when you have more than one measure, it is always the whole measure group that you move.
Global grouping

With global grouping you use a limited data set, and in that data set, you single out values that you want to focus on, for example, the best quarters, the top sales persons, or the worst selling products.

You can regard global grouping as a two-step procedure. First you apply a limitation to a data set, and then, in the resulting list, you apply the same limitation again to the inner dimension (that is, the dimension that is second in the sorting hierarchy), to only show results for the singled out inner dimension values.
Creating visualizations

Example:

In the following pivot table, no limitation is applied. The values are sorted on *Sales*, descending. The list is long, the values for 2013 are not shown.

<table>
<thead>
<tr>
<th>Year</th>
<th>Sales Rep Name</th>
<th>sum(Sales)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Judy Thurman</td>
<td>$6,037,992.86</td>
</tr>
<tr>
<td></td>
<td>Stewart Wind</td>
<td>$4,717,671.77</td>
</tr>
<tr>
<td></td>
<td>Lee Chin</td>
<td>$3,535,768.74</td>
</tr>
<tr>
<td></td>
<td>Cheryle Sincock</td>
<td>$1,791,498.68</td>
</tr>
<tr>
<td></td>
<td>Brenda Gibson</td>
<td>$1,750,292.96</td>
</tr>
<tr>
<td></td>
<td>John Greg</td>
<td>$1,443,128.36</td>
</tr>
<tr>
<td></td>
<td>Martha Richard</td>
<td>$1,388,402.75</td>
</tr>
<tr>
<td></td>
<td>Amalia Craig</td>
<td>$1,200,853.57</td>
</tr>
<tr>
<td></td>
<td>David Laychak</td>
<td>$1,170,791.14</td>
</tr>
<tr>
<td></td>
<td>Kari Anderson</td>
<td>$957,467.35</td>
</tr>
<tr>
<td></td>
<td>Max Blagburn</td>
<td>$940,445.81</td>
</tr>
<tr>
<td></td>
<td>David Howard</td>
<td>$850,675.53</td>
</tr>
<tr>
<td></td>
<td>Angelen Carter</td>
<td>$810,618.88</td>
</tr>
<tr>
<td></td>
<td>Amanda Honda</td>
<td>$704,245.66</td>
</tr>
<tr>
<td></td>
<td>Amelia Fields</td>
<td>$635,124.63</td>
</tr>
<tr>
<td></td>
<td>Donna Brown</td>
<td>$603,055.36</td>
</tr>
<tr>
<td></td>
<td>Peggie Hurt</td>
<td>$525,843.84</td>
</tr>
<tr>
<td></td>
<td>Craig Amundson</td>
<td>$495,495.93</td>
</tr>
<tr>
<td></td>
<td>Micheal Williams</td>
<td>$469,045.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$482,024.22</td>
</tr>
</tbody>
</table>

In the following pivot table, a limitation has been applied to the (inner) dimension *Sales Rep Name*, so that only the top five sales representatives for the years 2013 and 2014 are shown.
3 Creating visualizations

The next step is to select global grouping in the properties panel. The option **Global grouping** is only available when you have applied a limitation on the dimension.

When global grouping is selected, the limitation of the top five sales representatives is applied again, but this time regardless of the dimension Year. The five sales representatives with the highest sales (either in 2013 or 2014) are the only ones that will be presented in the final pivot table.

The following image shows the six highest results for 2014 and 2013. The top four results are from 2014, but the fifth (John Greg) is from 2013. Because five other sales representatives have higher sales than **Brenda Gibson** (who was number five in 2014), she is knocked out of the list.

The following image shows the pivot table with global grouping applied. The pivot table only contains the sales results for the top five sales representatives. Even though **Brenda Gibson** had a better result in 2014 than John Greg, his result for 2013 qualified him for the top five list.
Creating visualizations

3 Viewing precise values for several dimensions and measures with a pivot table

The efficiency of a pivot table can be illustrated by comparing a regular table with a pivot table that has the same data.

Dataset

In the following table, you have three dimensions: Customer, Product Group, and Item, and two measures: Quantity and Sales.

The table shows the sales of some food products. If you want to rearrange the data to simplify analysis, the options are somewhat limited. You can change the order of the columns, but that does not improve the overview. You can also set the sorting order, either in the sorting section in the properties panel, or by clicking the dimension columns. However, the problem persists. The customers, product groups, and items are all presented more than once, and it is not possible to get a good summary of the data.
3  Creating visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Product Group</th>
<th>Item</th>
<th>Quantity</th>
<th>Quantity</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td>1,818,294</td>
<td>$104,852,674.81</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Good Light Wine</td>
<td>2</td>
<td>$337.58</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Pearl Chardonnay</td>
<td>8</td>
<td>$513.80</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Pearl Light Beer</td>
<td>1</td>
<td>$69.10</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Alcoholic Beverages</td>
<td>Watrus Light Wine</td>
<td>7</td>
<td>$34.66</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Colony Pumpernickel Bread</td>
<td>2</td>
<td>$9.54</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Colony Wheat Bread</td>
<td>1</td>
<td>$74.73</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baked Goods</td>
<td>Great Blueberry Muffins</td>
<td>3</td>
<td>$149.92</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBB Best Apple Butter</td>
<td>6</td>
<td>$211.35</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBB Best Apple Preserves</td>
<td>2</td>
<td>$276.26</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBB Best Extra Chunky Peanut Butter</td>
<td>1</td>
<td>$17.40</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBB Best Grape Jam</td>
<td>1</td>
<td>$33.75</td>
<td></td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>BBB Best Pepper</td>
<td>4</td>
<td>$338.97</td>
<td></td>
</tr>
</tbody>
</table>

Visualization
We add a pivot table to the sheet and use the same three dimensions: Customer, Product Group, and Item, and two measures: Quantity and Sales.
Discovery

As you can see, the pivot table presents the data in a much more condensed way, which simplifies analysis and comparison. Compared to the regular table, the number of rows has been halved in the pivot table and the number of columns is three instead of five.

One of the advantages of a pivot table is the interchangeability, that is, the ability to move row items to columns and column items to rows. This flexibility is very powerful and enables you to rearrange the data and have several different views of the same data set. Depending on what you want to focus on, you move the dimensions and measures to bring forward data of interest and hide data that is either too detailed, or irrelevant for the analysis.

The pivot table shows the dimensions Customer, Product Group, and Item, and the measures Quantity and Sales. In this view, you have a summary of quantity and sales for each customer. If you want to know which items and product groups that the customers bought, you need to expand the customer fields by clicking ▶. A ▶ icon indicates that a field can be further expanded and present more details, while a ▶ icon indicates that the field can be collapsed, to reduce the number of fields and details.

Pivot table properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.
3 Creating visualizations

If the visualization has 📌 in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click **Add data** to add a row, column, or a measure. When you select **Row** or **Column**, you can only add dimensions. By default, dimensions are added to the rows section and measures to the columns section. But once an item has been added, you can move it.

Dimensions
- **<Dimension name>**: Click the dimension name to open the dimension settings.
  
  If you want to delete the dimension, long-touch/right-click the dimension and select 📐 in the dialog. Alternatively, click the dimension and click ✎.

  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click 🕵️‍♂️ to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click 🕵️‍♂️ to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click 🕵️‍♂️ to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click 🕵️‍♂️ to open the expression editor.
    - **Calculated on measure**: `<measure>`: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
• **Show column if**: You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown. You can use this to require a field selection before calculating and showing large amounts of data.

• **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

• **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click \( \text{fx} \) to open the expression editor.
  - **Add**: On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use. You can also click \( \text{fx} \) to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.

• **Global grouping**: If a limitation is set, you can use global grouping.

• **Show totals**: Adds a top row in the pivot table showing the total value of the underlying rows. Show totals is not available for dimensions (except the first one) when Indent rows is selected in the Appearance property.

• **Totals label**: Enter a label for the totals row.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

**Measure**

- `<Measure name>`: Click the measure to open the measure settings.

  If you want to delete the measure, long-touch/right-click the measure and select \( \text{trash} \) in the dialog. Alternatively, click the measure and click \( \text{trash} \).

- **Expression**: Click \( \text{fx} \) to open the expression editor. The existing expression is displayed by default.

- **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.

- **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
3 Creating visualizations

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `# #0` describes the number as an integer with a thousands separator. In this example `" "` is used as a thousands separator.
- `##0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as `0123`.
- `0.00` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

  **Limitations:**
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Show column if**: You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown.

- **Background color expression**: Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

- **Text color expression**: Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.
You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Each of the dimensions and measures can also be sorted internally:

Click the dimension or measure name to open the settings and click the sorting button to switch to **Custom** sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either **Ascending** or **Descending**.

- **Sort by expression**: Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to **Custom** and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in **Sorting**.

**Add-ons**

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value ‘0’ are not included in the presentation. If there is more than one measure value, all the measure values must have the value ‘0’ to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
  
  A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

**Appearance**

**General**

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.

  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click $\mathfrak{f}$ if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: `Sales: ' & Sum(Sales)`.

---

3 Creating visualizations
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

**Alternate states**

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - <inherited>, in which case the state defined for the sheet is used.
  - <default state>, which represents the state where no alternate state is applied.

**Presentation**

- **Fully expanded**: When selected, all values in the pivot table are displayed.
- **Indent rows**: When selected, an indentation is added to the beginning of each row.

**Scatter plot**

The scatter plot presents pairs of values from two or three measures. This is useful when you want to show data where each instance has two numbers, for example, the relationship between Sales and Quantity per Customer. In the scatter plot below, a third measure (Cost) is used to generate the bubble size.

*Scatter plot displaying the relationship between Sales and Quantity per Customer.*

The scatter plot presents values from different measures over one dimension as a collection of points. In most charts, you find your dimension on one of the axes, but for a scatter plot, the dimension is represented by the
points in the chart, and the measures are found on each of the two axes. When a third, optional, measure is used, its value is reflected in the bubble size. If you are analyzing large data sets and view compressed data, the density of the data points is reflected by color.

When to use it
The scatter plot helps you find potential relationships between values, and to find outliers in data sets. The scatter plot is useful when you want to show data where each instance has at least two metrics, for example, average life expectancy and average gross domestic product per capita in different countries.

Advantages
The scatter plot is a great way to visualize the correlation of two or more measures at the same time. The third measure is an efficient way of differentiating between values and simplifying the identification of, for example, large countries, large customers, large quantities, and so on.

Disadvantages
The scatter plot may be difficult to understand for an inexperienced user, because it has measure value on both axes, and the third, optional, measure adds complexity to the interpretation. Make sure a novice can interpret the scatter plot correctly. Using descriptive labels is a good way to make the visualization easier to interpret.

Values may be placed on top of each other and are then not visible until you zoom in.

Creating a scatter plot
You can create a scatter plot on the sheet you are editing.

In a scatter plot you need one dimension and at least two measures. You can have maximum one dimension and three measures, where the third measure is visualized as bubble size.

Do the following:

1. From the assets panel, drag an empty scatter plot to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.
4. Click Add measure and select a measure or create a measure from a field.
5. Optionally, if you want bubble size to be set according to a third measure:
   Click Add measure and select a measure or create a measure from a field.

When you have created the scatter plot, you may want to adjust its appearance and other settings in the properties panel.

Display limitations
Large data sets in scatter plots
If you have a scatter plot with large amounts of data (more than 1000 data points) Qlik Sense uses an algorithm to create an overview of the data, as shown in the scatter plot below. However, if you zoom or make selections so that the number of displayed data points is reduced to less than 1000 data points, the data will be shown as individual bubbles. This switch between compressed view and bubble view is done automatically. The density of the data points is reflected by color.
**Zooming and panning**

In a scatter plot, you can zoom and pan around in your data. The interaction differs depending on what device you are using. If you are zooming in you can see where in the data set you are located by looking at the mini chart in the bottom right corner. If you zoom in on large data sets you will be able to see the data shown as boxes with values inside. The values represent the number of points in each box. If you zoom in so that there are <1000 data points, you will instead see the data points represented by bubbles.

Zooming and panning is not possible when you have made a selection in the compressed data view.

You can change the compression resolution in the visual exploration menu or in the properties panel.


### Coloring

Compressed scatter plots are always auto-colored by the primary data color. That means that any custom color definition made will not affect compressed data.

However, if you zoom or make selections so that the number of displayed data points is reduced to less than 1000 data points, the data will be colored as defined.

### Scatter plot properties

You open the properties panel for a visualization by clicking the **Edit** button in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click the button in the lower right-hand corner to open it.

*If the visualization has a symbol in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.*

*Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.*

### Data

Click **Add** to add a dimension or a measure.

#### Dimensions

On the **Data** tab, under **Dimensions**, click **Add** to open a list of available **Dimensions** and **Fields**. Select the dimension or field that you want to use.

You can also click the symbol to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

```
=If (Week < 14, Week, 'Sales')
```

If **Add** is dimmed, you cannot add more dimensions.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  
  If you want to delete the dimension, long-touch/right-click the dimension and select **Delete** in the dialog.
  
  Alternatively, click the dimension and click **Delete**.

- **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
3 Creating visualizations

- **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click $\mathbf{fx}$ to open the expression editor.
- **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
- **Includenull values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
- **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
  - **No limitation**: The default value.
  - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Calculated on measure**: `<measure>`: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
  - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
    This option is not available in box plot dimensions.
  - **Other label**: Enter a label for the summarized values (when Show others is selected). You can also use an expression as a label. Click $\mathbf{fx}$ to open the expression editor.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click $\mathbf{fx}$ to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.
3 Creating visualizations

If **Add** is dimmed, you cannot add more measures.

- **<Measure name>**:
  - **Expression**: Click $\mathbf{fx}$ to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples**:

- `##0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.
- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.
3 Creating visualizations

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.
- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.
  - Limitations:
    - Only works with visualizations that accept measures.
    - Does not affect the number formatting of the axis.

**Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag a field from **Dimensions** to **Measures** to change how it is used. Moving a dimension to **Measures** assigns it an aggregation. You cannot drag a master dimension to **Measures**.

**Add-ons**

- **X-axis reference lines**:
  - **Add reference line**: Click to add a new reference line.
  - **Show**: When selected, the reference line is displayed.
  - **Label**: Enter a label for the reference line.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
  - **Delete**: Click to remove the reference line.

- **Y-axis reference lines**:
  - **Add reference line**: Click to add a new reference line.
  - **Show**: When selected, the reference line is displayed.
  - **Label**: Enter a label for the reference line.
  - **Color**: In the color picker, select the color of the reference line and the label.
  - **Reference line expression**: Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
  - **Delete**: Click to remove the reference line.

- **Data handling**:
  - **Include zero values**: When unselected, measures that have the value '0' are not included in the presentation. If there is more than one measure value, all the measure values must have the value '0' to be excluded from the presentation.
  - **Calculation condition**: Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula.
For example: count(distinct Team)<3. If the condition is not fulfilled, the message or expression entered in Displayed message is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

General

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click **fix** if you want to create an expression by using the expression editor.

  **Example:**

  Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).
  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=′Sales: ′ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in Master items.
  - **<inherited>**, in which case the state defined for the sheet is used.
  - **<default state>**, which represents the state where no alternate state is applied.

Presentation

- **Navigation**: By default, off. When set to Auto, the navigation tool is displayed, with options to pan and zoom.

- **Bubble size**: Set the size of the data point bubbles.
  For a scatter plot with two measures, this sets the uniform size of all bubbles.
  For a scatter plot with three measures, this sets the scale of the bubble sizes. In a scatter plot with three measures, the third measure controls the size of each bubble.

- **Labels**: Select what labels to display, you have three options:
  - **Auto**: The number of labels displayed varies with the size of the visualization
  - **All**: All labels are displayed. This option may cause labels to overlap.
  - **None**: No labels are displayed.

- **Compression resolution**: Set the resolution for compressed data. Only available for large data sets
3 Creating visualizations

 (>1000 data points).

- **Grid line spacing**: Select the spacing of the grid lines. The **Auto** setting is **Medium**.

**Colors and legends**

You can set the presentation colors of the distribution plot. You only need to select **Custom** if you want to change the settings.

- **Colors**: Select how the chart values are colored. There are two settings:
  - **Auto**: Colors the chart values using default settings.
  - **Custom**: Manually select the method of coloring your values in the chart. The following methods are available:
    - **Single color**: Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    - **Use library colors**: Option available when a master dimension used in the visualization has a color assigned to it. You can select to use the master dimension color or to disable the master dimension color.
  - **By dimension**: Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
    - **Select dimension**: Enter a field or expression containing the values to color objects in this chart.
    - **Library colors**: Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
    - **Persistent colors**: Select to have colors remain the same between selection states.
    - **Color scheme**: Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.

- **By measure**:
  - **Select measure**: Select the measure to use to color your chart.
  - **Library colors**: Select whether to use the master measure color or to disable the master measure color. Option available only when a master measure used in the visualization has assigned colors.
  - **Label**: Enter text or an expression for the measure that displays in the legend.
  - **Color scheme**: Select a color scheme from the following options:
    - **Sequential gradient**: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
    - **Sequential classes**: The transition between the different color groups is made using distinctly different colors.
    - **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas.
on a chart. Low and high values have dark colors, mid-range colors are light.

- **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the Min and Max values for the color range.

- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \( \text{fix} \) to open the expression editor.

- **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.
  For more information, see *Coloring a visualization* (page 387)
  When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option **The expression is a color code** must be cleared before you can set the color range.

- **Show legend**: Not available when **Single color** is selected. By default set to **Off**. The legend is displayed if there is enough space. The placement can be changed in the **Legend position** setting.

- **Legend position**: Select where to display the legend.

- **Show legend title**: When selected, the legend title is displayed.

**X-axis**

- **Labels and title**: Select what to display of labels and title.

- **Position**: Select where to display the axis.

- **Scale**: Set the spacing of the axis scale.

- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

**Y-axis**

- **Labels and title**: Select what to display of labels and title.

- **Position**: Select where to display the axis.

- **Scale**: Set the spacing of the axis scale.

- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.
Table

The table shows several fields simultaneously, where the content of each row is logically connected. Typically, a table consists of one dimension and several measures.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Sales</th>
<th>Quantity</th>
<th>Margin(%)</th>
<th># of Invoices</th>
<th>Average Sales per Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>$164,052,074.81</td>
<td>1,816,372</td>
<td>6127.81</td>
<td>30,314</td>
<td>$2,735.97</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>$196,288.49</td>
<td>1,418</td>
<td>3841.78</td>
<td>98</td>
<td>$2,384.40</td>
</tr>
<tr>
<td>A-ARVIN Laser Resources</td>
<td>$4,053.85</td>
<td>25</td>
<td>3702.65</td>
<td>13</td>
<td>$311.77</td>
</tr>
<tr>
<td>A Superior System</td>
<td>$163,726.12</td>
<td>868</td>
<td>4974.5%</td>
<td>167</td>
<td>$562.13</td>
</tr>
<tr>
<td>A&amp;B</td>
<td>$22,120.09</td>
<td>891</td>
<td>4202.0%</td>
<td>18</td>
<td>$1,117.81</td>
</tr>
<tr>
<td>A &amp; G</td>
<td>$11,502.61</td>
<td>133</td>
<td>4708.0%</td>
<td>12</td>
<td>$941.68</td>
</tr>
<tr>
<td>A&amp;R Partners</td>
<td>$36,392.45</td>
<td>156</td>
<td>3469.9%</td>
<td>6</td>
<td>$5,005.41</td>
</tr>
<tr>
<td>A1 Datacom Supply</td>
<td>$250,500.52</td>
<td>5,830</td>
<td>4925.7%</td>
<td>111</td>
<td>$2,338.73</td>
</tr>
<tr>
<td>a2l</td>
<td>$451.64</td>
<td>14</td>
<td>5963.7%</td>
<td>9</td>
<td>$59.18</td>
</tr>
<tr>
<td>A2Z Solutions</td>
<td>$69,977.36</td>
<td>454</td>
<td>4121.1%</td>
<td>94</td>
<td>$744.44</td>
</tr>
<tr>
<td>AA-Wizard</td>
<td>$94,289.44</td>
<td>917</td>
<td>4668.0%</td>
<td>41</td>
<td>$2,297.79</td>
</tr>
</tbody>
</table>

You only make selections in the dimension columns. All dimension columns have a search icon (🔍) in the header.

When to use it

Use a table, when you want to view detailed data and precise values rather than visualizations of values. Tables are good when you want to compare individual values. Drill-down group dimensions are very efficient in tables. Within a limited space, you can drill down to the next level of detail and analyze the updated measure values.

Advantages

You can filter and sort the table in different ways. Many values can be included in a table, and when you drill down in a table, you make good use of a limited space of the sheet. A table is excellent when you want to see exact values rather than trends or patterns.

Disadvantages

If the table contains many values, it is difficult to get an overview of how values are related. It is also hard to identify an irregularity within the table.

Creating a table

You can create a new table on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty table to the sheet.
2. Click Add dimension and select a dimension or a field.
3. Click Add measure and select a measure or create a measure from a field.

When you have created the table, you may want to adjust its appearance and other settings in the properties panel.
Aligning data

If **Text alignment** is set to **Auto**, column data is aligned according to data type: text values are left-aligned and number values, including date related values, are right-aligned. If you set it to **Custom**, you can select to align the data to the left or to the right.

Sorting the table

You can adjust the sorting of the table in several ways:

- Column sorting - adjust the order of the dimensions and measures from left to right
- Row sorting - adjust the sorting priority order of the rows
- Internal sorting - use the internal sorting order of dimensions and measures
- Interactive sorting - during analysis you can click on a column header to sort the table

**Column sorting**

By default, the order in which columns are sorted is set by the order in which dimensions and measures are added to the table. If you add the measure **Sales** first, it is presented first (leftmost) in the table. The next dimension or measure that is added is presented in the second column, and so on. The column sorting order can be changed in the properties panel, under **Columns**.

**Row sorting**

By default, rows are sorted by the first added dimension or measure, numeric values descending, text values ascending. A small arrow under the column header shows by which column the table is sorted.

You can change the row sorting in the properties panel, under **Sorting**. Drag the dimensions and measures to change the sorting priority order. In many cases, sorting is not only affected by the first dimension or measure in **Sorting**, but also the following ones.

**Example:**

In the following screenshot, the rows are first sorted by **Customer**, then by **Month**, and then by **Product Type**. As you can see, the columns **Customer** and **Month** have several rows with the same values (**A-2-Z Solutions** and **Month**). The rows in **Product Type** are ordered alphabetically, but only those that were sold in January to the customer **A-2-Z Solutions** are displayed.
3 Creating visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Month</th>
<th>Product Type</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td>184,852,674.81</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Baking Goods</td>
<td>$248.83</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Beer and Wine</td>
<td>$129.25</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Breakfast Foods</td>
<td>$68.29</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Canned Soup</td>
<td>$45.24</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Carbonated Beverages</td>
<td>$187.42</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Dairy</td>
<td>$8,262.54</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Jan</td>
<td>Specialty</td>
<td>$586.59</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Feb</td>
<td>Beer and Wine</td>
<td>$24.68</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Feb</td>
<td>Breakfast Foods</td>
<td>$270.72</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>Feb</td>
<td>Canned Soup</td>
<td>$91.88</td>
</tr>
</tbody>
</table>

By changing the sorting order, so that secondary sorting is by Product Type, followed by Month, all Product Type items sold to the customer A-Z-Z Solutions are presented in alphabetical order, whereas only the months when they were sold are displayed under Month.
Creating visualizations

<table>
<thead>
<tr>
<th>Customer</th>
<th>Product Type</th>
<th>Month</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td>$104,852,674.81</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>Jan</td>
<td>$248.83</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>Jul</td>
<td>$1,318.04</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Baking Goods</td>
<td>Nov</td>
<td>$396.00</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Jan</td>
<td>$120.25</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Feb</td>
<td>$24.60</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Apr</td>
<td>$120.25</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Jun</td>
<td>$60.10</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Jul</td>
<td>$120.25</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Oct</td>
<td>$480.65</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Nov</td>
<td>$10.00</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Beer and Wine</td>
<td>Dec</td>
<td>$63.07</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Bread</td>
<td>Jul</td>
<td>$158.56</td>
</tr>
<tr>
<td>A-2-Z Solutions</td>
<td>Bread</td>
<td>Oct</td>
<td>$74.73</td>
</tr>
</tbody>
</table>

**Internal sorting**

Each dimension and measure has a default (Auto) internal sorting order, which can be changed. Under Sorting, click the item you want to change and click the button to switch to Custom sorting. Changes made to the internal sorting of an item may not have any effect if the sorting is in conflict with an item with higher priority.

**Interactive sorting**

During analysis, you can set which column to sort on by clicking the column header. The first click sorts the table according to the default sorting of the selected item. A second click reverses the sorting order. Interactive sorting is session based and is not saved. If you want your changes to the sorting to be persistent, you need to make the changes in the properties panel.

**Displaying totals**

By default, the totals of numeric values are displayed under the column names. In the properties panel, you can change this to display the totals at the bottom of a column, or not at all.

**Displaying more data**

You can freeze the first column from scrolling, and select to wrap multiline text in headers and cells separately. These settings are changed in the property panel under Appearance > Presentation.
Display limitations

Number of rows and columns
In a table, you can have millions of rows and virtually any number of columns with dimensions and measures. But because huge tables are impractical and hard to manage, the limit for what is practical is far less than the theoretical maximum. In most cases, it is desirable to see all the columns without scrolling horizontally.

Tables with content of mixed sizes
In a table you can have both columns where the content fits on one row within the cell, and columns containing wrapped multiline text. In some cases you will see a shift in alignment and number of rows when the multiline column is scrolled in and out of view. When the view only contains content that fits on one row, the table will adjust and show all content on single line rows, which means more rows are displayed.

We recommend that you disable multiline text wrapping in these cases to avoid confusion for the user.

Searching in tables
In a table, you can search the dimension columns, and make selections in the resulting list.

Do the following:

1. Click $\text{Q}$ in the dimension column that you want to search in. A selection popup is displayed.
2. Type your search string. While you type, the list is filtered to only display matching items.
3. Make a selection by clicking or drawing.
4. Confirm your selection.

You can confirm the selection of all matching items by pressing Enter.

The new selection is active and reflected in all associated visualizations.

You can remove the search string by clicking $\text{X}$ or pressing Esc. The search string is always removed when you press return/Enter.

Selections in tables
Table with three selected fields in the dimension Customer.
Creating visualizations

You can make selections in a table by clicking or drawing in the dimension columns. Measure values cannot be selected. When you make a selection, it is always the dimension values that you select. You can only make selections in one column at a time.

To deselect a row, click it. To confirm a selection, click \( \checkmark \) or click outside the visualization. You can also press Enter. To cancel, click \( \times \) or press Esc. If you confirm, the selection is reflected in all visualizations associated with the table.

You cannot select dimension values that are null. Null values in a table are presented as dashes (-). Rows without valid dimension values will not be included in the selection.

Table properties

You open the properties panel for a visualization by clicking \( \square \) in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click \( \square \) in the lower right-hand corner to open it.

If the visualization has \( \square \) in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.
Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click **Add column** to add a dimension or a measure. Options that are dimmed are not available.

Columns

In the table, the dimensions and measures are presented together under the heading **Columns**.

Dimension settings

On the **Data** tab, click **Add column** and select **Dimension** to open a list of available **Dimensions** and **Fields**. Select the dimension or field that you want to use.

A dimension can either be selected from the list of already existing **Dimensions**, or created from the list of available **Fields**.

To edit a dimension that is stored as a master item, you must first unlink the dimension from the master item.

- **<Dimension name>**: Click the dimension name to open the dimension settings. If you want to delete the dimension, long-touch/right-click the dimension and select **[ ]** in the dialog. Alternatively, click the dimension and click **[ ]**.
  - **Field**: If you have added a field from **Fields** in the assets panel, the field name is automatically displayed. Click **fx** to open the expression editor.
  - **Label**: Enter a label for the dimension. If you have added a field from **Fields** in the assets panel, the field name is automatically displayed.
  - **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
  - **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
  - **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion.
    - **No limitation**: The default value.
    - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click **fx** to open the expression editor.
    - **Calculated on measure **<measure>**: Shown when you make a limitation to the number
of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.

- **Show column if**: You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown.
  You can use this to require a field selection before calculating and showing large amounts of data.

- **Background color expression**: Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

- **Text color expression**: Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible.

- **Text alignment**: When set to Custom, you can select how to display the content: Align left or Align right. If Text alignment is set to Auto, the alignment is automatically aligned left or right, depending on the content.

- **Representation**: When set to Text, all values are displayed as static text. When set to URL, field values that contain a URL are displayed as clickable links. Clickable links open a new browser tab.

- **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.

  - **Others label**: Enter a label for the summarized values (when Show others is selected).
    You can also use an expression as a label. Click \( f_x \) to open the expression editor.

You can drag a field from Measures to Dimensions to change how it is used. Moving a measure to Dimensions removes its aggregation. You cannot drag a master measure to Dimensions. You can only drag a measure to Dimensions if its expression is simple.

### Measure settings

On the Data tab, click Add column and select Measure to open a list of available measures. Select the measure that you want to use. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

To edit a measure that is stored as a master item, you must first unlink the measure from the master item.

- **<Measure name>**: Click the measure to open the measure settings. If you want to delete the measure, click Delete.
  
  - **Expression**: Click \( f_x \) to open the expression editor. The existing expression is displayed by default.
  
  - **Label**: Enter a label for the measure. Measures not saved in Master items are, by default, displayed with the expression as label.
  
  - **Measure**: Click the measure to open the measure settings. If you want to delete the measure, click Delete.
  
  - **Number formatting**: Different options for formatting the measure values. If you want to change
the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

- **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- `# ###0` describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as `0123`.
- `0.000` describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

**Limitations:**

- Only works with visualizations that accept measures.
- Cannot be used with a box plot.
- Does not affect the number formatting of the axis.
3 Creating visualizations

- **Show column if:** You can show or hide a column depending on if a condition is true or false. The column is shown only if the expression in this field is evaluated as true. If this field is empty, the column is always shown.

- **Background color expression:** Enter an expression for the background color. The text color automatically changes to white when a dark background color is used.

- **Text color expression:** Enter an expression for the text color. If you use the same expression as in the background color, the text will not be visible. For more information, see Coloring a visualization (page 387).

- **Totals function:** Select which aggregation function you want to use for the Totals row in the table. If Totals function is set to Auto, it will use the same function that is used in the measure expression. You can set the position of the Totals row under Presentation.

- **Text alignment:** When set to Custom, you can select how to display the content: Align left or Align right. If Text alignment is set to Auto, the alignment is automatically aligned left or right, depending on the content.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

**Sorting**

Drag the dimensions and measures to set the sorting priority order. The numbers show the order.

Each of the dimensions and measures can also be sorted internally:

Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following list shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

- **Sort by expression:** Enter an expression to sort by. Only available for dimensions.
- **Sort numerically**
- **Sort alphabetically**

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

**Add-ons**

- **Data handling:**
  - **Include zero values:** When unselected, measures that have the value '0' are not included in the presentation. If there is more than one measure value, all the measure values must have the value '0' to be excluded from the presentation.
  - **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in Displayed message is displayed.
A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

### Appearance

#### General

- **Show titles**: On by default in all visualizations except filter panes, KPIs, and text & image visualizations. Enter **Title, Subtitle,** and **Footnote.** By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.

  Click $\mathbf{fx}$ if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: ‘Sales: ’ & Sum(Sales).

By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=’Sales: ’ & Sum(Sales)), the string is interpreted as an expression instead. The output is then Sales: <value of expression>, where <value of expression> is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

#### Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - <inherited>, in which case the state defined for the sheet is used.
  - <default state>, which represents the state where no alternate state is applied.

### Presentation

- **Totals**:
  - **Auto**: The totals (the result of the expression), are automatically included at the top of the table.
  - **Custom**: Select whether to display the totals and where to display them, at the top or bottom.

- **Totals label**: Set the label for the totals row. You can also use an expression as a label.

- **Scrolling**: You can select to freeze the first column from horizontal scrolling.

> It is not possible to freeze the first column on touch devices.

- **Multiline text wrapping**: You can enable or disable multiline text wrapping in headers and cells separately.
Text & image

The text & image visualization complements other visualizations by offering options to add text, images, hyperlinks, and measures.

You can format and color the text and align the paragraphs. The background image has sizing and positioning options. You can also set the responsive behavior for text and images.

When to use it

The text & image visualization is intended for presentation purposes, and does not support selections. However, the measures in the text & image visualization are updated when selections are made. Some typical uses:

- Use it on the first sheet of an app for essential information.
- Display a company image, or use a background image together with formatted text and measure values to present figures in a compelling way.
- Link to sites with additional information.
- Use the responsive behavior to ensure that the visualization renders well on all devices.

Advantages

The text & image visualization contrasts with the other visualizations. You have many options for making the text & image visualization stand out next to more regular charts.

Disadvantages

You are limited to a few measure values and rather short texts, otherwise the text & image visualization will be cluttered.

Creating a text & image

You can create a text & image visualization on the sheet you are editing.

Do the following:
3 Creating visualizations

1. From the assets panel, drag an empty text & image chart to the sheet.
2. Click the text & image chart to open the editing toolbar.
3. Add and format text, images, hyperlinks or measures to the text & image chart.

If you double-click a text & image chart in the assets panel, it is added to the sheet immediately.

Editing a text & image

In the text & image visualization you can add and format text, images, measures, and links in various ways.

When you are editing a sheet and the text & image visualization does not have focus, you need to click twice to open the editing toolbar. In the editing toolbar, you can format text properties such as color, size, and style, and also align the text. Additionally, you have options for adding links and images.

The editing toolbar with options to format text and add links and images.

Creating a link

You can mark a text section and use it for a link.

If you do not add a prefix, http:// is added automatically, assuming that you are adding a web address.

Do the following:

1. Select the text section that you want to use for the link.
2. Click in the editing toolbar to open the link dialog.
3. Enter the web address that you want to link to.
4. Click.

The link is created.

Removing a link

You can remove a link from a text section.

Do the following:

1. Click the link so that the cursor is somewhere inside it.
2. Click in the editing toolbar to open the link dialog.
3. Click .

The link is removed, but not the text.

Adding an image

You can add an image through the editing toolbar. You can use one of the default images, or an image of your own.
Do the following:

1. Click 📜 in the editing toolbar.
   The Media library opens.
   The following formats are supported: .png, .jpg, jpeg, and .gif.
   For Qlik Sense: You can upload images to the In app folder in the media library. You need to use the Qlik Management Console to upload images to the default folder.
   For Qlik Sense Desktop: You can place images in the following folder on your computer:
   C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Images will be available in the default folder in the media library. When moving an app between installations, the images that you use in the app are saved in the qvf file together with the app. When you open the app in a new location, for example Qlik Sense Cloud, the images will be in the In app folder in the media library for the app.
2. Click on a folder in the media library, for example In app or Default.
3. Select the image that you want to add.
4. Click Insert.

   Alternatively, long-touch/right-click the image file you want to add and select Insert.

The image is added.

In the properties panel, you can add a background image, which, for example, can be used when you want to insert text in the image. The images added through the editing toolbar are not background images.

Adding a measure
You can add a measure in the following ways:

- By dragging a field from the assets panel and adding it as a measure.
- By dragging a measure from Master items.
- By adding a measure (existing or new) from the properties panel.

When you are editing the measure, it is displayed as a token, which can be styled and moved around in the visualization. You can also apply number formatting to it. When you leave the editor, the measure value is displayed. Values that cannot be aggregated are shown as a hyphen (-).

Deleting a measure
You can delete a measure in the following ways:

- Place the cursor before the token and press Delete.
- Place the cursor after the token and press Backspace.
- In the properties panel, long-touch/right-click the measure and select Delete in the dialog.
- In the properties panel, click the measure and click Delete 🗑️.
Creating visualizations

Text & image properties

You open the properties panel for a visualization by clicking Edit in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click Add measure and select a measure or create a measure from a field.

Measure

On the Data tab, under Measures, click Add measure to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add measure is dimmed, you cannot add more measures.

- **Measure name**: Click the measure to open the measure settings. If you want to delete the measure, long-touch/right-click the measure and select in the dialog. Alternatively, click the measure and click.
  - **Expression**: Click to open the expression editor. The existing expression is displayed by default.
  - **Label**: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the
regional settings, that is, in the \textbf{SET} statements at the beginning of the script in the data load editor.

The following number formats are available:

- **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as \textit{k} (thousand), \textit{M} (million), and \textit{G} (billion).

- **Number**: By default, the formatting is set to \textbf{Simple}, and you can select the formatting from the options in the drop-down list. Click the button to change to \textbf{Custom} formatting, and use the \textbf{Format pattern} box to change the format pattern.

**Examples:**

- \#\#0 describes the number as an integer with a thousands separator. In this example \textit{""} is used as a thousands separator.
- \###0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example \textit{"."} is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the \textbf{Format pattern} box to change the format pattern.

- **Date**: By default, the formatting is set to \textbf{Simple}, and you can select the formatting from the options in the drop-down list. Click the button to change to \textbf{Custom} formatting, and use the \textbf{Format pattern} box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the \textbf{Format pattern} box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the \textbf{Format pattern} boxes to change the format pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization. Limitations: Only works with visualizations that accept measures. Cannot be used with a box plot. Does not affect the number formatting of the axis.

- **Decimal separator**: Set the decimal separator.

- **Thousands separator**: Set the thousands separator.

- **Format pattern**: Set the number format pattern.
Appearance

General
- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click \(\overline{fx}\) if you want to create an expression by using the expression editor.

  **Example:**

  Assume that the following string is used, including quotation marks: `Sales: ' & Sum(Sales)`.
  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=`Sales: ' & Sum(Sales)`), the string is interpreted as an expression instead. The output is then `Sales: <value of expression>`, where `<value of expression>` is the calculated value.

- **Show details**: Set to Show if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states
- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Presentation
In the list, set whether text and images should have a responsive behavior. When responsive behavior is selected, the size of text and images are adjusted to the size of the visualization area. However, they do not expand beyond their normal size.

Background image
- **Use background image**: Off by default. Click the button to enable selection or removal of a background image. You can only have one background image at a time.
  - **Image**: Click \(\overline{\text{Image}}\) to open the media library where you can select a background image. To remove the background image, click \(\overline{\text{X}}\).
  - **Sizing**: Set the sizing of the image. With the **Auto** setting, the image does not scale when the text & image visualization is resized.
  - **Position**: Select the position of the image.

Treemap
Treemaps display hierarchical data by using nested rectangles, that is, smaller rectangles within a larger rectangle.
In this image you have several product groups, such as Produce, Canned Products, and Frozen Foods. Each product group consists of a large rectangle. You can regard the product groups as branches of the tree. When you select a product group, you drill down to the next level, the product type, for example, Vegetables, Meat, and Dairy. You can regard the product types as sub-branches of the tree. The branches have leaves. A leaf node’s rectangle has an area proportional to a specified dimension of the data. In this example, the items Ebony Squash, Bravo Large Canned Shrimp, Red Spade Pimento Loaf, and so on, are the leaves. The leaf nodes are colored to show a separate dimension of the data.

Sorting is automatic according to size. By default, the coloring is by dimension, with 12 colors, but that can be changed in the properties panel. When you have more than one dimension, you can decide which dimension to color by. In this example, the coloring is not by dimension, but by expression (Avg(Margin)), a calculated measure, and by using this expression, you can see which items have the highest average margin. The darker the color, the higher the average margin.

If the data set contains negative values, a text message is shown stating that the negative values cannot be displayed.

**When to use it**

Use a treemap when space is constrained and you have a large amount of hierarchical data that you need to get an overview of. Treemaps should primarily be used with values that can be aggregated.

**Advantages**

Treemaps are economical in that they can be used within a limited space and yet display a large number of items simultaneously.

When there is a correlation between color and size in the tree structure, you are able to see patterns that would be difficult to spot in other ways, for example, when a certain color is particularly relevant.

**Disadvantages**

Treemaps are not good when there is a big difference in the magnitude of the measure values. Nor is a treemap the right choice when mixing absolute and relative values.

Negative values cannot be displayed in treemaps.
Creating a treemap

You can create a treemap on the sheet you are editing.

Do the following:

1. From the assets panel, drag an empty treemap to the sheet.
2. Click **Add dimension** and select a dimension or a field. This should be the highest level in the hierarchy.
3. Click **Add measure** and select a measure or create a measure from a field.
4. Continue adding dimensions and fields according to the hierarchy of the data.

In a treemap you need at least one dimension and one measure, but to make full use of the treemap it is preferable to have two or three dimensions. You can only have one measure, but up to 15 dimensions. We do not recommend using more than three dimensions as the treemap may become unmanageable.

When you have created the treemap, you may want to adjust its appearance and other settings in the properties panel.

Display limitations

When displaying large amounts of data in a treemap, there may be cases when not each dimension value within a rectangle is displayed with correct color and size. These remaining values will instead be displayed as a gray, striped area. The size and total value of the rectangle will still be correct, but not all dimension values in the rectangle will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties panel.

Treemap properties

You open the properties panel for a visualization by clicking **Edit** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click in the lower right-hand corner to open it.

- If the visualization has in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

- Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data

Click **Add** to add a dimension or a measure.
Dimensions
On the Data tab, under Dimensions, click Add to open a list of available Dimensions and Fields. Select the dimension or field that you want to use.

You can also click $\mathbf{fx}$ to create a dimension in the expression editor. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension. Another way to create a dimension is to type the expression directly in the text box. Expressions added in this way must begin with an equals sign (=). Here is an example with a calculated dimension:

$$\text{if} \ (\text{Week} < 14, \text{Week}, \ 'Sales')$$

If Add is dimmed, you cannot add more dimensions.

- **<Dimension name>**: Click the dimension name to open the dimension settings.
  If you want to delete the dimension, long-touch/right-click the dimension and select $\mathbf{fx}$ in the dialog.
  Alternatively, click the dimension and click $\mathbf{fx}$.
- **Dimension**: Only displayed for master items. To be able to edit a dimension that is linked to a master item, you must first unlink the dimension.
- **Field**: If you have added a field from Fields in the assets panel, the field name is automatically displayed. Click $\mathbf{fx}$ to open the expression editor.
- **Label**: Enter a label for the dimension. If you have added a field from Fields in the assets panel, the field name is automatically displayed.
- **Include null values**: When selected, the measure values of all null dimensions are summarized and presented as one dimension item in a visualization. All null values are displayed as gaps or dashes (-).
- **Limitation**: Limits the number of displayed values. When you set a limitation, the only dimensions displayed are those where the measure value meets the limitation criterion:
  - **No limitation**: The default value.
  - **Fixed number**: Select to display the top or bottom values. Set the number of values. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Exact value**: Use the operators and set the exact limit value. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Relative value**: Use the operators and set the relative limit value in percent. You can also use an expression to set the number. Click $\mathbf{fx}$ to open the expression editor.
  - **Calculated on measure**: $<$measure$>$: Shown when you make a limitation to the number of displayed dimension values. The dimensions whose measure value meet the criterion are displayed.
  - **Show others**: When selected, the last value in the visualization (colored gray), summarizes all the remaining values. When some kind of limitation is set (Fixed number, Exact value, or Relative number), the value counts as 1 in that setting. If, for example, Exact value is used and set to 10, the tenth value is Others.
• **Other label**: Enter a label for the summarized values (when **Show others** is selected). You can also use an expression as a label. Click **fx** to open the expression editor.

• **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag the dimensions to set the order in which they are displayed in the visualization. Use the drag bars (≡) to rearrange the order.

You can drag a field from **Measures** to **Dimensions** to change how it is used. Moving a measure to **Dimensions** removes its aggregation. You cannot drag a master measure to **Dimensions**. You can only drag a measure to **Dimensions** if its expression is simple.

**Measures**

On the **Data** tab, under **Measures**, click **Add** to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click **fx** to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If **Add** is dimmed, you cannot add more measures.

• **<Measure name>**: Click the measure to open the measure settings.

  If you want to delete the measure, long-touch/right-click the measure and select **unlink** in the dialog. Alternatively, click the measure and click **unlink**.

  • **Expression**: Click **fx** to open the expression editor. The existing expression is displayed by default.

  • **Label**: Enter a label for the measure. Measures not saved in **Master items** are by default displayed with the expression as label.

  • **Measure**: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.

  • **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the **SET** statements at the beginning of the script in the data load editor.

  The following number formats are available:

  • **Auto**: Qlik Sense automatically sets a number formatting based on the source data.

    To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).

  • **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.
Examples:

- `###0` describes the number as an integer with a thousands separator. In this example `""` is used as a thousands separator.
- `###0` describes the number as an integer without a thousands separator.
- `0000` describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- `0.00` describes the number with three decimals. In this example `"."` is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the Format pattern box to change the format pattern.

- **Date**: By default, the formatting is set to Simple, and you can select the formatting from the options in the drop-down list. Click the button to change to Custom formatting, and use the Format pattern box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the Format pattern box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the Format pattern boxes to change the format pattern.
  
  - **Decimal separator**: Set the decimal separator.
  - **Thousands separator**: Set the thousands separator.
  - **Format pattern**: Set the number format pattern.
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

  Limitations:
  
  - Only works with visualizations that accept measures.
  - Cannot be used with a box plot.
  - Does not affect the number formatting of the axis.

- **Add alternative**: Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration.

You can drag a field from Dimensions to Measures to change how it is used. Moving a dimension to Measures assigns it an aggregation. You cannot drag a master dimension to Measures.

**Sorting**

The sorting is done automatically by measure size.
Add-ons

- **Data handling:**
  - **Include zero values:** When unselected, measures that have the value '0' are not included in the presentation. If there is more than one measure value, all the measure values must have the value '0' to be excluded from the presentation.
  - **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: \texttt{count(distinct Team)<3}. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed. A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.

Appearance

**General**

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart. Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression. Click \(\text{fix}\) if you want to create an expression by using the expression editor.

**Example:**

Assume that the following string is used, including quotation marks: \(\text{Sales: ' & Sum(Sales).}\) By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: \(=\text{"Sales: ' & Sum(Sales)\}}\), the string is interpreted as an expression instead. The output is then **Sales: <value of expression>**, where \(<\text{value of expression}>\) is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State:** Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - \(<\text{inherited}\>\), in which case the state defined for the sheet is used.
  - \(<\text{default state}\>\), which represents the state where no alternate state is applied.

Presentation

- **Headers and labels:** With the **Auto** setting, the display varies with the size of the treemap. Very small treemaps have no headers or leaf labels. Small treemaps have overlay labels and no leaf labels. Large treemaps have headers and (some) leaf labels. With the **Custom** option you can make settings for headers and leaf labels:
• **Headers:** When set to Off, you can either use Overlay labels, or no labels at all, by setting Overlay labels to Off.

• **Leaf labels:** With the Auto setting the leaf labels are displayed if there is enough space.

• **Value labels:** Set this to Off if you want to hide value labels on bars. With the Auto setting, the value labels are displayed if there is enough space.

**Colors and legends**

• **Colors:** Select how the chart values are colored. There are two settings:
  
  • **Auto:** Colors the chart values using default settings.
  
  • **Custom:** Manually select the method of coloring your values in the chart. The following methods are available:
    
    • **Single color:** Color the chart using a single color (by default blue). Use the color picker to change the dimension color.
    
    • **Use library colors:** Option available when a master dimension or master measure used in the visualization has a color assigned to it. You can select to use the master item colors or to disable the master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.
    
    • **By dimension:** Color the chart by dimension values. By default, 12 colors are used for the dimensions. The colors are reused when there are more than 12 dimension values. When selected, the following settings are available:
      
      • **Select dimension:** Enter a field or expression containing the values to color objects in this chart.
      
      • **Library colors:** Select whether to use the master dimension color or to disable the master dimension color. Option available only when a master dimension used in the visualization has a color assigned to it.
      
      • **Persistent colors:** Select to have colors remain the same between selection states.
      
      • **Color scheme:** Select 12 colors or 100 colors to be used for the different values. The 12 colors can all be distinguished by people with color vision deficiency, but not all of the 100 colors.
    
    • **By measure:**
      
      • **Select measure:** Select the measure to use to color your chart.
      
      • **Library colors:** Select whether to use the master measure colors or to disable the master measure colors. Option available only when a master measure used in the visualization has colors assigned to it.
      
      • **Label:** Enter text or an expression for the measure that displays in the legend.
      
      • **Color scheme:** Select a color scheme from the following options:
        
        • **Sequential gradient:** The transition between the different color groups is made using different shades of colors. High measure values have darker hues.
        
        • **Sequential classes:** The transition between the different color groups is made using distinctly different colors.
3 Creating visualizations

- **Diverging gradient**: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a chart. Low and high values have dark colors, mid-range colors are light.

- **Diverging classes**: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.

- **Reverse colors**: When selected, the color scheme is reversed.

- **Range**: Define the range of values used to color by measure or by expression.
  - **Auto**: The color range is set by the measure or expression values.
  - **Custom**: When custom is selected, you can set the Min and Max values for the color range.

- **By expression**: Color the chart using an expression to define colors for values. Supported color formats are: RGB, ARGB, and HSL.
  - **Expression**: Enter the expression that you want to use. Click \(\text{fx}\) to open the expression editor.
  - **The expression is a color code**: Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients. For more information, see Coloring a visualization (page 387) When the coloring is by measure or by expression, you can set the color range (Min and Max values). By setting the color range, the colors remain constant throughout selections and paging. When using color by expression, the option The expression is a color code must be cleared before you can set the color range.

- **Show legend**: Not available when Single color is selected. By default set to Off. The legend is displayed if there is enough space. The placement can be changed in the Legend position setting.

- **Legend position**: Select where to display the legend.

- **Show legend title**: When selected, the legend title is displayed.

**Waterfall chart**

The waterfall chart is suitable for illustrating how an initial value is affected by intermediate positive and negative values. The starting and the final values are represented by whole bars, and intermediate values by floating bars. You can also show subtotals in the chart.

*Waterfall chart displaying Sales, Sales cost and Sales margin.*
When to use it
The waterfall chart is suitable for illustrating how an initial value is affected by intermediate positive and negative values. One example of this is an income statement, when you want to show the positive and negative contributions of different accounts.

Advantages
The waterfall chart provides a quick understanding of the transition of a value.

Disadvantages
The waterfall chart is not relevant for detailed analysis of the data as you can't make selections in the chart or expand the data.

Creating a waterfall chart
You can create a waterfall chart on the sheet you are editing.

In a waterfall chart you need to use one measure for each bar in the chart. The order of the measures defines the order of the bars in the chart. For each measure, you need to define how it affects the previous value.

Do the following:

1. From the assets panel, drag an empty waterfall chart to the sheet.
2. Add the first measure.
This is the first bar of the chart. By default, it will use the measure operation **Add**, and show a positive value.

3. **Add a second measure.**
   This is the second bar of the chart. If you want to show this measure as a negative contribution, change **Measure operation** to **Subtract**.

4. **Continue to add measures**, setting **Measure operation** to **Add** or **Subtract** depending on how you want them to contribute.

5. **Add subtotals.** There are two ways of adding subtotal bars to the chart:
   - If you have a data field containing subtotal data, add a measure with the subtotal data and select **Subtotals** as **Measure operation**.
   - If you don't have a data field containing subtotal data, you can add an automatically calculated subtotal by selecting the **Subtotals** check box of the measure before where you want the subtotal bar.

When you have created the waterfall chart, you may want to adjust its appearance and other settings in the properties panel.

**Defining your measures**

You can use the **Measure operation** option of each measure to set how it affects the previous value.

- **Add**
  The measure value adds to the previous bar. If this is the first measure, a whole bar is shown starting at 0.

- **Subtract**
  The measure value subtracts from the previous bar.

  *If the data already contains a negative sign, the result of subtraction will be a positive change.*

- **Subtotals**
  The measure value is considered a subtotal.

  *If you do not have sub-totals as a field, you can add subtotals automatically by enabling **Subtotals** in the measure before you want the subtotal.*

In the waterfall chart shown above, the first bar, Sales, is defined as **Add**. The second bar, Sales cost, is defined as **Subtract**, and the third bar, Sales margin, is defined as **Subtotals**.

**Waterfall chart properties**

You open the properties panel for a visualization by clicking **Edit** in the toolbar and clicking the visualization that you want to edit.

If the properties panel is hidden, click **Property** in the lower right-hand corner to open it.
If the visualization has ☰ in the upper right-hand corner, the visualization is linked to a master item. You cannot edit a linked visualization, but you can edit the master item. You can also unlink the visualization to make it editable.

Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

Data
Click Add to add a dimension or a measure.

On the Data tab, under Measures, click Add to open a list of available measures. Select the measure that you want to add to the visualization. If you select a field, you are automatically presented with some common aggregation functions that you can choose between for the measure.

If no measure is available, you need to create one. You can enter the expression directly in the text box, or click fx to create a measure in the expression editor.

To be able to edit a measure that is linked to a master item, you must first unlink the measure.

If Add is dimmed, you cannot add more measures.

Measures
- `<Measure name>`: Click the measure to open the measure settings. If you want to delete the measure, long-touch/right-click the measure and select ☰ in the dialog. Alternatively, click the measure and click ☰.
  - Expression: Click fx to open the expression editor. The existing expression is displayed by default.
  - Label: Enter a label for the measure. Measures not saved in Master items are by default displayed with the expression as label.
  - Measure: Only displayed for master items. To be able to edit a measure that is linked to a master item, you must first unlink the measure.
  - Measure operation: Select how to use the measure in the chart:
    - Add: The measure value is added.
    - Subtract: The measure value is subtracted.
    - Subtotals: The measure value is treated as a subtotal value of the last measures using the same measure operation.
  - Subtotals: Select Subtotals to add an automatically calculated subtotal measure based on the result of all previous measure operations.
  - Subtotal label: Enter a label for the automatically calculated subtotal measure.
You can drag the measures to set the order in which they are displayed in the visualization. Use the drag bars (Ê) to rearrange the order.

Number formatting

- **Number formatting**: Different options for formatting the measure values. If you want to change the number format at app level, and not just for a single measure, it is better to do that in the regional settings, that is, in the SET statements at the beginning of the script in the data load editor. The following number formats are available:
  
  - **Auto**: Qlik Sense automatically sets a number formatting based on the source data. To represent numeric abbreviations, the international SI units are used, such as k (thousand), M (million), and G (billion).
  
  - **Number**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

**Examples:**

- # ##0 describes the number as an integer with a thousands separator. In this example " " is used as a thousands separator.
- ####0 describes the number as an integer without a thousands separator.
- 0000 describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.
- 0.000 describes the number with three decimals. In this example "." is used as a decimal separator.

If you add the percent sign (%) to the format pattern, the measure values are automatically multiplied by 100.

- **Money**: By default, the format pattern used for money is the same as set up in the operating system. Use the **Format pattern** box to change the format pattern.

- **Date**: By default, the formatting is set to **Simple**, and you can select the formatting from the options in the drop-down list. Click the button to change to **Custom** formatting, and use the **Format pattern** box to change the format pattern.

- **Duration**: By default, the format pattern used for duration is the same as set up in the operating system. Duration can be formatted as days, or as a combination of days, hours, minutes, seconds and fractions of seconds. Use the **Format pattern** box to change the format pattern.

- **Custom**: By default, the format pattern used for custom is the same as set up in the operating system. Use the **Format pattern** boxes to change the format pattern.
  
  - **Decimal separator**: Set the decimal separator.
  
  - **Thousands separator**: Set the thousands separator.
  
  - **Format pattern**: Set the number format pattern.
  
  - **Reset pattern**: Click to reset to default pattern.

- **Measure expression**: The format pattern is determined by the measure expression. Use this option to display custom number formatting for a measure in a visualization.

**Limitations:**
3 Creating visualizations

Only works with visualizations that accept measures.
Cannot be used with a box plot.
Does not affect the number formatting of the axis.

Add-ons

- **Data handling:**
  - **Include zero values:** When unselected, measures that have the value '0' are not included in the presentation. If there is more than one measure value, all the measure values must have the value '0' to be excluded from the presentation.
  - **Calculation condition:** Specify an expression in this text field to set a condition that needs to be fulfilled (true) for the object to be displayed. The value may be entered as a calculated formula. For example: `count(distinct Team)<3`. If the condition is not fulfilled, the message or expression entered in **Displayed message** is displayed.
    A calculation condition is useful when a chart or table is very big and makes the visualization slow to respond. A calculation condition can then help so that for example an object does not show until the user has filtered the data to a more manageable level by applying selections.
  - **Reference lines: Add reference line:** Click to add a new reference line.
    - **Show:** When selected, the reference line is displayed.
    - **Label:** Enter a label for the reference line.
    - **Color:** In the color picker, select the color of the reference line and the label.
    - **Reference line expression:** Enter a value or an expression for the reference line. Click \( \text{fx} \) to open the expression editor.
    - \( \text{del} \): Click to remove the reference line.

Appearance

General

- **Show titles:** Select to enable or disable titles, subtitles, and footnotes in the chart.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click \( \text{fx} \) if you want to create an expression by using the expression editor.

Example:

Assume that the following string is used, including quotation marks: `Sales: ‘& Sum(Sales)`.
By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: `(‘Sales: ‘& Sum(Sales))`, the string is interpreted as an expression instead. The output is then `Sales: `<value of expression`>, where `<value of expression`> is the calculated value.

- **Show details:** Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.
Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - **<inherited>**, in which case the state defined for the sheet is used.
  - **<default state>**, which represents the state where no alternate state is applied.

Presentation

- **Gridline spacing**: Set this to **Custom** if you want to customize the horizontal gridlines. You can choose between: **No lines**, **Medium** or **Narrow**.
- **Value labels**: Set this to **Off** if you want to hide value labels on bars.

Colors and legend

- **Colors**: You can set the presentation color for the different measure operations: **Positive value color**, **Negative value color** or **Subtotal color**
- **Show Legend**: Set to **Auto** to show a legend of the measure operations. You can set the position of the legend with **Legend position**:
  - **Auto**: The legend is automatically positioned where there is available space.
  - **Right**
  - **Bottom**
  - **Left**
  - **Top**

Y-axis

- **Labels**: Select if you want to show labels on the Y-axis.
- **Position**: Select where to display the dimension axis.
- **Scale**: Select how many lines you want to show on the Y-axis. **Narrow** shows many lines, and **Wide** shows few lines.
- **Range**: Select to set the min value, the max value, or both. The min value cannot be larger than the max value. You can use expressions for the values.

X-axis

- **Labels**: Select if you want to show labels on the X-axis.
- **Label orientation**: Select orientation of the labels.
- **Position**: Select where to display the measure axis.

Container

The container is an object that lets you add visualizations in a limited space. You can also show or hide the visualizations inside the container based on conditions.
3 Creating visualizations

When to use it
The container is useful when you want to be able to quickly switch between different visualizations, on a dashboard with limited screen real estate. You can also use a container to show different visualizations based on:

- Which user is accessing the chart.
- The value of a variable.
- Possible number of values in a field, by using the `GetPossibleCount()` function in the condition expression.

Creating a container
You can create a container on the sheet you are editing.

Do the following:

1. From the assets panel, drag a **Container** object to the sheet.
2. Click **Add** under **Content** in the properties panel.
3. Select a master visualization in **Master items**, or select to create a new visualization in **Charts**. Alternatively: you can add content to your container by dragging available visualizations from your sheet, or from your **Master items**, directly on the container.
4. Drag the charts in the property panel to set the tab order.

You will now have a container with a tab for each visualization you added. You can switch between tabs to show different visualizations.

Adding show conditions
You can add show conditions on the tabs you have created.
Do the following:

1. Click on the chart you want to add a show condition to, under **Content** in the property panel.
2. Add a show condition for the chart in **Show condition**. Typically you would use an If() function.
3. Add another show condition to a different chart.
   The charts will now be shown or hidden depending on the result of the conditions you added. If the condition of a chart results in True, it is shown, and if it is False, it is hidden.

**Display limitations**

- You cannot use a master visualization that contains a container inside another container.
- It is not possible to add the same master visualization twice on a container.
- Tab selection is remembered when navigating between sheets or refreshing the browser only for the same session only.
- It is not possible to create a chart inside a container by dropping measures or dimensions on the container.

**Container properties**

You open the properties panel for a container by clicking ✏️ **Edit** in the toolbar and clicking the container that you want to edit.

If the properties panel is hidden, click ✗ in the lower right-hand corner to open it.

- If the container has ☰ in the upper right-hand corner, the container is linked to a master item. You cannot edit a linked container, but you can edit the master item. You can also unlink the container to make it editable.

- Some of the settings in the properties panel are only available under certain circumstances, for example, when you use more than one dimension or measure, or when you select an option that makes other options available.

**Content**

Click **Add** to add a chart to the container. If the container has more than one charts, you can drag the charts to set the tab order.

You can edit each chart under **Content**:

- **Label**: Change how the label of the chart appears on the tab.
- **Show condition**: Add a show condition for the chart. Typically you would use an If() function
- **Edit properties**: Allows you to edit the properties of the chart inside the container.
- **Delete** Deletes the chart from the container.
3 Creating visualizations

Appearance

General

- **Show titles**: Select to enable or disable titles, subtitles, and footnotes in the container.
  Enter **Title**, **Subtitle**, and **Footnote**. By default, the string is interpreted as a text string. However, you can also use the text field for an expression, or a combination of text and expression. An equals sign (=), at the beginning of a string shows that it contains an expression.
  Click \( \text{fx} \) if you want to create an expression by using the expression editor.

  **Example:**

  Assume that the following string is used, including quotation marks: ‘*Sales:* ‘ & Sum(Sales).
  By default, the string is interpreted as a text string and is displayed as presented in the example. But if you begin the string with an equals sign: (=‘*Sales:* ‘ & Sum(Sales)), the string is interpreted as an expression instead. The output is then *Sales:* `<value of expression>`, where `<value of expression>` is the calculated value.

- **Show details**: Set to **Show** if you want to allow users to be able to choose to view details, such as descriptions, measures, and dimensions.

Alternate states

- **State**: Set the state to apply to the visualization. You can select:
  - Any alternate state defined in **Master items**.
  - `<inherited>`, in which case the state defined for the sheet is used.
  - `<default state>`, which represents the state where no alternate state is applied.

Container

- **Tabs**: Set whether each chart in the container appears in a tab. If set to **Off** only the top chart will appear. By default, set to **On**.

- **Menu**: Set whether a menu button appears when there is not enough space for all tabs. By default, set to **Auto**.

- **Navigation arrows**: Set whether navigation arrows appear when there is not enough space for all tabs. By default, set to **Auto**.

- **Show icons**: By default, **Off**. With the **On** setting, chart icons are displayed on each tab.

Reference lines

A reference line is a line intersecting the chart area from a given point on the measure axis. You can use a reference line to indicate a certain level of chart data. The reference line is only drawn if it falls within the current range of the measure axis. You can have several reference lines in the same chart.

*Bar chart Top 5 customers with a reference line at 5M.*
Reference lines are available in the following visualization types:

- Bar chart
- Box plot
- Distribution plot
- Gauge
- Histogram
- Line chart
- Scatter plot
- Waterfall chart

**Reference line expression**

You can either set the reference line expression to an absolute numeric value, or enter an arbitrary numeric expression.

**Null values in visualizations**

Data is sometimes missing or cannot be calculated, because the fields contain values that are null or not a number (NaN). In the visualizations, null and NaN values are displayed in different ways, according to the following table.

<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Null values in dimensions</th>
<th>NaN values in measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>–</td>
<td>– ( when labels are enabled in the properties panel, otherwise empty)</td>
</tr>
<tr>
<td>Box plot</td>
<td>–</td>
<td>No representation</td>
</tr>
</tbody>
</table>
Creating visualizations

3.7 Creating and editing visualizations

You create visualizations from pre-defined charts, fields, or custom objects. Once added to your sheet, you can edit and refine your visualizations. You must be in Edit mode to be able to add or edit visualizations.

Creating visualizations

You create visualizations by dragging the chosen type of visualization onto the sheet from the assets panel and configuring its properties settings. For instructions on creating specific types of visualizations, see that visualization type in Visualizations (page 104).

Qlik Sense offers two methods of creating visualizations with assistance. You can use insight advisor to let Qlik Sense generate a selection of visualizations by analyzing your data. You can then choose to add these visualizations to your sheets. You can also create visualizations using chart suggestions by dragging a field onto the sheet from the assets panel and then dragging additional fields that you want in the visualization onto the first field. Qlik Sense then creates a suggested visualization based on the fields selected for the visualization. For more information, see Creating visualizations using chart suggestions (page 295).

You can also add a visualization by copying visualizations. This is useful if you want to use existing visualization settings in another visualization type. For more information, see Copying a visualization from an existing visualization (page 373)
3 Creating visualizations

Custom objects are added in a similar manner. You start creating a visualization by dragging a visualization extension or a widget onto the sheet. For more information, see Creating a visualization using a custom object (page 305).

You can use containers to save space on your dashboard, by quickly switching between tabs with different visualizations.

Dimensions determine how the data in a visualization is grouped - for example total sales per country or number of products per supplier. For more information, see Dimensions (page 58).

Measures are calculations used in visualizations, typically represented on the y-axis of a bar chart or a column in a table. Measures are created from an expression composed of aggregation functions, such as Sum or Max, combined with one or several fields. For more information, see Measures (page 61).

Do the following:

1. Drag the visualization from the assets panel onto the sheet, or double-click the visualization.
2. Add dimensions and measures to the visualization.
   You can add dimensions and measures using the buttons on the visualization. Or you can drag a field from the Fields tab of the assets panel, and then select it to use it as a dimension or measure. The number of dimensions and measures that are required depends on which visualization you selected.
3. Adjust the presentation: for example sorting, coloring, or labeling.
   For more information, see Changing the appearance of a visualization (page 380).

Editing visualizations

After creating a visualization, you may want to make adjustments to improve how it conveys information to users. For example, you can change the data used, or adjust the appearance of the visualization. You can add more dimensions or measures for further depth of information, or remove some to improve clarity, and declutter a visualization.

The data in a visualization can be changed. For example, you might correct an invalid dimension or measure, or unlink a measure from a master measure so you can modify it without changing the master measure. For more information, see Changing the data of a visualization (page 374).

The appearance of a visualization can be edited to improve design and enhance understanding. There are a number of different ways you can adjust the appearance of your visualizations:

- Colors: Coloring is one of the best ways to highlight values in your visualizations. Qlik Sense provides a range of different coloring options.
  For example, you can assign specific colors to the distinct values in a master dimension to ensure that those values use the same colors across all your visualizations.
  For more information, see Coloring a visualization (page 387).
- Sorting: The sorting of your dimensions and measures helps ensure that content is presented in a logical and understandable manner.
  For more information, see Change the sorting of a visualization (page 384).
- Titles and labels: Titles and labels can be changed for clarity and detail.
3 Creating visualizations

For example, in a pie chart showing sales by region, you could add an expression providing the total sales sum.
For more information, see Changing the appearance of a visualization (page 380).

- Presentation: Different visualizations have different options that can be adjusted to enhance the display of data.
  For example, you can set bars in a bar chart to display as grouped or stacked, as well as vertically or horizontally.
  For more information, see Changing the appearance of a visualization (page 380).

You can convert a visualization into another visualization type, and preserve your settings. For more information, see Converting a visualization to another kind of visualization (page 407).

You edit visualization properties in the properties panel.

Do the following:

1. Click in the toolbar.
The properties panel for the sheet opens to the right. (If it is hidden, click in the lower right-hand corner.)
2. Click the visualization that you want to edit.
The properties panel now shows the properties of the visualization.
3. Make your changes in the properties panel.
4. Click Done in the toolbar.

Best practices for designing visualizations

Decluttering your apps

Too much information in an app makes it difficult to see what is important. Today’s modern user interface style is a cleaner, simpler, flatter style of design. A simplified design subtly guides the reader and allows them to stay focused.

Less is more

Users often try to include too much information in one app. Line charts with several measures can be confusing and difficult to interpret. Try creating several smaller visualizations to spread this information out onto the page. It also allows the reader to efficiently compare and contrast visualizations that are side-by-side. You can also use alternative dimensions and measures to allow the reader to quickly switch between measures without overcrowding a visualization. For more information, see Changing the data of a visualization (page 374).

There are number of different ways you can improve the aesthetics and functionality of your app. Depending on your audience and what data you want to highlight, the way you design your visualization may have a serious impact on the reader’s interpretation of the data.

Know your limits

Consumers of your visualizations may be working with limited screen space or resolution. Qlik Sense uses responsive design to address these limitations. However, if screen space or resolution is too limited, certain design accommodations are necessary. These can include:
3 Creating visualizations

- A subset of data being displayed in bar charts and line charts. When the number of dimension values exceeds the width of the visualization, a mini chart with a scroll bar is displayed.
- Collapsed menus for selecting data filters. When the number of dimension values exceeds the space available for the filter pane, the menu is collapsed. App consumers have to click on the dimension name in the title of the filter pane to open a new pane. They can then make their selections in the new pane. Additionally, when there is limited space, dimension names may appear as ellipses in filter pane titles. App consumers have to click on the ellipses to view the name of the filter pane.
- Missing legends, labels and titles.

App consumers can expand visualizations to address some of these issues. However, we recommend that you test your apps on devices where the apps may be consumed. You can also use various tools to test, such as responsive design mode in Firefox (Ctrl + Shift + M). If necessary, you can move visualizations to new sheets, reduce the amount of data shown in visualizations, and so on.

Color accessibility
The spectrum of colors is narrower for people who have color-based visual impairment. They may interpret your visualization differently than you intended.

For example, some people see the colors red and green more as yellow or brown. This form of red-green color vision deficiency is the most common. This is worth noting since red often carries a negative connotation in data visualizations, especially in finance.

A red or green KPI status can be confusing. You can use shapes with colors as performance indicators to make your designs more accessible. For example, use a red empty circle to denote bad, a green full circle for good, and a triangle as a warning symbol that only appears when a KPI status is at an unacceptable level.

Lines, bars, and pie slices can be difficult to distinguish when the colors are distorted.

For more information, see Changing the appearance of a visualization (page 380).

Filter and icon placement
Filers and icons are an essential part of data visualization, but it can be difficult to know where to place them or how to sort them. You can often anticipate where the user will begin to read based on a few well-established design principles.

Left placement
Several popular websites use left-side navigation tiles and filters. This is due to the fact that many languages read from left to right. As a result, the left-side of the screen is where these readers look most frequently. Users who are scanning for content tend to gravitate toward the left side of the screen. The farther to the right objects are, the less users will look at them. If all your filters and icons are stacked vertically on the left, it gives them equal weight.

Alternately, with languages where text is written right to left, the opposite of this is true. This should be kept in mind if your apps are translated into these languages.
Top placement
Another common placement option for icons and filters is along the top of an app. By not placing filters or icons on the left it gives more space for larger visualizations with distracting menus. When filters and icons are placed above visualizations they are also seen as separate from the content below. This can help show the reader that you are prioritizing the filters or icon. If all your filters and icons are side-by-side at the top, the one furthest to the left carries more weight and is prioritized by the reader.

For more information, see Structuring an app using sheets (page 11).

Information hierarchy
Sometimes you want your reader to prioritize certain visualizations over others. You can show hierarchy of information by using a few key design best practices. For example, you can use different sizes to emphasize some visualizations. Larger information is seen as more important: by increasing the font or chart size, you can show the reader where to look first.

Page placement also plays a part in information hierarchy. The information at the top of a page is perceived as more important than information at the bottom of the page because it is read first. Information on the first page is perceived as more important than information on the last page.

Adding context to KPIs
KPIs are a great way to communicate some of the big ideas inside your app. However, KPI values do not provide any context to the numbers and calculations that are happening behind the scenes. A green light next to a KPI does not tell the reader if the goal was barely achieved, or if you greatly surpassed it.

To help bring context to your KPIs, include supporting information next to the value in smaller text. For example, you can compare the current KPI value with the value from the previous year. You can also add a small bar chart without axes or values to provide information about the current trend.

For more information, see KPI properties (page 166).

Avoid the pitfalls of data visualization
To experience the benefits of data visualization you must avoid the pitfalls. Here are some common ones:

Color abuse
Do not overdo colors. Be aware that the wrong color in the wrong place might cause confusion rather than clarity. Also, the same color may mean different things in different parts of the world.

Misuse of pie charts
Avoid having pie charts side by side to compare. Try not to squeeze too much information into them.

Visual clutter
Too much information defeats the purpose of clarity. Use a maximum of nine KPIs, and remove all visual clutter.

Style over substance
A beautiful visualization is not necessarily the most effective. Use design best practices at all times.
Bad data
Spot and correct issues with your data before you present it. Do not let your visualization take the blame for bad information.

Creating visualizations from your data using insight advisor
Insight advisor provides an entry point for exploring your data and creating visualizations. Insight advisor uses the Qlik cognitive engine to create visualizations for you based on your fields and master items, as well as learned precedents for using fields in charts.

You can search insight advisor to display visualizations, including new insight charts and existing visualizations from your sheets. Insight advisor can also generate a set of visualizations by analyzing your data set and creating charts of potential interest.

As you change the data in your app, by adding data, making associations, editing tables, or classifying fields, the insight charts generated by insight advisor may change. When insight advisor is opened in a published app, it looks at how fields and master items in the data model are used in dimensions, measures, and expressions. It can then learn from the previous interactions when creating insight charts in other apps.

Insight charts can be added to existing sheets or to new sheets in your app. An insight chart can also be downloaded as an image, PDF, or as an Excel spreadsheet containing the data used in that chart.

Selecting a chart expands the chart and enables you to interact with it. You can make selections in your insight charts and have those selections carry over to other insight charts as you explore other insight charts. If you already made selections in existing charts in your sheets, these are kept when you open insight advisor.

Selections do not affect the charts created by insight advisor.

Insight advisor supports keyboard navigation.

Where can you use insight advisor
Insight advisor has the following limitations:

- Precedent based learning is not available for apps in the cloud hub.
- If the app is published you can only search for master items.
- Insight advisor can only be used in unpublished apps. When insight advisor cannot be used, search for visualizations using smart search instead.

What happens when you search
As you type your search query, Qlik Sense uses fields you explicitly selected to return visualizations. Qlik Sense uses the fields you search for and the fields which contain the values you search for. It may also add additional fields to visualizations.

Insight advisor can look for:

- Field names
- Field values
• Master items

When generating results, insight advisor looks at your data model and how fields are used in existing charts and master items in your app. Insight advisor uses any precedents you have given it for hiding insight charts, setting fields as dimensions or measures, and excluding fields from analysis. In Qlik Sense Enterprise, Insight advisor can also use precedents learned from other published apps if they used a similar or identical data model.

*Insight advisor in an app.*

**A: Fields and master items**
These are the available assets (fields and master items) for creating insight charts. You can access fields by clicking 🗝️ and master items by clicking 🚴.

**B: Insight search field**
In unpublished apps, enter field names or values, and master item names to search for charts using those fields. In published apps, enter master item names. Fields and master items selected from the assets are added to the insight search field.

**C: Insight charts**
These are the insight charts created by insight advisor. Insight advisor indicates the number of results and breaks them down into how many results are found, how many charts already exist in your sheets, and how many charts are newly generated by insight advisor.
You can see why the chart was included by clicking to view the confidence rating. The insight chart can be downloaded as image, PDF, or as a spreadsheet by clicking . You can expand a chart by selecting it or clicking .

If an insight chart is new, you can add it to your sheets. If the insight chart exists already, you can click the sheet name at the bottom of the chart to go to that page.

If you do not like an insight chart, you can hide it so it will no longer be included in future results. You can view hidden charts and restore them if you change your mind.

Editing insight charts

After expanding a chart suggested by insight advisor, you can edit some of its properties. In the Properties section, you can see the Analysis type used to create the chart. Click to learn more about the analysis type used. You can change the fields used as Dimensions or as Measures, as well as the aggregation used. If multiple measures or dimensions are available, you can reorder them by dragging.

You can also teach insight advisor precedents for how to use fields in insight charts. By clicking Help us learn when editing a dimension or measure, you can indicate that certain fields should only be used as dimensions or measures. You can also exclude fields from further insight charts. If you edit a chart, insight advisor can learn from your preferences in that chart if you add it to a sheet or if you click Learn after closing the editor. Precedents set by a user in insight advisor only apply to that user’s instance of insight advisor.

Creating visualizations with insight advisor

Charts you add to the sheet from insight advisor continue to show as generated until the app is refreshed.

Do the following:

1. In a sheet in your app, click Insights.
2. To generate charts based on an analysis of your data, click Generate insights.
3. To generate charts based on specific data, select which fields and master items to use. Select the data from the list of available assets or search for them by name in the search field.
4. To add an insight chart to your app, do one of the following:
   - To add a chart to your current sheet, click Add to sheet.
   - To add a chart to a specific sheet, click and select the sheet
   - To add the chart to a new sheet, click and select Create new sheet.

Disabling insight advisor in an app

Insight advisor can be disabled in an app by adding a variable and then refreshing the app. Disabling insights advisor on a published app in Qlik Sense Enterprise or an app in a cloud hub prevents the Precedents Service from learning precedents from the app. By disabling insight advisor, the service will no longer learn the aggregations, dimensions, and measures used with that data model for use in apps with a similar data model.

Do the following:
3 Creating visualizations

1. In the sheet edit mode, in the assets panel, click + .
2. Click Create new.
3. In Name, type DISABLE_INSIGHTS.
4. In Definition, type any value.
5. Click Close.
6. Refresh the app.

Precedent based learning for insight advisor in cloud hubs

Insight advisor can analyze an app to see how fields are used to create charts. The Qlik Precedents Service analyzes apps whenever insight advisor is opened in the app. The service examines the use of data fields and master items in the app. This teaches insight advisor precedents for making aggregations, dimensions, and measures for the data model of the app.

App analysis does not examine the data in fields, only the data tables and field names and how they are used. Precedents learned are only applied to the app from which the precedents were learned.

For an app in a shared space, precedents learned from the app are shared amongst users. Precedents learned from users are not shared and are unique to each cloud hub user with access to the app.

You can disable insight advisor in an app if you do not want insight advisor to learn precedents from that app. For a shared app, if one user disables insight advisor, it is disabled for all app users.

Creating visualizations using chart suggestions

Qlik Sense offers a wide range of visualizations to use with your data. Deciding on the correct chart type can be challenging when creating your first Qlik Sense app. Chart suggestions enable you to select data fields and let Qlik Sense choose the dimensions, measures, and visualization types. As you add or remove fields, the suggested visualization adjusts itself based on your changes. You can customize a suggested visualization with a focused set of properties.

If you started a visualization, enabling Chart suggestions will change your visualization to a suggested visualization.

If you enable Chart suggestions and then disable them, you will lose changes made to your visualization. You can restore your old visualization by undoing the changes. However, if you navigate away from Sheet view or make changes in the assets panel, you will not be able to undo and restore your visualization.

Creating a new visualization using chart suggestions

Do the following:

1. Click ✏ Edit in the toolbar.
   The assets panel opens on the left-hand side.
2. From Fields, drag and drop a field into your sheet.
Fields suggested as dimensions are added as tables or histograms. Fields suggested as measures are added as KPIs.
To add fields as filter panes hold the shift key when you drag and drop the field.

3. Add additional fields by doing one of the following:
   - Drag and drop a field onto the visualization created from the first field, or on Suggest on the right-hand side.
     Qlik Sense determines if the field should be used as a dimension or as a measure, and which measure aggregation to use.
   - Click Add on the properties panel and select a field.
   - Drag and drop a field on Drop item here under Dimensions or Measures.
     The visualization will change as fields are added to it.

4. Optionally, remove unwanted fields.

5. Click.Done.

Changing an existing visualization using chart suggestions
You change an existing visualization by adding fields or removing unwanted fields. Enabling Chart suggestions in the properties panel on the right-hand side changes the selected visualization to a chart suggestion based on the fields of the visualization. You can change the suggestions made by Qlik Sense. For example you can:

- Drag fields between Dimensions and Measures to change how a field is used. Moving a field to Dimensions removes its aggregation. Moving a field to Measures assigns it an aggregation.
- Choose a different aggregation for a field used as a measure. Your aggregation choice will be used whenever you use this field as a measure, while Chart suggestions is enabled.
- Use Change chart type to choose a different type of chart from the one suggested.

Adjusting the settings when using chart suggestions
You can adjust the settings in the properties panel for Data and Appearance. The properties panel for visualizations created with chart suggestions contains a focused set of properties settings. Disabling Chart suggestions brings back access to all available properties. For descriptions of the available fields see the visualization properties topics in Visualizations (page 104).

Limitations when using chart suggestions
- You cannot enable Chart suggestions for a master visualization. You cannot enable Chart suggestions for histograms or maps.
- Charts with Chart suggestions enabled are not supported in Qlik NPrinting reports. To include charts created using chart suggestions in Qlik NPrinting reports, disable Chart suggestions.
- You can only change the aggregation of a measure when its label is the default label.
- You cannot drag a master dimension to Measures. You cannot drag a master measure to Dimensions.
- You can only drag a field from Measures to Dimensions if its expression is simple. For more information on how to use expressions in visualizations see Using expressions in visualizations (page 86).
Guidelines for visualizations, fields, and naming

There are certain conventions and limitations you need to be aware of when working with Qlik Sense. For example: the maximum number of characters to use in names, descriptions, and expressions, as well as characters reserved for use by Qlik Sense only.

Max number of visualizations

The maximum number of visualizations there can be on a sheet is limited to the number of cells on a sheet: 288 (24x12). The maximum practical number will be less than this because of the limited use for visualizations that are made up of only 1 cell.

Upper limits on name lengths

The following limits apply to the number of characters that can be used in various situations in Qlik Sense:

<table>
<thead>
<tr>
<th>Situation</th>
<th>Upper limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names (title, dimension, footnote...)</td>
<td>Max 255 characters.</td>
</tr>
<tr>
<td>Descriptions</td>
<td>Max 512 characters.</td>
</tr>
<tr>
<td>Expressions</td>
<td>Max 64,000 characters.</td>
</tr>
<tr>
<td>Tags</td>
<td>Max 31 characters per tag and max 30 tags per master item.</td>
</tr>
<tr>
<td>Text &amp; image chart:</td>
<td>Max 12,000 characters.</td>
</tr>
</tbody>
</table>

Naming dimensions and measures

If you use long names for your dimensions and measures they will be truncated, and “…” will be shown to denote that part of the name is hidden. It is also recommended to avoid using characters reserved for system purposes, as unpredictable results and errors could occur.

Avoid using the following characters in dimension and measure names:

- `:`
- `=`
- `[`
- `]`
- `{`
- `}`
- `$`

Max number of characters in expressions

The maximum number of characters that can be written in a visualization expression is 64,000. If you attempt to build an expression with more than this number, the expression will be truncated.
Conventions for number and time formats

In many interpretation and formatting functions it is possible to set the format for numbers and dates by using a format code. This topic describes the conventions used to format a number, date, time, or time stamp. These conventions apply both to script and chart functions.

Number formats

To denote a specific number of digits, use the symbol "0" for each digit.

To denote a possible digit to the left of the decimal point, use the symbol "#".

To mark the position of the thousands separator or the decimal separator, use the applicable thousands separator and the decimal separator.

The format code is used for defining the positions of the separators. It is not possible to set the separator in the format code. Use the DecimalSep and ThousandSep variables for this in the script.

It is possible to use the thousand separator to group digits by any number of positions, for example, a format string of "0000-0000-0000" (thousand separator="-".) could be used to display a twelve-digit part number as "0012-4567-8912".

Examples:

<table>
<thead>
<tr>
<th>Number format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># ##0</td>
<td>describes the number as an integer with a thousands separator. In this example &quot; &quot; is used as a thousands separator.</td>
</tr>
<tr>
<td>###0</td>
<td>describes the number as an integer without a thousands separator.</td>
</tr>
<tr>
<td>0000</td>
<td>describes the number as an integer with at least four digits. For example, the number 123 will be shown as 0123.</td>
</tr>
<tr>
<td>0.000</td>
<td>describes the number with three decimals. In this example &quot;.&quot; is used as a decimal separator.</td>
</tr>
</tbody>
</table>

Special number formats

Qlik Sense can interpret and format numbers in any radix between 2 and 36 including binary, octal and hexadecimal. It can also handle roman formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary format</td>
<td>To indicate binary format the format code should start with (bin) or (BIN).</td>
</tr>
<tr>
<td>Octal format</td>
<td>To indicate octal format the format code should start with (oct) or (OCT).</td>
</tr>
</tbody>
</table>
### Creating visualizations

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hexadecimal format</strong></td>
<td>To indicate hexadecimal format the format code should start with (hex) or (HEX). If the capitalized version is used A-F will be used for formatting (for example 14FA). The non-capitalized version will result in formatting with a-f (for example 14fa). Interpretation will work for both variants regardless of the capitalization of the format code.</td>
</tr>
<tr>
<td><strong>Decimal format</strong></td>
<td>The use of (dec) or (DEC) to indicate decimal format is permitted but unnecessary.</td>
</tr>
<tr>
<td><strong>Custom radix format</strong></td>
<td>To indicate a format in any radix between 2 and 36 the format code should start with (rxx) or (Rxx) where xx is the two-digit number denoting the radix to be used. If the capitalized R is used letters in radices above 10 will be capitalized when Qlik Sense is formatting (for example 14FA). The non-capitalized r will result in formatting with non-capital letters (for example 14fa). Interpretation will work for both variants regardless of the capitalization of the format code. Note that (r02) is the equivalent of (bin), (R16) is the equivalent of (HEX), and so on.</td>
</tr>
<tr>
<td><strong>Roman format</strong></td>
<td>To indicate roman numbers the format code should start with (rom) or (ROM). If the capitalized version is used capital letters will be used for formatting (for example MMXVI). The non-capitalized version will result in formatting with lower cap letters (mmxvi). Interpretation will work for both variants regardless of the capitalization of the format code. Roman numbers are generalized with minus sign for negative numbers and 0 for zero. Decimals are ignored with roman formatting.</td>
</tr>
</tbody>
</table>

**Examples:**

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>num(199, '(bin)')</td>
<td>returns 11000111</td>
</tr>
<tr>
<td>num(199, '(oct)')</td>
<td>returns 307</td>
</tr>
<tr>
<td>num(199, '(hex)')</td>
<td>returns c7</td>
</tr>
<tr>
<td>num(199, '(HEX)')</td>
<td>returns C7</td>
</tr>
<tr>
<td>num(199, '(r02)')</td>
<td>returns 11000111</td>
</tr>
<tr>
<td>num(199, '(r16)')</td>
<td>returns c7</td>
</tr>
<tr>
<td>num(199, '(R16)')</td>
<td>returns C7</td>
</tr>
<tr>
<td>num(199, '(R36)')</td>
<td>returns 5J</td>
</tr>
<tr>
<td>num(199, '(rom)')</td>
<td>returns cxcix</td>
</tr>
<tr>
<td>num(199, '(ROM)')</td>
<td>returns CXCIX</td>
</tr>
</tbody>
</table>

**Dates**

You can use the following symbols to format a date. Arbitrary separators can be used.
Symbols to format a date

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>To describe the day, use the symbol &quot;D&quot; for each digit.</td>
</tr>
<tr>
<td>M</td>
<td>To describe the month number, use the symbol &quot;M&quot;. Use &quot;M&quot; or &quot;MM&quot; for one or two digits. &quot;MMM&quot; denotes short month name in letters as defined by the operating system or by the override system variable <code>MonthNames</code> in the script. &quot;MMMM&quot; denotes long month name in letters as defined by the operating system or by the override system variable <code>LongMonthNames</code> in the script.</td>
</tr>
<tr>
<td>Y</td>
<td>To describe the year, use the symbol &quot;Y&quot; for each digit.</td>
</tr>
<tr>
<td>W</td>
<td>To describe the weekday, use the symbol &quot;W&quot;. &quot;W&quot; will return the number of the day (for example 0 for Monday) as a single digit. &quot;WW&quot; will return the number with two digits (e.g. 02 for Wednesday). &quot;WWW&quot; will show the short version of the weekday name (for example Mon) as defined by the operating system or by the override system variable <code>DayNames</code> in the script. &quot;WWWW&quot; will show the long version of the weekday name (for example Monday) as defined by the operating system or by the override system variable <code>LongDayNames</code> in the script.</td>
</tr>
</tbody>
</table>

Examples: (with 31st March 2013 as example date)

Examples of date formats

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>YY-MM-DD</td>
<td>describes the date as 13-03-31.</td>
</tr>
<tr>
<td>YYYY-MM-DD</td>
<td>describes the date as 2013-03-31.</td>
</tr>
<tr>
<td>YYYY-MMM-DD</td>
<td>describes the date as 2013-Mar-31.</td>
</tr>
<tr>
<td>DD MMMM YYYY</td>
<td>describes the date as 31 March 2013.</td>
</tr>
<tr>
<td>M/D/YY</td>
<td>describes the date as 3/31/13.</td>
</tr>
<tr>
<td>W YY-MM-DD</td>
<td>describes the date as 6 13-03-31.</td>
</tr>
<tr>
<td>WWW YY-MM-DD</td>
<td>describes the date as Sat 13-03-31.</td>
</tr>
<tr>
<td>WWWWW YY-MM-DD</td>
<td>describes the date as Saturday 13-03-31.</td>
</tr>
</tbody>
</table>

Times

You can use the following symbols to format a time. Arbitrary separators can be used.
3 Creating visualizations

Symbols to format a time

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>To describe the hours, use the symbol &quot;h&quot; for each digit.</td>
</tr>
<tr>
<td>m</td>
<td>To describe the minutes, use the symbol &quot;m&quot; for each digit.</td>
</tr>
<tr>
<td>s</td>
<td>To describe the seconds, use the symbol &quot;s&quot; for each digit.</td>
</tr>
<tr>
<td>f</td>
<td>To describe the fractions of a second, use the symbol &quot;f&quot; for each digit.</td>
</tr>
<tr>
<td>tt</td>
<td>To describe the time in AM/PM format, use the symbol &quot;tt&quot; after the time.</td>
</tr>
</tbody>
</table>

Examples: (with 18.30 as example time):

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>hh:mm</td>
<td>describes the time as 18:30.</td>
</tr>
<tr>
<td>hh:mm:ss.ff</td>
<td>describes the time as 18.30.00.00</td>
</tr>
<tr>
<td>hh:mm:tt</td>
<td>describes the time as 18.30.00.00</td>
</tr>
</tbody>
</table>

Time stamps

The same notation as that of dates and times above is used in time stamps.

Examples: (with 31th March 2013 18.30 as example time stamp):

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>YY-MM-DD hh:mm</td>
<td>describes the time stamp as 13-03-31 18:30.</td>
</tr>
<tr>
<td>M/D/Y hh:mm:ss.ff</td>
<td>describes the time stamp as 3/31/13 18.30.00.00.00</td>
</tr>
</tbody>
</table>

Using system fields in a visualization

You can use system fields in a visualization. System fields are created by Qlik Sense when the data load script is generated, and include information about the fields and tables in the loaded data. A system field begins with "$", and you need to reference it by typing the field name including the "$" manually. You can use a system field to create a dimension either as a master item or from the properties panel.

Preview of a dimension based on a system field.
A system field added as dimension in the properties panel.

See also:

* Reusing dimensions with master dimensions (page 63)
* Fields (page 49)
Creating visualizations

Using alternate states for comparative analysis
If you want to perform comparative analysis you can use alternate states in Qlik Sense. Alternate states allow you to make different selections on the same dimension, and compare the selections in a single visualization or in two or more visualizations side by side.

You can use alternate states in visualizations in two different ways:

- Applying a state to the visualization. This connects the selection of the visualization to the selection of the state.
- Using states in the set expression of a measure. This is useful to compare measure values of different states.

Creating alternate states

You can create a new alternate state under Alternate states in Master items:

1. Select Create new.
2. Provide a name for the new state. There are some naming limitations:
   - Do not use $, 0, or 1 as a state name.
   - Do not use a state name starting with $ or $_ followed by a number, for example, $3.
   - Do not use a state name already used as a bookmark name.

You have now created a new alternate state that you can use to perform comparative analysis. Typically you would want to create another new state to compare the two states.

Applying alternate states to sheets and visualizations

You can apply a state to a visualization, or a sheet. If you apply a state to a sheet, all visualizations on the sheet inherit the state unless you apply another state to a specific visualization. When you apply a state to a visualization, it reflects the selections made in the state. Any selections you make will be applied to the state and be reflected in other visualizations that have the same state applied.

The easiest way to apply an alternate state is dropping it on a sheet or a visualization, and then selecting Apply state.

You can also apply an alternate state with the State setting in the property panel:

- For a sheet, you find the setting under Alternate states.
- For a visualization, you find the setting under Appearance > Alternate states.

You can select:

- Any alternate state defined in Master items.
- <inherited>, in which case the state defined for the sheet is used.
- <default state>, which represents the state where no alternate state is applied.
Creating visualizations

Using alternate states in visualizations

Besides applying a state to a visualization you can also use alternate states in the set expression of a measure. This is useful when you want to compare measure values for different dimension selections side by side.

You can set the alternate state as an identifier in the set expression. If you want to use the measure \( \text{sum(Sales)} \) in your visualization, for example a bar chart, with a state called \( \text{Group1} \) you use the following expression as measure:

\[
\text{sum(\{Group1\}Sales)}
\]

To compare with a different state called \( \text{Group2} \), you can create another measure with the expression \( \text{sum(\{Group2\}Sales)} \).

The bar chart will now show sales for the selection in \( \text{Group1} \) side by side with sales for \( \text{Group2} \).

Getting information about the selection of an alternate state

You can see the selections of different states in the selections bar.

You may also want to be able to use information about which, and how many selections are made in a alternate state in labels or titles of visualizations. You can use the following chart functions with the \text{state\_name} parameter to return selections associated with the specified state name:

- \text{GetCurrentSelections()} \) to return all current selections.
- \text{GetFieldSelections()} \) to return current selections of a field.
- \text{GetSelectedCount()} \) to return the number of selected values in a field.

Limitations

It is not possible to add visualizations to master items if you have set the state of the visualization to any other value than <inherited>.

Comparative analysis example

In this example we want to be able to compare the sales numbers of product lines for different selections of sales regions. We want to select the regions we compare dynamically, either as single regions or a combination of regions.

Dataset and app

If you want to follow this example, you need to download the Qlik Sense Tutorial - Building an App to get the dataset. If you have completed the tutorial you can use the app you created. Otherwise you need to create an app, add all six data files in the Tutorials source folder, and associate them using automatic recommendations in the data manager.

Tutorial - Building an App

Create alternate states

For this example we need two alternate states. In \text{Master items > Alternate states}:
1. Create a new state called Group 1.
2. Create a new state called Group 2.

You have now created the two alternate states we need in this example.

Create filter panes for selection
1. Add a filter pane with the field Region.
2. Edit the label of the filter pane to say =StateName(). This is to make it easier to tell them apart, as the state is not indicated in the filter pane. The StateName() function returns the state that is applied to the function.
3. Drop the state Group 1 on the filter pane and select Apply state.
4. Add another filter pane with the field Region.
5. Edit the label of the second filter pane to say =StateName().
6. Drop the state Group 2 on the second filter pane and select Apply state.

You have now created the two filter panes that are used to control the selections of each of the two states. When you make a selection in the Group 1 filter pane, the same selection is applied to the state Group 1 which is reflected in all visualizations connected to that state.

Create a bar chart for analysis
1. Create a master item measure with name Group1Sales.
   Set Expression to sum([Group 1][Sales]).
   This expression sums the sales for all selections in the Group 1 state.
   Set Label expression to 'Sales ' &GetCurrentSelections(chr(13)&chr(10), '=', ',', 9, 'Group 1').
   We use a label expression to be able to show the current selection of the state as a label in the chart, instead of the default label.
2. Create another master item measure with name Group2Sales.
   Set Expression to sum([Group 2][Sales]).
   Set Label expression to 'Sales ' &GetCurrentSelections(chr(13)&chr(10), '=', ',', 9, 'Group 2').
3. Add a bar chart to the sheet.
4. Set the Product Line field as dimension.
5. Add the measures Group1Sales and Group2Sales.

You have now created a bar chart that shows the sales by product line for the two groups of regions selected in the filter panes. When you make a new selection in one of the filter panes, the corresponding measure value changes according to the new selection.

Discovery
You can now make selections in Group 1 and Group 2, and see the results of the selected combinations of regions in the bar chart.

Creating a visualization using a custom object
You can enhance your apps with custom-objects. Custom objects that are available are:
• visualization extensions
• widgets
• visualization extension bundles supplied by Qlik:
  • Dashboard bundle is a set of visualization extensions that you can use to enhance navigation and selection in your Qlik Sense app. The extensions are optional. You do not have to install or enable them to use Qlik Sense. (page 308)
  • Visualizations are an important means of conveying information from massive data. The Visualization bundle is a set of extensions that can be used to enhance and increase your Qlik Sense app’s charting capacity. The extensions are optional. You do not have to install or enable them to use Qlik Sense. (page 318)

You can find custom objects in the assets panel under Custom objects when you are editing a sheet.

You can build your own visualization extensions and widgets in the Dev Hub.
* For the Dev Hub, see Dev Hub.

Adding a custom object to the sheet

You start creating a visualization by dragging a visualization extension or a widget onto a sheet.

Do the following:

1. Click in the toolbar.
2. Click in the panel on the left-hand side to expand custom objects.
3. Drag a visualization extension or a widget onto the sheet.
   You can drop it in an empty location on the sheet, split the area of an existing visualization into two, or replace an existing visualization.
   
   If you double-click a custom object, it is added to the sheet immediately.

4. Change the required settings for the custom object in the properties panel. The required settings are defined by the extension developer, this can be dimensions, measures, or other settings.

You now have a complete visualization that you can start using while exploring the data in the app.

Limitations of extension bundles supplied by Qlik

When you use extensions from an extension bundle supplied by Qlik there are some limitations compared to built-in visualizations, such as bar charts. The following limitations are valid for all extensions from an extension bundle:

• The user interface of the visualization is not localized to the language that Qlik Sense is using.
• Right-to-left reading order is not currently supported.
• Accessibility features are not currently supported.
• It is not possible to edit visualization extensions from an extension bundle supplied by Qlik with Dev Hub.
3 Creating visualizations

The following tables show which additional features are supported, or not supported, for all bundled extensions. Some capabilities are generally supported (Y), with some exceptions (N), as described in the capability support tables. In some cases the capability is not applicable to an extension (N/A).

- Printing
  Printing a visualization made in an extension.
- Qlik NPrinting
  There is an On-Demand reporting extension (page 313). However, visualizations made in some extensions cannot be used in Qlik NPrinting reports.
- Export
  Exporting to image, PDF, or Excel.
- Storytelling
  Using a snapshot of a visualization created with an extension in a story.
- Alternate states
- Qlik Sense Mobile offline
- Qlik Sense Mobile

**Dashboard bundle capability support**

<table>
<thead>
<tr>
<th>Extension</th>
<th>Printing</th>
<th>Qlik NPrinting</th>
<th>Export</th>
<th>Storytelling</th>
<th>Alternate states</th>
<th>Qlik Sense Mobile offline</th>
<th>Qlik Sense Mobile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buttons for navigation</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Date picker</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>On-demand reporting</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
</tr>
<tr>
<td>Show/hide container</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Tabbed container</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Variable input</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Share button</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Visualization bundle capability support**
Creating visualizations

<table>
<thead>
<tr>
<th>Extension</th>
<th>Printing</th>
<th>Qlik NPrinting</th>
<th>Export</th>
<th>Storytelling</th>
<th>Alternate states</th>
<th>Qlik Sense Mobile offline</th>
<th>Qlik Sense Mobile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar &amp; area</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Bullet</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Funnel</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Heatmap</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Multi KPI</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Network</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>P&amp;L pivot</td>
<td>Y</td>
<td>N/A</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Radar</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Sankey</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Trellis container</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Wordcloud</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

Dashboard bundle

Dashboard bundle is a set of visualization extensions that you can use to enhance navigation and selection in your Qlik Sense app. The extensions are optional. You do not have to install or enable them to use Qlik Sense.

Enabling extensions

You can install the Dashboard bundle when you install Qlik Sense. If you need to adjust your extension installation, see: Modifying extension bundles installation.

Creating extensions

Dashboard extensions are in the asset panel under Custom objects.

The following extensions are included:

- **Date range picker extension (page 309)**
  You can select a single date or a range of dates from a calendar.

- **Navigation button extension (page 310)**
  You can add a button that will navigate to another sheet, story, or website. You can also add one or more actions that will be executed before navigation.

- **On-Demand reporting extension (page 313)**
  You can add a button that creates a Qlik NPrinting report using the current selections in the app.
Share button extension (page 314)
You can add a button to generate a link to share so other can see what you see.

Show/hide container extension (page 315)
You can control which visualization to show based on conditions that you have defined.

This visualization extension is replaced by the container object.

Tabbed container extension (page 316)
You can control which visualization to show based on conditions that you have defined.

This visualization extension is replaced by the container object.

Variable input extension (page 317)
You can set the value of a variable.

Date range picker extension
The date range picker (Date picker) is a visualization extension that lets you select a single date or a range of dates from a calendar. It is included in Dashboard bundle.

- In single date mode, you select from a simple calendar.
- In date interval mode, you can select a range from the calendar, or any of the predefined ranges that are available.

When to use it
The date range picker is useful when you have one or more date fields that you need to use to filter your selections.

Creating a date range picker
You can create a date range picker on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Date picker object to the sheet.
2. Select the date field to use as filter in Date field.
   The list contains only fields that are recognized as a date field by Qlik Sense.

   If you want to use a timestamp field, you need to convert it to a date. Use the expression 
   =date(floor(myTimeStamp_Field)) instead of myTimeStamp_Field.

3. Select if you want to be able to pick a single date or a date interval in Single date / interval.
   Date interval lets you pick a range of dates.
   Single date lets you pick a single date only.

When you have created the date range picker, you may want to adjust its appearance and other settings.
Setting the available date range
You can set the range of dates available to pick by setting the option Advanced setup to On. You can use expressions or explicit date values. The expressions used below refer to a field named DateField.

- Set the first date of the calendar with Min date. Default value is $\min(1) \{[\text{DateField}]\}$. This expression returns the first date in DateField in the full data set.
- Set the last date of the calendar with Max date. Default value is $\max(1) \{[\text{DateField}]\}$. This expression returns the last date in DateField in the full data set.
- Set the date to show when the date range picker is opened with Start date. Default value is $\min([\text{DateField}])$. This expression returns the first date in DateField in the current selection.

Setting locale of the calendar
You can set the locale of the calendar to get local names for days and months. Change the setting Locale under Calendar Settings > Language and labels to the two-letter code of the locale you want to use. For example, you can change the default value of en for English to de for German.

Customizing text labels
You can customize the text labels that are shown when the date range picker is used.

You change the text prompt shown when the date range picker is minimized with the setting Default Text under Calendar Settings > Language and labels. The default setting is 'Select date range'.

In date interval mode there are a number of predefined ranges available to pick if Show predefined ranges is set to On. You can customize the text labels for the predefined range selections with the settings under Calendar Settings > Predefined ranges:

- Custom Range represents the option where you select a date interval freely from the calendar. Default value is Range.
- Today represents the date value of today. Default value is Today.
- Yesterday represents the date value of yesterday. Default value is Yesterday.
- Last $s$ days represents the two options for showing the last 7 or 30 days. $s$ is replaced by 7 or 30 in the string. Default value is Last $s$ days.
- This Month represents the current month. Default value is This Month.
- Last Month represents the current month. Default value is Last Month.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

Navigation button extension
The navigation button (Button for navigation) is a visualization extension that lets you add a button that navigates to another sheet, story, or website. You can also add one or more actions that will be executed before navigation. It is included in Dashboard bundle.
3 Creating visualizations

When to use it
The navigation button is useful when you want to provide customized navigation options, for example, if you want to go to another sheet and clear all selections.

Creating a navigation button
You can create a navigation button on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Button for navigation object to the sheet.
2. Select a navigation action by setting the option Navigation action in Actions and navigation > Navigation. The navigation options that are available are:
   - **None**: no navigation action is performed when clicking the button, but you can add another basic action.
   - **Go to first sheet**: open the first sheet of the app.
   - **Go to next sheet**: open the next sheet of the app.
   - **Go to previous sheet**: open the previous sheet of the app.
   - **Go to last sheet**: open the last sheet of the app.
   - **Go to a sheet**: open a specified sheet. Select which sheet to open with Select sheet.
   - **Go to a sheet (defined by sheet ID)**: open a specified sheet defined by the sheet ID. Enter the sheet ID of the sheet to open with Sheet ID.
   - **Go to a story**: open a specified story. Select which sheet to open with Select story.
   - **Open a website / eMail**: open a specified web site. Enter the URL of the web site in Website URL. You can set if you want to open the website in the same window or in a new window with the Open in same window setting.
   - **Switch to edit mode**: switch to edit mode of the current sheet.
3. Set the name of the button in Label under Button layout > Label.

When you have created the navigation button, you may want to adjust its appearance and add one or more basic actions to perform before navigation.

Adding actions that are performed before navigation
You can add one or more additional actions that are performed before the navigation action under Actions and navigation > Navigation. The actions are performed in order from the top.

In all actions where you can select a field with Select field you can define the field with an expression by selecting Define field by expression in the drop-down, and then entering the expression in Field.

- **Apply a bookmark**: apply a bookmark that you specify with Select bookmark.
- **Clear all selections**: clear all selections in all fields.
- **Clear selections in other fields**: clear selections in all fields that are related to a field that you specify with Select field. You can choose to override locked fields with the Overwrite locked selections setting.
3 Creating visualizations

- **Move forwards (in your selections):** go one step forward in the selection history.
- **Move backwards (in your selections):** go one step back in the selection history.
- **Clear selections in field:** clear all selections in a field that you specify with **Select field**.
- **Lock all selections:** lock all selections in all fields.
- **Lock a specific field:** lock all selections in a field that you specify with **Select field**.
- **Unlock all selections:** unlock all selections in all fields.
- **Unlock a specific field:** unlock all selections in a field that you specify with **Select field**.
- **Unlock all and clear all:** unlock and clear all selections in all fields.
- **Select a value in a field:** select a value, specified with **Value**, in a field that you specify with **Select field**.
- **Select all values in a field:** select all values in a field that you specify with **Select field**. You can choose to override locked fields with the **Overwrite locked selection** setting.
- **Select multiple values in a field:** select multiple values, specified with a list of values separated by a semi-colon in **Value**, in a field that you specify with **Select field**.
- **Select alternatives:** select all alternative values in a field that you specify with **Select field**. You can choose to override locked fields with the **Overwrite locked selection** setting.
- **Select a value and lock field:** select a value, specified with **Value**, in a field that you specify with **Select field**, and then lock the field.
- **Select excluded:** select all excluded values in a field that you specify with **Select field**. You can choose to override locked fields with the **Overwrite locked selection** setting.
- **Select possible values in a field:** select all possible values in a field that you specify with **Select field**. You can choose to override locked fields with the **Overwrite locked selection** setting.
- **Set variable value:** set the value, specified with **Value**, of a variable that you specify with **Variable name**.
- **Toggle field selection:** toggle a value, specified with **Value**, in a field that you specify with **Select field**. You can choose to override locked fields with the **Overwrite locked selection** setting.

**Changing appearance**

You can change the appearance of the button in several ways under **Button layout** in the property panel:

- Change the label of the button in **Label**.
- Add an icon to the button by setting **Show icon** to **On** under **Icon**, and selecting which icon to show in **Icon**.
- Set size and alignment under **Size and alignment**.
  You can set the width of the button with **Button width**. Select **Full Width** if you want the button to be as wide as possible, and choose the position of the label with **Label alignment**. You can also select **Auto Width** if you want the button width adjusted to the length of the label text.
  Set the position of the button within the container with **Button position**.
- Set a condition for enabling the button by setting **Use enable condition** to **On** under **Enable condition**, and entering the expression to evaluate in **Enable condition**.
Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

On-Demand reporting extension
The On-Demand reporting extension is a visualization extension that adds a button to create Qlik NPrinting reports on demand. It is included in Dashboard bundle.

Requirements
You need to have access to a Qlik NPrinting Server (June 2017 or later) with a Qlik NPrinting app that is connected to the Qlik Sense app that you are designing. This Qlik NPrinting app contains your report templates. There are some additional requirements:

- Reports need to be enabled for On-Demand in the Qlik NPrinting web console.
- All users running On-Demand reports need to be added as users in Qlik NPrinting, with a security role that supports running On-Demand reports.

When to use it
The On-Demand reporting extension is useful when you want the user to be able to print predefined Qlik NPrinting reports within Qlik Sense, using their selections in the app as a filter.

Creating an on-demand reporting button
You can create an On-Demand reporting button on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag On-demand reporting to the sheet.
2. Set the server connection in Server Connection under NPrinting Connection in the property panel. The URL must end with /.
   
   Example: https://<server name>:4993/

3. Select the Qlik NPrinting that contains the report template app in Choose App.
4. Select the report to connect to the button in Choose Report under Report Configuration.
5. Select a default export format of the report in Default Export Format.
6. Set the button label in Button Label under Appearances.

You have now created an On-Demand reporting button. When you click the button, a report is generated.

Generating a report
You can generate a report that is filtered according to the current selections in the Qlik Sense app. You need to be in analysis mode.

You can only filter on fields that are included in the Qlik NPrinting report template, or the report will fail. It is not possible to filter on selections using an expression.
1. Click on the button that you created. The Export dialog is opened, showing the status of the report generation.

2. When the report is generated a download button is activated. Click the download button to download the report.

You have now downloaded the report.

You can also generate any Qlik NPrinting On-Demand report that is available to you with the New Report button in the Export dialog. You are prompted to select a report and export format.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

• If the Qlik NPrinting report template contains a filter, it is not possible to make conflicting selections in the Qlik Sense app, or the report will fail.

Share button extension
The Share button (Share button) is a visualization extension that lets you add a button to generate a link to the current sheet. When you follow the link all selections are maintained. It is included in the Dashboard bundle.

When to use it
The share button is useful when you want others to see this sheet as you see it.

Creating a share button
You can create a share button on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Share button object to the sheet.

2. Click Copy from textbox under Export settings > Output method in the property panel. The button displays with the text Generate Link and an empty textbox next to it.

3. Click the Done button to stop editing the sheet.

4. Click the button you created. A link is generated and displayed in the textbox next to the share button.

5. Copy and share the link with those you wish to share with. You can share the generated link through three output methods:

   • Copy to Clipboard
   • Create New Email with link
   • A textbox.
Example:

When you create a share button the “full screen” Copy to clipboard button is created by default. To use this version, click Done and click the button you created to copy the sharable site link to the clipboard. There are limitations to this option in certain browsers, for example when using a mobile.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

- We recommend that you do not use selections of many individual values. The URL should contain less than 2000 characters due to browser limitations. You can limit the number of selections included with the option Export Settings > Max Values Selected in One Field.
- Special characters (' / - * & ') are not allowed in selections.
- It is not possible to copy to clipboard in all browsers.
- It is not possible to use selections based on an expression.

Show/hide container extension
The show/hide container is a visualization extension that lets you show or hide master visualizations based on conditions. It is included in Dashboard bundle.

This visualization extension is replaced by the container object.

When to use it
The show/hide container is useful when you want to show different visualizations based on, for example:

- Which user is accessing the chart.
- The value of a variable.
- Possible number of values in a field, by using the GetPossibleCount() function in the condition expression.
Creating a show/hide container
You can create a show/hide container on the sheet you are editing. You need to have at least two master visualizations that you have created.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Show/hide container object to the sheet.
2. Click Add Visualization under Visualizations in the property panel.
3. Select a master visualization in Master Object.
4. Add a show condition for the chart in Show Condition for Chart. Typically you would use an If() function.
5. Add another visualization with a different show condition.

You will now have two visualizations in Visualizations. If the condition of a chart results in 1, it is shown, and if it is 0, it is hidden. The container can only show one chart, so if both conditions are 1, the first chart is shown. If all chart conditions are 0, all charts will be hidden.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

You cannot use a master visualization that contains a show/hide container inside another show/hide container.

Tabbed container extension
The tabbed container is a visualization extension that lets you add up to five tabs to show different master visualizations. It is included in Dashboard bundle.

This visualization extension is replaced by the container object.

When to use it
The tabbed container is useful when you want the user to be able to switch between different visualizations quickly on a dashboard with limited screen real estate.

Creating a tabbed container
You can create a tabbed container on the sheet you are editing. You need to have at least two master visualizations that you have created.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag a Tabbed container object to the sheet.
2. Select how many tabs you want to display in Number of Tabs under Appearance > Tabs in the property panel.
3. For each tab, select the master visualization to display in Chart, and enter the tab label in Label.
You can also select to enable export for each tab with **Enable export**. This adds an export button which exports the data of the visualization in Excel format.

You will now have a visualization with two tabs. You can switch between the tabs to show different visualizations.

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

There are some specific limitations for the tabbed container:

- It is not possible to use a master visualization that contains a tabbed container inside another tabbed container.
- Tab selection is not remembered when navigating between sheets or refreshing the browser.

**Variable input extension**

The variable input extension is a visualization extension for setting the value of a variable. It is included in Dashboard bundle.

**When to use it**

If you have visualizations with expressions that contain a variable, you can use the variable input extension to let the user control the variable value.

**Creating a variable input control**

You can create a variable input control on the sheet you are editing.

Do the following:

1. From the assets panel, under **Custom objects** > **Dashboard bundle** drag a **Variable input** object to the sheet.
2. Select the variable to use in **Name** under **Appearance** > **Variable** in the property panel.
3. Select how you want to input data in **Show as**:
   - **Buttons** lets you add a number of buttons with one button for each defined variable value. You can select how to display the buttons in **Display**, select **Row** to show them in a horizontal row or **Column** to show them in a vertical column. You can define the buttons in two different ways, fixed (Fixed) or (dynamic) Dynamic with the **Fixed or dynamic values** setting under **Values**. If you select to use fixed values, you need to add each button with **Add Alternative** and define a value (Value) and a label (Label) for each button. If you use dynamic values, you define the buttons with a string in **Dynamic values**. Use | to separate buttons, and ~ to separate value from label. For example, ‘Germany~GER|France~FRA’ will create two buttons labelled GER and FRA. The first will change the variable value to Germany, and the second changes the value to France. You do not need to specify labels if you want to use values as labels.
   - **Drop down** adds a drop down with one item for each defined variable value. You can define the items in two different ways, fixed (Fixed) or (dynamic) Dynamic with the **Fixed or dynamic values** setting under **Values**.
3 Creating visualizations

If you select to use fixed values, you need to add each item with Add Alternative and define a value (Value) and a label (Label) for each item.

If you use dynamic values, you define the items with a string in Dynamic values. Use | to separate items, and ~ to separate value from label. For example, ‘Germany~GER|France~FRA’ will create two items labelled GER and FRA. The first will change the variable value to Germany, and the second changes the value to France. You do not need to specify labels if you want to use values as labels.

- **Input box** provides a simple input box that will update the variable value.

- **Slider** creates a slider that updates the variable value. You define the minimum setting with Min and the maximum setting with Max under Values. You can also set the step to use with Step. If you select Slider label, the selected value is displayed when you drag the slider.

The variable value is updated when you stop dragging the slider, but you can select Update on drag if you want the variable value to be updated while you drag. This can be useful when you want visualizations based on the variable to update dynamically when dragging the slider. Use this option with caution, as the constant redrawing of charts can be annoying.

**Limitations**

For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

- The slider label can only display numeric values. This means, if the value is a date the numeric value of the date is displayed. If the value is a percentage value, the percentage character is not displayed.

**Visualization bundle**

Visualizations are an important means of conveying information from massive data. The Visualization bundle is a set of extensions that can be used to enhance and increase your Qlik Sense app's charting capacity. The extensions are optional. You do not have to install or enable them to use Qlik Sense.

**Enabling extensions**

You can install the Visualization bundle when you install Qlik Sense. If you need to adjust your extension installation, see: Modifying extension bundles installation.

**Creating extensions**

Visualization extensions are in the asset panel under Custom objects.

The following extensions are included:

- **100% stacked bar chart (page 320)**
  Create bar charts and area charts and enhance them with transitions and connectors.

- **Changing the color scheme (page 324)**
  A bullet chart is a gauge that can also show a target marker and a qualitative range to show performance.

- **Funnel mode (page 327)**
  A funnel chart is a visual representation of the connected stages of a linear process.
3 Creating visualizations

- **Using the lasso selection tool** *(page 335)*
  A chart that displays comparative data and with the values represented as colors.

- **Multi KPI extension** *(page 339)*
  An extension that shows KPI for multiple dimension values to quickly understand and track performance.

- **Configuring edge type** *(page 353)*
  Creates a cluster diagram representing a graphical chart of a computer network.

- **Style template format** *(page 357)*
  Creates a pivot table that you can style, for example for profit and loss reporting.

- **Changing the color scheme** *(page 361)*
  Creates a two-dimensional chart using radial axes to show the scoring of a measure in one dimension or another.

- **Sankey chart extension** *(page 363)*
  A flow chart diagram chart visually emphasizing major transfers or flows within defined system boundaries.

- **Troubleshooting** *(page 367)*
  Creates a trellis chart based on a master visualization.

- **Word cloud chart extension** *(page 369)*
  A cloud chart of words with their size based on measure value.

**Bar & area chart extension**
You can use the bar & area chart *(Bar & area chart)* to create simple or stacked bar charts and area charts. You can enhance the charts with transitions and connectors, and use the **100% bar chart** option to make all stacked bars the same height. The bar & area chart is included in the Visualization bundle.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>no dimension</td>
<td>up to 10 measures</td>
<td>A simple bar chart with one bar for each measure.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>1 measure</td>
<td>A simple bar chart with one bar for each dimension value.</td>
</tr>
<tr>
<td>1 dimension</td>
<td>up to 5 measures</td>
<td>A stacked bar chart with one bar for each dimension value or an area chart.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>1 measure</td>
<td>A stacked bar chart with one bar for each value of the first dimension or an area chart. Each bar will show the measure value for each value of the second dimension.</td>
</tr>
</tbody>
</table>

**Bar & area chart recipes**
Here are some examples of charts you can create with the bar & area chart extension.
100% stacked bar chart

This example creates a stacked bar chart where each bar is the same height. You can use this to compare the bar segments relative to each other, but not in absolute values.

You need a chart with two dimensions and one measure. Set the following properties:

- **Appearance > Presentation > 100% bars = 100% bars**
- **Appearance > Presentation > Grid height relative to max bar = 1**
- **Appearance > Colors and Legend > Single Colors = Multi-color**

A bar & area chart where the stacked bars are displayed with equal height.

We can add connectors to the chart. Set the following additional properties:

- **Appearance > Presentation > Show bar connectors = Bars with connectors**
- **Appearance > Presentation > Bar spacing = 0.5**
- **Appearance > Presentation > Outer bar spacing = 0**
A bar & area chart where the stacked bars are displayed with equal height, and connectors are used.

**Area chart**

This example creates an area chart. You can use the same data set as in the previous examples. Set the following properties:

- Appearance > Presentation > 100% bars = Not 100%
- Appearance > Presentation > Grid height relative to max bar = 1.1
- Appearance > Presentation > Show bar connectors = Bars with connectors
- Appearance > Presentation > Bar spacing = 1
- Appearance > Presentation > Outer bar spacing = 0

![Area chart example](image)

Area chart

Just like the stacked bar chart, you can make a 100% area chart by changing the following properties:

- Appearance > Presentation > 100% bars = 100% bars
- Appearance > Presentation > Grid height relative to max bar = 1
Changing the appearance of the chart
You can customize the appearance of your chart.

Adding connectors
You can add connectors between bars by setting Appearance > Presentation > Show bar connectors to Bars with connectors. You can adjust the width of the connectors with the Bar spacing setting. If you set Bar spacing to 1, you will get an area chart.

Setting stacked bars to 100%
You can set the bars to be equally high to compare the bar segments relative to each other. Set Appearance > Presentation > 100% bars to 100% bars.

Adding transitions
You can add transition effects when the chart is updated by changed selections under Appearance > Transitions.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

- Negative measure values are not supported.

Bullet chart extension
The bullet chart (Bullet chart) displays a gauge with extended options. Bullet charts can be used to visualize and compare performance of a measure to a target value and to a qualitative scale, such as poor, average, and good. The bullet chart is included in the Visualization bundle.

A bullet chart can contain from one to three measures:
3  Creating visualizations

- The first measure (Measure) is the actual value, represented by the bar.
- The second measure (Marker) defines a target value, which is represented by a vertical marker line.
- The third measure (Range) defines a qualitative range displayed behind the bar. This consists of three ranges.

You can also add a dimension. This will show one gauge for every dimension value. If you do not define a dimension, the chart will show a single gauge.

**Example:**

![Bullet chart example](image)

*A bullet chart with one gauge for each value of the dimension (product group).*

**When to use it**

Bullet charts let you compare and measure performance with more enriched information than a common gauge. This is helpful when comparing performance according to a target and a simple performance rating. For example: you can show how sales relate to a target value, and in context of poor, good, and stretched performance.

**Creating a bullet chart**

You can create a bullet chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects >Visualization bundle and drag a Bullet chart object to the sheet.
2. Click the Add measure button to select the value measure of the chart.
   Once the first measure is selected the bullet chart is displayed.
3. To add a target value, click **Add** under **Measures**. You can define a fixed value or use a measure with target values.

4. To add performance ranges, click **Add** under **Measures**. This will define the maximum performance range value. You can set the internal range limits later.

5. To show one gauge for every dimension value, click **Add** under **Dimensions**.

The bullet chart is now displayed with the dimensions and measures you selected.

### Changing the appearance of the chart
You can customize the appearance of your bullet chart.

### Changing the color scheme
You can change color scheme of the value bar, the marker and the range.

Do the following:

- Set value bar color in **Appearance > Measure bar > Change bar color** in the property panel.
- Set marker color in **Appearance > Marker > Change marker color** in the property panel.
- Set range color in **Appearance > Range > Change range color** in the property panel. The color you select is used for the highest range. The two lower ranges are displayed in darker shades of that color.

> It's a good idea to select a light range color to avoid poor contrast between the ranges. You should also make sure that the range color is less visually dominant than the value bar.

### Changing the range limits
You can also customize the limits of the ranges under **Appearance > Range** in the properties panel. The full range is defined by the value of the third measure of the chart.

- **Set middle range (%)** defines the upper limit of the middle range.
- **Set lower range (%)** defines the upper limit of the lower range.

### Changing the scale of the axis
If you use a dimension to show several gauges, you can select how to show the scale of the axis with **Axis > Consistent for all axis dimension values**.

- If you want each dimension gauge to use the same scale, enable this option. If the range measure depends on the dimension value, the range bars will have different lengths. This is useful when you want to be able to compare the actual values.
- If you want each range bar to be equally long, disable this option.

**Example:**

In this example, **Consistent for all axis dimension values** is disabled. This makes it easier to compare the relative performance of each product group.
Creating visualizations

A bullet chart with **Consistent for all axis dimension values** disabled.

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

- You can not make selections in a bullet chart.

**Funnel chart extension**

The Funnel chart (**Funnel chart**) is a visualization extension that lets you add a sequential chart showing the connected stages of a process. Each stage will decrease and should contain a subset of the previous stage. The decrease is gradual, giving the chart an ever narrower funnel.

Funnel charts show values across multiple stages in a process. They can represent anything that is decreasing in size. The funnel chart shows a process that starts at 100% and ends with a lower percentage. Each chart segment represents the value of a specific item and can influence the size of other segments. The Funnel chart is included in the Visualization bundle.

- The chart requires one dimension and one measure.
- Unlike bar charts, funnel chart segments are centered to create a funnel shape.
- A chart with increasing stages instead of decreasing is a pyramid graph.

**When to use it**

The funnel chart is useful to illustrate the stages of a process and the overall decrease of each step, for example:
• Represent a sales process showing the amount of potential revenue for each stage.
• Illustrate the number of sales prospects at each stage in a sales pipeline, i.e. the process from prospective customer to made purchase.
• Identify potential problem areas and bottlenecks of a sales process.
• Communicate a sales process to new team members and vendors.
• Illustrate website visitor trends – from visitor homepage hits to other areas, for example downloads, etc.
• Show order fulfillment with initiated orders at the top, followed by for example, orders in delivery, delivered, canceled and returned.
• Showing the flow of information from top secret to unclassified.
• Representing knowledge areas from general knowledge to expert knowledge.

Creating a funnel chart
You can create a funnel chart on the sheet you are editing. Decide what the bars in the funnel should correspond to (measure) and how it should be grouped, that is which field value to use as labels (dimension). Dimension values are always displayed in descending order by the measure value.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Funnel chart object to the sheet.
2. Click the top Add dimension button and select the target dimension (usually target market) of the chart.
3. Click the Add measure button to select the measure (what is to be measured) of the chart. Once dimensions (dimension label) and measure (value label) have been selected the funnel chart displays automatically (in color) in the chart field.
4. Click Done to revert to the main display field.
5. Click applicable region under Region. The chart field will update displaying chosen parameters and details.

Dimension, measure and region details will continue to display in the chart field even when reverting to Edit mode.
Example:

A funnel chart displaying the conversion rates of prospects to customers in a sales process.

Changing the appearance of the chart

You can customize your chart with one or more features. Your chart automatically updates.

Funnel mode

Do the following:

1. Click Appearance > Presentation in the property panel.
2. Select from the drop-down menu under Funnel Mode the funnel's shape.

- **Area**: The area of each item is proportionate to the measure, only the height of the individual segment are affected - not the overall chart or contents.
• **Height**: The height of each item is proportionate to the measure, only the height of the individual segment are affected - not the overall chart or contents.

• **Width**: The width of the upper edge is proportionate to the maximum value of the measure. The top segment is always 100% and the following segments are segments are relative in size to the first. The lowest segment is rectangular. This affects the shape of the funnel and each segment has its individual slope.
• **Ordering**: The measure only orders the segments with largest value at the top. The ordering is fixed so the shape of the funnel is not affected.

**Colors**

The color option enables the segments of the funnel chart to be differentiated or unified by color. Colors can be chosen automatically by keeping the default setting of **Auto** (under **Appearance > Colors** in the property panel). They can also be configured from a color palette or from color schemes with sets of predefined colors. They can also be chosen individually from a color circle (click the easel symbol in the color palette) or by entering a color code string in the field next to the easel symbol. You can also change the font using an expression in the Expression editor (ﬁx). The colors should be valid CSScolors.
Configure the main color settings:

- **Single color**: You can use a single color for the entire funnel chart.
  1. Click *Appearance > Colors* in the property panel.
  2. Move the *Colors* slide button to the left to turn the option from Auto to Custom.
  3. Select *Single color* from the *Colors* menu. The chart will update.
  4. Move the *Colors* slide button to the left to turn the option from Auto to Custom.
  5. Click the *color palette box* and select applicable color from the color palette.

- **By dimension**: You can also color your entire funnel chart by dimension.

  Do the following:

  1. Click *Appearance > Colors* in the property panel.
  2. Move the *Colors* slide button to the left to turn the option from Auto to Custom.
  3. Select *By dimension* from the *Colors* menu. The chart will update according to previously chosen dimension and measure and also display in the property panel.
  4. Select one of three color options to use for the chart:

    - **Persistent colors**: Click the *Persistent colors* box and the chart will update.
    - **The 12 color gradient color scheme**: Click the colored button under *12 colors* to apply.
    - **The 100 colors gradient color scheme**: Click the colored button under *100 colors* to apply.
3 Creating visualizations

- **By measure**: You can color your entire funnel chart by measure. By default the initially chosen measure will show under **Select measure**. This measure must be unlinked before a new can be selected. You can also change the measure using an expression in the Expression editor (fx).

- **Change Library colors**:

  Do the following:

  1. Click **Appearance > Colors** in the property panel.
  2. Move the **Colors** slide button to the left to turn the option from Auto to Custom.
  3. Select **By measure** from the **Colors** menu.
  4. Move the **Library colors** slide button to the left to turn the option off to set your own.
  5. Click applicable color scheme under **Color scheme** depending on what scheme you want.

- **Reverse colors**: You can also reverse the color order of the chart based on the measure.

  Do the following:

  1. Click **Appearance > Colors** in the property panel.
  2. Move the **Colors** slide button to the left to turn the option from Auto to Custom.
  3. Select **By measure** from the **Colors** menu. The chart will update.
  4. Check the **Reverse colors** button and the colors of the chart will reverse their order.

- **Color range by measure**: You can set a color range for your chart based on your measure.

  Do the following:
1. Click Appearance > Colors in the property panel.
2. Move the Colors slide button to the left to turn the option from Auto to Custom.
3. Select By measure from the Colors menu.
4. Move the Range slide button to the left to turn the option to on.
5. Enter a minimum range number under Range > Min and press Enter. You can also change the minimum range number using an expression in the Expression editor (fx).
6. Enter a maximum range number under Range > Max and press Enter. You can also change the maximum range number using an expression in the Expression editor (fx).

**By expression:** Colors can also be configured by entering an expression or in the Expression Editor (fx). The colors used should be valid CSScolors.

Do the following:

1. Click Appearance > Colors in the property panel.
2. Move the Colors slide button to the left to turn the option from Auto to Custom.
3. Select By expression from the Colors menu. The chart will update.
4. Enter a color code string under Expression and press Enter. You can also change the color using an expression in the Expression editor (fx).

If the expression is a color code, uncheck the **The expression is a color code** box (checked by default). You can then change label, select another color scheme, reverse the funnel chart’s color order or set a new color range.

**Styling, formatting**

The position and order of labels for dimension and measure values can be displayed in different ways. You can for example hide the dimension value or display them as values or as a percentage.

**Number formatting:** You can also custom format the measure value. Different formatting can be applied to the same value. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the property panel and click chosen measure.
2. Select applicable number formatting form the **Number formatting** menu and the chart updates.

**Value Labels:** Measure labels can be configured in different ways. You can display them as values or as a percentage.

Do the following:
1. Click Appearance > Presentation in the property panel.
2. Move the Value labels slide button to the left to turn the option off.
3. Select from the menu how the labels are to display in the chart.

- Hide Dimension Label: This option hides the dimension label of the funnel chart. To hide the label click Appearance > Presentation in the property panel. Move the Dimension label slide button to the left to turn the option off.

Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

Heatmap chart extension
A Heatmap chart (Heatmap chart) displays comparative data where the values are represented as color patterns in a chart. Creating a heatmap helps convey information instantly by combining elements from several sources into one. It is included in the Visualization bundle.

A heatmap can display large amounts of data in their entirety because values are replaced by colors. This condensed color-coded format provides an easy-to-understand overview of data.

Heatmaps require two dimensions and one measure. A second measure is optional. The chart displays in a tabular format with color-coded tiles. The highest and lowest values show in each dimension column. The values in between are shown in a color gradient, centered upon the average.

When to use it
A heatmap chart displays a visual summary of large amounts of comparative data. The information is presented in color patterns, and is communicated almost instantly in a single chart. A heatmap is also useful when:

- Comparing performance between companies, markets, or investments.
- Identifying the level of performance between departments of a business.
- Setting investment priorities and highlighting areas of concern.
- Presenting vast statistical data and data sets.
- Measuring user interaction with websites.
- Rating and categorizing places, people, performances, or jobs.

Creating a heatmap chart
You can create a heatmap chart on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Visualization bundle drag a Heatmap chart object to the sheet.
2. Click the top Add dimension button and select dimension.
3. Click the lower **Add dimension** button and select second dimension variable.

4. Click the **Add measure** button to select the measure of the chart.

   Once dimensions and measure have been selected, the heatmap chart displays.

**Examples:**

![Sales Trend heatmap](image)

*A heatmap displaying results using colors only.*
Creating visualizations

The same heatmap as above with grid layout, data, and labels.

Changing the appearance of the chart

Using the lasso selection tool

The lasso selection tool lets you make a two-dimensional selection of a specific area you want to take a closer look at, by tracing a border around it.

That outline then disappears and you can trace another lasso in the desired area.

Do the following:

1. Open your heat map in the main display field. If you are working in edit mode, click Done.
2. Click the cursor on a tile and, while pressing the mouse button down, outline of the area of the chart you want to take a close look at.
3. End your outline where it began. The chart will automatically zoom in and display only the outlined area.
Examples:

A border is traced around an area using the lasso tool, coloring it green.

Once selection is complete, only the zoomed-in outlined area show in the chart.

Using dimension selection option

You can select a column or row of tiles for either dimension by clicking on the dimension label, or a selection of two dimensions by clicking on a tile. Once selected, only the chosen row, column or tile displays in the chart.

Changing the color scheme

You can change color scheme of your chart by choosing from four predefined options.

Do the following:

1. Click **Appearance > Design** in the property panel.
2. Select a color scheme under **Color schema**.

![Color Schema](image)

*The different color gradients that can be used in heatmaps.*

**Changing label colors**

Labels are text or image elements that can be placed anywhere on any chart. You can set your own label color under **Appearance > Label color** in the properties panel. Click the label color box and select a color from the gradient color circle. You can also click the easel symbol below the color circle, and select color or enter a color code string in the field next to the easel symbol. The colors should be valid CSS colors.

**Toggling the legend**

The legend provides a thin gradient line of color description at the top of the chart. To hide the legend, move the slide button under **Appearance > Design > Legend** in the properties panel to the left to turn the option off.

**Adjusting tile opacity**

You can adjust tile opacity by moving the slide button of the tile opacity slider under **Appearance > Design > Tile opacity** in the properties panel. Setting opacity to 1 allows the setting to show colors clearly, giving tiles a more individually distinct appearance.

**Using a mean in scale**

In a heatmap you can calculate and display the mean of data set. It is used as middle value in a color scale. You can toggle this feature on or off under **Appearance > Options > Use mean in scale** in the properties panel.
3 Creating visualizations

Enter a scale value by expression for mean value. This allows the system to choose color range that defines a median color scale. You can also insert a scale string into the expression in the Expression editor (fx) under Appearance > Options > Mean scale value in the properties panel. When no mean is used, the mean scale value should be set to 0.

Setting a fixed scale

You can set minimum, maximum, and mean values to define a fixed color scale independent from a data set. To do this, move the Fixed scales slide button to the right under Appearance > Options > Fixed scale in the properties panel. Then enter a minimum value under Min scale value, a maximum value under Max scale value, and a mean value under Mean scale value. You can also insert a scale string into the expression in the Expression editor (fx).

Toggling titles

This option hides the name of the heatmap chart. Click Appearance > General in the properties panel, and toggle the Show titles slide button.

Changing label sizes on chart axes

You can also customize the size of the labels on both the y-axis and the x-axis of the chart. Click Appearance in the properties panel, and enter the label size you want under Y-axis label size and under X-axis label size.

Limiting dimension values

You can limit your dimension values. Go to Data > Dimensions in the properties panel. Click dimension and under Limitation, choose a limitation from the menu.

Setting minimum horizontal size

In a heatmap you enter a minimum size of how the chart displays horizontally. Enter the size you want Appearance > Options > Minimum horizontal size in the properties panel. You can also insert a string into the expression in the Expression editor (fx).

Number formatting

It is possible to format the measure value. Different formatting can be applied to the same value, for example money, date, duration. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the properties panel and click a measure.
2. Select applicable number formatting from the Number formatting menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when to configuring the chart.

Limitations

For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).
Multi KPI extension

The Multi KPI extension (Multi KPI) is a visualization that allows you to show multiple KPI values for different dimension values. The values can be individually customized using various conditional formatting settings. This enables an easy view and tracking of goals. It is included in the Visualization bundle.

- The chart shows KPIs using measures and one dimension.
- Up to 15 measures and 80 values can display simultaneously.
- All KPI values can be grouped or displayed individually.
- Each value can be independently customized using for example, colors, icons, labels, font sizes, alignments, styles, links to different sheets, etc.
- The extension supports adding graphics, embedding objects into a chart and to display measures infographically.

When to use it

The multi KPI extension is useful when you want to easily view, understand and track the performance of your goals. It is also helpful when you want to customize individual KPI values using conditional formatting. You can link KPIs to separate sheet and insert objects to represent information or data.

Creating a multi KPI extension

You can create a multi KPI chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Multi KPI object to the sheet.
2. Click the Add measure button and select the main measure of the KPI chart. The main measure and a KPI value for the chosen measure is displayed.
3. Click Add under Data > Dimensions in the property panel and select dimension.

When you have selected measure and dimension, a multi KPI chart is displayed.

Example:

<table>
<thead>
<tr>
<th>Washington</th>
<th>Santander</th>
<th>Hannover</th>
<th>Detroit</th>
<th>Bristol</th>
<th>Miami</th>
<th>Newcastle</th>
<th>Liverpool</th>
<th>Valladolid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
</tr>
<tr>
<td>66</td>
<td>53</td>
<td>53</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

A chart with the measure (Margin %) shown for different values of the dimension (City).

Adding additional measures

You can add additional measures to your chart in property panel under Data > Dimensions. The chart updates to reflect the added measures. Up to 15 measures and 80 values can display simultaneously. The main measure is always the top measure listed for each dimension. When you add more measures, they appear under the initial
KPI value in the order they are entered.

**Example:**

<table>
<thead>
<tr>
<th>Washington</th>
<th>Santander</th>
<th>Hanover</th>
<th>Detroit</th>
<th>Bristol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
<td>Margin (%)</td>
</tr>
<tr>
<td>66 Quantity</td>
<td>53 Quantity</td>
<td>53 Quantity</td>
<td>51 Quantity</td>
<td>51 Quantity</td>
</tr>
<tr>
<td>771</td>
<td>1k</td>
<td>1k</td>
<td>315</td>
<td>13k</td>
</tr>
</tbody>
</table>

*A chart with a two measures (Margin %, Quantity) grouped per dimension (City).*

**Customizing the KPIs**

You can customize your KPI values and measures with one or more conditional settings. You can add several KPIs together, group them and link to different sheets. You can also configure KPI values independently by differentiating them with one or more conditional settings such as text, color, icons, graphics, etc.

For conditional settings options, see *Multi KPI properties (page 340).*

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik (page 306).*

- Multi KPI visualizations cannot be used in Qlik NPrinting reports.

**Customizing your KPIs**

The Multi KPI extension *(Multi KPI)* values and measures can be customized using one or more conditional settings. You can add several KPIs together, group them, and link to different sheets. KPI values can also be customized independently by differentiating them using one or more CSS-properties, such as text color, fonts, sizes, icons, labels, graphics.

**3.8 Multi KPI properties**

KPI values can also be customized independently by differentiating them using one or more css-properties such as text color, background color, fonts, sizes, icons, labels, graphics.

**Example:**

- Today Profit: 96 (-26% from yesterday)
- This Week: 250,75 (-26% from last week)
- Total Sales: 1,8k (-26% from last month)
- Visitors: 1,2k (-26% from last month)
- Page View: 118,23 (-26% from yesterday)

*KPI values using icons, different colors, fonts, Master Visualizations*
Creating visualizations

Coloring a Multi KPI

The color option enables all KPI values (measures and labels) to be differentiated by colors. You can change the colors of text, icons and background color. The colors should be valid css-colors.

Choose colors from:

- The color palette with a set of predefined colors.
- The color circle (click the easel symbol in the color palette and choose individually).
- Enter a color code string in the field next to the easel symbol.

Configure the main color settings:

- **Changing a measure/label color:**

  Do the following:

  1. Click **Data > Measures** in the property panel.
  2. Click applicable measure and select to color the value (**Value color**) or the label (**Label color**).
  3. Select color from the color palette that opens.

  **Example:**

- **Changing background color:**

  Do the following:

  1. Click **Appearance > Styles** in the property panel.
  2. Click the **Background color** box.
  3. Select color from the color palette that opens and the chart updates.
You can also set your own color by clicking the easel symbol in the color palette and select color or enter a color code string in the field next to the easel symbol. The colors should be valid css-colors.

Changing sizes of a Multi KPI

The size of dimensions, measures, labels and icons can be configured using predefined sizes available from a drop-down menu.

- **Dimension labels**: Select the size of the labels from the drop-down menu under **Appearance > Dimensions > Size** in the property panel.

- **Measure labels**: All measures can have individual sizes.

Do the following:

1. Select the size of the measures in the property panel under **Data > Measures**.
2. Select measure and click the **Override parameters** box.
3. Enter the label type as a string or in the expression under **Label** and select the size from the options in the drop-down menu under **Size**.

- **Icons**: All icons can be differentiated by applying different colors.

Do the following:

1. Go to **Data > Measures** in the property panel.
2. Select measure and choose icon from the icon option.
3. Then choose **icon size** from the drop-down menu under **Icon**.

Changing the fonts of a Multi KPI

You can change the font-family of all labels if you go to **Data > Measures** in the property panel and select applicable measure. Under **Font style** enter a label string and press Enter.

You can also change the font using an expression in the Expression editor (_EXPRESSION_1) or apply individual font css properties entered through **Appearance > Styles > Styles (CSS)** in the property panel.

Changing icons

You can set a predefined icon to represent a value and/or label by selecting from the icon set. The icons can then be further customized by differentiating using the colors, fonts, labels and sizes options.

Do the following:
3 Creating visualizations

1. Click **Data > Measures** in the property panel.
2. Check the **Select icon** box and click applicable icon from the icons set that opens.

3. Click **OK**. The pop-up will close and your chart update.
4. Choose whether to configure your label or value by selecting **Label** or **Value** under **Icon position**.

You can also change a value/label to an icon by entering an icon string under **Icon (Data > Measures > applicable measure in the property panel)** and then press Enter. Thereafter click **Label** or **Value** under **Icon position** depending on which you want to configure. It is also possible to change an icon using an expression in the Expression editor (fx). The icons should be valid CSSicons.

**Using infographic mode**

The infographic mode allows you to show each measure graphically as an appropriate number of icons.

Do the following:

1. Click the applicable measure under **Data > Measures** in the property panel and click the **Icon** button.
2. Select an icon to represent a measure from the predefined icon set (**Icons**) that opens.
3. Click the **Infographic mode** button. The resulting KPI chart updates and graphically shows the measures with applicable number of icons (max. 100 icons per measure).

   You can also select an icon using an expression in the Expression editor (fx).
3  Creating visualizations

Examples:

![VISITORS 1,2k](image1)
![CONVERSION 18,0%](image2)
![CLIENTS 223](image3)

<table>
<thead>
<tr>
<th></th>
<th>Washington</th>
<th>Santander</th>
<th>Hannover</th>
<th>Detroit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Margin (%)</strong></td>
<td>66</td>
<td>53</td>
<td>53</td>
<td>51</td>
</tr>
</tbody>
</table>

Two separate KPI charts using different types infographic illustration. A separate icon can be chosen for each measure.

Embedding a master visualization

To graphically illustrate the KPI object, you can embed a master visualization.

Do the following:

1. In the property panel go the Data > Measures and click Add.
2. Click the Expression editor (fx) button.
3. Enter the string = ’Drag and Drop here’ into the Expression editor and click Apply.
4. Drag and drop a master visualization object into the value region of each measure placeholder.

You can also change insert the object ID string into the expression in the Expression editor (fx) under Visualization for each measure (Data > Measures > applicable measure in the property panel).
Example:

KPI measures where each KPI is shown with corresponding master visualization.

Using Styles (CSS) properties

You can further configure your measures using non-predefined Styles (CSS) property for each measure. This can be icons, changing color of text/icons, label, font, background color, size, etc. Copy and paste the styles into the Styles (CSS) field (under Appearance > Styles in the property panel).

For icons, enter appropriate classes in the Icon field of the chosen measure under Data > Measures in the property panel. You can also enter the icon string using an expression in the Expression editor (fx).

Example:

Layout, style, formatting, alignment

You can format the chart layout to be presented in different ways.

- **Alignment**: You can configure the main chart text alignment by selecting applicable box under Alignment of chosen measure under Data > Measures in the property panel:
All KPIs can also be vertically aligned. This alignment can be adjusted to align top, bottom and center or as stretched. Select applicable alignment from the **Vertical alignment** menu under **Appearance > Styles** in the property panel.

It is also possible to center align labels by checking the **Center align labels** in the property panel under **Appearance > Dimensions**.

- **Number formatting**: You can also custom format the KPI number values. Different formatting can be applied to the same values. The chart updates to reflect the changed number type.

Do the following:

1. Click **Data > Measures** in the property panel and select applicable measure.
2. Select applicable number formatting from the **Number formatting** menu.

**Example:**

![Example visualization](image)
3 Creating visualizations

The same KPI object using two different types of number formatting (Auto, Money).

- **Format pattern:** The text of a specific measure can be changed or removed.

Do the following:

1. Click Data > Measures in the property panel.
2. Click applicable measure and enter/remove the applicable format string under Format pattern and press Enter.

- **Segment/card:** It is also possible to configure the layout of the KPI chart where dimensions and values display in a segment or card layout.

Do the following:

1. Click Appearance > Dimensions in the property panel.
2. Choose Segment or Card layout from the Show as menu. The chart will update.

**Example:**

![The same KPI object displayed in segment layout (top) and card layout (bottom).]
The segment layout can be configured horizontally or vertically under Appearance > Dimensions > Orientation in the property panel. Click either the Horizontal or the Vertical buttons.

- **Items per row:** It is also possible to decide the number of items (KPIs) per line in a chart in the property panel under Appearance > Measures. Use the default Auto or select applicable number from the Items per row menu (between 1-8).

- **Borders:** You can hide external and internal borders of the chart. By default all borders are visible. To configure borders go to Appearance > Dimensions in the property panel and check, as applicable, Hide external borders and/or Hide internal borders.

- **Value/Label layout and formatting:** The position and order of labels for both dimension and measure values can be altered and displayed in different ways. Labels can be hidden or displayed vertically or horizontally. By default Horizontal is selected.

  - **Dimension label layout:** To set the position of dimension labels:
    
    Do the following:
    
    1. Click Appearance > Measures in the property panel.
    2. Click either Horizontal or Vertical under Labels orientation to select how the labels should display.

  - **Measure value layout:** Measure value layout can be set in two different ways:
    
    - **Existing parameters:**
      
      Do the following:
      
      1. Click Appearance > Measures in the property panel.
      2. Click either Horizontal or Vertical under Labels orientation to select how the labels should display.

    - **New parameters:**
      
      Do the following:
      
      1. Click Data > Measures in the property panel.
      2. Click applicable measure and check the Override parameters box.
      3. Enter the label string under Label and press Enter.

  - **Label order:** You can also adjust the order in which measure value labels appear.
Do the following:

1. Click **Appearance > Measures** in the property panel.
2. Click either **Label, Value** or **Value, Label** under **Labels orientation** to select how the labels should display.

- **Icon order**: You can decide where to show icons - before or after a value. In the property panel under **Appearance > Measures** go to **Icon order** and click either the **Icon**, **Value** or **Value, Icon** buttons to select which displays first in the chart.

- **Hide Labels**:
  - **Measure labels**: This option hides the measure label of each KPI. To hide the labels click **Data > Measures** in the property panel and select applicable measure. Then check the **Hide labels** box.
  - **Dimension labels**: This option hides the dimension label of each KPI. To hide the labels click **Appearance > Dimensions** in the property panel. Then check the **Hide labels** box.

- **Hide Values**: This option hides the value for each KPI. To hide the value, click **Data > Measures** in the property panel. Then check the **Hide values** box.

- **Group KPI values**: All KPI values can be grouped or displayed individually per measure. Go to the **Data > Measures** in the property panel. Choose applicable measure and check the **Group by dimension** box.

Another option is to enter a dimension value string under **Dimension value** and press Enter. The chart will update. You can also enter the dimension value using an expression in the Expression editor (\(\text{fx}\)). The values should be valid CSS values.
3 Creating visualizations

- **Link to a separate sheet**: Each measure can be linked to another sheet. To link a measure to a separate sheet:

  Do the following:

  1. Click **Data > Measures** in the property panel and select applicable measure.
  2. Move the **Link to sheet** slider to the right to turn the option on.
  3. Click the **Select sheet** button and from the **Select sheet** pop-up click the page you want a link to. The sheet will close and your pages link.

**Example:**

![Example Image]

---

3.9 Limitations

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

**Network chart extension**

The network chart (**network chart**) lets you draw a network of connected nodes and edges from a data set to a sheet. A network chart shows how information flows, how components interact, and where components exist in the network. The network chart is included in the Visualization bundle.

A network chart can provide a broad overview or be very detailed. Nodes represent system components, and edges show the movement of information from one component to another. Network nodes are connected to the nodes they interact with the most. This visualization uses different styles, colors, sizes, and images to represent different levels of a network.
3 Creating visualizations

What it contains
You need to define three dimensions, with a fourth optional dimension:

- **Node identifier**: This dimension controls which nodes are presented in the chart.
- **Node label**: This dimension sets the label of each node.
- **Node parent**: This dimension sets the parent of a node, and controls the relationships between nodes. It needs to contain the value of the node identifier of the parent to connect to.
- **Node group** (optional): You can use this dimension to group nodes. All nodes in the same group will have the same color.

You can use up to three measures to enhance the diagram. All measures are optional, but you need to add them in the following order:

1. **Tooltip**: You can set a measure value that is displayed in a tooltip when hovering over a node.
2. **Node size**: You can set the size of the node according to a measure.
3. **Edge size**: You can set the width of the lines between nodes according to a measure.

You need to add a tooltip before you can set node size. You can set edge size after adding a tooltip and node size.

When to use it
Network chart diagrams can illustrate computer or telecommunications networks. They show the components of a network and how they interact. For example, a group of connected computers, printers, modems, hubs, and routers. This type of chart is helpful when:

- Planning the structure of a network.
- Coordinating updates to an existing network.
- Reporting and troubleshooting network problems.
- Keeping track of components.
- Documenting detailed network documentation.

Formatting your data
A network chart requires data that is structured consistently according to a network data model where each record can have multiple parents and children. Each record needs to contain at least:

- A field that identifies the node, the node identifier. Node identifier values must be integer values, starting from 0 and in sequential order.
- A field with the name of the node.
- A field that defines the parent node. This value needs to be the node identifier of another node. If this field is empty, and no other record refers to this node, a disconnected node is created.

It is also possible to use a hierarchical data model where each node has a single parent. This will create a tree-shaped chart.
Here is some example data that you can save in a text editor as `Airports.csv` and load in a new app. The example shows passenger flows between different airports.

- **ID** is the identifier of an airport node.
- **Name** is the name of an airport node. This is used as label of the node.
- **LinkTo** contains the node identifier of the parent node.
- **Group** states the group of a node. This can be used to color the nodes according to group.
- **Volume** is the passenger flow volume between ID and LinkTo. This can be used as a measure in tooltip, .node size and edge size.

```
ID;Name;LinkTo;Group;Volume
0;Frankfurt;0;0;
1;London;0;1;5
2;Madrid;0;1;4
2;Madrid;1;1;8
3;Warsaw;0;1;7
4;Arlanda;0;1;1
3;Warsaw;1;1;5
4;Arlanda;1;1;6
5;Tunis;0;2;8
5;Tunis;2;2;4
6;Berlin;0;1;6
6;Berlin;4;1;4
7;Rome;0;1;6
7;Rome;6;1;3
8;San Fransisco;0;3;2
9;New York;0;3;9
```

**Creating a network chart**

This example of a network chart illustrates how different airports are connected worldwide based on base data set. It uses the example data set from [Formatting your data](#). Prepare by saving the example data set in a text file, creating a new app and loading the example data set.

Do the following:

1. In the assets panel, open **Custom objects > Visualization bundle**, and drag a **Network chart** object to the sheet.
2. Click the top **Add dimension** button and select **ID** as the node identifier.
3. Click the second **Add dimension** button and select **Name** as the node label.
4. Click the third **Add dimension** button and select **LinkTo** as the parent node.
5. Click **Data** in the properties panel. Click the **Add** button under **Node group** and select **Group** as the group dimension.
6. Under **Measure**, click the **Add** button under **Tooltip**, and select **Volume > Sum(Volume)**.
7. Click the **Add** button under **Node size**, and select **Volume > Sum(Volume)**.
8. Click the **Add** button under **Edge size**, and select **Volume > Sum(Volume)**.

The chart displays:
A chart with four dimensions and three measures in a dynamic edge type, with dot nodes, and visible curve values.

Changing the appearance of the chart
You can customize your chart with one or more features.

Configuring edge type
You can configure the shape of the curve between chart nodes under Settings > Edge Type in the properties panel. Select the shape option of the chart curves from the menu.
Examples:

![A chart with dynamic edge type (curves).](image1)

The same chart with curved CW edges.

Toggling edge value

The edge value represents value of the curves between chart nodes and their width. This option hides the numerical value of each curve. To hide the value move the slide button under **Settings > Display edge value** in the properties panel to the left to turn the option off.

Configuring edge label

The edge label value is the numerical value of each chart curve. You can change the position of these or hide the labels.
• **Hide edge label value**: This option hides the edge label of the network chart. Toggle the slide button under **Settings > Display edge value** in the properties panel.

• **Edge label position**: This option decides where on each chart curve the edge value displays, for example: above or below. Select applicable option from the menu.

### Configuring node shape
You can customize the shape of the nodes, for example: dot, square, diamond, or triangle. Go to **Settings > Node shape** in the properties panel, and select the node shape from the menu.

### Toggling shadow option
This option lets you turn off the shadow effects behind chart curves and nodes (used to highlight background). Toggle the slide button under **Settings > Display shadow** in the properties panel.

### Sorting
Sorting is set to Auto with the system choosing the sorting order as the default (under **Sorting > chosen dimension or measure** in the properties panel) for all dimensions and measures. You can change them individually by expression.

Do the following:

1. Open the dimension or measure menu under **Sorting** in the properties panel.
2. Move **Sorting** slide button to the left to turn the option from Auto to Custom.
3. Click the **Sort by expression** check box.
4. Enter an order string under **Expression** and press Enter. You can also change the color using an expression in the Expression editor (\(\text{Expression}\)).
5. Choose start order by selecting **Ascending** or **Descending** for the menu below.

### Number formatting
It is possible to format the measure value. Different formatting can be applied to the same value, for example: money, data, or duration. The chart updates to reflect the changed number type.

Do the following:

1. Click **Data > Measures** in the properties panel and click chosen measure.
2. Select applicable number formatting form the **Number formatting** menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when to configuring the chart.

### Limitations
For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

- Network chart visualizations cannot be used in Qlik NPrinting reports.
P&L pivot chart extension

You can use the P&L pivot chart extension to create a pivot table with a layout for profit and loss reporting. You can color cells according to performance and style the chart with custom fonts and alternating row colors. You can also export the chart to Excel including formatting. The P&L pivot chart is included in the Visualization bundle.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Measures</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 dimension</td>
<td>up to 9 measures</td>
<td>A table with one row for each dimension value and one column for each measure.</td>
</tr>
<tr>
<td>2 dimensions</td>
<td>up to 8 measures</td>
<td>A pivot table with one row for each value of the first dimension and one column for each measure pivoted using the second dimension.</td>
</tr>
</tbody>
</table>

Coloring cells to show performance

You can color cells to show performance according to a scale of Poor, Fair and Good. All rows and columns are colored by default, but you can choose which columns and rows to color if you want to.

1. Make sure that Enabled is set to On under Appearance > Color by condition.
2. Select which rows to color by performance.
   Set Color all rows by condition to Specified rows.
   Add rows to color by name (dimension value) with Add row to color.
3. Select which measures to color by performance.
   Set Color all measures to Specified measures.
   Add a list of measures by number in Measure indices with the first measure of the chart numbered zero. Separate the measures with a comma.

   Example: Color the first, third, and fifth measure.

   0,2,4

4. Set performance limits and colors.

You can set the range limits for Poor and Fair.
   - All cells with a value lower than the Poor range limit are displayed with the background color and text color set for Poor.
   - All cells with a value lower than the Fair range limit, but higher than Poor, are displayed with the background color and text color set for Fair. You should set the Fair range limit higher than Poor.
   - All other cells are displayed with the background color and text color set for Good.

Styling the chart using a style template

You can create a layout for the chart, for example to show a profit and loss report, using a style template.

You need to be able to add and load a CSV file to the app.
1. Create a style template as a CSV file. Use the style template format described below.
2. Load the style template to your app as one field. When you add the file, do not use semicolon as field separator, each row should be loaded as one field.
3. Set **Style template field** under **Appearance > Table format** to the name of the template field you added.

You can load several style templates in your app, and change the layout with **Style template field**.

### Style template format

The style template is created as a comma separated text file (CSV) using UTF-8 encoding.

The style template rows need to align to the data in your first dimension. You need to refer to a dimension value in the template. The dimension value should be first in every row. You do not need to specify all row/dimension values in the template.

Each row in the template should be in the following format. It is not required to use a header row.

```
DimensionValue;Bold;Background;FontStyle;TextColor;Align;FontSize;Comment
```

- **DimensionValue**
  - The dimension value of the row that you want to style.
- **Bold**
  - Set to <bold> if you want bold text.
- **Background**
  - Set a background color. You can use <dark>, <night>, <soft>, <red>, <orange>, <violet>, <blue>, <green> or a color code in RGB format, for example rgb(183,219,255). The default background color is white.
- **FontStyle**
  - You can set the font style to <italic> or <oblique>.
- **TextColor**
  - You can set the color of the text to <white>. The default background color is black.
- **Align**
  - You can center align the text with <center>. The default alignment is left for text and right for numeric values.
- **FontSize**
  - You can set the font size to <large>, <medium> (default) or <small>.
- **Comment**
  - You can use the <comment> tag to replace all zero values with a space. This is useful when you want to include a sub header row. without values.

You can also use the style tags in any order, and exclude tags that are not used. These rows will give the same result:

```
Operating expenses;<bold>;&lt;italic>;:;
Operating expenses;&lt;italic>;:<bold>
```
Style template example for profit and loss reporting

Cost of goods sold; bold; RGB(225, 226, 226);
Extraordinary items after tax; bold; RGB(193, 216, 47);
Extraordinary items; bold; italic;
Financial revenue & expenses; bold; italic;
General & administrative expenses; bold; italic;
Gross profit; bold; RGB(193, 216, 47);
Income before tax & extraordinary items; bold; RGB(193, 216, 47);
Manufacturing overhead; bold; italic;
Net costs of goods sold; bold; RGB(225, 226, 226);
Net gain on sale of land; bold; RGB(193, 216, 47);
Net Income (Profit); bold; #191970; white;
Net mfr overhead; bold; RGB(225, 226, 226);
Net sales revenues; bold; RGB(225, 226, 226);
Operating expenses; bold; italic;
Operating income before taxes; bold; RGB(193, 216, 47);
Other general & admin expenses; bold; rgb(128, 191, 255);
Revenues; bold; italic;
total general & admin expenses; bold; #efefef;
total operating expenses; bold; rgb(128, 191, 255);
Total selling expenses; bold; RGB(225, 226, 226);

To use this template, you need a data file where the first dimension contains values that correspond to the first item of each row, for example Cost of goods sold.

<table>
<thead>
<tr>
<th>Account Desc</th>
<th>France</th>
<th>Italy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Balance...</td>
<td>Bal LY (k)</td>
</tr>
<tr>
<td>Revenues</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gross sales revenues</td>
<td>33,319</td>
<td>29,683</td>
</tr>
<tr>
<td>Less return &amp; allowances</td>
<td>346</td>
<td>242</td>
</tr>
<tr>
<td>Net sales revenues</td>
<td>32,983</td>
<td>29,441</td>
</tr>
<tr>
<td>Cost of goods sold</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Direct materials</td>
<td>-6,920</td>
<td>-6,636</td>
</tr>
<tr>
<td>Direct labor</td>
<td>-8,100</td>
<td>-5,171</td>
</tr>
<tr>
<td>Manufacturing overhead</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indirect labor</td>
<td>-5,923</td>
<td>-5,090</td>
</tr>
<tr>
<td>Depreciation, manufact equip</td>
<td>-350</td>
<td>-7</td>
</tr>
<tr>
<td>Other mfr overhead</td>
<td>-4,000</td>
<td>-4,000</td>
</tr>
<tr>
<td>Net mfr overhead</td>
<td>-9,623</td>
<td>-9,407</td>
</tr>
<tr>
<td>Gross profit</td>
<td>18,948</td>
<td>-8,407</td>
</tr>
</tbody>
</table>

P&L pivot chart styled with the layout template in the example
### Exporting the chart to Microsoft Excel

You can export the chart to Microsoft Excel including formatting by clicking the XLS icon in the rightmost cell of the chart header.

*When you open the exported chart in Microsoft Excel, you may get a warning message that the file format and extension does not match. You should still be able to open the file by clicking Yes.*

### Limitations

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

- There is a limitation for data transfer between Qlik Engine and an extension. This limits each request for data to 10000 elements, for example, 1000 rows and 10 columns. **P&L pivot** can make automatic requests for more data using pagination. You can set the limit of how much data to request with **Pagination > Max pagination loops**. The default value is 20000 elements (20k cells) and the maximum value is 100000 elements. You can also modify the error message displayed to the user when the data limit is exceeded. The recommended workaround when the data limit is exceeded is to apply filters to the data to limit the data transfer.

### Radar chart extension

The Radar chart (**Radar chart**) displays a two-dimensional chart using radial axes to chart one or more groups of values over multiple variables. Radar charts can be used to visualize and compare performance to a set standard or to a group’s performance. The Radar chart is included in the Visualization bundle.

Radar charts require two dimensions and one measure. The y-axis goes from the center to the perimeter and the x-axis is the perimeter of the chart. Each value represents the distance from the center of the chart, and displays on the axes starting from the center. The center of the chart represents the minimum value, and the edge the maximum value.

A radar chart can show multiple series, each separately connected with their values. The data only goes around the chart once. Adding values only increases the chart’s granularity.

### Understanding a radar chart

A radar chart consists of evenly spaced segments (axes) arranged radially around a point. There is one segment for each data value of the second dimension. The value of each measure is shown by a node on applicable axis. A line connects the values that belong to the same series creating the chart’s star-like shape.
Example:

A radar chart with one axis for each month of the Date.Month dimension.

When to use it
Radar charts let you compare and measure data with an arbitrary number of variables. This is helpful when comparing something’s features or performance over several metrics. For example: before buying a computer, you can compare different computers across several features, such as memory storage, processing, and screen size. A radar chart is also useful when:

- Measuring quality improvements and performance.
- Comparing allocated amount versus actual spending in an organization.
- Identifying outliers, commonality, and clusters of data with similar values and features.
- Charting an athlete’s strengths and weaknesses.
- Comparing results of small-to-moderate-sized multivariate data sets.

Creating a radar chart
You can create a radar chart on the sheet you are editing.

Do the following:
1. In the assets panel, open Custom objects > Visualization bundle and drag a Radar chart object to the sheet.
2. Click the top Add dimension button and select the first dimension category to be measured (x-axis).
3. Click the second Add dimension button to select the second dimension (y-axis).
4. Click the Add measure button to select the measure of the chart.

Once dimensions and measure have been selected the radar chart displays automatically (in color) in the chart field.

Example:

A radar chart with two dimensions and one measure.

Changing the appearance of the chart
You can customize your radar chart with one or more features.

Changing the color scheme
You can change color scheme of your chart by choosing from four predefined options.

Do the following:
Creating visualizations

1. Click **Appearance > Design** in the property panel.
2. Select a color scheme under **Color**.

![Radar chart color schemes.](image)

**Changing the stroke type**

You can also customize the shape line connecting each node under **Appearance > Design > Stroke type** in the properties panel. Select the shape from the menu.

**Toggling the legend**

The legend provides a small text description of each node of the chart. The legend expands to show its text, and the chart shrinks to accommodate the legend. To toggle the legend, move the slide button under **Appearance > Design > Legend** in the properties panel.

**Limiting dimensions**

You can set limits on your dimension values. To change limitations and terms go to **Data > Dimensions** in the properties panel. Click dimension, and under **Limitation** choose a limitation from the menu.

**Toggling titles**

This option can hide the name of the radar chart. To toggle the name, click **Appearance > General** in the properties panel. Move the **Show titles** slide button.

**Number formatting**

It is possible to format the measure value. Different formatting can be applied to the same value. The chart updates to reflect the changed option, for example money, date, duration.

Do the following:
1. Click **Data > Measures** in the properties panel and click a measure.
2. Select option form the **Number formatting** menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when to configuring the chart.

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

**Sankey chart extension**

The Sankey chart (**Sankey chart**) is a visualization extension that lets you add a specific type of flow chart to the sheet you are editing. The chart visually emphasizes major transfers or flows within defined system boundaries. The width of the chart arrows is shown proportionally to the flow quantity. The Sankey chart is included in the Visualization bundle.

- A minimum of two dimensions and one measure is required.
- The chart can measure up to five dimensions simultaneously.
- The dimensions need not be of equal size on each side of the diagram.
- The dimension values set the color of the flows in the chart.
- Link colors are based on source or target anchor.

**When to use it**

The sankey chart diagram is useful when you want to locate most significant sections to an overall flow. The chart is also helpful when you want to show specific quantities maintained within set system boundaries.

**Creating a sankey chart diagram**

You can create a sankey chart on the sheet you are editing.

Do the following:

1. In the assets panel, open **Custom objects > Visualization bundle** and drag a **Sankey chart** object to the sheet.
2. Click the top **Add dimension** button and select the source dimension for the flow of the chart (appears to the left).
3. Click the second **Add dimension** button to select the target dimension for the flow of the chart (appears to the right).
4. Click the **Add measure** button to select the measure of the chart.

Once dimensions and measure have been selected the sankey chart diagram displays automatically (in color) in the chart field.
Example:

A chart with a source dimension (Quarter) and the target dimension (Year).

Adding additional dimensions

You can add up to five dimensions to your chart in property panel under Data > Dimensions. The chart updates to reflect the added dimensions. The dimensions are displayed from left to right, with the first entered dimension always being the source dimension. The target dimension is always displayed to the right. When you add more dimensions, they appear added to the right in the order they are entered.
Creating visualizations

A chart with three dimensions: the source dimension (Origin), the target dimension (Decision) and one additional (Destination).

Changing the appearance of the chart
You can customize your chart with one or more features. Your chart automatically updates.

Link colors
The colors of chart links are based on either the source or target anchors. To apply the source or target anchor color to chart links either use the string ="SOURCE" or ="TARGET". You can also select a separate color by entering a color code string. The color should be a valid CSScolor.

Do the following:

1. Click Presentation under Appearance in the property panel.
2. Enter the applicable string under Link color.
3. Press Enter and the chart updates.

You can also change the link colors using an expression in the Expression editor (f). It is also possible to color a link that has its intensity based on the Margin % of the dimension values it represents.

Example:

Enter the string =rgb(round(Avg ([Margin %])*255), 100, 100) where Margin % is a value between 0-1 and the link will display as red in the chart.
Link opacity
You can adjust link opacity by moving the slide button of the link opacity slider under Appearance > Link opacity in the property panel. Also, setting opacity to 1 (furthest right) allows the setting to drop a shadow, giving links a more individually distinct appearance.

Node colors
You can change the node colors of each dimension value. The color should be a valid CSScolor.

Do the following:

1. Select applicable dimension under Data > Dimensions in the property panel.
2. Enter the color code string under Node color and press Enter. The chart will update.

Example:

Color Aqua: #00ffff in string: =‘#00ffff’.

You can also set the node colors using an expression in the Expression editor (fx).

Node padding and width
You can set both the vertical distance between nodes ("node padding") and the horizontal width of chart nodes ("node width"):
1. Click **Presentation** under **Appearance** in the property panel.
2. Move applicable slide button of the Node padding and/or Node width sliders to adjust node settings.

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

**Trellis container extension**

You can use the Trellis container extension to show a trellis chart based on a master visualization. The trellis chart shows a grid of the same chart for different dimension values. You can use the trellis chart to compare metrics for different groups of data.

![Trellis chart based on a bar chart of sales data, shown for different product categories](image)

**Creating a trellis chart**

You can create a trellis chart on the sheet you are editing. The chart that you want to repeat for different dimension values must be a master visualization.

Do the following:

1. In the assets panel, open **Custom objects > Visualization bundle** and drag a **Trellis container** object to the sheet.
2. Select which master visualization to show in **Appearance > Trellis options > Base visualization** in the property panel.
3. Select the dimension that you want to use as the grid dimension in **Data > Dimensions**.

You will now see a grid of charts, each based on the grid dimension you selected.

**Troubleshooting**

I do not see a grid of charts, and receive this message: **Too many dimension values!**

**Possible cause**

There are more dimension values than the maximum number of charts allowed in the grid.
Proposed action
You can increase the number of charts allowed in Appearance > Trellis options > Maximum number of charts.

Changing the appearance of the chart
You can customize your chart with one or more features.

Setting the number of columns
You can set the number of columns in the chart grid with Appearance > Trellis options > Number of columns.

Setting the y-axis range of charts
You can select which y-axis range to show for the charts in the trellis chart with Appearance > Trellis options > Auto range.
- On will show the same range for all charts. This is the best option if you want to compare values between different charts.
- Off will show an optimized range for each chart.

Slide mode
You can view the charts in slide mode instead of a grid by setting Appearance > Trellis options > Slide mode to On. In slide mode, you view one chart at a time. You can scroll between the charts.

Best practices for creating the master visualization
Here are some tips for creating a master visualization that will work well in a trellis chart:
- Show the title in the master visualization. In the trellis chart, the title is replaced with the grid dimension value of each chart.
- If you use expressions: create a label to hide the set expression.
- If you are using a combo chart: use only one axis, and set the minimum and maximum of the y-axis.
- If you are using a box plot: set the minimum and maximum of the y-axis.
- If you are using a scatter plot: set the x-axis.
- If you are using a map: use advanced mode, and set the layer color and title.

Using advanced mode
You can use advanced mode to specify where to insert set analysis and dimension values in the master visualization. Activate it by setting Appearance > Trellis options > Advanced mode to On.

You can use the following placeholders in formulas in the master visualization. They will be replaced in the trellis chart by the corresponding values:

Advanced mode value replacements in a trellis chart
Limitations
For information about general limitations, see Limitations of extension bundles supplied by Qlik (page 306).

Unsupported visualizations
You cannot use the following visualizations in a trellis chart:

- Filter pane
- Histogram

Multi KPI visualizations with embedded master visualizations
It is not possible to use a Multi KPI chart that contains an embedded master visualization.

Word cloud chart extension
The Word cloud chart (Word cloud chart) is a visualization extension that lets you create a visual of text data or free form text. Single words display and base their size on measure value. The measure can be anything you want to measure against, for example: times used, alphabetically, by importance, or by context. You can customize your chart with different shapes, fonts, layouts, and color schemes. It is included in the Visualization bundle.

Requirements
Word cloud charts must have one dimension and one measure.

When to use it
A word cloud chart lets you visualize and identify the importance of a value against a measure. The more important the value is against the measure, the larger it displays in the cloud.

Creating a word cloud chart
You can create a word cloud on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Word cloud chart object onto the sheet.
2. Click the Add dimension button and select the dimension.
3. Click the Add measure button to select the measure of the chart.
Once a dimension and a measure have been selected, the word cloud chart displays automatically.

Example:

A word cloud chart displaying food items in different sizes and colors.

**Changing the appearance of the word cloud**
You can customize your word cloud with one or more features.

**Changing the orientation**
You can set the shape or layout of the word cloud. Go to Appearance > Design > Orientations in the properties panel and change the word orientation number. These must be positive numbers.
Creating visualizations

Example:

A word cloud chart displaying food items in different sizes and colors.

Adjusting the start and end angles

You can adjust the starting point (angle) parameter of the word cloud under Appearance > Design > Start angle, and the end point under Appearance > Design > End angle in the properties panel. The angles can have positive or negative numbers.

Changing font size

You can set maximum word font sizes under Appearance > Design > Font max size and the minimum under Appearance > Design > Font min size in the properties panel. If a maximum and minimum limit is set, note that larger words disappear if the chart field is too small.

Changing scale

The word cloud chart scale can be either in linear or in log scale. Select scale Linear or Log under Appearance > Design > Scale in the properties panel. Only positive values can be used for the log scale. Zero or negative values return nothing.

Setting custom ranges

You can also specify a range of colors or select from a predefined color scheme.
3 Creating visualizations

Do the following:

1. Click Appearance > Design in the properties panel.
2. Ensure that the Enable color range is set to On (default).
3. Click the color palette beside From, and choose a color.
4. Click the color palette beside To, and choose a color.

You can set your own color range by clicking the easel symbol in the color palette, and selecting a color. You can also enter a color code string in the field next to the easel symbol. The colors should be valid CSS colors.

Do the following:

1. Click Appearance > Design in the properties panel.
2. Move the Enable custom range slide button to the left to turn the option off.
3. Select a color scheme under Scale color.

A word cloud chart displaying food items in different sizes and colors.

Formatting numbers

It is possible to format the measure value. Different formatting can be applied to the same value, for example as money, date, duration. The chart updates to reflect the changed number type.

Do the following:

1. Click Data > Measures in the properties panel and click a measure.
2. Select applicable number formatting form the Number formatting menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto when further configuring the chart.

**Limitations**

For information about general limitations, see *Limitations of extension bundles supplied by Qlik* (page 306).

- The word cloud extension can handle maximum of 100 words per entry.
- Words that take up more space than the chart are not displayed. You can adjust the font size to show more values, but we do not recommend that you use fields with long text values.
- Word cloud chart visualizations cannot be used in Qlik NPrinting reports.

**Copying a visualization from an existing visualization**

You can copy a visualization:

- Within the same sheet
- Between sheets in the same app
- Between sheets belonging to different apps.

![Warning]

*For a copied visualization to work in a different app, the same dimensions and measures have to be a part of the target app as well.*

Do the following:

1. While editing a sheet, click on the item you want to copy.
   
   The item is highlighted.

2. On the edit bar, click ![Paste].

3. To insert the item on another sheet, navigate to the sheet via the sheet navigator.

4. Click ![Paste] to paste the item.

The copied item is added to the sheet.

![Info]

*Depending on what situation you are in, different things will happen when you paste the copied visualization on a sheet:*

- **If a visualization is selected, then the selected visualization will be replaced.**
- **If no visualization is selected, then the pasted visualization will be placed in the largest empty space.**
- **If there is no empty space, then the largest visualization on the sheet will be split in half to make space for the pasted visualization.**
Creating time-aware charts

Time-aware charts are visualizations that use a continuous scale to provide a complete and accurate view of time-based data. That is, when you enable continuous scaling on the x-axis in a chart with date fields, data points are separated from each other by a distance relative to their associated time. As well, the axis labels are evenly separated whether or not there is data for that point and the chart view is compressed to avoid scrolling.

Continuous scale is supported for line charts, bar charts, and combo charts.

A continuous scale is most commonly used with date fields such as:

- Second
- Minute
- Hour
- Week
- Month
- YearMonth
- Quarter
- YearQuarter
- Year
- Date
- Timestamp

Adding a continuous scale

Do the following:

1. In sheet view, click Edit in the toolbar.
2. Click the line chart that you want to edit.
3. In the properties panel, click the Appearance tab.
4. In the X-axis section, check Use continuous scale.
   The chart is compressed and the data points and labels are readjusted.

Making selections in a time-aware chart

When navigating a time-aware chart, you can zoom into a smaller time span to take snapshots of the data displayed and select data values. Selections made on a time axis using range selection select all data values (even those that are not visible). Selections made on the measure axis or using lasso selections only select visible values.

Changing the data of a visualization

The data displayed within a visualization can be changed after the visualization is created. For example, you may want to add additional dimensions or measures to a chart to add depth to the existing data. Alternatively, you may need to correct an invalid dimension or measure.
Adding dimensions and measures to a visualization

You can add multiple dimensions and measures to a visualization to add depth to the data displayed. Addition dimensions and measures enabled you to view more information in a single visualization. For example, the image below contains a visualization with the measure Sales and a dimension Month.

*Line chart with the measure Sales.*

You can add a second measure, Gross Sales. The example line chart now gives use more context by enabling a comparison of Gross Sales to Sales.

*Line chart with the measures Sales and Gross Sales.*
Do the following:

1. In the properties panel, click the Data tab.
   The Data tab is expanded.

2. In the Dimensions or Measures section, click Add to add a dimension or measure.
   A dialog with a text box opens. Below the text box all available dimensions or measures are listed, grouped into Dimensions or Measures (that is master items) and Fields.

3. Start typing in the text box.
   A list of matching fields and dimensions or measures is displayed.

   You can also create a dimension by entering an expression directly in the text box, or by clicking $\textbf{fx}$ to create a dimension in the expression editor.

   If no measure is displayed, you need to create one. You can enter an expression directly in the text box, or you can click $\textbf{fx}$ to create a measure in the expression editor.

4. Select the dimension or measure that you want to use.

The dimension or measure is added to the visualization. The new dimension or measure settings are shown in the properties panel.

Adding alternative dimensions and measures to a visualization

Alternative dimensions and measures are dimensions and measures that are added to a visualization, but are not displayed until a user chooses to switch which dimensions and measures are being displayed during visual exploration. You can toggle which of your dimensions and measure are displayed using the exploration menu of a visualization.
You can add alternative dimensions and measure to all chart types but changing alternative dimension and measures in the visualization can only be done in bar, line and combo charts. Only alternative dimensions can be changed in the pie charts visualization and only alternative measures in scatter plots.

Alternative dimensions and measures enable you to conserve space on your sheets. Rather than make multiple similar visualizations of the same type, you can use alternative dimensions and measure with a single visualization. You can then switch between the displayed dimensions and measures. For example, if you wanted to see total sales by product category and total sales by product subcategory, you could add product category as a dimension and product subcategory as an alternate dimension in the same visualization.

Alternative dimensions and measure enable you to have more dimensions and measures associated to a visualization that the display limit. Many visualizations have limitations on how many dimensions and measures that can be displayed at the same time. A line chart with two or more measures can only have one dimension, and a line chart with two dimensions can only have one measure. Alternative dimensions and measures enable you to exceed that limit.

Alternative dimensions and measures can be added like normal dimensions and measures in the properties pane. You can also drag dimensions and measures in the Data section of the properties panel into the Alternative dimensions or Alternative measures section.

Do the following:

1. In the properties panel, click the Data tab.
   The Data tab is expanded.
2. In the Dimensions or Measures section, click Add alternative.
   A dialog with a text box opens. Below the text box all available dimensions or measures are listed, grouped into Dimensions or Measures (that is master items) and Fields.
3. Start typing in the text box.
   A list of matching fields and dimensions or measures is displayed.

   You can also create a dimension by entering an expression directly in the text box, or by clicking \( \text{fix} \) to create a dimension in the expression editor.

   If no measure is displayed, you need to create one. You can enter an expression directly in the text box, or you can click \( \text{fix} \) to create a measure in the expression editor.

4. Select the dimension or measure that you want to use.

The alternate dimension or measure is added to the visualization.
3 Creating visualizations

Editing data in a visualization
You can edit and adjust the data in a visualization. You may need to edit an existing dimension or measure to adjust it to create a stronger visualization or correct an invalid dimension or measure. You may also want to edit a master item in a visualization to change the master item across all visualizations.

Invalid dimensions and measures
Dimensions and measures are invalid when the associated expression cannot be interpreted by Qlik Sense.

If you create an invalid dimension or edit an existing one so that it becomes invalid, the dimension is presented in the properties panel as dimmed with a red hue and the text Invalid dimension to indicate that the dimension is invalid. If you use an invalid dimension in a visualization, the visualization cannot be displayed.

If you create an invalid measure or edit an existing one so that it becomes invalid, the Expression text box under Measures in the properties panel is presented with a red border to indicate that the measure is invalid.

Editing a dimension
You can edit dimensions in the properties panel. If you want to edit a master item, you must first unlink the dimension from the master item. In the properties panel, click the dimension that you want to edit. Dimensions have the following properties:

- **Field**: Start typing the field name to display a list of matching fields to choose from. You can also click \(\text{fx}\) to open the expression editor, where you can create a calculated dimension.
- **Label**: Enter a name for the dimension.
- **Include null values**: When this is checked, the visualization will include the null values of the dimension, presented as a gap or a dash, depending on the type of visualization. For example, if you have sales figures but do not have any information about what company the figures belong to, the figures will be added to the measure value for the null value dimension.
- **Limitation**: You can limit the number of dimension values that are displayed.
- **Show others**: When you have set a limitation for the number of dimension values displayed, you have an option to summarize the measure values for the remaining dimensions by selecting Show others.

Editing a measure
You can edit measures in the properties panel. If you want to edit a master item, you must first unlink the measure from the master item. In the properties panel, click the measure that you want to edit. Measures have the following properties:

- **Expression**: Enter the expression. You can also click \(\text{fx}\) to open and use the expression editor.
- **Label**: Enter a name for the measure. The label is not automatically updated when you make changes in Expression.
- **Number formatting**: Set the number formatting for the measure values. The options Number and Date offer custom formatting options for defining your own format pattern.
3 Creating visualizations

Editing master items
Dimensions and measures that are linked to a master item are displayed with a [image] in the properties panel. If you want to edit a linked dimension or measure, you have two options: either updating the master item in the assets panel, or unlinking the item and making the changes in the properties panel. An update of the master item is reflected in all linked items.

Even if linked items cannot be edited in the properties panel, you still have a few settings that can be edited. These are related to the presentation of the items.

A visualization that is linked to a master item is displayed with a [image] on the sheet. You can edit a linked visualization, either by editing the master item or by unlinking the visualization. The unlinked visualization is independent of the master item and can be edited, but it can still contain dimensions or measures that are linked to master items.

Deleting dimensions and measures
In the properties panel, you can delete a dimension or measure. Long-touch or right-click the dimension or measure and select Delete in the dialog. Alternatively, click the dimension or measure and click Delete [image]. If you delete an instance of a master item, the master item is still available in the assets panel.

You can undo a deletion by clicking [image]. Changing which sheet you are viewing will prevent you from undoing your deletion.

Unlinking from a master item
If you want to make changes to a dimension or measure that is linked to a master dimension or master measure, you must first unlink it from the master item. The dimension or measure in your visualization is then independent with no connection to the master item in the assets panel.

Unlinking from the properties panel
A linked dimension or measure that is used in a visualization can be unlinked from the properties panel.

Do the following:

1. Click Edit. The properties panel opens on the right-hand side.
2. Select the visualization on the sheet. The properties for the selected visualization are displayed in the properties panel.
3. Under Data, locate and click the dimension or measure. A linked dimension or measure is indicated by the symbol [image].
4. Click [image]. A dialog is displayed that you are about to unlink from a master item.
5. Click OK.
The dimension or measure used in the visualization can now be edited and the changes will not affect any other dimensions or measures.

ℹ️ You can only unlink from a single dimension, not to a drill-down dimension.

### Changing the appearance of a visualization

The **Appearance** section in the properties panel offers several options to set and modify the appearance of a visualization. Many of the settings have **Auto** options that support an optimal presentation of the visualization, taking into account the number of dimensions and measures and the type of data used. Normally, you do not need to change these settings, unless you have a special reason for doing so, for example, when space is very limited.

Appearance can be affected by the sorting of the dimensions and measures.

#### General

**Show titles**: On by default in all visualizations except filter panes and text & image visualizations. Filter panes have the name of each dimension, and in most cases do not need any additional title. The text & image visualization includes an editing toolbar with many options to format the text, and therefore the title field can be used for other purposes.

**Title, Subtitle, and Footnote**: Apart from the obvious use of title, subtitle, and footnote as text fields, you can use these fields to also display an expression, which provides additional information that complements the measure in the visualization. You could, for example, show the totals in the title field, so that the totals of the selected values are always available.

#### Example:

In the following image, the total sales are calculated and used in the title. When a selection is made, the total sales are updated accordingly.
Creating visualizations

The following string was used to add the Total Sales expression to the field **Title**:

```
=’Total Sales: $’ & Round(Sum(Sales)/1000000, 0.1) & ’M’.
```

Because the title field is primarily a text field, it is necessary to start the string with an equals sign (=), to signify that the strings contains an expression.

Because ‘Total Sales: $’ is a text string when it is used in an expression, the string must be surrounded by single quotation marks.

& is used to concatenate the string and the expression.

`Round(Sum(Sales)/1000000, 0.1)` is the expression. The aggregation `Sum(Sales)` is divided by 1000000 and the function `Round (x,0.1)` reduces the number of decimals to one.

& ‘M’, finally, concatenates the expression with the unit M for million.

For the title there are three options for adding an expression:

- Directly in the title field of a visualization. Start the string with an equals sign (=).
- Directly in the box **Title** under **Appearance** in the properties panel. Start the string with an equals sign (=).
- Through the expression editor in the box **Title**. Click **fx** to open the expression editor. No equals sign is needed.

For the subtitle and footnote only the last two options are available.

**Show details: Hide** by default. When set to **Show**, users can click  when analyzing to view details such as descriptions, measures, and dimensions.
3 Creating visualizations

Presentation

Many of the presentation settings only apply to a certain visualization.

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Set the bars to be displayed grouped or stacked, vertically or horizontally.</td>
</tr>
<tr>
<td>Box plot</td>
<td>Select to show whisker ticks and grid lines. You can show the visualization vertically or horizontally.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>Select to show point, background or both. You can show the visualization vertically or horizontally.</td>
</tr>
<tr>
<td>Gauge</td>
<td>Set the gauge to be displayed as a radial or a bar. You can set range limits and use segments with limits.</td>
</tr>
<tr>
<td>Histogram</td>
<td>Select to show grid lines.</td>
</tr>
<tr>
<td>Line chart</td>
<td>Set the line chart to be displayed as a line or an area.</td>
</tr>
<tr>
<td>Pie chart</td>
<td>Set the pie chart to be displayed as a pie or a donut.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>Turn on/off navigation. Set the size of the bubbles in a scatter plot. Set the compression resolution for large data sets in scatter plot.</td>
</tr>
<tr>
<td>Table</td>
<td>Set the totals to be displayed at the top, bottom, or not at all.</td>
</tr>
<tr>
<td>Treemap</td>
<td>Set the headers, labels, overlay labels, and leaf values. Select to show the data values.</td>
</tr>
</tbody>
</table>

**Example:**

A bar chart with two dimensions is by default presented with the bars grouped.
Let us assume that you want to compare the total monthly quantity for these years. Then it would be a good idea to switch to a stacked bar chart.

In the properties panel, under **Appearance > Presentation** there is an option **Stacked**.

With stacked bars it is easier to compare the quantity between different months.

Now it is quite easy to compare the quantities per month. There is a legend to display the years.

Under **Colors and legend**, **Show legend** is set to **Auto**, which means that the legend is displayed when there is enough space. In the properties panel, you can also set where to display the legend and whether to display the legend title.

*There is only data for the first half of 2013 (red bars).*
Colors and legend

The **Colors and legend** section of the properties panel sets your color and legend options. Qlik Sense automatically colors visualizations as they are added to your sheets. As a best practice, it is recommended to add or change colors only when it serves as purpose in the visualization. Too many colors or indistinct color choices can make visualizations less clear.

You can manually set the colors and legends by deselecting the **Auto** option and selecting your color preferences. Qlik Sense enables you to color your visualizations by:

- Single color
- Multiple colors
- Dimension
- Measure
- Master items
- Expression

For more information on different visualization coloring options, see *Coloring a visualization* (page 387). For examples of each of these methods of coloring visualizations and the settings used can be found, see *Example 1: Coloring by a dimension in the visualization* (page 403).

**X-axis and Y-axis**

For both the y-axis and the y-axis, you have options for deciding what combination of labels and title to display, as well as their orientation and position. Sometimes it may feel unnecessary to have labels and/or title, because the visualization is self-explanatory and then it would be good to be able to hide them. Furthermore, when you create a visualization that is very small, for example, three by three squares, the labels are automatically hidden.

**Range**: The measure axis (usually the y-axis) has an option to set the range of the axis. By default, the range is adjusted according to the highest positive or the lowest negative measure value, but if, for example, a single measure value is much larger than all the other values, you may want to set a range that is suitable for the lower values. In the properties panel, under **Appearance > Y-axis <measure name>**, there is a button for **Range**, which is set to **Auto**. Click the button to switch to **Custom**. Now you can set the range for **Max, Min**, or both. In a bar chart, the bars that are out of the range are cut diagonally to indicate that they are out range. In a line chart, only the parts that are within the range are visible.

**Change the sorting of a visualization**

When you are working with a visualization, you will occasionally want to change the sorting order of the dimensions and measures so that your data is presented in the way you intend. Most visualizations have a **Sorting** section in the properties panel where you can put the cursor on the drag bars and drag the dimension or measure to rearrange the sorting order. In visualizations without a sorting section, you can still adjust the sorting to some extent.

In the following screenshot, the primary sorting is on the measure **Gross Sales**.
A bar chart with that sorting order will look as follows.

Since there are two measures, Gross Sales and Sales, the bars are by default grouped. Gross Sales is presented first, because it has sorting priority 1. If you were to drag Sales to the top of Sorting, the first bar would be Sales and the second bar Gross Sales.

To sort by Year, instead, you need to drag Year to the top in Sorting. The bar chart is then updated and sorted by Year.
In bar charts with multiple dimensions, sorting is locked to the first dimension. This dimension is what groups and stacks are based on, and sorting on a different dimension or a measure would break up these groups in an undesirable way. If you still want to sort by the measure value, try using the option Sort by expression on the first dimension under Sorting.

Sorting in the dimensions and measures sections

Although it is primarily under Sorting that you set the sorting order, you can also adjust the order in the properties panel section Data under Dimensions and Measures. In Dimensions you can change the priority order between the different dimensions by dragging them, and, likewise, in Measures, you can drag the measures to change the sorting order. Put the cursor on the drag bars and drag the dimension or measure to rearrange the order. Changes are reflected in the visualization.

Internal sorting

Apart from setting the sorting order between dimensions and measures, you can also set the internal sorting order, under Sorting.

Click the dimension or measure name to open the settings and click the sorting button to switch to Custom sorting. The following table shows the internal sorting priority order and sorting options. The sorting is either Ascending or Descending.

Sorting options:

- Sort by expression (Enter an expression to sort by. Only available for dimensions.)
- Sort numerically
- Sort alphabetically

Additionally, you can sort by load order by switching to Custom and leaving all sorting options unselected.

If you have set a custom order for a field, that custom order will override any selected internal sort order in Sorting.

Default sorting

By default, the dimensions and measures are sorted in the order they were added, with the most recently added item last. Each dimension is sorted internally in the most common way for that type of data. Numbers are sorted numerically, ascending. Text is sorted alphabetically, ascending.

Default sorting in visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>By default, a bar chart with one measure and one dimension is presented with vertical bars sorted descending on the measure. When a dimension has less than 10 values, the sorting is by dimension, alphabetically.</td>
</tr>
</tbody>
</table>
### 3 Creating visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box plot</td>
<td>By default, a box plot is sorted by the center line. You can also sort by first whisker, box start, box end or last whisker.</td>
</tr>
<tr>
<td>Combo chart</td>
<td>Sorted by the first item added, either the dimension or the measure.</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>By default, a distribution plot is sorted by the outer dimension.</td>
</tr>
<tr>
<td>Filter pane</td>
<td>By default, data in filter panes is presented ascending.</td>
</tr>
<tr>
<td>Gauge</td>
<td>A gauge only uses a single measure value, the first one under Measures.</td>
</tr>
<tr>
<td>Histogram</td>
<td>The histogram does not have any sorting section.</td>
</tr>
<tr>
<td>KPI</td>
<td>By default, the first added measure becomes the main value.</td>
</tr>
<tr>
<td>Line chart</td>
<td>By default, a line chart is sorted by the dimension.</td>
</tr>
<tr>
<td>Map</td>
<td>A map layer can only have one dimension. Sorting is used to determine the order points or areas are added to the map.</td>
</tr>
<tr>
<td>Pie chart</td>
<td>A pie chart uses one measure and one dimension. By default, a pie chart is sorted by the measure in descending order.</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>The scatter plot does not have any sorting section, but the order of the measures decides where they are used. The first measure is used on the x-axis, the second measure is used on the y-axis, and the third (optional) measure is used for the bubble size (it is used to set the color on large data sets) in the scatter plot. You can only have one dimension in a scatter plot.</td>
</tr>
<tr>
<td>Table</td>
<td>By default, the column presents the dimensions and measures in the order they were added. Sorting order of rows: By default, the table is sorted in ascending order by the first dimension or measure under Sorting. You can temporarily change the sorting by clicking the header of the row you want to sort on. One click - ascending order, two clicks - descending order.</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>The text &amp; image visualization does not have any sorting section, but you can drag the measure tokens in the visualization to change the order.</td>
</tr>
<tr>
<td>Treemap</td>
<td>The treemap does not have any sorting section. The sorting is automatically by measure size.</td>
</tr>
</tbody>
</table>

### Coloring a visualization

Qlik Sense automatically colors visualizations as they are added to your sheets. You can manually set the colors in your visualizations to meet your requirements or preferences. Color options for most visualizations are set in the properties panel, in Appearance > Colors and legend. By selecting Custom, you can manually apply colors to your visualizations using the following methods:

- Color by single color
- Color by multiple colors
3 Creating visualizations

- Color by dimension
  Dimension fields can also be dragged and dropped from the assets panel onto a visualization to color the visualization by dimension (if supported by the visualization type).

- Color by measure
  Measure fields can also be dragged and dropped from the assets panel onto a visualization to color the visualization by measure (if supported by the visualization type).

- Color by expression

Tables and pivot tables can only be colored by expression. Options for coloring tables and pivot tables are found in the properties panel in Data.

If you want to keep colors consistent for dimensions or measures between different visualizations, you can assign specific colors to master items in your library. Most visualizations will use any colors assigned to master items automatically. In cases where a visualization uses both a master dimension and a master measure with assigned colors, the color assigned to the master dimension is used by default. You can select which master item color to use or disable master item colors entirely.

For more information, see Assigning colors to master items (page 74).

You can also assign colors to individual master dimension values to ensure the colors of different values are consistent across visualizations.

For more information, see Assigning colors to master dimension values (page 76).

To keep visualizations clear when you manually set colors, you should select colors for accessibility and only use different colors when they serve a purpose.

Color by single color

When you color by single color, one color is used for all objects in the chart. Coloring by a single color is best used for visualizations, such as bar or line charts, with a single dimension and measure.

If you have a master dimension or master measure that has a color assigned to it, you can color the visualization by that single color. In cases where a visualization uses both a master dimension and a master measure with assigned colors, the color assigned to the master dimension is used by default. You can select which master item color to use or disable master item colors entirely.

The following options are available when Single color is selected from Colors in Appearance > Colors and legend:

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use library colors</td>
<td>Select to use master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.</td>
</tr>
<tr>
<td></td>
<td>This option is available when a master dimension or master measure used in the visualization has a color assigned to it.</td>
</tr>
</tbody>
</table>
3  Creating visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Select a color using the color picker. You can select a color from the default palette, enter a hex value for a color, or select a color from a color wheel.</td>
</tr>
</tbody>
</table>

Color by multiple colors

When you have multiple measures in a visualization, you can select Multicolor to color each measure with a different color. Qlik Sense offers a 12 color and a 100 color palette to apply to the visualization. By default, **12 colors** is selected as the color scheme dimensions.

If you are using master measures in your visualization, you can also choose to use them in your visualization. When a visualization is colored by master measures, master measures will use their assigned colors and any other measures are assigned colors from the **12 colors** scheme.

The following options are available when Multicolor is selected from Colors in Appearance > Colors and legend:

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use library colors</td>
<td>Select to use master item colors. In cases where a visualization has both a master dimension and a master measure that have colors assigned to them, you can select which to use in the visualization.</td>
</tr>
<tr>
<td></td>
<td>This option is available when a master dimension or master measure used in the visualization has a color assigned to it.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>Select the color scheme used in the visualization. The following schemes are available:</td>
</tr>
<tr>
<td></td>
<td><strong>12 colors</strong>: The colors are reused when there are more than 12 values. The 12 colors in this color scheme can all be distinguished by people with a color vision deficiency.</td>
</tr>
<tr>
<td></td>
<td><strong>100 colors</strong>: The colors are reused when there are more than 100 values. Not all of the 100 colors can be distinguished by people with a color vision deficiency.</td>
</tr>
</tbody>
</table>

Color by dimension

When you color a visualization by a dimension, all values in the visualization are colored by the corresponding values in the dimension field selected. By default, the visualization is colored by the primary dimension of the visualization, but you can select other dimensions. Qlik Sense offers a 12 color and a 100 color palette. By default, **12 colors** is set as the palette for color by dimensions.

If you are using a master dimension, you can color the visualization using the colors assigned to the distinct values of that dimension.

Coloring by dimension is useful when you want to keep track of related information in your visualizations, such as coloring multiple charts by the dimension of **Region** to clearly see the values related to each region in each chart.
The following options are available when *By dimension* is selected from *Colors in Appearance > Colors and legend*:

### Options for color by dimension

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Dimension</strong></td>
<td>Select the dimension used to color this visualization with this field. By default, if you have already selected a dimension for the visualization, it is set with that dimension. Click ▼ to select a different dimension. You can enter an expression by clicking $fx$ to open the expression editor</td>
</tr>
<tr>
<td><strong>Persistent colors</strong></td>
<td>When selected, colors persist between selection states. If cleared, colors will be changed and reassigned for different dimension values as selections are made in the visualization.</td>
</tr>
</tbody>
</table>
| **Color scheme** | Select the color scheme used in the visualization. The following schemes are available:  
  12 colors: The colors are reused when there are more than 12 values. The 12 colors in this color scheme can all be distinguished by people with color vision deficiency.  
  100 colors: The colors are reused when there are more than 100 values. Not all of the 100 colors can be distinguished by people with color vision deficiency. |
| **Library colors** | Select to use master dimension color values.  
  This option is available when a master dimension is used in the visualization. |

### Color by measure

When you color a visualization by a measure, all values in the visualization are colored by a gradient or class based on the values in the selected measure. By default, the visualization is colored by the primary measure of the visualization, but you can select another measure. There are four available color schemes.

Coloring by measure is useful when you want to clearly see objects colored by their corresponding measure value.

The following options are available when *By measure* is selected from *Colors in Appearance > Colors and legend*:

### Options for color by measure

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Measure</strong></td>
<td>Select the measure used to color this visualization. By default, if a measure has been added to the visualization, that measure is selected. Click ▼ to select a measure. You can enter an expression by clicking $fx$ to open the expression editor</td>
</tr>
</tbody>
</table>

---

Create apps and visualizations - Qlik Sense, June 2019
3 Creating visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color scheme</td>
<td>Select the color scheme used in the visualization. The following schemes are available:</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential gradient</strong>: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential classes</strong>: The transition between the different color groups is made using distinctly different colors.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging gradient</strong>: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging classes</strong>: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.</td>
</tr>
<tr>
<td>Reverse colors</td>
<td>Select this option to switch which colors are used for low values and which colors are used for high values in the selected color scheme.</td>
</tr>
<tr>
<td>Range</td>
<td>Set the measure value ranges used to color the visualization. When set to Auto, Qlik Sense creates ranges based on the detected minimum and maximum values. When set to Custom, Qlik Sense automatically creates ranges based on user-defined minimum and maximum values. You must enter values or expressions that calculate those values in the fields Min and Max. You can enter an expression by clicking ( \text{fx} ) to open the expression editor.</td>
</tr>
</tbody>
</table>

Color by expression

Coloring by expression applies colors to a visualization based on a user-defined expression. This enables you to use expressions to define both the colors used and the values upon which the colors are applied in a visualization. You could, for example, use an expression to set conditional colors in a chart.

The following options are available when **By expression** is selected from **Colors in Appearance > Colors and legend**:

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Enter an expression by clicking ( \text{fx} ) to open the expression editor. For more information, see <em>Examples (page 394)</em>.</td>
</tr>
<tr>
<td>The expression is a color code</td>
<td>Selected by default. In most cases, it is best to keep this setting. When the selection is cleared, the expression evaluates to a number, which in turn is plotted against one of the chart gradients.</td>
</tr>
<tr>
<td>UI item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>Enter the label to appear for the legend.</td>
</tr>
<tr>
<td></td>
<td><strong>This expression is a color code</strong> must be cleared.</td>
</tr>
<tr>
<td><strong>Color scheme</strong></td>
<td>Color scheme sets the colors used in the visualization. The following color schemes are available:</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential gradient</strong>: The transition between the different color groups is made using different shades of colors. High measure values have darker hues.</td>
</tr>
<tr>
<td></td>
<td><strong>Sequential classes</strong>: The transition between the different color groups is made using distinctly different colors.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging gradient</strong>: Used when working with data that is ordered from low to high, for instance, to show the relationship between different areas on a map. Low and high values have dark colors, mid-range colors are light.</td>
</tr>
<tr>
<td></td>
<td><strong>Diverging classes</strong>: Can be seen as two sequential classes combined, with the mid-range shared. The two extremes, high and low, are emphasized with dark colors with contrasting hues, and the mid-range critical values are emphasized with light colors.</td>
</tr>
<tr>
<td></td>
<td><strong>This expression is a color code</strong> must be cleared.</td>
</tr>
<tr>
<td><strong>Reverse colors</strong></td>
<td>When selected, the color scheme is reversed.</td>
</tr>
<tr>
<td></td>
<td><strong>This expression is a color code</strong> must be cleared.</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>This setting sets the value ranges for coloring results in the visualization.</td>
</tr>
<tr>
<td></td>
<td><strong>Auto</strong>: Qlik Sense creates ranges based on the detected minimum and maximum values.</td>
</tr>
<tr>
<td></td>
<td><strong>Custom</strong>: Qlik Sense automatically creates ranges based on user-defined minimum and maximum values. You must enter values or expressions that calculate those values in the fields <strong>Min</strong> and <strong>Max</strong>. You can enter an expression by clicking <strong>fx</strong> to open the expression editor.</td>
</tr>
<tr>
<td></td>
<td><strong>This expression is a color code</strong> must be cleared.</td>
</tr>
</tbody>
</table>

**Color by expression in table visualizations**

Expressions can be used to color table and pivot table backgrounds and text. This enables you to use expressions to define both the colors used and the conditional values upon which the colors are applied in a visualization. You could, for example, use expressions to change text and background colors depending on the values within different table cells.

The following options are available in **Data** for coloring table and pivot table visualizations:
3 Creating visualizations

Options for coloring table and pivot table visualizations

<table>
<thead>
<tr>
<th>UI item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background color expression</td>
<td>Enter an expression by clicking ( \text{fix} ) to open the expression editor. The text color automatically changes to white when a dark background color is used.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Examples (page 394).</td>
</tr>
<tr>
<td>Text color expression</td>
<td>Enter an expression by clicking ( \text{fix} ) to open the expression editor. If you use the same expression as in the background color, the text will not be visible.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Examples (page 394).</td>
</tr>
</tbody>
</table>

Color by expression

Coloring by expression sets colors using a user-defined expression. When coloring by expression, you can define both what colors to use and which values to use them with, enabling more control over how colors are used in the visualization. For example, you might highlight values of particular interest, or differentiate between values within different value ranges. Coloring by expression can also be used to color a visualization by values not included within a visualization, such as coloring products and the sum of their monthly sales by the country of origin for the product.

When you select to color By expression, you can choose to either use the expression as a color code or to define how By measure color options are applied to the visualization using an expression.

The following visualizations support color by expression:

- Bar chart
- Combo chart
- Line chart
- Map
- Pie chart
- Pivot table
- Scatter plot
- Table
- Treemap

**Legend selection is not available in a visualization when coloring by expression. Visualizations that are colored by expression with a color code do not support legends.**

Coloring by expression as a color code

By default, if you choose to color by expression, The expression is a color code is enabled. If you have this option selected, your expression must include a color code in a supported expression format to define the colors to use. Using this method provides you with manual control over visualization colors as well as the conditions for the colors being used in a visualization. With tables and pivot tables, you can use expressions to define the background color and the text color of columns.
3 Creating visualizations

When coloring by expression, objects in visualizations are colored gray if the expression contains errors or if objects in the visualization have multiple colors they could be assigned in the expression.

Examples

Here are a few examples to show what you can do with expressions by color.

Example: Coloring by random color range

```plaintext
argb(255, rand() * 255, rand() * 255, rand() * 255)
```

This example uses ARGB color. It starts with alpha value that sets full opacity, and then uses the rand() function to generate random values for the red, green, and blue colors, creating a random color.

Example: Coloring by single measure value

```plaintext
if (sum([Budget Amount]) > 1000000, 'cornflowerblue', magenta())
```

In this example, there is a condition. If sum([Budget Amount]) is greater than 1 million, the corresponding measure values will be colored 'cornflowerblue', otherwise they will be colored magenta.

'cornflowerblue' is the color keyword for the color rgb(100, 149, 227).

magenta() is the Qlik Sense color function that generates a magenta color.

Example: Coloring by single measure value using an aggregated expression

```plaintext
if (avg(Value) > avg(Total aggr(avg(Value), Name)), Blue(), Brown())
```

In this example, there is a condition. If the avg(Value) value is greater than the aggregated avg(Value) value of the entire table, then the corresponding measure value is colored blue. If the avg(Value) value is less than the aggregated avg(Value) value of the entire table, then the corresponding measure value is colored brown.

Example: Coloring by multiple measure values

```plaintext
if (Sum(Sales) > 3000000, 'green', if (Sum(Sales) > 2000000, 'yellow', if (Sum(Sales) > 1000000, 'orange', red())))
```

In this example, there are multiple conditions. If Sum(Sales) is greater than 3,000,000, then corresponding measure values will be colored green. If Sum(Sales) is between 2,000,000 and 3,000,000, then the corresponding measure values will be colored yellow. If Sum(Sales) is between 1,000,000 and 2,000,000, the corresponding measure values will be colored orange. All other measure values will be colored red.

Example: Coloring by multiple dimensions

```plaintext
if ([CompanyName] = 'A Corp', rgb(100, 149, 227), if ([CompanyName] = 'B Corp', rgb(100, 149, 200), if ([CompanyName] = 'C Corp', rgb(100, 149, 175), if ([CompanyName] = 'D Corp', rgb(100, 149, 150), 'grey'))))
```

Create apps and visualizations - Qlik Sense, June 2019
In this example, the expression is used to define a RGB color for each specific dimension value in the field CompanyName.

**Example: Coloring table object font and background by measure value.**

```
if(Sum([Sales]) < 10000, 'red', green())
if(Sum([Sales]) > 200000, 'gold', )
```

In this example, two expressions are used to color the background and text of the Sales column. Measure values in Sales that are lower than $10000 have a red background color, all other values have a green background. In addition, the values that are higher than $200000 have the text color 'gold'.

<table>
<thead>
<tr>
<th>Customer KPIs</th>
<th>Sales</th>
<th>Quantity</th>
<th>Margin (%)</th>
<th># of Invoices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>$194,852,674.81</td>
<td>1,816,372</td>
<td>4127.8%</td>
<td>33314</td>
</tr>
<tr>
<td>A-Z-Z Solutions</td>
<td>$196,298.49</td>
<td>1,418</td>
<td>3841.7%</td>
<td>58</td>
</tr>
<tr>
<td>A-ARVIN Laser Resources</td>
<td>$4,053.05</td>
<td>25</td>
<td>3792.6%</td>
<td>13</td>
</tr>
<tr>
<td>A Superior System</td>
<td>$183,728.12</td>
<td>808</td>
<td>4074.5%</td>
<td>107</td>
</tr>
<tr>
<td>A&amp;B</td>
<td>$92,120.60</td>
<td>891</td>
<td>4202.9%</td>
<td>18</td>
</tr>
<tr>
<td>A&amp;G</td>
<td>$12,502.61</td>
<td>133</td>
<td>4768.0%</td>
<td>12</td>
</tr>
<tr>
<td>A&amp;R Partners</td>
<td>$30,392.45</td>
<td>155</td>
<td>3469.9%</td>
<td>6</td>
</tr>
<tr>
<td>A1 Datacom Supply</td>
<td>$259,599.52</td>
<td>5,839</td>
<td>4015.7%</td>
<td>111</td>
</tr>
<tr>
<td>a2i</td>
<td>$451.64</td>
<td>14</td>
<td>5963.7%</td>
<td>9</td>
</tr>
<tr>
<td>A1Z Solutions</td>
<td>$99,977.36</td>
<td>494</td>
<td>4111.1%</td>
<td>94</td>
</tr>
<tr>
<td>AA-Wizard</td>
<td>$94,209.44</td>
<td>917</td>
<td>4660.6%</td>
<td>41</td>
</tr>
<tr>
<td>A&amp;dset</td>
<td>$351,243.31</td>
<td>881</td>
<td>3767.3%</td>
<td>35</td>
</tr>
<tr>
<td>Aaron D. Meyer &amp; Associates</td>
<td>$90,017.11</td>
<td>1,869</td>
<td>4404.1%</td>
<td>58</td>
</tr>
</tbody>
</table>

**Coloring by expression without a color code**

You can color by expression without a color by disabling **The expression is a color code** when you enable coloring by expression. In this method of coloring, the expression is used to evaluate to a numeric value that is plotted against a **By measure** chart gradient, treating the expression like a measure when coloring by measure.

> When coloring by expression, objects in visualizations are colored gray if the expression contains errors or if objects in the visualization have multiple colors they could be assigned in the expression.
Example:

\[100 \times \text{Sum(}[\text{Sales Margin Amount}])/\text{Sum(}[\text{Sales Amount}])\]

In this example, charts would have **By measure** color gradients applied to them based on the profit margin percentile calculated in the expression.

**Supported expression formats**
The following formats are supported when you create your expressions.

**RGB**
With RGB colors you enter an integer value between 0 and 255 (or an expression that evaluates to such a value) for each of the colors red, green, and blue. The resulting color is produced by adding the three colors together.

**Example:**

\[rgb(0,0,255)\]

This example generates the color blue. Many of the RGB colors have a corresponding keyword in plain text that can be used instead of the RGB code. If you use 'blue' as expression, you would get exactly the same color. Hexadecimal numbers are also supported, and the color blue has the string '\#0000ff'.

**ARGB**
The ARGB color model has the same support as the RGB color model, but extends it with an additional alpha value to set the opacity of a color.

**Example:**

\[argb(125,0,0,255)\]

The first value (125), sets the alpha value. The value 0 generates full transparency and the value 255 full opacity.

**HSL**
In HSL, the color is defined by a hue value, a saturation value, and a luminosity value. You use values between 0 and 1. Hue is represented as an angle of the color circle (that is, the rainbow represented in a circle). Saturation is full with the value 1 and a shade of gray with the value 0. Lightness with the value 1 is white, and black with the value 0. The value 0.5 is commonly used.

**Example:**

\[hsl(0,0.5,0.5)\]

This example generates a red color with medium saturation and lightness.
Color keywords

Qlik Sense supports W3C recommended color keywords. With color keywords, specific colors are defined by a name which corresponds to a RGB hex value. Enter the color name in the expression to use the color.

Use the following links to find out more about W3C color keywords:
- [http://www.w3.org/TR/CSS21/syndata.html#value-def-color](http://www.w3.org/TR/CSS21/syndata.html#value-def-color)

**Example:**

'cornflowerblue'

This example generates a blue color with the hex value of #6495ed and a RGB value of (100, 149, 237).

Qlik Sense color functions

The following color functions can be used in expressions when coloring by expression.

- black()
- darkgray()
- lightgray()
- white()
- blue()
- lightblue()
- green()
- lightgreen()
- cyan()
- lightcyan()
- red()
- lightred()
- magenta()
- lightmagenta()
- brown()
- yellow()

**Creating an expression**

You create expressions for colors in the properties panel.

Do the following:

1. In the properties panel, open Appearance > Colors and legend.
2. Click the Colors button to switch to Custom.
3. In the drop-down list, select the option By expression.
An expression text box is opened.

4. Enter your expression in the text box, or click \( \text{\text{fx}} \) to open the expression editor.

If the expression is valid, the visualization is updated.

Visualization support for coloring methods
Not all Qlik Sense visualizations support the same coloring options. Additionally, some visualization types have specific behaviors or limitations when using certain coloring methods. Color methods supported by visualizations and their limitations are determined primarily by the kinds of data the visualizations displays. For example, visualizations that only support displaying measures cannot be colored by dimension or through using master dimensions.

Color method support by visualization
The following table outlines color method support by visualization type.

<table>
<thead>
<tr>
<th>Visualizations</th>
<th>Single</th>
<th>Multicolor</th>
<th>Master measure</th>
<th>Master dimension</th>
<th>Dimension</th>
<th>Measure</th>
<th>Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Box plot</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Combo chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distribution plot</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Filter pane</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Gauge</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Histogram</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>KPI</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Line chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Map</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pie chart</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pivot table</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Scatter plot</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Table</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Text &amp; image</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Treemap</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Visualization coloring limitations and behaviors
Different visualizations have different behaviors with the methods of setting color in visualizations. This section outlines specific considerations when coloring different visualizations.
3 Creating visualizations

Line chart

Line charts do not support coloring by measure if they have two or more dimensions.

Map

Colors assigned to master dimensions that contain geopoint data or area data (polygons of geopoints) cannot be used to color a map.

Pie chart

Pie charts do not use master item colors when Auto is selected under Colors and legend.

Examples of visualization color settings

Although Qlik Sense sets colors in visualizations automatically, you can use a number of different methods to control the use of colors in your visualizations. You can manually apply colors to your visualizations using the following methods:

- Color by single color
- Color by multiple colors
- Color by dimension
- Color by measure
- Color by expression

In the example dashboard below, each method of setting colors has a corresponding visualization. This section outlines each example as well as the specific settings used in the properties panel.
Color by single color

Visualizations can be colored with a single user-defined color. Colors can be selected from a palette or color wheel or by entering a hex color code.

In this example visualization, a single color has been applied to the line chart.

Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and Single color. Color set as hex value 4477aa.

Color by multiple colors

Visualizations with multiple measures can have different colors applied to each measure. When a visualization is colored using Multicolor, colors are automatically applied from a default color scheme of 12 colors or 100 colors.

In this example visualization, multiple colors have been applied to the measures of Expense Amount and Budget in the line chart.
2. Color by multiple colors

Properties panel settings

For this visualization, the following properties were set in the properties panel under **Appearance > Colors and Legends**:

- **Colors**: Set to Custom and Multicolored.
- **Color scheme**: Set to 12 colors.

**Color by master item**

Colors can be kept consistent across visualizations for dimensions or measures through setting colors in master items. When set to use master item colors, visualizations will use all colors associated to the master items in the visualization. Master item colors can be used when **Color** is set to Single color or Multicolor.

In these example visualizations, both the bar chart and line chart share a master measure, Revenue, that is colored orange. In each visualization, the same assigned color is used for each instance of Revenue. The line chart is colored by a second master measure, Expense Amount, which is colored blue.
Master measure settings

For this visualization, the following settings were applied to the master measures in **Edit measure**:

- **Color**: Hex color set as #f8981d for Revenue and #4477aa for Expense Amount.

For more information, see **Assigning colors to master items (page 74)**.

Properties panel settings

For the bar chart, the following properties were set in the properties panel under **Appearance > Colors and Legends**:

- **Colors**: Set to **Custom** and **Single color**.
- **Use library colors**: Set to enabled.

For the line chart, the following properties were set in the properties panel under **Appearance > Colors and Legends**:

- **Colors**: Set to **Custom** and **Multicolor**.
- **Use library colors**: Set to enabled.

For more information, see **Bar chart properties (page 113)** and **Line chart properties (page 172)**.

**Color by measure**

When a visualization colored by measure, sequential or diverging gradients or classes are applied to values in the chart based on the values of the selected measure. Visualizations can be colored by measures within the visualization or they can be colored with measures associated to values in the visualization.

In this example, this bar chart is colored by the measure used in the visualization, **Revenue**. A diverging gradient has been applied to the values in the chart based on the **Revenue** value for each dimension value.
4. Color by measure

Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By measure. The measure selected is Revenue.
- **Color scheme**: Set to Diverging gradient.
- **Reverse colors**: Set to enabled.
- **Range**: Set to Auto.

For more information, see Bar chart properties (page 113).

Color by dimension

When a visualization is colored by dimension, each value within the visualization is assigned a color based on an associated value from the coloring dimension. When colored by dimension, colors are automatically applied from a default palette set of 12 or 100 colors.

Example 1: Coloring by a dimension in the visualization

In this example, the line chart is colored by the dimension of the different sales representatives, using the 100 colors scheme. Each sales representative has their own distinct color in the visualization.
3  Creating visualizations

5. Color by dimension

**Properties panel settings**

For this visualization, the following properties were set in the properties panel under **Appearance > Colors and Legends**:

- **Colors**: Set to Custom and By dimension. The dimension *Sales Rep Name* is selected.
- **Persistent colors**: Set to enabled.
- **Color scheme**: Set to 100 colors.

For more information, see *Line chart properties (page 172)*.

**Example 2: Coloring by a dimension not included in the visualization**

In this example, the bar chart is colored by the dimension of *Region*, using the **12 colors** scheme. The bar for each sales representative is colored by the region in which they work.
Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By dimension. The dimension Region is selected.
- **Persistent colors**: Set to enabled.
- **Color scheme**: Set to 12 colors.

Color by expression

You can use expressions to set specific colors to appear with specific values, enabling conditional coloring of values in your visualizations. When a visualization is colored by expression, you define the colors and how the colors are applied to values within the expression.

Example 1: Color by expression in a table

In this example, the table visualization uses two expressions, one for the background color and one for the text. These expressions apply conditional colors to the background and text based on which rows contain the top 10 and bottom 10 values for Revenue.
6. Color by expression

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homebound</td>
<td>$1,263,085.68</td>
</tr>
<tr>
<td>Icon Site Builders</td>
<td>$9,429.32</td>
</tr>
<tr>
<td>Kari &amp; Associates</td>
<td>$7,364.12</td>
</tr>
<tr>
<td>Livermore Laboratories (LSLI)</td>
<td>$50,151.75</td>
</tr>
<tr>
<td>MATRIX</td>
<td>$512,901.49</td>
</tr>
<tr>
<td>Pacific Matica</td>
<td>$24,625.51</td>
</tr>
<tr>
<td>Ra Co Amo</td>
<td>$1,203,542.53</td>
</tr>
<tr>
<td>Ready-to-Run</td>
<td>$98,191.57</td>
</tr>
<tr>
<td>Remedy</td>
<td>$226,538.83</td>
</tr>
<tr>
<td>Reuters Usability Group</td>
<td>$45,384.54</td>
</tr>
<tr>
<td>RFI Corporation</td>
<td>$1,772,832.86</td>
</tr>
<tr>
<td>Satronix</td>
<td>$126,639.22</td>
</tr>
</tbody>
</table>

Properties panel settings

For this visualization, the following properties were set in the properties panel under Data > Columns:

- **Background color expression**: `if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10, 'honeydew', if(Rank(-Sum([Sales Quantity]*[Sales Price])) <= 10, 'mistyrose', ')))`
- **Text color expression**: `if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10, 'green', if(Rank(-Sum([Sales Quantity]*[Sales Price])) <= 10, 'red', )))`

To learn more about table properties, see Table properties (page 257).

Example 2: Color by expression in a chart

In this example, the bar chart uses an expression to assign specific colors to different values in the Customer field.
Properties panel settings

For this visualization, the following properties were set in the properties panel under Appearance > Colors and Legends:

- **Colors**: Set to Custom and By expression.
- **Expression**: Set to if([Customer] = 'Fill It', rgb(100, 149, 227), if([Customer] = 'Hetrick Systems', rgb(100, 149, 200), if([Customer] = 'Icon', rgb(100, 149, 175), if([Customer] = 'J. S. Lee Associates', rgb(100, 149, 150), 'grey'))).
- **This expression is a color code**: Set to enabled.

Converting a visualization to another kind of visualization

You can convert from one visualization type to another by dragging a chart from the assets panel on the left-hand side onto the visualization that you want to convert.

All properties that the original visualization has are transferred to the new type. The new visualization uses the dimensions, measures, and settings that are applicable to that visualization type. If a visualization requires an additional primary dimension or measure, the first listed alternative dimension or measure is used by default. If no alternative dimensions or measures exist and one is required the new visualization, you will be prompted to add one.

All properties from the original visualization are saved, even if they are not available or visible in the new visualization. This means that properties can become available again if you decide to convert to yet another visualization type where those properties are used.
Do the following:

1. While editing a sheet, drag a new chart from the assets panel onto the visualization that you want to convert. The shortcut menu opens.
2. Select the conversion option.

The new visualization is displayed, using the data from the original visualization.

**i** When you convert to a new visualization type, some of the settings from the original visualization may not be optimal for the new visualization, for example, the sorting order. Therefore, you may need to make some changes in the properties panel, so that the new visualization is displayed as you want.

**i** You cannot convert to or from a map or a text & image visualization, nor can you convert a master visualization.

Embedding a visualization or a sheet in a web page

You can integrate Qlik Sense visualizations or sheets into an iframe element on a web page with the Single Integration API. This could for example be a web page on your intranet. You select which visualization or sheet to embed, and make some settings to customize selections, interaction and appearance. Then you can copy the iframe code containing the URL of the object and add it to your web page.

The embedded object will be subject to the same access rules as the original object and app. This means that anyone who wants to view the embedded object must have:

- Access to Qlik Sense.
- Access to the app. If the app is unpublished (in My work), you are the only one with access.
- Access to the sheet. If the sheet is unpublished (in My sheets) in a published app, you are the only one with access.
- Access to any bookmark used for selection. Private bookmarks will be applied for you, but not for anyone else.
- Same access to the data used in the selection as you, if section access is used to restrict data access.

**Embedding a sheet**

You can embed a sheet in your web page.

Do the following:

1. Click Embed sheet in the global menu.
2. Customize selections, appearance and interaction options for the embedded sheet.
3. Click **Open preview in new tab** to see a preview of the embedded sheet.
4. Click **Copy**.

You now have the iframe code of the sheet in your clipboard, ready to add to your web page.

**Embedding a visualization**

You can embed a visualization in your web page.

Do the following:

1. Click **Embed chart** in the context menu of a visualization, or in the toolbar of a master visualization.
2. Customize selections, appearance and interaction options for the embedded visualization.
3. Click **Open preview in new tab** to see a preview of the embedded visualization.
4. Click **Copy**.

You now have the iframe code of the visualization in your clipboard, ready to add to your web page.

**Setting appearance and interaction**

You can customize how you can interact with the embedded object.

- **Allow interaction**
  You can select if you want the user to be able to interact with the embedded object.

- **Enable context menu**
  You can select if you want the context menu to be available when the embedded object is right-clicked.

- **Language**
  You can select which language to use in menus for the embedded object.

- **Theme**
  You can select which theme to use for the embedded object.

**Selections in the embedded object**

You can choose if the user can make selections in the embedded object, and which selection state to show in the embedded object.

- **Use current selections**
  You can select to use the current selections in the app.

- **Show selections bar**
  You can select to show the selections bar above the sheet.

- **Allow selections**
  You can select if you want the user to be able to make selections in the embedded object. You also need to enable **Allow interaction**.

- **Clear selections on reload**
  You can select to clear all selections made in the app when the object is rendered.

- **Apply bookmark**
  You can select to apply a bookmark and use the selections defined in the bookmark.
3 Creating visualizations

When the page containing the embedded object is rendered, the initial selection state is defined by the order of execution and your settings.

1. **Clear selections on reload**
2. **Apply bookmark**
3. **Use current selections**

When you make selections in the embedded object, they will be replicated in the app. If you select **Clear selections on reload**, for example, and use the embedded object, selections are cleared in the app.

You can use *Open preview in new tab* to preview the embedded object, and interact without affecting selections in the app.

**Limitations of embedded objects**

- **Embed sheet** and **Embed chart** features are not available on mobile devices.
- The URL is limited to 2083 characters due to browser limitations. If your URL is too long, this is most likely due to a large number of individual selections.

You can create a bookmark with the same set of selections, and apply the bookmark. This will create a shorter URL.

### 3.10 Troubleshooting - Creating visualizations

This section describes problems that can occur when creating visualizations in Qlik Sense.

**I cannot find the fields in the assets panel**

I can find **Charts** and **Master items** in the assets panel, but not **Fields**.

**Possible cause**

You are working with a published app. Some content is not available in the assets panel in a published app.

**My chart is not sorted correctly**

I set my chart to sort automatically on the dimension, but the results are not sorted correctly.

**Possible cause**

The dimension is an expression with a result that has a different data type than the data fields used in the expression.
Proposed action

Change sorting of the dimension to Custom, and select a sorting option that matches the result of the expression. For example, if your expression concatenates two fields to a string, like Month(salesDate)'/'&Day(salesDate), select to sort alphabetically.

My calendar measures display incorrect aggregations in visualizations

When I use my calendar measures in visualizations, I see incorrect aggregation results. For example, calendar measures created from identical fields and aggregations but different time ranges may display identical totals.

Possible cause

The table containing the aggregated field is not associated to the table containing the date field, preventing accurate aggregation of the field by the selected time ranges.

Proposed action

Create an association between the table containing the aggregated field and the table containing the date field. If there is no association possible, in Data manager, add a table that includes a date field that has an association to the table containing the aggregated field.

There are no time ranges to select in Create calendar measures

When I have a date field selected in the Create calendar measures dialog try to create calendar measures from a field, there are no time ranges to select in the Create calendar measures dialog.

Possible cause

The selected date field does not have the correct time flags to work with calendar measures. If you have no valid date fields, you cannot create calendar measures. If you have at least one valid date field, all date fields will be available in Date field. However, only those with the correct time flags set in autoCalendar enable the selection of time ranges from the Time Range drop-down list.

Proposed action

Select a date field that uses autoCalendar. If you are unsure which calendar is associated to your date field, date fields in the Field section of the Assets panel which calendar it uses when clicked.

My date field selected for calendar measures does not use the correct calendar

I have two calendars to which I have manually added time flags. My time flags have the same names as those in autoCalendar, making both qualified for use with calendar measures. However, only one of my calendars has the same definition for the time flags as autoCalendar. I have a date field associated to both calendars. When I try to create calendar measures using that date field, the calendar with the correct names but different definitions than autoCalendar is used.
3 Creating visualizations

Possible cause

In cases where a date field is associated to multiple calendars and each calendar has the correctly named time flags set in it, calendar measures uses the first qualified calendars defined in your data load script.

Proposed action

Move the script section containing the calendar you want to use with calendar measures before other qualified calendars in your data load script.

I cannot edit a variable value

I cannot edit a variable that is listed in the variables overview.

Possible cause

The variable is defined in the script.

Proposed action

Edit the variable in the script, using the data load editor, or delete the variable from the script, using the data load editor, to make the variable editable from the variables overview.

For more information, see Editing a variable (page 96)

You cannot rename a variable.

The map is placing the locations in my location field incorrectly

When I add a location field to a layer in my map, the locations do not display in the correct places.

Possible cause

The map does not have enough context to locate the locations in your field. This can happen when a location in the field shares a name with a number of other possible locations on the map.

Proposed action

Set Scope for Location in your layer to Custom and enter additional information. Alternatively, qualify your location field using an expression that contains additional fields with relevant geographic information. If your location field contained cities and you had Country and State fields, you could use [city]&’ , & [State]&’ , & [country].

No map is displayed

I am using Qlik Geoanalytics server, the background map is not displayed.
Possible cause

Your browser cannot access qlikcloud.com or your firewall settings or proxies prevent the use of JavaScript from qlikcloud.com.

Proposed action

Visit the status page from your browser.

If your browser cannot access qlikcloud.com contact your system administrator for assistance.

If the page prints "ok" then your browser can access qlikcloud.com. Make sure that JavaScript from qlikcloud.com is allowed.

Do the following:

- Add https://*.qlikcloud.com as a trusted site. (recommended)
- Enable JavaScript from untrusted sites. (not recommended)

Error message: The data contains invalid geometries that could not be shown on the map. Review your data for errors and try again.

I loaded geoshapes from a KML file to Qlik Sense. When I try to add the field to my map, an error message tells me that my data contains invalid geometries that could not be shown on the map.

Possible cause

There is an error in your geometries that is preventing Qlik Sense from displaying them on the map or your geometry data may be in an invalid format.

Proposed action

Review your geometry data for errors and try again.

Error message: The following locations could not be found: <locations>. Review the values in your data and try again.

I added my location field to my map and I received an error messaging telling me locations in my location field could not be found.

Possible cause

Qlik Sense could not find the location. There may be a spelling error in the name or the location is not available in the Qlik Sense location database.

Proposed action

Review the values in your data for errors and try adding the field again. If a location cannot be found, you can alternatively manually add it using coordinates for points or geoshapes for areas.
Error message: The following locations could not be located:
<locations>. Review the values in your data and try again.

I added a location field to my layer and I received an error message telling me that certain locations in my location field could not be located.

Possible cause
Qlik Sense could not find the location. There may be a spelling error in the name or the location is not available in the Qlik Sense location database.

Proposed action
Review the values in your data for errors and try adding the field again. If a location cannot be found, you can alternatively manually add it using coordinates for points or geoshapes for areas.

Error message: The following locations had more than one result:
<locations>. Set a custom scope to clarify which locations to display.

I added a location field to my layer and I received an error message telling me that certain locations in my field had more than one possible result on the map.

Possible cause
One or more locations in your location field are ambiguous, with multiple possible locations on your map.

Proposed action
Set Scope for Location in your layer to Custom and enter additional information. Alternatively, qualify your location field using an expression that contains additional fields with relevant geographic information. If your location field contained cities, you, such as: [City]&', '&[County]&', '&[State].

Error message: Some lines could not be shown because of invalid data in the width expression. Review your data for errors and try again.

I entered a field or expression to control the width of the lines on my map and I received an error message telling me that certain lines have invalid data.

Possible cause
There is an error in your width expression that is preventing Qlik Sense from displaying specific lines on the map.

Proposed action
Your expression may contain non-numeric values. Review your data for errors and try again.
Error message: Some density points could no be shown because of invalid data in the weight expression. Review your data for errors and try again.

I entered a field or expression to control the density of the points on my map and I received an error message telling me that certain densities have invalid data.

Possible cause
There is an error in your weight expression that is preventing Qlik Sense from displaying specific densities on the map.

Proposed action
Your expression may contain non-numeric values. Review your data for errors and try again.

I added an image background layer and cannot see my image
I added an image background layer to my map visualization, but I cannot see it on the map.

Possible cause
Depending on the projection of your map and the scale of the image, the map may be too zoomed out to see the image.

Proposed action
Do one of the following:

- In Map settings, enable Auto-zoom. Add a layer containing location data that would put it over the same area as your image background layer.
- In Presentation, enable Show debug info. The map now includes coordinates for the center of the displayed area.